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CAPITOLUL1

Curs Introductiv

1.1 Cuvânt înainte

Welcome to our course! We will be showing you how to use QGIS easily and efficiently. If you are new to GIS,
we will tell you what you need to get started. If you are an experienced user, you will see how QGIS fulfills all the
functions you expect from a GIS program, and more!

1.1.1 Why QGIS?

As information becomes increasingly spatially aware, there is no shortage of tools able to fulfill some or all commonly
used GIS functions. Why should anyone be using QGIS over some other GIS software package?
Here are only some of the reasons:

• It’s free, as in lunch. Installing and using the QGIS program costs you a grand total of zero money. No initial
fee, no recurring fee, nothing.

• It’s free, as in liberty. If you need extra functionality in QGIS, you can domore than just hope it will be included
in the next release. You can sponsor the development of a feature, or add it yourself if you are familiar with
programming.

• It’s constantly developing. Because anyone can add new features and improve on existing ones, QGIS never
stagnates. The development of a new tool can happen as quickly as you need it to.

• Extensive help and documentation is available. If you’re stuck with anything, you can turn to the extensive
documentation, your fellow QGIS users, or even the developers.

• Cross-platform. QGIS can be installed on macOS, Windows and Linux.
Now that you know why you want to use QGIS, these exercises will make you know how.
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1.1.2 Fundal

In 2008 we launched the Gentle Introduction to GIS, a completely free, open content resource for people who want to
learn about GIS without being overloaded with jargon and new terminology. It was sponsored by the South African
government and has been a phenomenal success, with people all over the world writing to us to tell us how they are
using thematerials to runUniversity Training Courses, teach themselves GIS and so on. TheGentle Introduction is not
a software tutorial, but rather aims to be a generic text (although we used QGIS in all examples) for someone learning
about GIS. There is also the QGIS manual which provides a detailed functional overview of the QGIS application.
However, it is not structured as a tutorial, but rather as a reference guide. At Linfiniti Consulting CC. we frequently
run training courses and have realised that a third resource is needed - one that leads the reader sequentially through
learning the key aspects of QGIS in a trainer-trainee format - which prompted us to produce this work.
Acest manual de instruire pune la dispozit,ie toate materialele necesare desfăs,urării unui curs de 5 zile despre
QGIS, PostgreSQL s, i PostGIS. Cursul are un cont,inut structurat, fiind deopotrivă adecvat începătorilor, utilizatorilor
intermediari sau avansat,i, s, i având multe exercit,ii cu răspunsuri complete adnotate.

1.1.3 Licent,ă

The Free Quantum GIS Training Manual by Linfiniti Consulting CC. is based on an earlier version from Linfiniti and
is licensed under a Creative Commons Attribution 4.0 International. Permissions beyond the scope of this license
may be available at below.
We have published this QGIS training manual under a liberal license that allows you to freely copy, modify and
redistribute this work. A complete copy of the license is available at the end of this document. In simple terms, the
usage guidelines are as follows:

• Nu putet,i prezenta acest material ca fiind scris de dvs., sau să eliminat,i textele de acreditare din această lucrare.
• Nu avet,i dreptul să redistribuit,i această lucrare sub permisiuni mai restrictive decât cele pe baza cărora v-a fost
furnizată dumneavoastră.

• If you add a substantive portion to the work and contribute it back to the project (at least one complete module)
you may add your name to the end of the authors list for this document (which will appear on the front page)

• Dacă efectuat,i modificări minore s, i corecturi vă putet,i adăuga în lista de contribuitori de mai jos.
• Dacă at,i tradus acest document în întregime, vă putet,i adăuga numele în lista autorilor, în felul următor
„Traducere efectuată de Joe Bloggs”.

• În cazul în care sponsorizat,i un modul sau o lect,ie, putet,i solicita autorului să includă o informat,ie despre acest
lucru, la începutul fiecărei lect,ii la care at,i contribuit, cum ar fi:

Notă: Această lect,ie a fost sponsorizată de MegaCorp.

• Dacă avet,i nelămuriri cu privire la ceea ce se poate face sub această licent,ă, vă rugăm să ne contactat,i la
office@linfiniti.com, pentru a vă informa dacă ceea ce intent,ionat,i să facet,i este acceptabil.

• If you publish this work under a self publishing site such as https://www.lulu.com we request that you donate
the profits to the QGIS project.

• You may not commercialise this work, except with the expressed permission of the authors. To be clear, by
commercialisation we mean that you may not sell for profit, create commercial derivative works (e.g. selling
content for use as articles in a magazine). The exception to this is if all the profits are given to the QGIS project.
You may (and we encourage you to do so) use this work as a text book when conducting training courses, even
if the course itself is commercial in nature. In other words, you are welcome to make money by running a
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training course that uses this work as a text book, but you may not profit off the sales of the book itself - all
such profits should be contributed back to QGIS.

1.1.4 Capitole Sponsorizate

This work is by no means a complete treatise on all the things you can do with QGIS and we encourage others to add
new materials to fill any gaps. Linfiniti Consulting CC. can also create additional materials for you as a commercial
service, with the understanding that all such works produced should become part of the core content and be published
under the same license.

1.1.5 Autori

• Rüdiger Thiede - Rudi has written the QGIS instructional materials and parts of the PostGIS materials.
• Tim Sutton (tim@kartoza.com) - Tim has overseen and guided the project and co-authored the PostgreSQL
and PostGIS parts.

• Horst Düster (horst.duester@kappasys.ch ) - Horst este co-autor al părt,ilor de PostgreSQL s, i PostGIS
• Marcelle Sutton - Marcelle provided proof-reading and editorial advice during the creation of this work.

1.1.6 Contribut, ii Individuale

Introduceţi numele dvs. aici!

1.1.7 Sponsori

• Universitatea de Tehnologie din Cape Peninsula

1.1.8 Fis, iere sursă s, i rapoarte despre probleme

Sursa acestui document se poate găsi în Depozitul Documentat,iei QGIS de pe GitHub. Consultat,i GitHub.com pentru
instruct,iunile de folosire a sistemului de versionare git.
În ciuda eforturilor depuse, at,i putea găsi unele erori sau at,i putea omite unele informat,ii pe durata acestei instruiri.
Vă rugăm să le raportat,i la https://github.com/qgis/QGIS-Documentation/issues.

1.1.9 Ultima versiune

You can always obtain the latest version of this document by visiting the online version which is part of the QGIS
documentation website (https://www.qgis.org/resources/hub/#documentation).

Notă: The documentation website contains links to both online and PDF versions of the Training manual and other
parts of the QGIS documentation.
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1.2 About the exercises

Now that you know why you want to use QGIS, we can show you how.

Atent,ionare: This course includes instructions on adding, deleting and altering GIS datasets. We have provided
training datasets for this purpose. Before using the techniques described here on your own data, always ensure
you have proper backups!

1.2.1 How to use this tutorial

Any text that looks like this refers to something that you can see in the QGIS user interface.
Text that looks ► like ► this directs you through menus.
This kind of text refers to something you can type, such as a command.
This/kind/of.text refers to a path or filename.
This+That refers to a keyboard shortcut comprised of two buttons.

1.2.2 Tiered course objectives

This course caters to different user experience levels. Depending on which category you consider yourself to be in,
you can expect a different set of course outcomes. Each category contains information that is essential for the next
one, so it’s important to do all exercises that are at or below your level of experience.

��� (Basic level) Basic

In this category, the course assumes that you have little or no prior experience with theoretical GIS knowledge or the
operation of GIS software.
Limited theoretical background will be provided to explain the purpose of an action you will be performing in the
program, but the emphasis is on learning by doing.
When you complete the course, you will have a better concept of the possibilities of GIS, and how to harness their
power via QGIS.

��� (Moderate level) Intermediate

In this category, it is assumed that you have working knowledge and experience of the everyday uses of GIS software.
Building on the instructions for the beginner level will provide you with familiar ground, as well as to make you aware
of the cases where QGIS does things slightly differently from other software you may be used to. You will also learn
how to use analysis functions in QGIS.
When you complete the course, you should be comfortable with using QGIS for all of the functions you usually need
for everyday use.
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��� (Advanced level) Advanced

In this category, the assumption is that you are experienced with GIS software, have knowledge of and experience
with spatial databases, using data on a remote server, perhaps writing scripts for analysis purposes, etc.
Building on the instructions for the other two levels will familiarize you with the approach that the QGIS interface
follows, and will ensure that you know how to access the basic functions that you need. You will also be shown how
to make use of the QGIS plugin system, database access, and so on.
When you complete the course, you should be well-acquainted with the everyday operation of QGIS, as well as its
more advanced functions.

1.2.3 Data

The sample data that accompanies this resource is freely available and comes from the following sources:
• Streets and Places datasets from OpenStreetMap
• Property boundaries (urban and rural), water bodies from NGI
• SRTM DEM from the CGIAR CSI

Download the prepared dataset from the Training data repository and unzip the file. All the necessary data are
provided in the exercise_data folder.
If you are an instructor, and would like to use more relevant data, you will find instructions for creating local data in
the Pregătirea Datelor pentru Exercit,ii appendix.
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CAPITOLUL2

Modulul;: Crearea s, i Explorarea unei Hărt,i de Bază

În acest modul, vet,i crea o hartă de bază care va fi folosită mai târziu pentru demonstrat,ii ulterioare ale
funct,ionalităt,ilor QGIS.

2.1 Lesson: An Overview of the Interface

Vom explora interfat,a cu utilizatorul QGIS, pentru a vă familiariza cu meniurile, barele de instrumente, canevasul
hărt,ii s, i lista de straturi care formează structura de bază a interfet,ei.
Scopul acestei lect,ii: De a înt,elege not,iunile de bază ale interfet,ei QGIS.
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2.1.1 ��� Try Yourself: The Basics

Elementele identificate în figura de mai sus sunt:
1. Lista Straturilor/Panoul Navigatorului
2. Bare de instrumente
3. Canevasul hărt,ii
4. Bara de Stare
5. Bara Laterală de Instrumente
6. Bara locatorului

��� The Layers List

În lista Straturi, putet,i vedea o listă, în orice moment, a tuturor straturilor disponibile pentru dvs.
Extinderea obiectelor restrânse (făcând clic pe săgeata sau pe simbolul plus de lângă ei) vă va oferi maimulte informat,ii
despre aspectul stratului actual.
Hovering over the layer will give you some basic information: layer name, type of geometry, coordinate reference
system and the complete path of the location on your device.
Un clic-dreapta pe un strat vă va oferi un meniu cu o mult,ime de opt,iuni suplimentare. Vet,i folosi unele dintre ele
mult timp de acum înainte, as,a că haidet,i să aruncăm o privire asupra lor!

Notă: Un strat vectorial este un set de date, de obicei, al unui anumit tip de obiect, cum ar fi drumuri, copaci, etc.
Un strat vectorial poate consta fie în puncte, în linii sau poligoane.
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��� The Browser Panel

The QGIS Browser is a panel in QGIS that lets you easily navigate in your database. You can have access to common
vector files (e.g. ESRI Shapefile or MapInfo files), databases (e.g. PostGIS, Oracle, SpatiaLite, GeoPackage or MS
SQL Server) and WMS/WFS connections. You can also view your GRASS data.
If you have saved a project, the Browser Panel will also give you quick access to all the layers stored in the same path
of the project file under in the Project Home item.
Moreover, you can set one or more folder as Favorites: search under your path and once you have found the folder,
right click on it and click on Add as a Favorite. You should then be able to see your folder in the Favorites
item.

Sfat: It can happen that the folders added to Favorite item have a really long name: don’t worry right-click on the
path and choose Rename Favorite... to set another name.

��� Toolbars

Your most often used sets of tools can be turned into toolbars for basic access. For example, the Project toolbar
allows you to save, load, print, and start a new project. You can easily customize the interface to see only the tools
you use most often, adding or removing toolbars as necessary via the View ► Toolbars menu.
Even if they are not visible in a toolbar, all of your tools will remain accessible via the menus. For example, if you
remove the Project toolbar (which contains the Save button), you can still save your map by clicking on the Project
menu and then clicking on Save.

��� The Map Canvas

This is where the map itself is displayed and where layers are loaded. In the map canvas you can interact with the
visible layers: zoom in/out, move the map, select features and many other operations that we will deeply see in the
next sections.

��� The Status Bar

Shows you information about the current map. Also allows you to adjust the map scale, the map rotation and see the
mouse cursor’s coordinates on the map.

��� The Side Toolbar

By default the Side toolbar contains the buttons to load the layer and all the buttons to create a new layer. But
remember that you can move all the toolbars wherever it is more comfortable for you.

��� The Locator Bar

Within this bar you can access to almost all the objects of QGIS: layers, layer features, algorithms, spatial bookmarks,
etc. Check all the different options in the locator_options section of the QGIS User Manual.

Sfat: With the shortcut Ctrl+K you can easily access the bar.
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2.1.2 ��� Try Yourself: 1

Încercat,i să identificat,i cele patru elemente enumerate pe ecranul dvs., fără a face referire la diagrama de mai sus.
Vedet,i dacă putet,i identifica numele s, i funct,iile lor. Vă vet,i familiariza cu aceste elemente, pe măsură ce le vet,i folosi
în următoarele zile.

Răspuns
Refer back to the image showing the interface layout and check that you remember the names and functions of the
screen elements.

2.1.3 ��� Try Yourself: 2

Încercat,i să identificat,i fiecare dintre aceste instrumente pe ecran. Care este scopul lor?

1.

2.

3.

4. Render

5.

Notă: Dacă nici unul dintre aceste instrumente nu este vizibil pe ecran, încercat,i să activat,i unele bare de instrumente
care sunt în prezent ascunse. De asemenea, ret,inet,i că, dacă nu există suficient spat,iu pe ecran, o bară de instrumente
poate fi redusă prin ascunderea unora dintre instrumentele sale. Putet,i vedea instrumentele ascunse, făcând clic pe
butonul cu două săget,i îndreptate în dreapta, de pe oricare bară de instrumente restrânsă. Putet,i vedea un balon cu
numele oricărui instrument, prin trecerea un pic a mouse-ului pe deasupra unui instrument.

Răspuns
1. Save as
2. Zoom to layer(s)

3. Invert selection
4. Rendering on/off
5. Measure line

2.1.4 Ce urmează?

Now that you are familiar with the basics of the QGIS interface, in the next lesson we will see how to load some
common data types.
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2.2 Lesson: Adding your first layers

Vom porni aplicat,ia, s, i vom crea o hartă de bază, pentru utilizarea în exemple s, i exercit,ii.
Scopul acestei lect,ii: De a începe cu un exemplu de hartă.

Notă: Before starting this exercise, QGIS must be installed on your computer. Also, you should have downloaded
the sample data to use.

Lansat,i QGIS cu ajutorul scurtăturii de pe ecran, din meniul de strat, etc., în funct,ie de modul în care at,i efectuat
instalarea.

Notă: The screenshots for this course were taken in QGIS 3.4 running on Linux. Depending on your setup, the
screens you encounter may well appear somewhat different. However, all the same buttons will still be available, and
the instructions will work on any OS. You will need QGIS 3.4 (the latest version at time of writing) to use this course.

Să începem imediat!

2.2.1 ��� Follow Along: Prepare a map

1. Deschidet,i QGIS. Vet,i avea o hartă nouă, albă.

2. The Data Source Manager dialog allows you to choose the data to load depending on the data type. We’ll use
it to load our dataset: click the Open Data Source Manager button.
If you can’t find the icon, check that theData Source Manager toolbar is enabled in the View► Toolbarsmenu.

2.2. Lesson: Adding your first layers 13



QGIS Training Manual

3. Load the protected_areas.shp vector dataset:
1. Click on the Vector tab.

2. Enable the File source type.
3. Press the… button next to Vector Dataset(s).
4. Select the exercise_data/shapefile/protected_areas.shp file in your training

directory.
5. Click Open. You will see the original dialog, with the file path filled in.
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6. Click Add here as well. The data you specified will now load: you can see a protected_areas item
in the Layers panel (bottom left) with its features shown in the main map canvas.
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Felicitări! Avet,i o hartă de bază. Acum ar fi un moment bun pentru a vă salva munca.

1. Clic pe butonul Save As:
2. Save the map under a solution folder next to exercise_data and call it basic_map.qgz.

2.2.2 ��� Try Yourself:

Repeat the steps above to add the places.shp and rivers.shp layers from the same folder
(exercise_data/shapefile) to the map.

Answer
In the main area of the dialog you should see many shapes with different colors. Each shape belongs to a layer you
can identify by its color in the left panel (your colors may be different from the ones in Fig. 2.1 below):

Fig. 2.1: A basic map

2.2.3 ��� Follow Along: Loading vector data from a GeoPackage Database

Databases allow you to store a large volume of associated data in one file. You may already be familiar with a
database management system (DBMS) such as Libreoffice Base or MS Access. GIS applications can also make use
of databases. GIS-specific DBMSes (such as PostGIS) have extra functions, because they need to handle spatial data.
The GeoPackage open format is a container that allows you to store GIS data (layers) in a single file. Unlike the ESRI
Shapefile format (e.g. the protected_areas.shp dataset you loaded earlier), a single GeoPackage file can
contain various data (both vector and raster data) in different coordinate reference systems, as well as tables without
spatial information; all these features allow you to share data easily and avoid file duplication.
In order to load a layer from a GeoPackage, you will first need to create the connection to it:

1. Click on the Open Data Source Manager button.

2. On the left click on the GeoPackage tab.
3. Click on the New button and browse to the training_data.gpkg file in the exercise_data folder

you downloaded before.
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4. Select the file and press Open. The file path is now added to the Geopackage connections list, and appears in
the drop-down menu.

You are now ready to add any layer from this GeoPackage to QGIS.
1. Click on the Connect button. In the central part of the window you should now see the list of all the layers

contained in the GeoPackage file.
2. Select the roads layer and click on the Add button.

A roads layer is added to the Layers panel with features displayed on the map canvas.
3. Click on Close.

Congratulations! You have loaded the first layer from a GeoPackage.

2.2.4 ��� Follow Along: Loading vector data from a SpatiaLite Database with
the Browser

QGIS provides access to many other database formats. Like GeoPackage, the SpatiaLite database format is an
extension of the SQLite library. And adding a layer from a SpatiaLite provider follows the same rules as described
above: Create the connection –> Enable it –> Add the layer(s).
While this is one way to add SpatiaLite data to your map, let’s explore another powerful way to add data: the Browser.

1. Click the icon to open the Data Source Manager window.

2. Click on the Browser tab.
3. In this tab you can see all the storage disks connected to your computer as well as entries for most of the tabs

in the left. These allow quick access to connected databases or folders.

For example, click on the drop-down icon next to the GeoPackage entry. You’ll see the
training-data.gpkg file we previously connected to (and its layers, if expanded).
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4. Right-click the SpatiaLite entry and select New Connection….
5. Navigate to the exercise_data folder, select the landuse.sqlite file and click Open.

Notice that a landuse.sqlite entry has been added under the SpatiaLite one.

6. Expand the landuse.sqlite entry.

7. Double-click the landuse layer or select and drag-and-drop it onto the map canvas. A new layer is added
to the Layers panel and its features are displayed on the map canvas.

Sfat: Enable the Browser panel in View ► Panels ► and use it to add your data. It’s a handy shortcut for the Data
Source Manager ► Browser tab, with the same functionality.

Notă: Remember to save your project frequently! The project file doesn’t contain any of the data itself, but it
remembers which layers you loaded into your map.
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2.2.5 ��� Try Yourself: Load More Vector Data

Load the following datasets from the exercise_data folder into your map using any of the methods explained
above:

• buildings

• water

Answer
Your map should have seven layers:

• protected_areas

• places

• rivers

• roads

• landuse

• buildings (taken from training_data.gpkg) and
• water (taken from exercise_data/shapefile).

2.2.6 Follow Along: Reordering the Layers

Straturile din lista de straturi sunt desenate pe hartă într-o anumită ordine. Stratul cel mai jos în listă este desenat
primul, iar stratul de la vârful listei este desenat ultimul. Schimbând ordinea în care sunt prezentate în listă putet,i
schimba ordinea în care sunt desenate.

Notă: You can alter this behavior using the Control rendering order checkbox beneath the Layer Order panel. We
will however not discuss this feature yet.

Ordinea în care straturile au fost încărcate în hartă probabil că nu este logică în acest moment. Este posibil ca stratul
de străzi să fie complet ascuns deoarece alte straturi sunt deasupra lui.
De exemplu, această ordine a straturilor…

… would result in roads and places being hidden as they run underneath the polygons of the landuse layer.
Pentru a rezolva această problemă:

1. Clic apoi glisat,i pe un strat din Lista straturilor.
2. Reordonat,i-le, pentru a arăta în felul următor:
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Vet,i vedea că harta are mai mult sens, cu străzile s, i clădirile desenate deasupra regiunilor.

2.2.7 În concluzie

Now you’ve added all the layers you need from several different sources and created a basic map!

2.2.8 Ce urmează?

Now you’re familiar with the basic function of the Open Data Source Manager button, but what about all the others?
How does this interface work? Before we go on, let’s take a look at some basic interaction with the QGIS interface.
This is the topic of the next lesson.

2.3 Lesson: Navigating the Map Canvas

Această sect,iune se va concentra asupra instrumentelor de navigat,ie principale, folosite la navigarea pe Canevasul
Hărt,ilor din QGIS. Aceste instrumente vă vor permite explorarea vizuală a straturilor, la diverse scări.
Scopul acestei lect,ii: Înt,elegerea not,iunilor despre scara hărt,ii s, i utilizarea instrumentelor Deplasare s, i Zoom din
QGIS.

2.3.1 ��� Follow Along: Basic Navigation Tools

Before learning how to navigate within the Map Canvas, let’s add some layers that we can explore during this tutorial.
1. Open a new blank project and using the steps learnt in Create a Map, load the previously seen

protected_areas, roads and buildings layers to the project. The result view should look similar to
the snippet in Fig. 2.2 below (colors do not matter):
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Fig. 2.2: Protected areas, roads and buildings added

Let’s first learn how to use the Pan Tool.

1. In the Map Navigation Toolbar, make sure the Pan button is activated.
2. Move the mouse to the center of the Map Canvas area.
3. Left-click and hold, and drag the mouse in any direction to pan the map.

Next, let’s zoom in and take a closer look at the layers we imported.

1. In the Map Navigation Toolbar, click on the Zoom In button.
2. Move your mouse to approximately the top left area of where there is the highest density of buildings and roads.
3. Left click and hold.
4. Then drag the mouse, which will create a rectangle, and cover the dense area of buildings and roads (Fig. 2.3).
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Fig. 2.3: Zoom in

5. Release the left click. This will zoom in to include the area that you selected with your rectangle.
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6. To zoom out, select the Zoom Out button and perform the same action as you did for zooming in.
As you pan, zoom in, or zoom out, QGIS saves these views in a history. This allows you to backtrack to a previous
view.

1. In the Map Navigation Toolbar, click on Zoom Last button to go to your previous view.

2. Click on Zoom Next button to proceed to move forward in your history.
Sometimes after exploring the data, we need to reset our view to the extent of all the layers. Instead of trying to use
the Zoom Out tool multiple times, QGIS provides us with a button to do that action for us.

1. Click on the Zoom Full Extent button.
As you zoomed in and out, notice that the Scale value in the Status Bar changes. The Scale value represents the Map
Scale. In general, the number to the right of : represents how many times smaller the object you are seeing in the
Map Canvas is to the actual object in the real world.
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You can also use this field to set the Map Scale manually.
1. In the Status Bar, click on the Scale text field.
2. Type in 50000 and press Enter. This will redraw the features in the Map Canvas to reflect the scale you

typed in.
3. Alternatively, click on the options arrow of the Scale field to see the preset map scales.

4. Select 1:5000. This will also update the map scale in the Map Canvas.
Now you know the basics of navigating the Map Canvas. Check out the User Manual on Zooming and Panning to
learn about alternative ways of navigating the Map Canvas.

2.3.2 În concluzie

Knowing how to navigate the Map Canvas is important, as it allows one to explore and visually inspect the layers.
This could be done for initial data exploration, or to validate output of a spatial analysis.

2.4 Lesson: Symbology

Simbolistica unui strat reprezintă aspectul său vizual pe hartă. Abilităt,ile de bază ale GIS, comparativ cu alte moduri
de reprezentare a datelor cu aspecte spat,iale, constă în faptul că, în GIS, avet,i o reprezentare vizuală dinamică a
datelor cu care lucrat,i.
Prin urmare, aspectul vizual al hărt,ii (care depinde de simbolistica straturilor individuale) este foarte important.
Utilizatorul final a hărt,ilor pe care le producet,i, va trebui să fie capabil de a înt,elege cu us,urint,ă ceea ce reprezintă
harta. La fel de important, dvs. trebuie să fit,i în măsură să explorat,i datele cu care lucrat,i, iar o bună simbolistică
ajută foarte mult.
Cu alte cuvinte, a avea propria simbologie nu reprezintă un lux sau doar o not,iune frumoasă. De fapt, este esent,ial să
utilizat,i un GIS în mod corespunzător, pentru a produce hărt,i s, i informat,ii pe care oamenii să le poată folosi.
Scopul acestei lect,ii: De a putea crea simbolistica dorită pentru orice strat vectorial.
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2.4.1 ��� Follow Along: Changing Colors

To change a layer’s symbology, open its Layer Properties. Let’s begin by changing the color of the landuse layer.
1. Right-click on the landuse layer in the layers list.
2. Select the menu item Properties… in the menu that appears.

Notă: De asemenea, în mod implicit, putet,i accesa proprietăt,ile unui strat făcând un dublu clic pe acesta, în
lista Straturilor.

Sfat: The button at the top of the Layers panel will open the Layer Styling panel. You can use this panel
to change some properties of the layer: by default, changes will be applied immediately!

3. In the Layer Properties window, select the Symbology tab:

4. Click the color select button next to the Color label. A standard color dialog will appear.
5. Aleget,i o culoare gri, apoi facet,i clic pe OK.
6. Clic iarăs, i pe OK din fereastra Layer Properties, apoi vet,i vedea schimbarea de culoare asupra stratului.
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2.4.2 ��� Try Yourself:

Change the color of the water layer to light blue. Try to use the Layer Styling panel instead of the Layer Properties
menu.

Solut,ie
• Verify that the colors are changing as you expect them to change.

• It is enough to select the water layer in the legend and then click on the Open the Layer Styling panel button.
Change the color to one that fits the water layer.

If you want to work on only one layer at a time and don’t want the other layers to distract you, you can hide a layer
by clicking in the checkbox next to its name in the layers list. If the box is blank, then the layer is hidden.

2.4.3 ��� Follow Along: Changing Symbol Structure

This is good stuff so far, but there’s more to a layer’s symbology than just its color. Next we want to eliminate the
lines between the different land use areas so as to make the map less visually cluttered.

1. Open the Layer Properties window for the landuse layer.

Under the Symbology tab, you will see the same kind of dialog as before. This time, however, you’re
doing more than just quickly changing the color.

2. In the symbol layers tree, expand the Fill dropdown and select the Simple fill option.
3. Click on the Stroke style dropdown. At the moment, it should be showing a short line and the words Solid Line.
4. Change this to No Line.
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5. Clic pe OK
Now the landuse layer won’t have any lines between areas.

2.4.4 ��� Try Yourself:

• Change the water layer’s symbology again so that it has a darker blue outline.
• Change the rivers layer’s symbology to a sensible representation of waterways.

Remember: you can use the Open the Layer Styling panel button and see all the changes instantly. That panel also allows
you to undo individual changes while symbolizing a layer.

Răspuns
Your map should now look like this:
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If you are a Beginner-level user, you may stop here.
• Use the method above to change the colors and styles for all the remaining layers.
• Try using natural colors for the objects. For example, a road should not be red or blue, but can be gray or black.
• Also feel free to experiment with different Fill style and Stroke style settings for the polygons.
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2.4.5 ��� Follow Along: Scale-Based Visibility

Sometimes you will find that a layer is not suitable for a given scale. For example, a dataset of all the continents may
have low detail, and not be very accurate at street level. When that happens, you want to be able to hide the dataset
at inappropriate scales.
In our case, we may decide to hide the buildings from view at small scales. This map, for example…

… nu este foarte utilă. Clădirile sunt greu de distins la acea scară.
Pentru a activa randarea în funcţie de scară:

1. Open the Layer Properties dialog for the buildings layer.

2. Activate the Rendering tab.
3. Enable scale-based rendering by clicking on the checkbox labeled Scale dependent visibility:
4. Change the Minimum value to 1:10000.
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5. Clic pe OK
Test the effects of this by zooming in and out in your map, noting when the buildings layer disappears and
reappears.

Notă: You can use your mouse wheel to zoom in increments. Alternatively, use the zoom tools to zoom to a window:

2.4.6 ��� Follow Along: Adding Symbol Layers

Now that you know how to change simple symbology for layers, the next step is to create more complex symbology.
QGIS allows you to do this using symbol layers.

1. Go back to the landuse layer’s symbol properties panel (by clicking Simple fill in the symbol layers tree).
In this example, the current symbol has no outline (i.e., it uses the No Line border style).
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2. Select the Fill level in the tree and click the Add symbol layer button. The dialog will change to look something
like this, with a new symbol layer added:
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It may appear somewhat different in color, for example, but you’re going to change that anyway.
Now there’s a second symbol layer. Being a solid color, it will of course completely hide the previous kind of symbol.
Plus, it has a Solid Line border style, which we don’t want. Clearly this symbol has to be changed.

Notă: It’s important not to get confused between a map layer and a symbol layer. A map layer is a vector (or raster)
that has been loaded into the map. A symbol layer is part of the symbol used to represent a map layer. This course
will usually refer to a map layer as just a layer, but a symbol layer will always be called a symbol layer, to prevent
confusion.

With the new Simple Fill symbol layer selected:
1. Set the border style to No Line, as before.
2. Change the fill style to something other than Solid or No brush. For example:
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3. Clic pe OK
Now you can see your results and tweak them as needed. You can even add multiple extra symbol layers and create
a kind of texture for your layer that way.

It’s fun! But it probably has too many colors to use in a real map…
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2.4.7 ��� Try Yourself:

Remembering to zoom in if necessary, create a simple, but not distracting texture for the buildings layer using
the methods above.

Răspuns
Customize your buildings layer as you like, but remember that it has to be easy to tell different layers apart on
the map.
Iată un exemplu:

2.4.8 ��� Follow Along: Ordering Symbol Levels

When symbol layers are rendered, they are also rendered in a sequence, similar to the way the different map layers
are rendered. This means that in some cases, having many symbol layers in one symbol can cause unexpected results.

1. Give the roads layer an extra symbol layer (using the method for adding symbol layers demonstrated above).
2. Give the base line a Stroke width of 1.5 and a black color.
3. Give the new, uppermost layer a thickness of 0.8 and a white color.

Vet,i observa că se întâmplă acest lucru:
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Well, roads have now a street like symbology, but you see that lines are overlapping each others at each cross. That’s
not what we want at all!
To prevent this from happening, you can sort the symbol levels and thereby control the order in which the different
symbol layers are rendered.
To change the order of the symbol layers:

1. Select the topmost Line layer in the symbol layers tree.
2. Click Advanced ► Symbol levels… in the bottom right-hand corner of the window.

2.4. Lesson: Symbology 35



QGIS Training Manual

This will open a dialog like this:

3. Check Enable symbol levels. You can then set the layer order of each symbol by entering the corresponding
level number. 0 is the bottom layer.
In our case, we just want to activate the option, like this:

This will render the white line above the thick black line borders:
4. Facet,i clic pe Ok pentru a reveni la hartă.

Harta va arăta acum în modul următor:
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When you’re done, remember to save the symbol itself so as not to lose your work if you change the symbol again
in the future. You can save your current symbol style by clicking the Save Style… button at the bottom of the Layer
Properties dialog. We will be using the QGIS QML Style File format.
Save your style in the solution/styles/better_roads.qml folder. You can load a previously saved style
at any time by clicking the Load Style… button. Before you change a style, keep in mind that any unsaved style you
are replacing will be lost.

2.4.9 ��� Try Yourself:

Change the appearance of the roads layer again.
Make the roads narrow and yellow, with a thin, pale gray outline and a thin black line in the middle. Remember that
you may need to change the layer rendering order via the Advanced ► Symbol levels… dialog.

Răspuns
To make the required symbol, you need three symbol layers:
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The lowest symbol layer is a broad, solid gray line. On top of it there is a slightly thinner solid yellow line and finally
another thinner solid black line.
If your symbol layers resemble the above but you’re not getting the result you want:

1. Check that your symbol levels look something like this:

2. Now your map should look like this:
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2.4.10 ��� Try Yourself:

Symbol levels also work for classified layers (i.e., layers having multiple symbols). Since we haven’t covered
classification yet, you will work with some rudimentary pre-classified data.

1. Create a new project and add only the roads dataset.
2. Apply the style file advanced_levels_demo.qml provided in exercise_data/styles to the

layer. This can be done through the Style ► Load Style… combobox at the bottom of the Layer Properties
dialog.

3. Focalizat,i în aria Swellendam.
4. Using symbol layers, ensure that the outlines of layers flow into one another as per the image below:
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Răspuns
1. Adjust your symbol levels to these values:

1. Experiment with different values to get different results.
2. Open your original map again before continuing with the next exercise.
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2.4.11 ��� Follow Along: Symbol layer types

In addition to setting fill colors and using predefined patterns, you can use different symbol layer types entirely. The
only type we’ve been using up to now was the Simple Fill type. The more advanced symbol layer types allow you to
customize your symbols even further.
Each type of vector (point, line and polygon) has its own set of symbol layer types. First we will look at the types
available for points.

Tipurile de Straturi pentru Simbolurile de tip Punct

1. Uncheck all the layers except for places.
2. Change the symbol properties for the places layer:

3. You can access the various symbol layer types by selecting the Simple marker layer in the symbol layers tree,
then click the Symbol layer type dropdown:
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4. Investigate the various options available to you, and choose a symbol with styling you think is appropriate.
5. If in doubt, use a round Simple marker with a white border and pale green fill, with a Size of 3.00 and a Stroke

width of 0.5.

Tipurile de Straturi pentru Simbolurile de tip Linie

Pentru a vedea diferitele opt,iuni disponibile pentru datele de tip linie:
1. Change the Symbol layer type for the roads layer’s topmost symbol layer to Marker line:
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2. Select the Simple marker layer in the symbol layers tree. Change the symbol properties to match this dialog:
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3. Select the Marker line layer and change the interval to 1.00:

44 Capitolul 2. Modulul;: Crearea s, i Explorarea unei Hărt,i de Bază



QGIS Training Manual

4. Ensure that the symbol levels are correct (via the Advanced ► Symbol levels dialog we used earlier) before
applying the style.

Once you have applied the style, take a look at its results on the map. As you can see, these symbols change direction
along with the road but don’t always bend along with it. This is useful for some purposes, but not for others. If you
prefer, you can change the symbol layer in question back to the way it was before.

Tipurile de Straturi pentru Simbolurile de tip Poligon

Pentru a vedea diferitele opt,iuni disponibile pentru datele poligonale:
1. Change the Symbol layer type for the water layer, as before for the other layers.
2. Investigat,i ce pot face diferitele opt,iuni din listă.
3. Aleget,i una dintre ele, pe care o găsit,i potrivită.
4. Dacă avet,i îndoieli, utilizat,i Umplere cu model din puncte, având următoarele opt,iuni:
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5. Adăugat,i un nou strat simbol, cu o Umplere simplă, normală.
6. Facet,i-l în acelas, i albastru deschis, cu un chenar albastru mai închis.
7. Mutat,i-l sub stratul simbol cu modelul din puncte, cu ajutorul butonului Move down:
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As a result, you have a textured symbol for the water layer, with the added benefit that you can change the size, shape
and distance of the individual dots that make up the texture.

2.4.12 ��� Try Yourself:

Apply a green transparent fill color to the protected_areas layer, and change the outline to look like this:
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Răspuns
Here are examples of the symbol structure:
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2.4.13 ��� Follow Along: Geometry generator symbology

You can use the Geometry generator symbology with all layer types (points, lines and polygons). The resulting symbol
depends directly on the layer type.
Very briefly, the Geometry generator symbology allows you to run some spatial operations within the symbology
itself. For example you can run a real centroid spatial operation on a polygon layer without creating a point layer.
Moreover, you have all the styling options to change the appearance of the resulting symbol.
Let’s give it a try!

1. Select the water layer.
2. Click on Simple fill and change the Symbol layer type to Geometry generator.
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3. Before to start writing the spatial query we have to choose the Geometry Type in output. In this example we
are going to create centroids for each feature, so change the Geometry Type to Point / Multipoint.

4. Now let’s write the query in the query panel:

centroid($geometry)
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5. When you click on OK you will see that the water layer is rendered as a point layer! We have just run a
spatial operation within the layer symbology itself, isn’t that amazing?
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With the Geometry generator symbology you can really go over the edge of normal symbology.

��� Try Yourself:

Geometry generator are just another symbol level. Try to add another Simple fill underneath the Geometry generator
one.
Change also the appearance of the Simple marker of the Geometry generator symbology.
The final result should look like this:
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Răspuns

1. Click on the button to add another Symbol level.

2. Move the new symbol at the bottom of the list clicking the button.
3. Choose a good color to fill the water polygons.
4. Click onMarker of the Geometry generator symbology and change the circle with another shape as your wish.
5. Try experimenting other options to get more useful results.

2.4.14 ��� Follow Along: Creating a Custom SVG Fill

Notă: To do this exercise, you will need to have the free vector editing software Inkscape installed.

1. Start the Inkscape program. You will see the following interface:
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Ar trebui să vi se pară familiar dacă at,i folosit alte programe de editare a imaginilor vectoriale, cum ar fi Corel.
În primul rând, vom schimba canevasul la o dimensiune adecvată pentru o mică textură.

2. Click on the menu item File ► Document Properties. This will give you the Document Properties dialog.
3. Schimbat,i Unităt,ile în px.
4. Change theWidth and Height to 100.
5. Închidet,i dialogul, după încheiere.
6. Facet,i clic pe elementul de meniu View ► Zoom ► Page pentru a vedea pagina la care lucrat,i.
7. Selectat,i instrumentul Circle:
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8. Ment,inet,i apăsat butonul mouse-ului s, i trasat,i pe pagină o elipsă. Pentru a transforma o elipsă într-un cerc,
ment,inet,i apăsat s, i butonul Ctrl pe durata desenării.

9. Right-click on the circle you just created and open its Fill and Stroke options. You can modify its rendering,
such as:
1. Stabilit,i pentru culoarea de Umplere o culoare albastru spre gri pal,
2. Assign to the border a darker color in Stroke paint tab,
3. And reduce the border thickness under Stroke style tab.
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10. Draw a line using the Pencil tool:
1. Click once to start the line. Hold Ctrl to make it snap to increments of 15 degrees.
2. Deplasat,i indicatorul pe orizontală s, i punet,i un punct cu un simplu click.
3. Click and snap to the vertex of the line and trace a vertical line, ended by a simple click.
4. Now join the two end vertices.
5. Change the color and width of the triangle symbol to match the circle’s stroke and move it around as

necessary, so that you end up with a symbol like this one:
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11. If the symbol you get satisfies you, then save it as landuse_symbol under the directory that the course is
in, under exercise_data/symbols, as SVG file.

În QGIS:
1. Open the Layer Properties for the landuse layer.

2. In the Symbology tab, change the symbol structure by changing the Symbol Layer Type to SVG Fill shown
below.

3. Click the… button and then Select File… to select your SVG image.
It’s added to the symbol tree and you can now customize its different characteristics (colors, angle, effects,
units…).
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Once you validate the dialog, features in landuse layer should now be covered by a set of symbols, showing a
texture like the one on the following map. If textures are not visible, you may need to zoom in the map canvas or set
in the layer properties a bigger Texture width.

2.4. Lesson: Symbology 59



QGIS Training Manual

2.4.15 ��� Follow Along: Masking

Masking feature allows you to mask some symbol layer using another symbol layer or label.
In the following exercise, we want to configure rendering so that polygon labels will mask the black part of lines layer.

1. Load the selective_masking.qgs from dataset in directory exercise_data/masking.
2. Open the Layer Properties window for the polys layer.

Under the Labels tab, you will see that Single Labels have already been defined.

3. From the Labels tab, select the Mask (and not Masks in general category list)

4. Enable label mask by checking the Enable mask option
A message tells you that the now defined label mask shape can be later selected as a mask source to mask other
symbol layers. Let’s do that.

5. Click OK
6. Open the Layer Properties window for the lines layer.

7. Go to the Masks tab
8. Click on the black line part of lines checkbox from masked symbol layers

Amessage warns you that you have to select both masking and masked symbol layers to be able to save masking
configuration. Again, let’s do that.

9. Click on polys Label mask checkbox
The message disappears, you can now safely save your configuration.
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10. Click OK
You can see now that labels are masking the black part of lines, leaving only the yellow part.
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2.4.16 ��� Follow Along: Masking using points symbols

We want now to mask the black part of lines using only black planes that represent the points layer (i.e. B52 and
Jet points categories). For the sake of visibility, you can switch off polys layer visibility.

1. Open the Layer Properties window for the points layer.

Under the Symbology tab, you will see that a Categorized renderer has been defined with 3 different
symbols depending on the Class field value.

2. Double click on B52 plane icon, within the Symbol column

3. Click the Add symbol layer button and select the Mask Symbol layer type
A new hierarchy Mask (symbol layer) > Marker (symbol) > Simple Marker (symbol layer) appear below
the root symbol Marker.
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Now, let’s define a mask that is identical to our plane marker but a little bit bigger.
4. Select the newly created Simple Marker symbol layer and change its Symbol layer type to SVG marker

5. Set the SVG file path to be the same as the already existing SVG marker, and the size to be bigger (24
millimeters is a pretty good choice for this use case).
Mask color doesn’t matter here, only the shape is used in masking. Symbol layer order is also irrelevant in that
situation.
You should get something like that:

6. Repeat the same operations on Jet symbol.
7. Click OK
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8. Open the Layer Properties window for the lines layer.

9. Go to the Masks tab.
The black line part of lines checkbox from masked symbol layers is already checked from our previous
configuration.

10. Uncheck the Label mask polys checkbox and check both B52 and Jet Mask symbol layer
11. Click OK

You now see that black planes are masking the black part of lines, with only the yellow part visible.

2.4.17 În concluzie

Changing the symbology for the different layers has transformed a collection of vector files into a legible map. Not
only can you see what’s happening, it’s even nice to look at!

2.4.18 Further Reading

Exemple de Hărt,i Aspectuoase
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2.4.19 Ce urmează?

Changing symbols for whole layers is useful, but the information contained within each layer is not yet available to
someone reading these maps. What are the streets called? Which administrative regions do certain areas belong to?
What are the relative surface areas of the farms? All of this information is still hidden. The next lesson will explain
how to represent this data on your map.

Notă: V-at,i amintit recent să efectuat,i o salvare a hărt,ii?
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CAPITOLUL3

Module: Classifying Vector Data

Clasificarea datelor vectoriale vă permite să atribuit,i diferite simboluri entităt,ilor (diverse obiecte din acelas, i strat),
în funct,ie de atributele lor. Acest lucru permite celui care foloses, te harta, să vadă cu us,urint,ă atributele feluritelor
entităt,i.

3.1 Lesson: Vector Attribute Data

Datele vectoriale sunt, fără îndoială, cel mai comun tip de date utilizate zilnic în GIS. Modelul vectorial reprezintă
locat,ia s, i forma entităt,ilor geografice cu ajutorul punctelor, liniilor s, i poligoanelor (iar pentru datele 3D, de asemenea,
cu ajutorul suprafet,elor s, i volumelor), în timp ce celelalte proprietăt,i ale acestora sunt incluse ca atribute (deseori
prezentate sub formă de tabel în QGIS).
Până în prezent, nici una dintre schimbările pe care le-am adus hărt,ii nu au fost influent,ate de obiectele afis,ate. Cu
alte cuvinte, toate zonele de utilizare a terenurilor s, i toate drumurile arată la fel. Atunci când văd o hartă, privitorii
nu s, tiu nimic despre drumurile pe care le observă; doar faptul că există un drum de o anumită formă, într-o anumită
zonă.
Adevărata putere a GIS-ului constă în faptul că toate obiectele care sunt vizibile pe harta au, la rândul lor, atribute.
Hărt,ile dintr-un GIS nu sunt doar imagini. Ele reprezintă nu numai obiectele din locat,ii, dar, ci s, i informat,ii despre
aceste obiecte.
The goal for this lesson: To learn about the structure of vector data and explore the attribute data of an object

3.1.1 ��� Follow Along: Viewing Layer Attributes

De asemenea, este important de s, tiut că datele cu care lucrat,i nu reprezintă doar locul „unde” se află obiectele în
spat,iu, dar vă spun s, i ce sunt acele obiecte.
From the previous exercise, you should have the protected_areas layer loaded in your map. If it is not loaded,
then you can find the protected_areas.shp ESRI Shapefile format dataset in directory exercise_data/
shapefile.
The polygons representing the protected areas constitute the spatial data, but we can learn more about the protected
areas by exploring the attribute table.

1. In the Layers panel, click on the protected_areas layer to select it.
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2. In the Layer menu, click the Open Attribute Table button (also accessible from top toolbars buttons). This will
open a new window showing the attribute table of the protected_areas layer.

A row is called a record and is associated with a feature in the Canvas Map, such as a polygon. A column is
called a field (or an attribute), and has a name that helps describe it, such as name or id. Values in the cells
are known as attribute values. These definitions are commonly used in GIS, so it is good to become familiar
with them.
In the protected_areas layer, there are two features, which are represented by the two polygons we see
on the Map Canvas.

Notă: In order to understand what the fields and attribute values represent, one may need to find
documentation (or metadata) describing the meaning of the attribute values. This is usually available from
the creator of the data set.

Next, let’s see how a record in the attribute table is linked to a polygon feature that we see on the Map Canvas.
1. Revenit,i la fereastra QGIS principală.

2. In the Edit ► Select menu, click on the Select Feature(s) button.
3. Asigurat,i-vă că stratul protected_areas este încă selectat în panoul Straturilor.
4. Move your mouse to the Map Canvas and left click on the smaller of the two polygons. The polygon will turn

yellow indicating it is selected.
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5. Go back to the Attribute Table window, and you should see a record (row) highlighted. These are the attribute
values of the selected polygon.
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De asemenea, putet,i selecta o entitate folosind Tabela de Atribute.
1. In the Attribute Table window, on the far left, click on the row number of the record that is currently not

selected.

2. Go back to the main QGIS window and look at the Map Canvas. You should see the larger of the two polygons
colored yellow.

3. To deselect the feature, go to the Attribute Table window and click on Deselect all features from the layer button.
Sometimes there are many features shown on the Map Canvas and it might be difficult to see which feature is selected
from the Attribute Table. Another way to identify the location of a feature is to use the Flash Feature tool.

1. In the Attribute Table, right-click on any cell in the row that has the attribute value r2855697 for the field
full_id.

2. In the context menu, click on Flash Feature and watch the Map Canvas.

You should see the polygon flash red a few times. If you missed it, try it again.
Another useful tool is the Zoom to Feature tool, that tells QGIS to zoom to the feature of interest.

1. In the Attribute Table, right-click on any cell in the row that has the attribute value r2855697 for the field
full_id.

2. In the context menu, click on Zoom to Feature

70 Capitolul 3. Module: Classifying Vector Data



QGIS Training Manual

Look at the Map Canvas. The polygon should now occupy the extent of the Map Canvas area.
Acum, putet,i închide tabelul de atribute.

3.1.2 ��� Try Yourself: Exploring Vector Data Attributes

1. How many fields are available in the rivers layer?
2. Tell us a bit about the town places in your dataset.
3. Open the attribute table for the places layer. Which field would be the most useful to represent in label form,

and why?

Răspuns
• There should be 9 fields in the rivers layer:

1. Select the layer in the Layers panel.

2. Right-click and choose Open Attribute Table, or press the button on the Attributes Toolbar (it can be
enabled from View ► Toolbars menu).

3. Totalizează numărul de coloane.
A quicker approach could be to double-click the rivers layer, open the Layer properties► Fields tab, where you
will find a numbered list of the table’s fields.

• Information about towns is available in the places layer. Open its attribute table as you did with the rivers layer:
there are two features whose place attribute is set to town: Swellendam and Buffeljagsrivier. You can add
comment on other fields from these two records, if you like.

• The name field is the most useful to show as labels. This is because all its values are unique for every object
and are very unlikely to contain NULL values. If your data contains some NULL values, do not worry as long
as most of your places have names.
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3.1.3 În concluzie

Acum s, tit,i cum să folosit,i tabelul de atribute pentru a vedea ceea ce se află, de fapt, în datele pe care îl utilizat,i. Orice
set de date va fi util pentru dvs. numai dacă are atributele care vă interesează. Dacă s, tit,i de care atribute avet,i nevoie,
putet,i decide rapid dacă putet,i utiliza un anumit set de date, sau dacă trebuie să căutat,i un altul care are datele cerute.

3.1.4 Ce urmează?

Diferite atribute sunt utile pentru diferite scopuri. Unele dintre ele pot fi reprezentate direct sub formă de text, pentru
ca utilizatorul sa le poată vedea. Vet,i afla cum să facet,i acest lucru în lect,ia următoare.

3.2 Lesson: Labels

Etichetele pot fi adăugate pe o hartă, pentru a afis,a informat,ii despre un obiect. Orice strat vectorial poate avea
etichete asociate cu el. Cont,inutul acestor etichete se bazează pe datele atributului unui strat.
Scopul acestei lect,ii: De a aplica etichete folositoare s, i plăcute unui strat.

3.2.1 ��� Follow Along: Using Labels

First, ensure that the button is visible in the GUI:
1. Go to the menu item View ► Toolbars

2. Ensure that the Label Toolbar item has a check mark next to it. If it doesn’t, click on the Label Toolbar item
to activate it.

3. Click on the places layer in the Layers panel so that it is highlighted
4. Click on the toolbar button to open the Labels tab of the Layer Styling panel
5. Switch from No Labels to Single Labels

You’ll need to choose which field in the attributes will be used for the labels. In the previous lesson, you decided
that the name field was the most suitable one for this purpose.

6. Select name from the Value list:
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7. Clic pe Aplicare.
Etichetele hărt,ii ar trebui să arate astfel:
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3.2.2 ��� Follow Along: Changing Label Options

Depending on the styles you chose for your map in earlier lessons, you might find that the labels are not appropriately
formatted and either overlap or are too far away from their point markers.

Notă: Above, you used the button in the Label Toolbar to open the Layer Styling panel. As with Symbology,
the same label options are available via both the Layer Styling panel and the Layer Properties dialog. Here, you’ll use
the Layer Properties dialog.

1. Open the Layer Properties dialog by double-clicking on the places layer
2. Select the Labels tab
3. Make sure Text is selected in the left-hand options list, then update the text formatting options to match those

shown here:
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4. Clic pe Aplicare.
That font may be larger and more familiar to users, but its readability is still dependent on what layers are
rendered beneath it. To solve this, let’s take a look at the Buffer option.

5. Select Buffer from the left-hand options list
6. Select the checkbox next to Draw text buffer, then choose options to match those shown here:
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7. Clic pe Aplicare.
You’ll see that this adds a colored buffer or border to the place labels, making them easier to pick out on the
map:
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Now we can address the positioning of the labels in relation to their point markers.
8. Select Placement from the left-hand options list
9. Select Around point and change the value of Distance to 2.0Millimeters:
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10. Clic pe Aplicare.
You’ll see that the labels are no longer overlapping their point markers.

3.2.3 ��� Follow Along: Using Labels Instead of Layer Symbology

In many cases, the location of a point doesn’t need to be very specific. For example, most of the points in the places
layer refer to entire towns or suburbs, and the specific point associated with such features is not that specific on a large
scale. In fact, giving a point that is too specific is often confusing for someone reading a map.
To name an example: on a map of the world, the point given for the European Union may be somewhere in Poland,
for instance. To someone reading the map, seeing a point labeled European Union in Poland, it may seem that the
capital of the European Union is therefore in Poland.
So, to prevent this kind of misunderstanding, it’s often useful to deactivate the point symbols and replace them
completely with labels.
In QGIS, you can do this by changing the position of the labels to be rendered directly over the points they refer to.

1. Open the Labels tab of the Layer Properties dialog for the places layer
2. Select the Placement option from the options list
3. Click on the Offset from point button
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This will reveal the Quadrant options which you can use to set the position of the label in relation to the point
marker. In this case, we want the label to be centered on the point, so choose the center quadrant:

4. Hide the point symbols by editing the layer Symbology as usual, and setting the size of theMarker size to 0.0:
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5. Click Apply and you’ll see this result:
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If you were to zoom out on the map, you would see that some of the labels disappear at larger scales to avoid
overlapping. Sometimes this is what you want when dealing with datasets that have many points, but at other times
you will lose useful information this way. There is another possibility for handling cases like this, which we’ll cover
in a later exercise in this lesson. For now, zoom out and click on the button in the toolbar and see what happens.

3.2.4 ��� Try Yourself: Customize the Labels

• Reset the label and symbol settings to have a point marker and a label offset of 2.0Millimeters.

Răspuns
Your map should now show the marker points and the labels should be offset by 2mm. The style of the markers and
labels should allow both to be clearly visible on the map:
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• Set the map to the scale 1:100000. You can do this by typing it into the Scale box in the Status Bar. Modify
your labels to be suitable for viewing at this scale.

Răspuns
One possible solution has this final product:
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To arrive at this result:
• Use a font size of 10
• Use an around point placement distance of 1.5 mm

• Use a marker size of 3.0 mm

• In addition, this example uses theWrap on character option:
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• Enter a space in this field and click Apply to achieve the same effect. In our case, some of the place names
are very long, resulting in names with multiple lines which is not very user friendly. You might find this setting
to be more appropriate for your map.
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3.2.5 ��� Follow Along: Labeling Lines

Acum, după ce s, tim cum funct,ionează etichetarea, remarcăm o problemă suplimentară. Punctele s, i poligoanele sunt
us,or de etichetat, dar ce spunet,i despre linii? Dacă le etichetăm în acelas, i mod ca s, i pe puncte, rezultatele ar arăta
astfel:

We will now reformat the roads layer labels so that they are easy to understand.
1. Hide the places layer so that it doesn’t distract you
2. Activate Single Labels for the roads layer as you did above for places
3. Set the font Size to 10 so that you can see more labels
4. Zoom in on the Swellendam town area
5. In the Labels tab’s Placement tab, choose the following settings:
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You’ll probably find that the text styling has used default values and the labels are consequently very hard to
read. Update the Text to use a dark-grey or black Color and the Buffer to use a light-yellow Color.
Harta va arăta aproximativ în modul următor, în funct,ie de scară:
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You’ll see that some of the road names appear more than once and that’s not always necessary. To prevent this
from happening:

6. In the Labels tab of the Layer Properties dialog, choose the Rendering option and select Merge connected lines
to avoid duplicate labels as shown:
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7. Clic pe OK
Another useful function is to prevent labels being drawn for features too short to be of notice.

8. In the same Rendering panel, set the value of Suppress labeling of features smaller than … to 5.00 mm and
note the results when you click Apply
Try out different Placement settings as well. As we’ve seen before, the Horizontal option is not a good idea in
this case, so let’s try the Curved option instead.

9. Select the Curved option in the Placement panel of the Labels tab
Iată rezultatul:
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După cum se vede, unele etichete care erau vizibile anterior sunt ascunse, datorită dificultăt,ii de le face să urmeze
liniile întortocheate ale străzilor s, i să rămână totus, i lizibile. În acelas, i timp, alte etichete devin mult mai utile, întrucât
urmăresc drumurile, în loc să plutească în spat,iul dintre ele. Putet,i decide pe care dintre aceste opt,iuni să o utilizat,i,
în funct,ie de ceea ce credet,i că e mai util sau că arată mai bine.

3.2.6 ��� Follow Along: Data Defined Settings

1. Deactivate labeling for the roads layer
2. Reactivate labeling for the places layer

3. Open the attribute table for places via the button
It has one field which is of interest to us now: place which defines the type of urban area for each record.
We can use this data to influence the label styles.

4. Navigate to the Text panel in the places Labels panel

5. Click the button next to the Italic text button beneath Style and select Edit… to open the Expression String
Builder:
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6. Under Fields and Values, double click on place and then click All Unique. This will list all unique values of
the place field of this layer. Add a = in the text editor and then double click on town.
Alternatively, you can type: "place" = 'town' directly in the text editor.

7. Click OK twice:

Notice that the labels for all places whose place field matches town are displayed in italics.
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3.2.7 ��� Try Yourself: Using Data Defined Settings

Notă: We’re jumping ahead a bit here to demonstrate some advanced labeling settings. At the advanced level, it’s
assumed that you’ll know what the following means. If you don’t, feel free to leave out this section and come back
later when you’ve covered the requisite materials.

1. Open the Attribute Table for places

2. Enter edit mode by clicking the button

3. Add a new column with the button
4. Configurat,i-l astfel:
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5. Use this to set custom font sizes for each different type of place (each key in the place field)

Răspuns
1. Still in edit mode, set the FONT_SIZE values to whatever you prefer. The example uses 16 for towns, 14 for

suburbs, 12 for localities, and 10 for hamlets.
2. Remember to save changes and exit edit mode
3. Return to the Text formatting options for the places layer and select FONT_SIZE in the Attribute field of

the font size data defined override dropdown:

Your results, if using the above values, should be this:
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3.2.8 ��� Further Possibilities With Labeling

We can’t cover every option in this course, but be aware that the Label tab has many other useful functions. You
can set scale-based rendering, alter the rendering priority for labels in a layer, and set every label option using layer
attributes. You can even set the rotation, XY position, and other properties of a label (if you have attribute fields
allocated for the purpose), then edit these properties using the tools adjacent to the main Layer Labeling Options
button:

(Aceste instrumente vor fi active dacă există câmpurile de atribute obligatorii s, i vă aflat,i în modul de editare.)
Simt,it,i-vă liberi să explorat,i mai multe posibilităt,i ale sistemului de etichetare.
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3.2.9 În concluzie

At,i învăt,at cum să folosit,i atributele stratului, pentru a crea în mod dinamic etichetele. Acest lucru poate face harta
mult mai informativă s, i mai elegantă!

3.2.10 Ce urmează?

Now that you know how attributes can make a visual difference for your map, how about using them to change the
symbology of objects themselves? That’s the topic for the next lesson!

3.3 Lesson: Classification

Labels are a good way to communicate information such as the names of individual places, but they can’t be used for
everything. For example, let us say that someone wants to know what each landuse area is used for. Using labels,
you would get this:

Acest lucru face etichetarea hărt,ii dificil de înt,eles, s, i chiar coples, itoare atunci când există suprafet,e de teren cu
numeroase utilizări.
Scopul acestei lect,ii: De a afla cum se pot clasifica în mod eficient datele vectoriale.

3.3.1 ��� Follow Along: Classifying Nominal Data

1. Open the Layer Properties dialog for the landuse layer
2. Go to the Symbology tab
3. Facet,i clic, în meniul cu derulare verticală, pe Simbol Unic s, i schimbat,i-l în Categorisit:
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4. In the new panel, change the Value to landuse and the Color ramp to Random colors

5. Click the button labeled Classify

6. Clic pe OK
Vet,i vedea ceva de genul următor:
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7. Click the arrow (or plus sign) next to landuse in the Layers panel, you’ll see the categories explained:

96 Capitolul 3. Module: Classifying Vector Data



QGIS Training Manual

Now our landuse polygons are colored and are classified so that areas with the same land use are the same
color.

8. If you wish to, you can change the symbol of each landuse area by double-clicking the relevant color block in
the Layers panel or in the Layer Properties dialog:
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Observat,i că există o categorie necompletată:
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This empty category is used to color any objects which do not have a landuse value defined or which have a NULL
value. It can be useful to keep this empty category so that areas with a NULL value are still represented on the map.
You may like to change the color to more obviously represent a blank or NULL value.
Amintit,i-vă să salvat,i harta dvs. acum, astfel încât să nu pierdet,i toate modificările greu efectuate!

3.3.2 ��� Try Yourself: More Classification

Use the knowledge you gained above to classify the buildings layer. Set the categorisation against thebuilding
field and use the Spectral color ramp.

Notă: Amintit,i-vă să focusat,i într-o zonă urbană, pentru a vedea rezultatele.

3.3.3 ��� Follow Along: Ratio Classification

Există patru tipuri de clasificare: nominal, ordinal, interval s, i raport.
In nominal classification, the categories that objects are classified into are name-based; they have no order. For
example: town names, district codes, etc. Symbols that are used for nominal data should not imply any order or
magnitude.

• For points, we can use symbols of different shape.
• For polygons, we can use different types of hatching or different colours (avoid mixing light and dark colours).
• For lines, we can use different dash patterns, different colours (avoidmixing light and dark colours) and different
symbols along the lines.

In ordinal classification, the categories are arranged in a certain order. For example, world cities are given a rank
depending on their importance for world trade, travel, culture, etc. Symbols that are used for ordinal data should
imply order, but not magnitude.
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• For points, we can use symbols with light to dark colours.
• For polygons, we can use graduated colours (light to dark).
• For lines, we can use graduated colours (light to dark).

In interval classification, the numbers are on a scale with positive, negative and zero values. For example: height
above/below sea level, temperature in degrees Celsius. Symbols that are used for interval data should imply order and
magnitude.

• For points, we can use symbols with varying size (small to big).
• For polygons, we can use graduated colours (light to dark) or add diagrams of varying size.
• For lines, we can use thickness (thin to thick).

In ratio classification, the numbers are on a scale with only positive and zero values. For example: temperature above
absolute zero (0 degrees Kelvin), distance from a point, the average amount of traffic on a given street per month,
etc. Symbols that are used for ratio data should imply order and magnitude.

• For points, we can use symbols with varying size (small to big).
• For polygons, we can use graduated colours (light to dark) or add diagrams of varying size.
• For lines, we can use thickness (thin to thick).

In the example above, we used nominal classification to color each record in the landuse layer based on its
landuse attribute. Now we will use ratio classification to classify the records by area.
We are going to reclassify the layer, so existing classes will be lost if not saved. To store the current classification:

1. Open the layer’s properties dialog
2. Click the Save Style … button in the Style drop-down menu.
3. Select Rename Current…, enter land usage and press OK.

The categories and their symbols are now saved in the layer’s properties.
4. Click now on the Add… entry of the Style drop-down menu and create a new style named ratio. This will

store the new classification.
5. Close the Layer Properties dialog

We want to classify the landuse areas by size, but there is a problem: they don’t have a size field, so we’ll have to
make one.

1. Open the Attributes Table for the landuse layer.

2. Enter edit mode by clicking the Toggle editing button

3. Add a new column of decimal type, called AREA, using the New field button:

4. Clic pe OK
The new field will be added (at the far right of the table; you may need to scroll horizontally to see it). However,
at the moment it is not populated, it just has a lot of NULL values.
To solve this problem, we will need to calculate the areas.
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1. Open the field calculator with the button.
You will get this dialog:

2. Check the Update existing fields

3. Select AREA in the fields drop-down menu

4. Under the Expression tab, expand the Geometry functions group in the list and find $area
5. Double-click on it so that it appears in the Expression field

3.3. Lesson: Classification 101



QGIS Training Manual

6. Clic pe OK
7. Scroll to the AREA field in the attribute table and you will notice that it is populated with values (you may

need to click the column header to refresh the data).

Notă: These areas respect the project’s area unit settings, so they may be in square meters or square degrees.

5. Press to save the edits and exit the edit mode with Toggle editing

6. Close the attribute table
Now that we have the data, let’s use them to render the landuse layer.

1. Open the Layer properties dialog’s Symbology tab for the landuse layer
2. Change the classification style from Categorized to Graduated
3. Change the Value to AREA
4. Under Color ramp, choose the option Create New Color Ramp…:
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5. Choose Gradient (if it’s not selected already) and click OK. You will see this:
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Vet,i folosi acest lucru pentru a desemna Color 1 pentru suprafet,ele mici s, i Color 2 pentru suprafet,ele mari.
6. Choose appropriate colors

În acest exemplu, rezultatul arată în felul următor:
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7. Clic pe OK
8. You can save the colour ramp by selecting Save Color Ramp… under the Color ramp tab. Choose an appropriate

name for the colour ramp and click Save. You will now be able to select the same colour ramp easily under All
Color Ramps.

9. Under Mode choose Equal Count (Quantile) .
10. Click Classify

Now you will have something like this:
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Lăsat,i totul as,a cum este.
11. Click OK:
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3.3.4 ��� Try Yourself: Refine the Classification

• Modificat,i valorile pentru Mod s, i Clase până când vet,i obt,ine o clasificare care are sens.

Răspuns
The settings you used might not be the same, but with the values Classes = 6 andMode = Natural Breaks (Jenks) (and
using the same colors, of course), the map will look like this:

3.3.5 ��� Follow Along: Rule-based Classification

Adesea este utilă combinarea mai multor criterii pentru o clasificare, dar, din păcate, clasificarea normală ia în
considerare doar un singur atribut. Acesta este cazul în care este utilă clasificarea bazată pe reguli.
In this lesson, we will represent the landuse layer in a way to easily identify Swellendam city from the other
residential area, and from the other types of landuse (based on their area).

1. Open the Layer Properties dialog for the landuse layer
2. Switch to the Symbology tab
3. Switch the classification style to Rule-based

QGIS will automatically show the rules that represent the current classification implemented for this layer. For
example, after completing the exercise above, you may see something like this:
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4. Click and drag to select all the rules

5. Use the Remove selected rules button to remove all of the existing rules
Let’s now add our custom rules.

1. Click the Add rule button
2. The Edit rule dialog then appears
3. Enter Swellendam city as Label

4. Click the button next to the Filter text area to open the Expression String Builder
5. Enter the criterion "name" = 'Swellendam' and validate

6. Back to the Edit rule dialog, assign it a darker grey-blue color in order to indicate the town’s importance in the
region and remove the border
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7. Apăsat,i pe OK
8. Repeat the steps above to add the following rules:

1. Other residential label with the criterion "landuse" = 'residential' AND "name" <>
'Swellendam'. Choose a pale blue-grey Fill color

2. Big non residential areas label with the criterion"landuse" <> 'residential' AND "AREA"
>= 605000. Choose a mid-green color.

These filters are exclusive, in that they exclude areas on the map (non-residential areas which are smaller
than 605000 (square meters) are not included in any of the rules).

3. We will catch the remaining features using a new rule labeled Small non residential areas. Instead of
a filter expression, Check the Else. Give this category a suitable pale green color.
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Your rules should now look like this:

9. Apply this symbology
Harta dvs. va arăta în felul următor:
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Acum avet,i o hartă cu cele mai notabile zone rezident,iale din Swellendam s, i cu alte zone, non-rezident,iale, colorate
în funct,ie de dimensiunea lor.

3.3.6 În concluzie

Simbologia ne permite să reprezentăm atributele unui strat într-un mod us,or de citit. Ne facilitează atât nouă, cât s, i
utilizatorului hărt,ii, înt,elegerea semnificat,iei entităt,ilor, utilizând atributele relevante alese. În funct,ie de problemele
cu care ne confruntăm, vom aplica diferite tehnici de clasificare pentru a le rezolva.

3.3.7 Ce urmează?

Acum avem o hartă cu un aspect plăcut, dar oare cum o vom exporta din QGIS, într-un format tipăribil, ca imagine
sau ca PDF? Asta e tema următoarei lect,ii!
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Module: Laying out the Maps

În acest modul, vet,i învăt,a cum să gestionat,i compozit,iile imprimabile QGIS, dotate cu toate elementele necesare
pentru a produce hărt,i de calitate.

4.1 Lesson: Using Print Layout

Now that you’ve got a map, you need to be able to print it or to export it to a document. The reason is, a GIS map
file is not an image. Rather, it saves the state of the GIS program, with references to all the layers, their labels,colors,
etc. So for someone who doesn’t have the data or the same GIS program (such as QGIS), the map file will be useless.
Luckily, QGIS can export its map file to a format that anyone’s computer can read, as well as printing out the map if
you have a printer connected. Both exporting and printing is handled via the Print Layout.
The goal for this lesson: To use the QGIS Print Layout to create a basic map with all the required settings.
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4.1.1 ��� Follow Along: The Layout Manager

QGIS allows you to create multiple maps using the same map file. For this reason, it has a tool called the Layout
Manager.

1. Click on the Project ► Layout Manager… menu entry to open this tool. You’ll see a blank Layout manager
dialog appear.

2. Under New from Template, select Empty layout and press the Create… button.
3. Give the new layout the name of Swellendam and click OK.
4. You will now see the Print Layout window:

You could also create this new layout via the Project ► New Print Layout… menu.
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Whichever route you take, the new print layout is now accessible from the Project► Layouts►menu, as in the image
below.

4.1.2 ��� Follow Along: Basic Map Composition

În acest exemplu, compozit,ia arată deja în modul dorit. Asigurat,i-vă că s, i a dvs. arată as,a cum at,i intent,ionat.
1. Right-click on the sheet in the central part of the layout window and choose Page properties… in the context

menu.
2. Check that the values in the Item Properties tab are set to the following:

• Size: A4
• Orientation: Landscape

Acum avet,i aspectul paginii pe care l-at,i dorit, dar această pagină este în continuare neagră. Îi lipses, te în mod
clar o hartă. Haidet,i să reparăm asta!

3. Click on the Add Map button.
With this tool activated, you will be able to place a map on the page.

4. Facet,i clic s, i trasat,i un dreptunghi pe pagina albă:
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Harta va apărea pe pagină.
5. Deplasat,i harta făcând clic s, i mis,când-o după dorint,ă:

6. Resize it by clicking and dragging the boxes on the edges:

116 Capitolul 4. Module: Laying out the Maps



QGIS Training Manual

Notă: Harta poate să prezinte un lot diferit, desigur! Acest lucru depinde de modul în care este configurat
propriul proiect. Dar nu vă facet,i griji! Aceste instruct,iuni sunt generale, astfel încât ele vor lucra la fel,
indiferent de ceea ce se afis,ează pe hartă.

7. Asigurat,i-vă că lăsat,i marginile în jurul conturului, s, i un spat,iu în partea de sus pentru titlu.
8. Mărit,i s, i mics,orat,i pagina (dar nu s, i harta!) folosind aceste butoane:

9. Zoom and pan the map in the main QGIS window. You can also pan the map using the Move item content tool.
The map view updates as you zoom in or zoom out.

10. If, for any reason, the map view does not refresh correctly, you can force the map to refresh by clicking the
Refresh view button.

Remember that the size and position you’ve given the map doesn’t need to be final. You can always come back
and change it later if you’re not satisfied. For now, you need to ensure that you’ve saved your work on this map.
Because a Print Layout in QGIS is part of the main map file, you must save your project.

11. Go to the Layout ► Save Project. This is a convenient shortcut to the one in the main dialog.

4.1.3 ��� Follow Along: Adding a Title

Now your map is looking good on the page, but your readers/users are not being told what’s going on yet. They need
some context, which is what you’ll provide for them by adding map elements. First, let us add a title.

1. Click on the Add Label button
2. Click on the page, above the map, accept the suggested values in the New Item Properties dialog, and a label

will appear at the top of the map.
3. Redimensionat,i-o s, i punet,i-o în partea centrală, de sus, a paginii. Aceasta poate fi redimensionată s, i mutată în

acelas, i mod în care se redimensionează s, i se mută harta.
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Pe măsură ce mutat,i titlul, vet,i observa că liniile directoare apar pentru a vă ajuta să-l pozit,ionat,i în centrul
paginii.
However, there is also a tool in the Actions Toolbar to help position the title relative to the map (not the page):

4. Click the map to select it
5. Hold in Shift on your keyboard and click on the label so that both the map and the label are selected.

6. Look for the Align selected items left button and click on the dropdown arrow next to it to reveal the positioning
options and click Align center:

Now the label frame is centered on the map, but not the contents. To center the contents of the label:
1. Selectat,i eticheta făcând clic pe ea.
2. Click on the Item Properties tab in the side panel of the layout window.
3. Modificat,i textul etichetei în „Swellendam”:
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4. Use this interface to set the font and alignment options under the Appearance section:
1. Choose a large but sensible font (the example will use the default font with a size of 36)
2. Set the Horizontal Alignment to Center.

De asemenea, putet,i schimba culoarea fontului, dar probabil că cel mai bine este să-l păstrat,i negru, as,a
cum este în mod implicit.

5. Setarea implicită nu adăugă un cadru casetei de text a titlului. Cu toate acestea, dacă dorit,i să adăugat,i
un cadru, putet,i proceda astfel:
1. În fila Proprietăt,ilor elementului, derulat,i caseta verticală până vet,i vedea opt,iunea Frame.
2. Clic pe caseta Frame pentru a activa cadrul. Putet,i schimba culoarea cadrului s, i lăt,imea.

În acest exemplu, nu vom activa rama, as,a că aceasta este pagina noastră de până acum:
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To make sure that you don’t accidentally move these elements around now that you’ve aligned them, you can
lock items into place:
1. Select both the label and the map items

2. Click the Lock Selected Items button in the Actions Toolbar.

Notă: Click the Unlock All Items button in the Actions Toolbar to be able to edit the items again.

4.1.4 ��� Follow Along: Adding a Legend

The map reader also needs to be able to see what various things on the map actually mean. In some cases, like the
place names, this is quite obvious. In other cases, it’s more difficult to guess, like the colors of the forests. Let’s add
a new legend.

1. Click on the Add Legend button
2. Click on the page to place the legend, accept the suggested values in the New Item Properties dialog,
3. A legend is added to the layout page, showing layers symbology as set in the main dialog.
4. As usual, you can click and move the item to where you want it:
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4.1.5 ��� Follow Along: Customizing Legend Items

Nu este chiar totul necesar în legendă, deci, să eliminăm unele elemente nedorite.
1. In the Item Properties tab, you’ll find the Legend items group.

2. Uncheck the Auto update box, allowing you to directly modify the legend items
3. Select the entry with buildings

4. Delete it from the legend by clicking the button
Putet,i redenumi, de asemenea, elementele.

1. Selectat,i un strat din aceeas, i listă.

2. Click the Edit selected item properties button.
3. Rename the layers to Places, Roads and Streets, Surface Water, and Rivers.

You can also reorder the items:
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Pe măsură ce legenda va fi probabil extinsă cu noile nume de straturi, at,i putea dori să mutat,i s, i să redimensionat,i
legenda s, i/sau harta. Acesta este rezultatul:
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4.1.6 ��� Follow Along: Exporting Your Map

Notă: T, i-ai amintit să vă salvat,i munca adesea?

Finally the map is ready for export! You’ll see the export buttons near the top left corner of the layout window:

• Print Layout: interfaces with a printer. Since the printer options will differ depending on the model of printer
that you’re working with, it’s probably better to consult the printer manual or a general guide to printing for
more information on this topic.
The other buttons allow you to export the map page to a file.

• Export as Image: gives you a selection of various common image formats to choose from. This is probably the
simplest option, but the image it creates is „dead” and difficult to edit.

• Export as SVG: If you’re sending the map to a cartographer (who may want to edit the map for publication),
it’s best to export as an SVG. SVG stands for „Scalable Vector Graphic”, and can be imported to programs like
Inkscape or other vector image editing software.

• Export as PDF: If you need to send the map to a client, it’s most common to use a PDF, because it’s easier
to set up printing options for a PDF. Some cartographers may prefer PDF as well, if they have a program that
allows them to import and edit this format.

Pentru scopurile noastre, vom folosi PDF.

1. Click the Export as PDF button
2. Choose a save location and a file name as usual. The following dialog will show up.
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3. You can safely use the default values now and click Save.
QGIS will proceed to the map export and push a message on top of the print layout dialog as soon as it finishes.

4. Click the hyperlink in the message to open the folder in which the PDF has been saved in your system’s file
manager

5. Open it and see how your layout looks.
Everything is OK? Congratulations on your first completed QGIS map project!

6. Anything unsatisfying? Go back to the QGIS window, do the appropriate modifications and export again.
7. Remember to save your project file.
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4.1.7 În concluzie

Now you know how to create a basic static map layout. We can go a step further and create a map layout that adapts
dynamically, with more layout items.

4.2 Lesson: Creating a Dynamic Print Layout

Now that you have learned to create a basic map layout we go a step further and create a map layout that adapts
dynamically to our map extent and to the page properties, e.g. when you change the size of the page. Also, the date
of creation will adapt dynamically.

4.2.1 ��� Follow Along: Creating the dynamic map canvas

1. Load the ESRI Shapefile format datasets protected_areas.shp, places.shp, rivers.shp and
water.shp into the map canvas and adapt its properties to suit your own convenience.

2. After everything is rendered and symbolized to your liking, click the New Print Layout icon in the Project
toolbar or choose Project ► New Print Layout. You will be prompted to choose a title for the new print
layout.

3. We want to create a map layout consisting of a header and a map of the region near Swellendam, South Africa.
The layout should have a margin of 7.5 mm and the header should be 36mm high.

4. Create a map item called main map on the canvas and go to the Layout panel. Scroll down to the Variables
section and find the Layout part. Here we set some variables you can use all over the dynamic print layout. Go
to the Layout panel and scroll down to the Variables section. The first variable will define the margin. Press the

button and type in the name sw_layout_margin. Set the value to 7.5. Press the button again
and type in the name sw_layout_height_header. Set the value to 36.

5. Now you are ready to create the position and the size of the map canvas automatically by means of the
variables. Make sure that your map item is selected, go to the Item Properties panel, scroll down to and
open the Position and Size section. Click the Data defined override for X and from the Variables entry, choose
@sw_layout_margin.

6. Click the Data defined override for Y, choose Edit… and type in the formula:

to_real(@sw_layout_margin) + to_real(@sw_layout_height_header)

7. You can create the size of the map item by using the variables for Width and Height. Click the
Data defined override forWidth and choose Edit … again. Fill in the formula:

@layout_pagewidth - @sw_layout_margin * 2

Click the Data defined override for Height and choose Edit …. Here fill in the formula:

@layout_pageheight - @sw_layout_height_header - @sw_layout_margin * 2

8. We will also create a grid containing the coordinates of the main canvas map extent. Go to Item Properties

again and choose the Grids section. Insert a grid by clicking the button. Click on Modify grid … and set
the Interval for X, Y and Offset according to the map scale you chose in the QGIS main canvas. The Grid type
Cross is very well suited for our purposes.
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4.2.2 ��� Follow Along: Creating the dynamic header

1. Insert a rectangle which will contain the header with the Add Shape button. In the Items panel enter the name
header.

2. Again, go to the Item Properties and open the Position and Size section. Using Data defined override, choose the
sw_layout_margin variable for X as well as for Y.Width shall be defined by the expression:

@layout_pagewidth - @sw_layout_margin * 2

and Height by the sw_layout_height_header variable.

3. We will insert a horizontal line and two vertical lines to divide the header into different sections using the
Add Node Item. Create a horizontal line and two vertical lines and name them Horizontal line, Vertical
line 1 Vertical line 2.
1. For the horizontal line:

1. Set X to the variable sw_layout_margin
2. Set the expression for Y to:

@sw_layout_margin + 8

3. Set the expression forWidth to:

@layout_pagewidth - @sw_layout_margin * 3 - 53.5

2. For the first vertical line:
1. Set the expression for X to:

@layout_pagewidth - @sw_layout_margin * 2 - 53.5

2. Set Y to the variable sw_layout_margin
3. The height must be the same as the header we created, so set Height to the variable

sw_layout_height_header.
3. The second vertical line is placed to the left of the first one.

1. Set the expression for X to:

@layout_pagewidth - @sw_layout_margin * 2 - 83.5

2. Set Y to the variable sw_layout_margin
3. The height shall be the same as the other vertical line, so set Height to the variable

sw_layout_height_header.
The figure below shows the structure of our dynamic layout. We will fill the areas created by the lines with
some elements.
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4.2.3 ��� Follow Along: Creating labels for the dynamic header

1. The title of your QGIS project can be included automatically. The title is set in the Project Properties. Insert
a label with the Add Label button and enter the name project title (variable). In the Main
Properties of the Items Properties Panel enter the expression:

[%@project_title%]

Set the position of the label.
1. For X, use the expression:

@sw_layout_margin + 3

2. For Y, use the expression:

@sw_layout_margin + 0.25

3. ForWidth, use the expression:

@layout_pagewidth - @sw_layout_margin *2 - 90

4. Enter 11.25 for Height
Under Appearance set the Font size to 16 pt.

2. The second label will include a description of the map you created. Again, insert a label and name it map
description. In the Main Properties enter the text map description. In the Main Properties we will
also include:

printed on: [%format_date(now(),'dd.MM.yyyy')%]

Here we used two Date and Time functions (now and format_date).
Set the position of the label.
1. For X, use the expression:
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@sw_layout_margin + 3

2. For Y, use the expression:

@sw_layout_margin + 11.5

3. The third label will include information about your organisation. First we will create some variables in the
Variables menu of the Item Properties. Go to the Layout menu, click the button each time and enter the
names o_department, o_name , o_adress and o_postcode. In the second row enter the information
about your organisation. We will use these variables in the Main Properties section.
In Main Properties enter:

[% @o_name %]
[% @o_department %]
[% @o_adress %]
[% @o_postcode %]

Set the position of the label.
1. For X, use the expression:

@layout_pagewidth - @sw_layout_margin - 49.5

2. For Y, use the expression:

@sw_layout_margin + 15.5

3. ForWidth, use 49.00
4. For Height, use the expression:

@sw_layout_height_header - 15.5
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4.2.4 ��� Follow Along: Adding pictures to the dynamic header

1. Use the Add Picture button to place a picture above your label organisation information. After
entering the name organisation logo define the position and size of the logo:
1. For X, use the expression:

@layout_pagewidth - @sw_layout_margin - 49.5

2. For Y, use the expression:

@sw_layout_margin + 3.5

3. ForWidth, use 39.292
4. For Height, use 9.583

To include a logo of your organisation you have to save your logo under your home directory and enter the path
under Main Properties ► Image Source.

2. Our layout still needs a north arrow. This will also be inserted by using Add North Arrow. We will use the
default north arrow. Define the position:
1. For X, use the expression:

@layout_pagewidth - @sw_layout_margin * 2 - 78

2. For Y, use the expression:

@sw_layout_margin + 9
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3. ForWidth, use 21.027
4. For Height, use 21.157

4.2.5 ��� Follow Along: Creating the scalebar of the dynamic header

1. To insert a scalebar in the header click on Add Scale Bar and place it in the rectangle above the north arrow.
In Map under the Main Properties choose your main map(Map 1). This means that the scale changes
automatically according to the extent you choose in the QGIS main canvas. Choose the Style Numeric. This
means that we insert a simple scale without a scalebar. The scale still needs a position and size.
1. For X, use the expression:

@layout_pagewidth - @sw_layout_margin * 2 - 78

2. For Y, use the expression:

@sw_layout_margin + 1

3. ForWidth, use 25
4. For Height, use 8
5. Place the Reference point in the center.

Congratulations! You have created your first dynamic map layout. Take a look at the layout and check if everything
looks the way you want it! The dynamic map layout reacts automatically when you change the page properties. For
example, if you change the page size from DIN A4 to DIN A3, click the Refresh view button and the page design is
adapted.
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4.2.6 Ce urmează?

On the next page, you will be given an assignment to complete. This will allow you to practice the techniques you
have learned so far.

4.3 Exercit,iul 1

Deschidet,i proiectul existent al hărt,ii s, i revizuit,i-l bine. Dacă at,i observat mici erori sau lucruri pe care v-ar fi plăcut
să le remediat,i mai devreme, facet,i acest lucru acum.
În timp ce personalizat,i harta, punet,i-vă întrebări. Este us,or de citit s, i de înt,eles aceată hartă pentru cineva care nu
este familiarizat cu datele respective? Dacă at,i vedea această hartă pe Internet, pe un poster sau într-o revistă, v-ar
capta atent,ia? V-ar interesa această hartă în cazul în care nu v-ar apart,ine?
If you’re doing this course at a ★☆☆ Basic or ★★☆ Intermediate level, read up on techniques from the more advanced
sections. If you see something you’d like to do in your map, why not try to implement it?
Dacă acest curs vă este prezentat, lectorul cursul vă poate cere să prezentat,i o versiune finală a hărt,ii dvs., exportate
în format PDF, pentru evaluare. Dacă urmat,i acest curs în mod individual, este recomandabil să vă evaluat,i propria
hartă utilizând aceleas, i criterii. Harta dvs. va fi evaluată pentru aspectul general s, i simbolistica proprie, precum s, i
pentru aspectul s, i as,ezarea în pagină a hărt,ii s, i a elementelor. Amintit,i-vă că, la evaluarea hărt,ilor, accentul se va
pune întotdeauna pe us,urint,a în utilizare. Cu cât este mai frumoasă harta, cu atât este mai us,or să o înt,eleget,i dintr-o
privire.
Personalizare plăcută!

4.3.1 În concluzie

Primele patru module v-au învăt,at cum să creat,i s, i să stilizat,i o hartă vectorială. În următoarele patru module, vet,i
învăt,a cum să folosit,i QGIS pentru o analiză completă GIS. Aceasta va include crearea s, i editarea datelor vectoriale;
analiza lor; utilizarea s, i analiza datelor raster; s, i utilizarea GIS pentru a rezolva o problemă de la început până la
sfârs, it, utilizând atât surse de date raster cât s, i vectoriale.
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Module: Creating Vector Data

Crearea hărt,ilor folosind datele existente este doar începutul. În acest modul, vet,i afla cum să modificat,i datele
vectoriale existente, s, i cum să creat,i noi seturi de date.

5.1 Lesson: Creating a New Vector Dataset

Datele pe care le utlizat,i trebuie să vină de undeva. Pentru aplicat,iile uzuale, datele există deja; dar cu cât proiectul
este mai aparte s, i mai specializat, cu atât scad s,ansele ca datele să fie disponibile. În asemenea cazuri va fi nevoie să
va creat,i propriile date.
Scopul acestei lect,ii: De a crea un nou set de date vectoriale.

5.1.1 ��� Follow Along: The Layer Creation Dialog

Înainte de a adăuga date vectoriale noi vet,i avea nevoie de un set de date la care să le adăugat,i. În cazul nostru vet,i
începe prin a creea date complet noi, mai degrabă decât să editat,i un set de date existent. În concluzie, va trebui să
începet,i prin a crea propriul set de date.

1. Open QGIS and create a new blank project.
2. Navigate to and click on the menu entry Layer ► Create Layer ► New Shapefile Layer. You’ll be presented

with the New Shapefile Layer dialog, which will allow you to define a new layer.
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3. Click… for the File name field. A save dialog will appear.
4. Navigate to the exercise_data directory.
5. Save your new layer as school_property.shp.

Este important să decidet,i ce fel de set de date dorit,i. Fiecare tip de strat vectorial este „construit diferit” în
fundal, deci odată ce at,i creat un strat, nu îi putet,i schimba tipul.
For the next exercise, we’re going to create new features which describe areas. For such features, you’ll need
to create a polygon dataset.

6. For Geometry Type, select Polygon from the drop down menu:

Aceasta nu are nici un impact asupra restului dialogului, dar va determina folosirea tipului corect de geometrie
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care să fie utilizat la crearea setului de date vectorial.
The next field allows you to specify the Coordinate Reference System, or CRS. CRS is a method of associating
numerical coordinates with a position on the surface of the Earth. See the User Manual on Working with
Projections to learn more.
For this example we will use the default CRS associated with this project, which is WGS84.

Next there is a collection of fields grouped under New Field. By default, a new layer has only one attribute, the
id field (which you should see in the Fields list) below. However, in order for the data you create to be useful,
you actually need to say something about the features you’ll be creating in this new layer. For our current
purposes, it will be enough to add one field called name that will hold Text data and will be limited to text
length of 80 characters.

7. Replicate the setup below, then click the Add to Fields List button:

8. Verificat,i dacă dialogul dvs. arată acum astfel:
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9. Clic pe OK
The new layer should appear in your Layers panel.

5.1.2 ��� Follow Along: Data Sources

Când creat,i date noi, este evident necesar să se refere la obiecte care există întradevăr pe teren. De aceea, va fi nevoie
să obt,inet,i informat,ia de undeva.
Există multe moduri de a obt,ine date despre obiecte. De exemplu, at,i putea folosi un GPS pentru a caputra puncte
din lumea reală, după care să importat,i datele in QGIS. Sau at,i putea să identificat,i punctele folosind un teodolit,
după care să introducet,i manual coordonatele pentru a crea noi entităt,i.
Pentru exemplul nostru, vet,i folosi digitizarea. Es,antioanele seturilor de date raster vă sunt puse la dispozit,ie, as,a că
va trebui să le importat,i după nevoie.

1. Click on Data Source Manager button.
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2. Select Raster on the left side.
3. In the Source panel, click on the… button:
4. Navigate to exercise_data/raster/.
5. Select the file 3420C_2010_327_RGB_LATLNG.tif.
6. Click Open to close the dialogue window.

7. Click Add and Close. An image will load into your map.
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8. If you don’t see an aerial image appear, select the new layer, right click, and choose Zoom to Layer in the
context menu.
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9. Click on the Zoom In button, and zoom to the area highlighted in blue below:
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Now you are ready to digitize these three fields:
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Before starting to digitize, let’s move the school_property layer above the aerial image.
1. Select school_property layer in the Layers pane and drag it to the top.

Pentru a începe digitizarea trebuie să intrat,i înmodul editare. Aplicat,iile GIS cer asta în mod curent pentru a preveni
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modificarea sau s, tergerea accidentală a datelor importante. Modul editare este activat sau dezactivat independent
pentru fiecare strat.
To enter edit mode for the school_property layer:

1. Click on the school_property layer in the Layers panel to select it.

2. Click on the Toggle Editing button.
Dacă nu putet,i găsi acest buton, verificat,i dacă bara de instrumente Digitizing este activată. Ar trebui să existe
un semn de selectare lângă elementul de meniu View ► Toolbars ► Digitizing.
As soon as you are in edit mode, you’ll see that some digitizing tools have become active:

• Capture Polygon

• Instrumentul Vertex

Other relevant buttons are still inactive, but will become active when we start interacting with our new data.
Notice that the layer school_property in the Layers panel now has the pencil icon, indicating that it is in
edit mode.

3. Click on the Capture Polygon button to begin digitizing our school fields.
You’ll notice that your mouse cursor has become a crosshair. This allows you to more accurately place the
points you’ll be digitizing. Remember that even when you’re using the digitizing tool, you can zoom in and
out on your map by rolling the mouse wheel, and you can pan around by holding down the mouse wheel and
dragging around in the map.
Prima entitate pe care o vet,i digitaliza este athletics field:

4. Începet,i digitizarea făcând clic pe un punct, de-a lungul marginii câmpului.
5. Plasat,i mai multe puncte, făcând clic în continuare de-a lungul marginii, până când forma desenată acoperă

complet câmpul.
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6. After placing your last point, right click to finish drawing the polygon. This will finalize the feature and show
you the Attributes dialog.

7. Completat,i valorile, as,a cum se arată mai jos:
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8. Click OK, and you have created a new feature!

9. In the Layers panel select the school_property layer.
10. Right click and choose Open Attribute Table in the context menu.
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In the table you will see the feature you just added. While in edit mode you can update the attributes data by
double click on the cell you want to update.
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11. Închidet,i tabelul de atribute.

12. To save the new feature we just created, click on Save Edits button.
Amintit,i-vă că dacă at,i făcut o gres,eală în timp ce digitizat,i o entitate, o putet,i edita oricând după ce at,i definitivat
crearea ei. Dacă at,i făcut o gres,eală, continuat,i digitizarea până at,i terminat crearea entităt,ii de mai sus. Apoi:

1. Clic pe butonul Instrumentului Vertex.
2. Hover the mouse over a vertex you want to move and left click on the vertex.
3. Move the mouse to the correct location of the vertex, and left click. This will move the vertex to the new

location.
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The same procedure can be used to move a line segment, but you will need to hover over the midpoint of the
line segment.

If you want to undo a change, you can press the Undo button or Ctrl+Z.

4. Remember to save your changes by clicking the Save Edits button.

5. When done editing, click the Toggle Editing button to get out of edit mode.
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5.1.3 ��� Try Yourself: Digitizing Polygons

Digitizarea s,colii propriu-zise s, i a câmpului de sus. Utilizat,i această imagine pentru a vă ajuta:

Remember that each new feature needs to have a unique id value!

Notă: După ce at,i terminat de adăugat entităt,ile într-un strat, nu uitat,i să salvat,i modificările s, i să ies, it,i din modul
de editare.

Notă: You can style the fill, outline and label placement and formatting of the school_property using
techniques learnt in earlier lessons.
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5.1.4 ��� Follow Along: Using Vertex Editor Table

Another way to edit a feature is to manually enter the actual coordinate values for each vertex using the Vertex Editor
table.

1. Make sure you are in edit mode on layer school_property.

2. If not already activated, click on Vertex Tool button.
3. Move the mouse over one of the polygon features you created in the school_property layer and right

click on it. This will select the feature and a Vertex Editor pane will appear.

Notă: This table contains the coordinates for the vertices of the feature. Notice there are seven vertices for
this feature, but only six are visually identified in the map area. Upon closer inspection, one will notice that
row 0 and 6 have identical coordinates. These are the start and end vertices of the feature geometry, and are
required in order to create a closed polygon feature.

4. Click and drag a box over a vertex, or multiple vertices, of the selected feature.
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The selected vertices will change to a color blue and the Vertex Editor table will have the corresponding rows
highlighted, which contain the coordinates of the vertices.
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5. To update a coordinate, double left click on the cell in the table that you want to edit and enter the updated
value. In this example, the x coordinate of row 4 is updated from 20.4450 to 20.4444.
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6. After entering the updated value, hit the enter key to apply the change. You will see the vertex move to the
new location in the map window.

7. When done editing, click the Toggle Editing button to get out of edit mode, and save your edits.

5.1.5 ��� Try Yourself: Digitizing Lines

We are going to digitize two routes which are not already marked on the roads layer; one is a path, the other is a track.
Our path runs along the southern edge of the suburb of Railton, starting and ending at marked roads:
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Piste este situată un pic mai departe de sud:
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1. If the roads layer is not yet in your map, then add the roads layer from the GeoPackage file
training-data.gpkg included in the exercise_data folder of the training data you downloaded.
You can read ��� Follow Along: Loading vector data from a GeoPackage Database for a how-to.

2. Create a new ESRI Shapefile line dataset called routes.shp in the exercise_data directory, with
attributes id and type (use the approach above to guide you.)

3. Activate edit mode on the routes layer.

4. Since you are working with a line feature, click on the Add Line button to initiate line digitizing mode.
5. One at a time, digitize the path and the track on the routes layer. Try to follow the routes as accurately as

possible, adding additional points along corners or turns.
6. Set the type attribute value to path or track.
7. Use the Layer Properties dialog to add styling to your routes. Feel free to use different styles for paths and

tracks.

8. Save your edits and toggle off editing mode by pressing the Toggle Editing button.
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Răspuns
The symbology doesn’t matter, but the results should look more or less like this:

5.1.6 În concluzie

Acum s, tit,i cum să creat,i entităt,i! Acest curs nu acoperă adăugarea entităt,ilor de tip punct, deoarece nu este neapărat
necesară după ce at,i lucrat cu entităt,i mai complexe (lini s, i poligoane). Funt,ionează exact la fel, cu except,ia faptului
că dat,i clic doar o singură dată unde dorit,i să plasat,i punctul, îi completat,i atributele ca de obicei, după care entitatea
este creată.
Cunoas, terea digitizării este importantă deoarece reprezintă o activitate frecventă în aplicat,iile GIS.
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5.1.7 Ce urmează?

Features in a GIS layer aren’t just pictures, but objects in space. For example, adjacent polygons know where they
are in relation to one another. This is called topology. In the next lesson you’ll see an example of why this can be
useful.

5.2 Lesson: Feature Topology

Topologia reprezintă un aspect util de straturi de date vectoriale, deoareceminimizează erorile, cum ar fi suprapunerile
sau lacunele.
De exemplu: dacă două entităt,i au o frontieră comună, s, i editat,i granit,a cu ajutorul topologiei, atunci nu va trebui
să editat,i mai întâi un element, apoi pe celălalt, s, i ulterior să aliniat,i cu atent,ie frontierele, astfel încât acestea să se
potrivească. În schimb, putet,i edita bordurile lor comune, ambele entităt,i schimbându-se în acelas, i timp.
Scopul acestei lect,ii: De a înt,elege topologia, cu ajutorul exemplelor.

5.2.1 ��� Follow Along: Snapping

Snapping makes topological editing easier. This will allow your mouse cursor to snap to other objects while you
digitize. To set snapping options:

1. Navigate to the menu entry Project ► Snapping Options….
2. Set up your Snapping options dialog to activate the landuse layer with Type vertex and tolerance 12 pixels:

3. Make sure that the box in the Avoid overlap column is checked.
4. Leave the dialog.

5. Select the landuse layer and enter edit mode ( )
6. Check (under View ► Toolbars) that the Advanced Digitizing toolbar is enabled.
7. Focalizat,i această arie (activând straturile s, i etichetele, dacă este necesar):
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8. Digitize this new (fictional) area shown in red:

9. When prompted, give it an OGC_FID of 999, but feel free to leave the other values unchanged.
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If you are careful while digitizing, and allow the cursor to snap to the vertices of adjoining areas, you’ll notice
that there won’t be any gaps between your new area and the existing adjacent areas.

10. Note the undo and redo tools in the Advanced Digitizing toolbar.

5.2.2 ��� Follow Along: Correct Topological Features

Topology features can sometimes need to be updated. In our study area, an area has been turned into forest, so the
landuse layer need an update. We will therefore expand and join some forest features in this area:

Instead of creating new polygons to join the forest areas, we are going to use the Vertex Tool to edit and join existing
polygons.

1. Enter edit mode (if it is not active already)

2. Selectat,i Instrumentul Vertex.
3. Choose an area of forest, select a vertex, and move it to an adjoining vertex so that the two forest features meet:
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4. Click on the other vertices and snap them into place.
Limitele topologic corecte vor arăta astfel:
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Continuat,i s, i alăturat,i mai multe zone zone folosind Instrumentul Vertex.

You can also use the Add Polygon Feature tool to fill the gap between the two forest polygons. If you have
enabled Avoid overlap, you don’t have to add every single vertex - they will be added automatically if your new
polygon overlaps the existing ones.
If you are using our example data, you should have a forest area looking something like this:

Nu vă facet,i griji dacă at,i îmbinat mai multe, mai put,ine sau zone diferite de pădure.

5.2.3 ��� Follow Along: Tool: Simplify Feature

Continuing on the same layer, we will test the Simplify Feature tool:
1. Facet,i clic pe el pentru a-l activa.
2. Click on one of the areas which you joined using either the Vertex Tool or Add Feature tool. You will see this

dialog:
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3. Modify the Tolerance and watch what happens:

This allows you to reduce the number of vertices.
4. Clic pe OK
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The advantage of this tool is that it provides you with a simple and intuitive interface for generalization. But notice
that the tool ruins topology. The simplified polygon no longer shares boundaries with its adjacent polygons, as it
should. So this tool is better suited for stand-alone features.
Înainte de a merge mai departe, setat,i poligonul înapoi la starea init,ială, prin anularea ultimei modificări.

5.2.4 ��� Try Yourself: Tool: Add Ring

The Add Ring tool allows you to add an interior ring to a polygon feature (cut a hole in the polygon), as long as the
hole is completely contained within the polygon (touching the boundary is OK). For example, if you have digitized
the outer boundaries of South Africa and you need to add a hole for Lesotho, you would use this tool.
If you experiment with the tool, you may notice that the snapping options can prevent you from creating a ring inside
a polygon. So you are advised to turn off snapping before cutting a hole.

1. Disable snapping for the landuse layer using the Enable Snapping button (or use the shortcut s).

2. Use the Add Ring tool to create a hole in the middle of a polygon geometry.

3. Draw a polygon over the target feature, as if you were using the Add polygon tool.
4. When you right-click, the hole will be visible.

5. Remove the hole you just created using the Delete Ring tool. Click inside the hole to delete it.

Răspuns
The exact shape doesn’t matter, but you should be getting a hole in the middle of your feature, like this one:

• Undo your edit before continuing with the exercise for the next tool.
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5.2.5 ��� Try Yourself: Tool: Add Part

The Add Part tool allows you to add a new part to a feature, that is not directly connected to the main feature. For
example, if you have digitized the boundaries of mainland South Africa, but you haven’t yet added the Prince Edward
Islands, you would use this tool to create them.

1. Select the polygon to which you wish to add the part by using the Select Features by area or single click tool.
2. Use the Add Part tool to add an outlying area.

3. Delete the part you just created using the Delete Part tool.

Notă: Click inside the part to delete it.

Răspuns
1. First select the Bontebok National Park:

2. Now add your new part:
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3. Undo your edit before continuing with the exercise for the next tool.

5.2.6 ��� Follow Along: Tool: Reshape Features

The Reshape Features tool is used to extend a polygon feature or cut away a part of it (along the boundary).
Extindere:

1. Select the polygon using the Select Features by area or single click tool.
2. Left-click inside the polygon to start drawing.
3. Draw a shape outside the polygon. The last vertex should be back inside the polygon.
4. Right-click to finish the shape:
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Acest lucru va genera un rezultat similar cu:

Cut away a part:

1. Select the polygon using the Select Features by area or single click tool.
2. Facet,i clic în afara poligonului.
3. Draw a shape inside the polygon. The last vertex must be back outside the polygon.
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4. Right-click outside the polygon:

Iată rezultatul:
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5.2.7 ��� Try Yourself: Tool: Split Features

The Split Features tool is similar to the Reshape Features tool, except that it does not delete either of the two parts.
Instead, it keeps them both.
We will use the tool to split a corner from a polygon.

1. First, select the landuse layer and re-enable snapping for it.

2. Select the Split Features tool and click on a vertex to begin drawing a line.
3. Draw the bounding line.
4. Click a vertex on the „opposite” side of the polygon you wish to split and right-click to complete the line:

5. At this point, it may seem as if nothing has happened. But remember that the landuse layer is rendered
without border lines, so the new division line will not be shown.

6. Use the Select Features by area or single click tool to select the part you just split out; the new feature will now be
highlighted:
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5.2.8 ��� Try Yourself: Tool: Merge Features

Now we will re-join the feature you just split out to the remaining part of the polygon:

1. Experiment with the Merge Selected Features and Merge Attributes of Selected Features tools.
2. Notat,i diferent,ele.

Răspuns
• Use the Merge Selected Features tool, making sure to first select both of the polygons you wish to merge.
• Use the feature with the OGC_FID of 1 as the source of your attributes (click on its entry in the dialog, then
click the Take attributes from selected feature button):

If you’re using a different dataset, it is highly likely that your original polygon’s OGC_FID will not be 1. Just choose
the feature which has an OGC_FID.
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Using theMerge Attributes of Selected Features tool will keep the geometries distinct, but give them the same attributes.

5.2.9 În concluzie

Editarea topologică este un instrument puternic, care vă permite să creat,i s, i să modificat,i obiectele rapid s, i us,or,
asigurându-vă în acelas, i timp că ele rămân corecte din punct de vedere topologic.

5.2.10 Ce urmează?

Now you know how to digitize the shape of the objects easily, but adding attributes is still a bit of a headache! Next
we will show you how to use forms, making attribute editing simpler and more effective.

5.3 Lesson: Forms

Atunci când adăugat,i prin digitizare noi date, vi se prezintă o fereastră de dialog care vă permite să completat,i
atributele entităt,ilor. Totus, i, acest dialog nu este, în mod implicit, prea aspectuos. Acest lucru poate cauza o problemă
de uzabilitate, mai ales dacă avet,i de creat seturi de date de mari dimensiuni, sau dacă dorit,i ca alte persoane să vă
ajute la digitizare, aces, tia descoperind repede că formularele implicite sunt confuze.
Din fericire, QGIS vă permite să creat,i propriile dialoguri personalizate pentru un strat. Această lect,ie vă arată cum.
Scopul acestei lect,ii: De a crea un formular pentru un strat.
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5.3.1 ��� Follow Along: Using QGIS» Form Design Functionality

1. Select the roads layer in the Layers panel
2. Enter Edit Mode as before
3. Open the roads layer’s attribute table
4. Right-click on any cell in the table. A short menu will appear, that includes the Open form entry.
5. Click on it to see the form that QGIS generates for this layer

Evident, ar fi frumos să fit,i în măsură să facet,i acest lucru, mai degrabă, în timp ce vă uitat,i la hartă, decât să fie
nevoie să căutat,i tot timpul o stradă specifică în Tabela de Atribute.

1. Select the roads layer in the Layers panel

2. Using the Identify Features tool, click on any street in the map.
3. The Identify Results panel opens and shows a tree view of the fields values and other general information about

the clicked feature.
4. At the top of the panel, check the Auto open form for single feature results checkbox in the Identify Settings

menu.
5. Now, click again on any street in the map. Along the previous Identify Results dialog, you’ll see the now-familiar

form:

6. Each time you click on a single feature with the Identify tool, its form pops up as long as the Auto open form is
checked.
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5.3.2 ��� Try Yourself: Using the Form to Edit Values

Dacă suntet,i în modul de editare, putet,i utiliza acest formular pentru a edita atributele unei entităt,i.
1. Activat,i modul de editare (dacă nu este deja activat).

2. Using the Identify Features tool, click on the main street running through Swellendam:

3. Edit its highway value to be secondary
4. Exit edit mode and save your edits
5. Open the Attribute Table and note that the value has been updated in the attributes table and therefore in the

source data

5.3.3 ��� Follow Along: Setting Form Field Types

E frumos să editat,i lucruri folosind un formular, dar tot trebuie să introducet,i manual totul. Din fericire, formele au
as,a-numitele widgets, care vă permit să editat,i datele în diverse moduri.

1. Open the roads layer’s Properties…
2. Merget,i la fila Câmpuri. Vet,i vedea următoarele:
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3. Switch to the Attributes Form tab. You’ll see this:

4. Click on the oneway row and choose Checkbox asWidget Type in the list of options:
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5. Clic pe OK
6. Enter edit mode (if the roads layer is not already in edit mode)

7. Click on the Identify Features tool
8. Click on the same main road you chose earlier

Youwill now see that the oneway attribute has a checkbox next to it denotingTrue (checked) orFalse (unchecked).

5.3.4 ��� Try Yourself:

Setat,i un widget mai adecvat pentru câmpul highway.

Răspuns
For the TYPE, there is obviously a limited amount of types that a road can be, and if you check the attribute table for
this layer, you’ll see that they are predefined.

1. Set the widget to Value Map and click Load Data from Layer.
2. Select roads in the Label dropdown and highway for both the Value and Description options:
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3. Click OK three times.
4. If you use the Identify tool on a street now while edit mode is active, the dialog you get should look like this:
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5.3.5 ��� Try Yourself: Creating Test Data

Avet,i posibilitatea să proiectat,i, de asemenea, formularul propriu complet de la zero.
1. Create a simple point layer named test-data with two attributes:

• name (text)
• age (integer)

2. Capturat,i câteva puncte de pe noul strat folosind instrumentele de digitizare, as,a că vet,i avea un pic de date cu
care să operat,i. Ar trebui să vedet,i în continuare formularul implicit, generat de QGIS, de fiecare dată când
capturat,i un nou punct.

Notă: Este posibil să trebuiască să dezactivat,i Acros,area, dacă este activată în urma act,iunilor anterioare.
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5.3.6 ��� Follow Along: Creating a New Form

Now we want to create our own custom form for the attribute data capture phase. To do this, you need to have QT
Designer installed (only needed for the person who creates the forms).

1. Start QT Designer.
2. În caseta de dialog care apare, creat,i un nou dialog:

3. Căutat,iWidget Box în partea stângă a ecranului (implicit). Aceasta cont,ine un element denumit Line Edit.
4. Facet,i clic s, i traget,i acest articol în formular. Aceasta va crea o nouă Linie de Editare în formular.
5. Având selectat noul element de linie de editare, îi vet,i vedea proprietăt,ile de-a lungul părt,ii laterale a ecranului

(din partea dreaptă, în mod implicit):
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6. Set its name to name.
7. Using the same approach, create a new Spin Box and set its name to age.
8. Add a Label with the text Add a New Person in a bold font (look in the object properties to find out how

to set this). Alternatively, you may want to set the title of the dialog itself (rather than adding a label).
9. Add a Label for your Line Edit and your Spin Box.
10. Arrange the elements to your own desire.
11. Facet,i clic oriunde, în fereastra de dialog.
12. Find the Lay Out in a Form Layout button (in a toolbar along the top edge of the screen, by default). This lays

out your dialog automatically.
13. Set the dialog’s maximum size (in its properties) to 200 (width) by 150 (height).
14. Your form should now look similar to this:
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15. Save your new form as exercise_data/forms/add_people.ui
16. When it’s done saving, you can close Qt Designer

5.3.7 ��� Follow Along: Associating the Form with Your Layer

1. Go back to QGIS
2. Dublu clic pe stratul test-data din legendă, pentru a-i accesa proprietăt,ile.
3. Click on the Attributes Form tab in the Layer Properties dialog
4. În caseta cu lista derulantă Attribute editor layout, selectat,i Provide ui-file.
5. Click the ellipsis button and choose the add_people.ui file you just created:

6. Click OK on the Layer Properties dialog
7. Enter edit mode and capture a new point
8. Când facet,i acest lucru, vă va fi prezentat dialogul personalizat (în loc de cel generic, pe care îl creează de

obicei QGIS).
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9. If you click on one of your points using the Identify Features tool, you can now bring up the form by right
clicking in the identify results window and choosing View Feature Form from the context menu.

10. If you are in edit mode for this layer, that context menu will show Edit Feature Form instead, and you can then
adjust the attributes in the new form even after initial capture.

5.3.8 În concluzie

Folosind formularele, vă putet,i face viat,a mai us,oară, atunci când editat,i sau când creat,i date. Prin editarea tipurilor
de widget sau pin crearea unui formular cu totul nou, de la zero, putet,i controla experient,a cuiva care digitalizează
date noi, minimizând, astfel, neînt,elegerile s, i erorile inutile.

5.3.9 Further Reading

If you completed the advanced section above and have knowledge of Python, youmaywant to check out this blog entry
about creating custom feature forms with Python logic, which allows advanced functions including data validation,
autocompletion, etc.

5.3.10 Ce urmează?

Deschiderea unui formular o dată cu identificarea unei entităt,i este una dintre act,iunile standard, pe care o poate
efectua QGIS. Cu toate acestea, putet,i efectua direct act,iunile personalizate pe care le definit,i. Acesta este subiectul
lect,iei următoare.

5.4 Lesson: Actions

Now that you have seen a default action in the previous lesson, it is time to define your own actions.
An action is something that happens when you click on a feature. It can add a lot of extra functionality to your map,
allowing you to retrieve additional information about an object, for example. Assigning actions can add a whole new
dimension to your map!
Scopul acestei lect,ii: De a afla cum să adăugat,i act,iuni particularizate.
In this lesson you will use the school_property layer you created previously. The sample data include photos of each
of the three properties you digitized. What we are going to do is to associate each property with its image. Then we
will create an action that will open the image for a property when clicking on the property.

5.4.1 ��� Follow Along: Add a Field for Images

The school_property layer has no way to associate an image with a property yet. First we will create a field for
this purpose.

1. Deschidet,i dialogul Layer Properties.
2. Dat,i clic pe fila Fields.
3. Comutat,i în modul de editare:
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4. Adăugat,i o nouă coloană:

5. Introducet,i valorile de mai jos:
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6. After the field has been created, move to the Attributes Form tab and select the image field.
7. SetWidget Type to Attachment:

8. Click OK in the Layer Properties dialog.
9. Folosit,i instrumentul Identify pentru a facet,i clic pe una dintre cele trei entităt,i din stratul school_property.

Since you are still in edit mode, the dialog should be active and look like this:
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10. Clic pe butonul de răsfoire (… de lângă câmpul imagine).
11. Select the path for your image. The images are in exercise_data/school_property_photos/

and are named the same as the features they should be associated with.
12. Clic pe OK
13. Asociat,i toate imaginile cu entităt,ile corecte folosind această metodă.
14. Salvat,i modificările s, i ies, it,i din modul de editare.

5.4.2 ��� Follow Along: Creating an Action

1. Open the Actions tab for the school_property layer, and click on the Add a new action button.

2. In the Add New Action dialog, enter the words Show Image into the Description field:
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Ceea ce vet,i face în continuare diferă în funct,ie de sistemul de operare, asa că aleget,i un curs adecvat:
• Windows
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Dat,i clic pe meniul vertical Type s, i aleget,i Open.
• Ubuntu Linux
Under Action, write eog for the Gnome Image Viewer, or write display to use ImageMagick.
Remember to put a space after the command!

• macOS
1. Clic pe caseta Type, apoi aleget,i Mac.
2. Under Action, write open. Remember to put a space after the command!

Now you can continue writing the command.
Vret,i să deschidet,i imaginea, si QGIS s, tie unde se află. Tot ce rămâne de făcut este să îi spunet,i Action unde
se află imaginea.

3. Selectat,i image din listă:
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4. Click the Insert field button. QGIS will add the phrase [% "image" %] in the Action Text field.
5. Click the OK button to close the Add New Action dialog
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6. Click OK to close the Layer Properties dialog
Now it is time to test the new action:

1. Click on the school_property layer in the Layers panel so that it is highlighted.

2. Find the Run feature action button (in the Attributes Toolbar).
3. Click on the down arrow to the right of this button. There is only one action defined for this layer so far, which

is the one you just created.

4. Apăsat,i butonul pentru a activa instrumentul.
5. Folosind acest instrument, facet,i clic pe oricare din cele trei proprietăt,i s,colare.

The image for that property should open.

5.4.3 ��� Follow Along: Searching the Internet

Let’s say we are looking at the map and want to know more about the area that a farm is in. Suppose you know
nothing of the area in question and want to find general information about it. Your first impulse, considering that
you’re using a computer right now, would probably be to Google the name of the area. So let’s tell QGIS to do that
automatically for us!

1. Deschidet,i tabela de atribute a stratului landuse.
We will be using the name field for each of our landuse areas to search Google.

2. Închidet,i tabelul de atribute.
3. Merget,i înapoi la Act,iuni în Proprietăt,ile Stratului.
4. Click on the Create Default Actions button to add a number of pre-defined actions.

5. Remove all the actions but the Open URL action with the short name Search Web using the
Remove the selected action button below.

6. Double-click on the remaining action to edit it
7. Change the Description to Google Search, and remove the content of the Short Name field.
8. Make sure that Canvas is among the checked Action scopes.

Ceea ce vet,i face în continuare diferă în funct,ie de sistemul de operare, asa că aleget,i un curs adecvat:
• Windows
Sub Tip, aleget,i Deschidere. Acest lucru va spune Windows-ului să deschidă o adresă de Internet din
browser-ul implicit, cum ar fi Internet Explorer.

• Ubuntu Linux
UnderAction, writexdg-open. This will tell Ubuntu to open an Internet address in your default browser,
such as Chrome or Firefox.

• macOS
Under Action, write open. This will tell macOS to open an Internet address in your default browser,
such as Safari.
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Now you can continue writing the command
Orice comandă at,i folosit mai sus, trebuie să îi spunet,i ce adresă să deschidă în continuare. Vret,i să accesat,i
Google s, i să căutat,i automat o expresie.
Usually when you use Google, you enter your search phrase into the Google Search bar. But in this case, you
want your computer to do this for you. The way you tell Google to search for something (if you don’t want to
use its search bar directly) is by giving your Internet browser the address https://www.google.com/
search?q=SEARCH_PHRASE, where SEARCH_PHRASE` is what you want to search for. Since we don’t
know what phrase to search for yet, we will just enter the first part (without the search phrase).

9. In the Action field, write https://www.google.com/search?q=. Remember to add a space after
your initial command before writing this in!
Now you want QGIS to tell the browser to tell Google to search for the value of name for any feature that you
could click on.

10. Selectat,i câmpul name.
11. Click Insert button:
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What this means is that QGIS is going to open the browser and send it to the address https://www.
google.com/search?q=[% "name" %]. [% "name" %] tells QGIS to use the contents of the
name field as the phrase to search for.
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So if, for example, the landuse area you click on is named Marloth Nature Reserve, QGIS is going to
send the browser to https://www.google.com/search?q=Marloth%20Nature%20Reserve,
which will cause your browser to visit Google, which will in turn search for „Marloth Nature Reserve”.

12. If you have not done so already, set everything up as explained above.
13. Click the OK button to close the Add New Action dialog
14. Click OK to close the Layer Properties dialog

Acum vom testa noua versiune.

1. With the landuse layer active in the Layers panel, click on the down arrow to the right of the Run feature action

button, and select the only action (Google Search) defined for this layer.
2. Click on any landuse area you can see on the map. Your browser will now open, and will start a Google search

for the place that is recorded as that area’s name value.

Notă: În cazul în care act,iunea nu funct,ionează, verificat,i dacă totul a fost introdus corect; erorile de introducere
sunt comune pentru această activitate!

5.4.4 ��� Follow Along: Open a Webpage Directly in QGIS

Above, you’ve seen how to open a webpage in an external browser. There are some shortcomings with this approach
in that it adds an unknowable dependency – will the end-user have the software required to execute the action on
their system? As you’ve seen, they don’t necessarily even have the same kind of base command for the same kind
of action, if you don’t know which OS they will be using. With some OS versions, the above commands to open the
browser might not work at all. This could be an insurmountable problem.
However, QGIS sits on top of the incredibly powerful and versatile Qt library. Also, QGIS actions can be arbitrary,
tokenized (i.e. using variable information based on the contents of a field attribute) Python commands!
Now you will see how to use a python action to show a web page. It is the same general idea as opening a site in an
external browser, but it requires no browser on the user’s system since it uses the Qt QWebView class (which is a
webkit based html widget) to display the content in a pop-up window.
Let us use Wikipedia this time. So the URL you request will look like this:
https://wikipedia.org/wiki/SEARCH_PHRASE

Pentru a crea act,iunea stratului:
1. Deschidet,i dialogul Proprietăt,ilor Stratului s, i merget,i la fila Actions.
2. Setat,i o nouă act,iune, folosind următoarele proprietăt,i pentru act,iune:

• Tip: Python
• Descriere: Wikipedia
• Scope: Feature, Canvas
• Action Text:

from qgis.PyQt.QtCore import QUrl
from qgis.PyQt.QtWebKitWidgets import QWebView

myWV = QWebView(None)
myWV.load(QUrl('https://wikipedia.org/wiki/[%name%]'))
myWV.show()
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Aici se întâmplă mai multe lucruri:
• [%name%] will be replaced by the actual attribute value when the action is invoked (as before).
• The code simply creates a new QWebView instance, sets its URL, and then calls show() on it to make
it visible as a window on the user’s desktop.

You could also use this approach to display an image without requiring that the users have a particular image
viewer on their system.

3. Try to use the methods described above to load a Wikipedia page using the Wikipedia action you just created.
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5.4.5 În concluzie

Actions allow you to give your map extra functionality, useful to the end-user who views the same map in QGIS. Due
to the fact that processes called can be shell commands for any operating system, as well as Python, the sky is the
limit in terms of the functions you could incorporate!

5.4.6 Ce urmează?

Now that you’ve done all kinds of vector data creation, you will learn how to analyze the data to solve problems. That
is the topic of the next module.
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Module: Vector Analysis

Acum, după ce at,i editat câteva entităt,i, trebuie să s, tit,i ce altceva se poate face cu ele. Având entităt,i cu atribute este
frumos, dar, în final, aceasta nu reprezintă chiar ceva care să se detas,eze net fat,ă de o hartă non-GIS.
Avantajul cheie al unui GIS este: un GIS poate răspunde întrebărilor.
Pentru următoarele trei module, ne vom strădui să răspundem la o întrebare de cercetare folosind funct,ii GIS. De
exemplu, dacă suntet,i un agent imobiliar s, i vă aflat,i în căutarea unei proprietăt,i rezident,iale în Swellendam, care
trebuie să respecte următoarele criterii:

1. Să fie situată în Swellendam.
2. Trebuie să fie la distant,ă de conducere rezonabilă, fat,ă de o s,coală (de exemplu, 1 km).
3. Trebuie să aibă mai mult de 100m pătrat,i în dimensiune.
4. Să fie situată sub 50m fat,ă de un drum principal.
5. Să fie situată la maximumb500m fat,ă de un restaurant.

În următoarele câteva module, vom valorifica puterea instrumentelor de analiză GIS, pentru a localiza proprietăt,ile
agricole potrivite pentru această nouă dezvoltare rezident,ială.

6.1 Lesson: Reprojecting and Transforming Data

Let us talk about Coordinate Reference Systems (CRSs) again. We have touched on this briefly before, but haven’t
discussed what it means practically.
Scopul acestei lect,ii: De a reproiecta s, i transforma seturile de date vectoriale.
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6.1.1 ��� Follow Along: Projections

The CRS that all the data, as well as the map itself are in right now is called WGS84. This is a very common
Geographic Coordinate System (GCS) for representing data. But there’s a problem, as we will see.

1. Save your current map
2. Then open the map of the world which you will find under exercise_data/world/world.qgs
3. Zoom in to South Africa by using the Zoom In tool
4. Try setting a scale in the Scale field, which is in the Statusbar along the bottom of the screen. While over South

Africa, set this value to 1:5 000 000 (one to five million).
5. Pan around the map while keeping an eye on the Scale field

Notice the scale changing? That’s because you are moving away from the one point that you zoomed into at 1:5
000 000, which was at the center of your screen. All around that point, the scale is different.
Pentru a înt,elege de ce, gândit,i-vă la un glob al Pământului. Acesta are linii care pornesc de la Nord înspre Sud.
Aceste linii longitudinale sunt situate departe una de alta la ecuator, dar se întâlnesc la poli.
In a GCS, you are working on this sphere, but your screen is flat. When you try to represent the sphere on a flat
surface, distortion occurs, similar to what would happen if you cut open a tennis ball and tried to flatten it out. What
this means on a map is that the longitude lines stay equally far apart from each other, even at the poles (where they
are supposed to meet). This means that, as you travel away from the equator on your map, the scale of the objects
that you see gets larger and larger. What this means for us, practically, is that there is no constant scale on our map!
To solve this, let’s use a Projected Coordinate System (PCS) instead. A PCS „projects” or converts the data in a way
that makes allowance for the scale change and corrects it. Therefore, to keep the scale constant, we should reproject
our data to use a PCS.

6.1.2 ��� Follow Along: „On the Fly” Reprojection

By default, QGIS reprojects data „on the fly”. What this means is that even if the data itself is in another CRS, QGIS
can project it as if it were in a CRS of your choice.

You can change the CRS of the project by clicking on the Current projection button in the bottom right corner of
QGIS.

1. In the dialog that appears, type the word global into the Filter field. A few CRSs should appear in the
Predefined Reference Systems field below.

2. SelectWGS 84 / NSIDC EASE-Grid 2.0 Global | EPSG:6933 entry by clicking on it, and then click OK.
Observat,i modul în care forma Africii de Sud se schimbă. Toate proiect,iile lucrează prin schimbarea formelor
aparente ale obiectelor de pe Terra.

3. Zoom to a scale of 1:5 000 000 again, as before.
4. Deplasat,i un pic harta.

Observat,i că scara rămâne la fel!
Reproiectarea „din zbor” este folosită, de asemenea, pentru a combina seturile de date aflate în diverse CRS-uri

1. Add another vector layer to your map which has the data for South Africa only. You will find it as
exercise_data/world/RSA.shp.

2. Load it. A quick way to see its CRS is by hovering the mouse over the layer in the legend. It is EPSG:3410.
Ce observat,i?
The layer is visible even if it has a different CRS from the continents one.
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6.1.3 ��� Follow Along: Saving a Dataset to Another CRS

Sometimes you need to export an existing dataset with another CRS. As we will see in the next lesson, if you need
to make distance calculations on layer, it is always better to have the layer in a projected coordinate system.
Be aware that the «on the fly» reprojection is related to the project and not to single layers. This means that a layer
can have a different CRS from the project even if you see it in the correct position.
You can easily export the layer with another CRS.

1. Add the buildings dataset from training_data.gpkg

2. Right-click on the buildings layer in the Layers panel
3. Select Export ► Save Features As… in the menu that appears. You will be shown the Save Vector Layer as…

dialog.
4. Click on the Browse button next to the File name field
5. Navigate to exercise_data/ and specify the name of the new layer as buildings_reprojected.

shp.
6. Change the value of the CRS. Only the recent CRSs used will be shown in the drop-down menu. Click on the

Select projection button next to the drop-down menu.
7. The Coordinate Reference System Selector dialog will appear. In its Filter field, search for 34S.
8. SelectWGS 84 / UTM zone 34S | EPSG:32734 from the list
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9. Leave the other options unchanged. The Save Vector Layer as… dialog now looks like this:
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10. Clic pe OK
You can now compare the old and new projections of the layer and see that they are in two different CRS but they
are still overlapping.
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6.1.4 ��� Follow Along: Creating Your Own Projection

Există mai multe proiect,ii decât cele incluse în QGIS în mod implicit. De asemenea, putet,i crea propriile proiect,ii.
1. Start a new map
2. Load the world/oceans.shp dataset
3. Go to Settings ► Custom Projections… and you will see this dialog.

4. Click on the Add new CRS button to create a new projection
5. O proiect,ie interesant de utilizat se numes, te Van der Grinten I. Introducet,i această denumire în câmpul

Nume.
Această proiect,ie reprezintă Pământul pe un teren circular, în locul uneia dreptunghiulară, la fel ca majoritatea
celorlalte proiect,ii.

6. In Format, selectWKT (Recommended)
7. Add the following string in the Parameters field:

PROJCRS["unknown",
BASEGEOGCRS["unknown",

DATUM["unknown",
ELLIPSOID["unknown",6371000,0,

LENGTHUNIT["metre",1,
ID["EPSG",9001]]]],

PRIMEM["Greenwich",0,
ANGLEUNIT["degree",0.0174532925199433],
ID["EPSG",8901]]],

CONVERSION["unknown",
METHOD["Van Der Grinten"],
PARAMETER["Longitude of natural origin",0,

(continues on next page)
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(continuare din pagina precedentă)
ANGLEUNIT["degree",0.0174532925199433],
ID["EPSG",8802]],

PARAMETER["False easting",0,
LENGTHUNIT["metre",1],
ID["EPSG",8806]],

PARAMETER["False northing",0,
LENGTHUNIT["metre",1],
ID["EPSG",8807]]],

CS[Cartesian,2],
AXIS["(E)",east,

ORDER[1],
LENGTHUNIT["metre",1,

ID["EPSG",9001]]],
AXIS["(N)",north,

ORDER[2],
LENGTHUNIT["metre",1,

ID["EPSG",9001]]]]

8. Clic pe OK

9. Click on the Current CRS button at the right of the status bar to change the project CRS
10. Choose your newly defined projection (search for its name in the Filter field)
11. După aplicarea acestei proiect,ii, harta va fi reproiectată astfel:
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6.1.5 În concluzie

Diferite proiect,ii sunt utile pentru scopuri diferite. Prin alegerea proiect,ia corectă, vă putet,i asigura că entităt,ile de
pe hartă sunt reprezentate cu precizie.

6.1.6 Further Reading

Materials for the Advanced section of this lesson were taken from this article.
Read further information on Coordinate Reference Systems.

6.1.7 Ce urmează?

In the next lesson you will learn how to analyze vector data using QGIS» various vector analysis tools.

6.2 Lesson: Vector Analysis

Vector data can also be analyzed to reveal how different features interact with each other in space. There are many
different analysis-related functions, so we won’t go through them all. Rather, we will pose a question and try to solve
it using the tools that QGIS provides.
Scopul acestei lect,ii: De a pune o întrebare s, i de a o rezolva folosind instrumentele de analiză.
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6.2.1 ��� The GIS Process

Before we start, it would be useful to give a brief overview of a process that can be used to solve a problem. The way
to go about it is:

1. Definirea Problemei
2. Obt,inerea Datelor
3. Analiza Problemei
4. Prezentarea Rezultatelor

6.2.2 ��� The Problem

Let’s start off the process by deciding on a problem to solve. For example, you are an estate agent and you are looking
for a residential property in Swellendam for clients who have the following criteria:

1. It needs to be in Swellendam
2. It must be within reasonable driving distance of a school (say 1km)
3. It must be more than 100m squared in size
4. Closer than 50m to a main road
5. Closer than 500m to a restaurant

6.2.3 ��� The Data

To answer these questions, we are going to need the following data:
1. The residential properties (buildings) in the area
2. The roads in and around the town
3. The location of schools and restaurants
4. The size of buildings

These data are available through OSM, and you should find that the dataset you have been using throughout this
manual also can be used for this lesson.
If you want to download data from another area, jump to the Introduction Chapter to read how to do it.

Notă: Although OSM downloads have consistent data fields, the coverage and detail does vary. If you find that your
chosen region does not contain information on restaurants, for example, you may need to chose a different region.

6.2.4 ��� Follow Along: Start a Project and get the Data

We first need to load the data to work with.
1. Start a new QGIS project
2. If you want, you can add a background map. Open the Browser and load the OSM background map from the

XYZ Tiles menu.
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3. In the training_data.gpkg Geopackage database, you will find most the datasets we will use in this
chapter:
1. buildings
2. roads
3. restaurants
4. schools

Load them, and also landuse.sqlite.
4. Zoom to the layer extent to see Swellendam, South Africa

Before proceeding we will filter the roads layer, in order to have only some specific road types to work with.
Some roads in OSM datasets are listed as unclassified, tracks, path and footway. We want to
exclude these from our dataset and focus on the other road types, more suitable for this exercise.
Moreover, OSM data might not be updated everywhere, and we will also exclude NULL values.

5. Right click on the roads layer and choose Filter….
6. In the dialog that pops up we filter these features with the following expression:

"highway" NOT IN ('footway', 'path', 'unclassified', 'track') AND "highway" IS␣
↪→NOT NULL

The concatenation of the two operators NOT and IN excludes all the features that have these attribute values
in the highway field.
IS NOT NULL combined with the AND operator excludes roads with no value in the highway field.

Note the icon next to the roads layer. It helps you remember that this layer has a filter activated, so some
features may not be available in the project.
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The map with all the data should look like the following one:

6.2.5 ��� Try Yourself: Convert Layers» CRS

Because we are going to be measuring distances within our layers, we need to change the layers» CRS. To do this,
we need to select each layer in turn, save the layer to a new one with our new projection, then import that new layer
into our map.
You have many different options, e.g. you can export each layer as an ESRI Shapefile format dataset, you can append
the layers to an existing GeoPackage file, or you can create another GeoPackage file and fill it with the new reprojected
layers. We will show the last option, so the training_data.gpkg will remain clean. Feel free to choose the
best workflow for yourself.

Notă: In this example, we are using the WGS 84 / UTM zone 34S CRS, but you should use a UTM CRS which is
more appropriate for your region.

1. Right click the roads layer in the Layers panel
2. Click Export –> Save Features As…
3. In the Save Vector Layer As dialog choose GeoPackage as Format
4. Click on… for the File name, and name the new GeoPackage vector_analysis
5. Change the Layer name to roads_34S
6. Change the CRS toWGS 84 / UTM zone 34S

7. Click on OK:
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This will create the new GeoPackage database and add the roads_34S layer.
8. Repeat this process for each layer, creating a new layer in the vector_analysis.gpkg GeoPackage file

with _34S appended to the original name.
On macOS, press the Replace button in the dialog that pops up to allow QGIS to overwrite the existing
GeoPackage.

Notă: When you choose to save a layer to an existing GeoPackage, QGIS will add that layer next to the
existing layers in the GeoPackage, if no layer of the same name already exists.

9. Remove each of the old layers from the project
10. Once you have completed the process for all the layers, right click on any layer and click Zoom to layer extent

to focus the map to the area of interest.
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Now that we have converted OSM data to a UTM projection, we can begin our calculations.

6.2.6 ��� Follow Along: Analyzing the Problem: Distances From Schools and
Roads

QGIS allows you to calculate distances between any vector object.
1. Make sure that only the roads_34S and buildings_34S layers are visible (to simplify the map while

you’re working)
2. Click on the Processing ► Toolbox to open the analytical core of QGIS. Basically, all algorithms (for vector

and raster analysis) are available in this toolbox.
3. We start by calculating the area around the roads_34S by using the Buffer algorithm. You can find it in the

Vector Geometry group.
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Or you can type buffer in the search menu in the upper part of the toolbox:

4. Double click on it to open the algorithm dialog
5. Select roads_34S as Input layer, set Distance to 50 and use the default values for the rest of the parameters.
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6. The default Distance is in meters because our input dataset is in a Projected Coordinate System that uses meter
as its basic measurement unit. You can use the combo box to choose other projected units like kilometers,
yards, etc.

Notă: If you are trying to make a buffer on a layer with a Geographical Coordinate System, Processing will
warn you and suggest to reproject the layer to a metric Coordinate System.

7. By default, Processing creates temporary layers and adds them to the Layers panel. You can also append the
result to the GeoPackage database by:
1. Clicking on the… button and choose Save to GeoPackage…
2. Naming the new layer roads_buffer_50m
3. Saving it in the vector_analysis.gpkg file

208 Capitolul 6. Module: Vector Analysis



QGIS Training Manual

8. Click on Run, and then close the Buffer dialog
Acum, harta dvs. va arăta în felul următor:
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If your new layer is at the top of the Layers list, it will probably obscure much of your map, but this gives you all the
areas in your region which are within 50m of a road.
Notice that there are distinct areas within your buffer, which correspond to each individual road. To get rid of this
problem:

1. Uncheck the roads_buffer_50m layer and re-create the buffer with Dissolve results enabled.
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2. Save the output as roads_buffer_50m_dissolved
3. Click Run and close the Buffer dialog

Once you have added the layer to the Layers panel, it will look like this:
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Acum, nu mai există subdiviziuni inutile.

Notă: The Short Help on the right side of the dialog explains how the algorithmworks. If you needmore information,
just click on the Help button in the bottom part to open a more detailed guide of the algorithm.

6.2.7 ��� Try Yourself: Distance from schools

Utilizat,i aceeas, i abordare de mai sus, s, i creat,i un tampon pentru s,colile dumneavoastră.
It shall be 1 km in radius. Save the new layer in the vector_analysis.gpkg file as
schools_buffer_1km_dissolved.

Răspuns
• Your buffer dialog should look like this:
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The Buffer distance is 1 kilometer.
• The Segments to approximate value is set to 20. This is optional, but it’s recommended, because it makes the
output buffers look smoother. Compare this:
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To this:
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The first image shows the buffer with the Segments to approximate value set to 5 and the second shows the value set
to 20. In our example, the difference is subtle, but you can see that the buffer’s edges are smoother with the higher
value.

6.2.8 ��� Follow Along: Overlapping Areas

Now we have identified areas where the road is less than 50 meters away and areas where there is a school within 1
km (direct line, not by road). But obviously, we only want the areas where both of these criteria are satisfied. To do
that, we will need to use the Intersect tool. You can find it in Vector Overlay group in the Processing Toolbox.

1. Use the two buffer layers as Input layer and Overlay layer, choose vector_analysis.gpkg GeoPackage
in Intersection with Layer name road_school_buffers_intersect. Leave the rest as suggested
(default).
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2. Clic pe Run
In the image below, the blue areas are where both of the distance criteria are satisfied.
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3. You may remove the two buffer layers and only keep the one that shows where they overlap, since that’s what
we really wanted to know in the first place:
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6.2.9 ��� Follow Along: Extract the Buildings

Now you’ve got the area that the buildings must overlap. Next, you want to extract the buildings in that area.
1. Look for the menu entry Vector Selection ► Extract by location within the Processing Toolbox
2. Select buildings_34S in Extract features from. Check intersect inWhere the features (geometric predicate),

select the buffer intersection layer in By comparing to the features from. Save to the vector_analysis.
gpkg, and name the layer well_located_houses.

3. Click Run and close the dialog
4. You will probably find that not much seems to have changed. If so, move the well_located_houses layer to the

top of the layers list, then zoom in.
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The red buildings are those which match our criteria, while the buildings in green are those which do not.
5. Now you have two separated layers and can remove buildings_34S from the layer list.

6.2.10 ��� Try Yourself: Further Filter our Buildings

We now have a layer which shows us all the buildings within 1km of a school and within 50m of a road. We now
need to reduce that selection to only show buildings which are within 500m of a restaurant.
Using the processes described above, create a new layer called houses_restaurants_500m which further filters your
well_located_houses layer to show only those which are within 500m of a restaurant.

Răspuns
To create the new houses_restaurants_500m layer, we go through a two step process:

1. First, create a buffer of 500m around the restaurants and add the layer to the map:
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2. Next, extract buildings within that buffer area:

220 Capitolul 6. Module: Vector Analysis



QGIS Training Manual

Your map should now show only those buildings which are within 50m of a road, 1km of a school and 500m of a
restaurant:
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6.2.11 ��� Follow Along: Select Buildings of the Right Size

To see which buildings are of the correct size (more than 100 square meters), we need to calculate their size.

1. Select the houses_restaurants_500m layer and open the Field Calculator by clicking on the Open Field Calculator

button in the main toolbar or in the attribute table window
2. Select Create a new field, set the Output field name to AREA, choose Decimal number (real) as Output field

type, and choose $area from the Geometry group.

The new field AREA will contain the area of each building in square meters.
3. Click OK. The AREA field has been added at the end of the attribute table.

4. Click the Toggle Editing button to finish editing, and save your edits when prompted.
5. In the Source tab of the layer properties, set the Provider Feature Filter to "AREA >= 100.
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6. Clic pe OK
Your map should now only show you those buildings which match our starting criteria and which are more than 100
square meters in size.

6.2.12 ��� Try Yourself:

Save your solution as a new layer, using the approach you learned above for doing so. The file should be saved within
the same GeoPackage database, with the name solution.
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6.2.13 În concluzie

Using the GIS problem solving approach together with QGIS vector analysis tools, you were able to solve a problem
with multiple criteria quickly and easily.

6.2.14 Ce urmează?

In the next lesson, we will look at how to calculate the shortest distance along roads from one point to another.

6.3 Lesson: Network Analysis

Calculating the shortest distance between two points is a common GIS task. Tools for this can be found in the
Processing Toolbox.
The goal for this lesson: learn to use Network analysis algorithms.

6.3.1 ��� Follow Along: The Tools and the Data

You can find all the network analysis algorithms in the Processing ► Network Analysis menu. You can see that there
are many tools available:
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Open the project exercise_data/network_analysis/network.qgz. It contains two layers:
• network_points

• network_lines

The network_lines layer has already a style that helps to understand the road network.

The shortest path tools provide ways to calculate either the shortest or the fastest path between two points of a network,
given:

• start and end points selected on the map
• start point selected on the map and end points taken from a point layer
• start points taken from a point layer and end point selected on the map

Let’s start.

6.3.2 ��� Calculate the shortest path (point to point)

The Network analysis ► Shortest path (point to point) allows you to calculate the shortest distance between two
manually selected points on the map.
In this example we will calculate the shortest (not fastest) path between two points.

1. Open the Shortest path (point to point) algorithm
2. Select network_lines for Vector layer representing network
3. Use Shortest for Path type to calculate

Use these two points as starting and ending points for the analysis:
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4. Click on the… button next to Start point (x, y) and choose the location tagged with Starting Point in the
picture. Enable the snapping options for an accurate selection. The coordinates of the clicked point are added.

5. Do the same thing, but choosing the location tagged with Ending point for End point (x, y)
6. Click on the Run button:

7. A new line layer is created representing the shortest path between the chosen points. Uncheck the
network_lines layer to see the result better:
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8. Open the attribute table of the output layer. It contains three fields, representing the coordinates of the start
and end points and the cost.
We chose Shortest as Path type to calculate, so the cost represent the distance, in layer units, between the
two locations.
In our case, the shortest distance between the chosen points is around 1000 meters:

Now that you know how to use the tool, feel free to test other locations.

6.3.3 ��� Try Yourself: Fastest path

With the same data of the previous exercise, try to calculate the fastest path between the two points.
How much time do you need to go from the start to the end point?

Answer
1. Open Network Analysis ► Shortest Path (Point to Point) and fill the dialog as:
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2. Make sure that the Path type to calculate is Fastest.
3. Click on Run and close the dialog.
4. Open now the attribute table of the output layer. The cost field contains the travel time between the two points

(as fraction of hours):

6.3.4 ��� Follow Along: Advanced options

Let us explore some more options of the Network Analysis tools. In the previous exercise we calculated the fastest
route between two points. As you can imagine, the time depends on the travel speed.
We will use the same layers and starting and ending points of the previous exercises.

1. Open the Shortest path (point to point) algorithm
2. Fill the Input layer, Start point (x, y) and End point (x, y) as we did before
3. Choose Fastest as the Path type to calculate
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4. Open the Advanced parameter menu
5. Change the Default speed (km/h) from the default 50 value to 4
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6. Click on Run
7. Once the algorithm is finished, close the dialog and open the attribute table of the output layer.

The cost field contains the value according to the speed parameter you have chosen. We can convert the cost
field from hours with fractions to the more readable minutes values.

8. Open the field calculator by clicking on the icon
9. Add a new field to store the path cost in minutes.

That’s it! Now you know how many minutes it will take to get from one point to the other one if the whole network
speed is at 4 km/h.
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6.3.5 ��� Shortest path with speed limit

The Network analysis toolbox has other interesting options. Looking at the following map:

we would like to know the fastest route considering the speed limits of each road (the labels represent the speed
limits in km/h). The shortest path without considering speed limits would of course be the purple path. But in that
road the speed limit is 20 km/h, while in the green road you can go at 100 km/h!
As we did in the first exercise, we will use the Network analysis► Shortest path (point to point) and we will manually
choose the start and end points.

1. Open the Network analysis ► Shortest path (point to point) algorithm
2. Select network_lines for the Vector layer representing network parameter
3. Choose Fastest as the Path type to calculate
4. Select the Start point (x, y) and End point (x, y) as we did before
5. Open the Advanced parameters menu
6. Choose the speed field as the Speed Field parameter. With this option the algorithm will take into account the

speed limits for each road.
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7. Click on the Run button
8. Turn off the network_lines layer to better see the result
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As you can see the fastest route does not correspond to the shortest one.

6.3.6 ��� Service area (from layer)

The Network Analysis ► Service area (from layer) algorithm can answer the question: given a point layer, what are
all the reachable areas given a distance or a time value?

Notă: The Network Analysis► Service area (from point) is the same algorithm, but it allows you to manually choose
the point on the map.

Given a distance of 250 meters we want to know how far we can go on the network from each point of the
network_points layer.

1. Uncheck all the layers except network_points
2. Open the Network Analysis ► Service area (from layer) algorithm
3. Choose network_lines for Vector layer representing network
4. Choose network_points for Vector layer with start points
5. Choose Shortest in Path type to calculate
6. Enter 250 for the Travel cost parameter
7. Click on Run and close the dialog
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The output layer represents the maximum path you can reach from the point features given a distance of 250
meters:
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Cool isn’t it?

6.3.7 În concluzie

Now you know how to use Network analysis algorithm to solve shortest and fastest path problems.
We are now ready to perform some spatial statistic on vector layer data. Let’s go!

6.3.8 Ce urmează?

Mai departe, vet,i vedea cum să rulat,i algoritmii statisticilor spat,iale asupra seturilor de date vectoriale.

6.4 Lesson: Spatial Statistics

Notă: Lect,ia a fost dezvoltată de Linfiniti s, i S Motala (Cape Peninsula University of Technology

Spatial statistics allows you to analyze and understand what is going on in a given vector dataset. QGIS includes many
useful tools for statistical analysis.
The goal for this lesson: To know how to use QGIS» spatial statistics tools within the Processing Toolbox.
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6.4.1 ��� Follow Along: Create a Test Dataset

We will create a random set of points, to get a dataset to work with.
To do so, you will need a polygon dataset to define the area you want to create the points in.
We will use the area covered by streets.

1. Start a new project
2. Add your roads dataset, as well as srtm_41_19 (elevation data) found in exercise_data/raster/

SRTM/.

Notă: You might find that the SRTM DEM layer has a different CRS to that of the roads layer. QGIS is
reprojecting both layers in a single CRS. For the following exercises this difference does not matter, but feel
free to reproject (as shown earlier in this module).

3. Open Processing toolbox
4. Use the Vector Geometry ► Minimum bounding geometry tool to generate an area enclosing all the roads by

selecting Convex Hull as the Geometry Type:

As you know, if you don’t specify the output, Processing creates temporary layers. It is up to you to save the
layers immediately or at a later stage.

Crearea de puncte aleatorii

• Create 100 random points in this area using the tool at Vector Creation► Random points in layer bounds, with
a minimum distance of 0.0:
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Notă: The yellow warning sign tells you that that parameter concerns distances. The Bounding geometry layer
is in a Geographical Coordinate System and the algorithm is just reminding you this. For this example we
won’t use this parameter so you can ignore it.

If needed, move the generated random point to the top of the legend to see them better:
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Es, antionarea datelor

To create a sample dataset from the raster, you’ll need to use the Raster Analysis ► Sample raster values algorithm.
This tool samples the raster at the locations of the points and adds the raster values in new field(s) depending on the
number of bands in the raster.

1. Open the Sample raster values algorithm dialog
2. Select Random_points as the layer containing sampling points, and the SRTM raster as the band to get

values from. The default name of the new field is rvalue_N, where N is the number of the raster band. You
can change the name of the prefix if you want.

3. Press Run
Now you can check the sampled data from the raster file in the attribute table of the Sampled Points layer. They
will be in a new field with the name you have chosen.
Un posibil strat es,antion este prezentat aici:
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The sample points are classified using the rvalue_1 field such that red points are at a higher altitude.
You will be using this sample layer for the rest of the statistical exercises.

6.4.2 ��� Follow Along: Basic Statistics

Obt,ine statisticile de bază pentru acest strat.

1. Click on the Show statistical summary icon in the Attributes Toolbar. A new panel will pop up.
2. In the dialog that appears, specify the Sampled Points layer as the source.
3. Select the rvalue_1 field in the field combo box. This is the field you will calculate statistics for.
4. The Statistics Panel will be automatically updated with the calculated statistics:
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Notă: You can copy the values by clicking on the Copy Statistics To Clipboard button and paste the results into
a spreadsheet.

5. Close the Statistics Panel when done
Many different statistics are available:
Număr

The number of samples/values.
Sum

The values added together.
Media

The mean (average) value is simply the sum of the values divided by the number of values.
Mediana

If you arrange all the values from smallest to greatest, the middle value (or the average of the twomiddle values,
if N is an even number) is the median of the values.

St Dev (pop)
Abaterea standard. Oferă o indicat,ie despre cât de strâns sunt grupate valorile în jurul mediei. Cu cât este mai
mică deviat,ia standard, cu atât mai apropiată tinde să fie media.

Minimum
Valoarea minimă.

Maximum
Valoarea maximă.

Intervalul
Diferent,a dintre valorile minime s, i maxime.

Q1
First quartile of the data.

Q3
Third quartile of the data.

Missing (null) values
The number of missing values.

6.4.3 ��� Follow Along: Compute statistics on distances between points

1. Create a new temporary point layer.
2. Enter edit mode, and digitize three points somewhere among the other points.

Alternatively, use the same random point generation method as before, but specify only three points.
3. Save your new layer as distance_points in the format you prefer.

To generate statistics on the distances between points in the two layers:
1. Open the Vector Analysis ► Distance matrix tool.
2. Select the distance_points layer as the input layer, and the Sampled Points layer as the target layer.
3. Set their id field as unique field references
4. Change the Output matrix type option into Summary distance matrix.
5. set value of Use only the nearest (k) target points to 2.
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6. If you want you can save the output layer as a file or just run the algorithm and save the temporary output layer
later.

7. Click Run to generate the distance matrix layer.
8. Open the attribute table of the generated layer: values refer to the distances between the distance_points features

and their two nearest points in the Sampled Points layer:

With these parameters, the Distance Matrix tool calculates distance statistics for each point of the input layer with
respect to their two nearest points in the target layer. The fields of the output layer contain the mean, standard
deviation, minimum and maximum for the calculated distances.
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For further testing, you may want to modify the Output matrix type option or the number of target points.

6.4.4 ��� Follow Along: Nearest Neighbor Analysis (within layer)

To do a nearest neighbor analysis of a point layer:
1. Choose Vector analysis ► Nearest neighbor analysis.
2. In the dialog that appears, select the Random points layer and click Run.
3. The results will appear in the Processing Result Viewer Panel.

4. Click on the blue link to open the html page with the results:
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6.4.5 ��� Follow Along: Mean Coordinates

Pentru a obt,ine coordonatele medii ale unui set de date:
1. Start Vector analysis ► Mean coordinate(s)

2. In the dialog that appears, specify Random points as Input layer, and leave the optional choices unchanged.
3. Clic pe Run

Let us compare this to the central coordinate of the polygon that was used to create the random sample.
1. Start Vector geometry ► Centroids

2. In the dialog that appears, select Bounding geometry as the input layer.
As you can see, themean coordinates (pink point) and the center of the study area (in green) don’t necessarily coincide.
The centroid is the barycenter of the layer (the barycenter of a square is the center of the square) while the mean
coordinates represent the average of all node coordinates.
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6.4.6 ��� Follow Along: Image Histograms

The histogram of a dataset shows the distribution of its values. The simplest way to demonstrate this in QGIS is via
the image histogram, available in the Layer Properties dialog of any image layer (raster dataset).

1. In your Layers panel, right-click on the srtm_41_19 layer
2. Select Properties
3. Choose the Histogram tab. You may need to click on the Compute Histogram button to generate the graphic.

You will see a graph that shows the frequency distribution for the raster values.
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4. The graph can be exported as an image with the Save plot button
5. You can see more detailed information about the layer in the Information tab (the mean and max values are

estimated, and may not be exact).
The mean value is 332.8 (estimated to 324.3), and the maximum value is 1699 (estimated to 1548)! You can
zoom in the histogram. Since there are a lot of pixels with value 0, the histogram looks compressed vertically. By
zooming in to cover everything but the peak at 0, you will see more details:

246 Capitolul 6. Module: Vector Analysis



QGIS Training Manual

Notă: If the mean and maximum values are not the same as above, it can be due to the min/max value calculation.
Open the Symbology tab and expand the Min / Max Value Settings menu. Choose Min / max and click on Apply.

Keep in mind that a histogram shows you the distribution of values, and not all values are necessarily visible on the
graph.
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6.4.7 ��� Follow Along: Spatial Interpolation

Let’s say you have a collection of sample points from which you would like to extrapolate data. For example, you
might have access to the Sampled points dataset we created earlier, and would like to have some idea of what the
terrain looks like.

1. To start, launch theGDAL►Raster analysis►Grid (IDWwith nearest neighbor searching) tool in theProcessing
Toolbox.

2. For Point layer select Sampled points

3. SetWeighting power to 5.0
4. In Advanced parameters, set Z value from field to rvalue_1
5. Finally click on Run and wait until the processing ends
6. Close the dialog

Here is a comparison of the original dataset (left) to the one constructed from our sample points (right). Yours may
look different due to the random nature of the location of the sample points.

As you can see, 100 sample points aren’t really enough to get a detailed impression of the terrain. It gives a very
general idea, but it can be misleading as well.

6.4.8 ��� Try Yourself: Different interpolation methods

1. Use the processes shown above to create a set of 10 000 random points

Notă: If the number of points is really big, the processing time can take a long time.

2. Use these points to sample the original DEM
3. Use the Grid (IDW with nearest neighbor searching) tool on this dataset.
4. Set Power and Smoothing to 5.0 and 2.0, respectively.

Rezultatele (în funct,ie de pozit,ionarea punctelor aleatorii) va arata mai mult, sau mai put,in, ca aceasta:
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This is a better representation of the terrain, due to the greater density of sample points. Remember, larger samples
give better results.

6.4.9 În concluzie

QGIS has a number of tools for analyzing the spatial statistical properties of datasets.

6.4.10 Ce urmează?

Now that we have covered vector analysis, why not see what can be done with rasters? That is what we will do in the
next module!
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Modulul: Rastere

Am folosit rastere pentru digitizarea anterioară, dar datele raster pot fi folosite, de asemenea, s, i în mod direct. În
acest modul, vet,i vedea cum se face acest lucru în QGIS.

7.1 Lesson: Working with Raster Data

Raster data is quite different from vector data. Vector data has discrete features with geometries constructed out of
vertices, and perhaps connected with lines and/or areas. Raster data, however, is like any image. Although it may
portray various properties of objects in the real world, these objects don’t exist as separate objects. Rather, they are
represented using pixels with different values.
During this module you are going to use raster data to supplement your existing GIS analysis.
The goal for this lesson: To learn how to work with raster data in QGIS.

7.1.1 ��� Follow Along: Loading Raster Data

Raster data can be loaded with the same methods we used for vector data. However we suggest to use the Browser
Panel.

1. Open the Browser Panel and expand the exercise_data/raster folder.
2. Load all the data in this folder:

• 3320C_2010_314_RGB_LATLNG.tif

• 3320D_2010_315_RGB_LATLNG.tif

• 3420B_2010_328_RGB_LATLNG.tif

• 3420C_2010_327_RGB_LATLNG.tif

You should see the following map:
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There we have it - four aerial images covering our study area.

7.1.2 ��� Follow Along: Create a Virtual Raster

Now as you can see from this, your solution layer lies across all four images. What this means is that you are going
to have to work with four rasters all the time. That’s not ideal. It would be better to have one file to work with.
Luckily, QGIS allows you to do exactly this, and without needing to actually create a new raster file. You can create
a Virtual Raster. This is also often called a Catalog, which explains its function. It’s not really a new raster. Rather,
it is a way to organize your existing rasters into one catalog: one file for easy access.
To make a catalog we will use the Processing ► Toolbox.

1. Open the Build virtual raster algorithm from the GDAL ► Raster miscellaneous;
2. In the dialog that appears, click on the… button next to the Input layers parameter and check all the layers or

use the Select All button;
3. Uncheck Place each input file into a separate band. Notice the code that is generated at the bottom of the

dialog under GDAL/OGR console call. This is the command that will be executed when you click Run. The
text updates as you change different options in the dialog.

Notă: Keep in mind that you can copy and paste the text in the OSGeo Shell (Windows user) or
Terminal (Linux and OSX users) to run the command. You can also create a script for each GDAL
command. This is very handy when the procedure is taking a long time or when you want to schedule specific
tasks. Use the Help button to get more help on the syntax of the command.

4. Finally click on Run.

Notă: As you know from the previous modules, Processing creates temporary layers by default. To save the file,
click on the… button under Virtual.
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You can now remove the original four rasters from the Layers Panel and leave only the output virtual catalog raster.
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7.1.3 ��� Transforming Raster Data

The above methods allow you to virtually merge datasets using a catalog, and to reproject them „on the fly”. However,
if you are setting up data that you’ll be using for quite a while, it may be more efficient to create new rasters that are
already merged and reprojected. This improves performance while using the rasters in a map, but it may take some
time to set up initially.

Reproiectare rasterelor

OpenWarp (reproject) from GDAL ► Raster projections.
You can also reproject virtual rasters (catalogs), enable multithreaded processing, and more.
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Îmbinarea rastererelor

If you need to create a new raster layer and save it to disk you can use the merge algorithm.

Notă: Depending on how many raster files you are merging and their resolution, the new raster file created can be
really big. Consider instead to create a raster catalog as described in the Create a Virtual Raster section.

1. Click on the Merge algorithm from the GDAL ► Raster miscellaneous menu.
2. As we did for the Create a Virtual raster, use the… button to choose which layers you want to merge.
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You can also specify a Virtual raster as input, and then all of the rasters that it consists of will be processed.
3. If you know the GDAL library, you can also add your own options by opening the Advanced parametersmenu.

7.1.4 În concluzie

QGIS face mai us,oară includerea datelor raster în proiectele existente.

7.1.5 Ce urmează?

Next, we’ll use raster data that isn’t aerial imagery, and see how symbolization is useful in the case of rasters as well.
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7.2 Lesson: Changing Raster Symbology

Not all raster data are aerial photos. There are many other forms of raster data, and in many of those cases, it is
essential to symbolize the them so that they becomes properly visible and useful.
Scopul acestei lect,ii: De a schimba simbolistica pentru un strat raster.

7.2.1 ��� Try Yourself:

1. Use the Browser Panel to load srtm_41_19.tif, found under exercise_data/raster/SRTM/
2. Zoom to the extent of this layer by right-clicking on it in the Layers panel and selecting Zoom to Layer.

This dataset is a Digital Elevation Model (DEM). It is a map of the elevation (altitude) of the terrain, allowing us to
see where the mountains and valleys are, for example.
While each pixel of the dataset of the previous section contained color information, in a DEM, each pixel contains
elevation values.
Once the DEM is loaded, you will notice that it is a grayscale representation:

QGIS has automatically applied a stretch to the pixel values of the image for visualization purposes, and we will learn
more about how this works as we continue.
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7.2.2 ��� Follow Along: Changing Raster Layer Symbology

You have two different options to change the raster symbology:
1. Within the Layer Properties dialog, by right-clicking on the layer in the Layer tree and selecting the Properties

option. Then switch to the Symbology tab

2. By clicking on the Open the Layer Styling panel button right above the Layers panel (shortcut F7). This will open

the Layer Styling panel, where you can switch to the Symbology tab.
Choose the method you prefer to work with.

7.2.3 ��� Follow Along: Singleband gray

When you load a raster file, if it is not a photo image like the ones of the previous section, the default style is set to a
grayscale gradient.
Let’s explore some of the features of this renderer.
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The default Color gradient is set to Black to white, meaning that low pixel values are black and while high
values are white. Try to invert this setting to White to black and see the results.
Very important is the Contrast enhancement parameter: by default it is set to Stretch to MinMaxmeaning that
the pixel values are stretched to the minimum and maximum values.
Look at the difference with the enhancement (left) and without (right):
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But what are the minimum and maximum values that should be used for the stretch? The ones that are currently
underMin / Max Value Settings. There are many ways to calculate the minimum and maximum values and use them
for the stretch:

1. User Defined: you enter the Min and Max values manually
2. Cumulative count cut: this is useful when you have some extreme low or high values. It cuts the 2% (or the

value you choose) of these values
3. Min / max: the Real or Estimated minimum and maximum values of the raster
4. Mean +/- standard deviation: the values will be calculated according to the mean value and the standard

deviation

7.2.4 ��� Follow Along: Singleband pseudocolor

Grayscales are not always great styles for raster layers. Let’s try to make the DEM more colorful.
• Change the Render type to Singleband pseudocolor. If you don’t like the default colors loaded, select another
Color ramp

• Click the Classify button to generate a new color classification
• If it is not generated automatically click on the OK button to apply this classification to the DEM
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Vet,i vedea un raster care arată în felul următor:

7.2. Lesson: Changing Raster Symbology 261



QGIS Training Manual

This is an interesting way of looking at the DEM. You will now see that the values of the raster are again properly
displayed, going from blue for the lower areas to red for the higher ones.

7.2.5 Follow Along: Changing the transparency

Sometimes changing the transparency of the whole raster layer can help you to see other layers covered by the raster
itself and better understand the study area.
To change the transparency of the whole raster switch to the Transparency tab and use the slider of theGlobal Opacity
to lower the opacity:
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More interesting is changing the transparency for some pixel values. For example in the raster we used you can see
a homogeneous color at the corners. To set these pixels as transparent, go to Custom Transparency Options in the
Transparency tab.

• By clicking on the Add values manually button, you can add a range of values and set their transparency
percentage

• For single values the Add values from display button is more useful

• Click on the Add values from display button. The dialog disappears, and you can interact with the map.
• Click on the homogeneous color in a corner of the DEM
• You will see that the transparency table will be filled with the clicked values:
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• Click on OK to close the dialog and see the changes.

See? The corners are now 100% transparent.
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7.2.6 În concluzie

These are some the basic functions to get you started with raster symbology. QGIS also gives you many other
options, such as symbolizing a layer using paletted/unique values, representing different bands with different colors
in a multispectral image, or making an automatic hillshade effect (useful only with DEM raster files).

7.2.7 Referint,ă

The SRTM dataset was obtained from CGIAR CSI website.

7.2.8 Ce urmează?

Acum, că putem vedea datele noastre afis,ate corect, să investigăm modul în care putem analiza mai departe.

7.3 Lesson: Terrain Analysis

Anumite tipuri de rastere vă permit să câs, tigat,i o perspectivă mai largă asupra terenului pe care îl reprezintă.
Modelele Digitale ale Elevat,iei (DEMS) sunt deosebit de utile în această privint,ă. În această lect,ie vet,i folosi anumite
instrumente pentru analiza terenului, pentru a afla mai multe despre zona de studiu, în scopul dezvoltării rezident,iale
propuse de mai devreme.
Scopul acestei lect,ii: De a utiliza instrumentele de analiză a terenului pentru a extrage mai multe informat,ii despre
teren.

7.3.1 ��� Follow Along: Calculating a Hillshade

We are going to use the same DEM layer as in the previous lesson. If you are starting this chapter from scratch, use
the Browser panel and load the raster/SRTM/srtm_41_19.tif.
The DEM layer shows you the elevation of the terrain, but it can sometimes seem a little abstract. It contains all the
3D information about the terrain that you need, but it doesn’t look like a 3D object. To get a better impression of the
terrain, it is possible to calculate a hillshade, which is a raster that maps the terrain using light and shadow to create
a 3D-looking image.
We are going to use algorithms in the Raster ► Raster terrain analysis menu.

1. Click on the Hillshade menu
2. The algorithm allows you to specify the position of the light source: Azimuth has values from 0 (North) through

90 (East), 180 (South) and 270 (West), while the Vertical angle sets how high the light source is (0 to 90
degrees).

3. We will use the following values:
• Z factor at 1.0
• Azimuth (horizontal angle) at 300.0°
• Vertical angle at 40.0°
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4. Save the file in a new folder exercise_data/raster_analysis/ with the name hillshade.tif
5. Finally click on Run

Avet,i acum un nou strat denumit hillshade, care arată astfel:
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That looks nice and 3D, but can we improve on this? On its own, the hillshade looks like a plaster cast. Can’t we use
it together with our other, more colorful rasters somehow? Of course we can, by using the hillshade as an overlay.

7.3.2 ��� Follow Along: Using a Hillshade as an Overlay

Umbra versant,ilor poate furniza informat,ii foarte utile despre lumina solară, la un moment dat al zilei. Ea poate fi,
de asemenea, utilizată în scopuri estetice, pentru a face harta să arate mai bine. Cheia pentru acest lucru este setarea
reliefului de a fi în cea mai mare parte transparent.

1. Change the symbology of the original srtm_41_19 layer to use the Pseudocolor scheme as in the previous
exercise

2. Hide all the layers except the srtm_41_19 and hillshade layers
3. Click and drag the srtm_41_19 to be beneath the hillshade layer in the Layers panel
4. Set the hillshade layer to be transparent by clicking on the Transparency tab in the layer properties
5. Set the Global opacity to 50%.

You’ll get a result like this:

6. Switch the hillshade layer off and back on in the Layers panel to see the difference it makes.
Using a hillshade in this way, it’s possible to enhance the topography of the landscape. If the effect doesn’t seem
strong enough to you, you can change the transparency of the hillshade layer; but of course, the brighter the hillshade
becomes, the dimmer the colors behind it will be. You will need to find a balance that works for you.
Remember to save the project when you are done.
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7.3.3 Follow Along: Finding the best areas

Think back to the estate agent problem, which we last addressed in the Vector Analysis lesson. Let us imagine that
the buyers now wish to purchase a building and build a smaller cottage on the property. In the Southern Hemisphere,
we know that an ideal plot for development needs to have areas on it that:

• are north-facing
• with a slope of less than 5 degrees
• But if the slope is less than 2 degrees, then the aspect doesn’t matter.

Let’s find the best areas for them.

7.3.4 ��� Follow Along: Calculating the Slope

Slope informs about how steep the terrain is. If, for example, you want to build houses on the land there, then you
need land that is relatively flat.
To calculate the slope, you need to use the Slope algorithm of the Processing ► Raster terrain analysis.

1. Open the algorithm
2. Choose srtm_41_19 as the Elevation layer
3. Keep the Z factor at 1.0
4. Save the output as a file with the name slope.tif in the same folder as the hillshade.tif
5. Click on Run

Now you’ll see the slope of the terrain, each pixel holding the corresponding slope value. Black pixels show flat terrain
and white pixels, steep terrain:
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7.3.5 ��� Try Yourself: Calculating the aspect

Aspect is the compass direction that the slope of the terrain faces. An aspect of 0 means that the slope is North-facing,
90 East-facing, 180 South-facing, and 270 West-facing.
Since this study is taking place in the Southern Hemisphere, properties should ideally be built on a north-facing slope
so that they can remain in the sunlight.
Use the Aspect algorithm of the Processing► Raster terrain analysis to get the aspect.tif layer saved along with
the slope.tif.

Răspuns
Set your Aspect dialog up like this:
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Your result:
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7.3.6 ��� Follow Along: Finding the north-facing aspect

Now, you have rasters showing you the slope as well as the aspect, but you have no way of knowing where ideal
conditions are satisfied at once. How could this analysis be done?
Răspunsul se află cu ajutorul: Calculatorului raster.
QGIS has different raster calculators available:

• Raster ► Raster Calculator

• In processing:
– Raster Analysis ► Raster calculator

– GDAL ► Raster miscellaneous ► Raster calculator

– SAGA ► Raster calculus ► Raster calculator

Each tool is leading to the same results, but the syntax may be slightly different and the availability of operators may
vary.
We will use Raster Analysis ► Raster calculator in the Processing Toolbox

1. Open the tool by double clicking on it.
• The upper left part of the dialog lists all the loaded raster layers as name@N, where name is the name
of the layer and N is the band.

• In the upper right part you will see a lot of different operators. Stop for a moment to think that a raster
is an image. You should see it as a 2D matrix filled with numbers.

2. North is at 0 (zero) degrees, so for the terrain to face north, its aspect needs to be greater than 270 degrees or
less than 90 degrees. Therefore the formula is:

aspect@1 <= 90 OR aspect@1 >= 270

3. Now you have to set up the raster details, like the cell size, extent and CRS. This can be done manually or it
can be automatically set by choosing a Reference layer. Choose this last option by clicking on the …
button next to the Reference layer(s) parameter.

4. In the dialog, choose the aspect layer, because we want to obtain a layer with the same resolution.
5. Save the layer as aspect_north.tif.

The dialog should look like:
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6. Finally click on Run.
Rezultatul va fi acesta:
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The output values are 0 or 1. What does it mean? For each pixel in the raster, the formula we wrote returns whether
it matches the conditions or not. Therefore the final result will be False (0) and True (1).

7.3.7 ��� Try Yourself: More criteria

Now that you have done the aspect, create two new layers from the DEM.
• The first shall identify areas where the slope is less than or equal to 2 degrees
• The second is similar, but the slope should be less than or equal to 5 degrees.
• Save them under exercise_data/raster_analysis as slope_lte2.tif and slope_lte5.
tif.

Răspuns
• Set your Raster calculator dialog up with:
• the following expression: slope@1 <= 2

• the slope layer as the Reference layer(s)
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• For the 5 degree version, replace the 2 in the expression and file name with 5.
Your results:

• 2 degrees:
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• 5 degrees:
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7.3.8 ��� Follow Along: Combining Raster Analysis Results

Now you have generated three raster layers from the DEM:
• aspect_north: terrain facing north
• slope_lte2: slope equal to or below 2 degrees
• slope_lte5: slope equal to or below 5 degrees

Where the condition is met, the pixel value is 1. Elsewhere, it is 0. Therefore, if you multiply these rasters, the pixels
that have a value of 1 for all of them will get a value of 1 (the rest will get 0).
The conditions to be met are:

• at or below 5 degrees of slope, the terrain must face north
• at or below 2 degrees of slope, the direction that the terrain faces does not matter.

Therefore, you need to find areas where the slope is at or below five degrees AND the terrain is facing north, OR the
slope is at or below 2 degrees. Such terrain would be suitable for development.
Pentru a calcula zonele care îndeplinesc aceste criterii:

1. Open the Raster calculator again
2. Use this expression in Expression:
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( aspect_north@1 = 1 AND slope_lte5@1 = 1 ) OR slope_lte2@1 = 1

3. Set the Reference layer(s) parameter to aspect_north (it does not matter if you choose another - they have
all been calculated from srtm_41_19)

4. Save the output under exercise_data/raster_analysis/ as all_conditions.tif
5. Click Run

Rezultatul:

Sugestie: The previous steps could have been simplified using the following command:

((aspect@1 <= 90 OR aspect@1 >= 270) AND slope@1 <= 5) OR slope@1 <= 2
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7.3.9 ��� Follow Along: Simplifying the Raster

As you can see from the image above, the combined analysis has left us with many, very small areas where the
conditions are met (in white). But these aren’t really useful for our analysis, since they are too small to build anything
on. Let us get rid of all these tiny unusable areas.

1. Open the Sieve tool (GDAL ► Raster Analysis in the Processing Toolbox)
2. Set the Input file to all_conditions, and the Sieved to all_conditions_sieve.tif (under

exercise_data/raster_analysis/).
3. Set the Threshold to 8 (minimum eight contiguous pixels), and check Use 8-connectedness.

Once processing is done, the new layer will be loaded.
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What is going on? The answer lies in the new raster file’s metadata.
4. View the metadata under the Information tab of the Layer Properties dialog. Look the

STATISTICS_MINIMUM value:
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This raster, like the one it is derived from, should only feature the values 1 and 0, but it has also a very large
negative number. Investigation of the data shows that this number acts as a null value. Since we are only after
areas that weren’t filtered out, let us set these null values to zero.

5. Open the Raster Calculator, and build this expression:

(all_conditions_sieve@1 <= 0) = 0

This will maintain all non-negative values, and set the negative numbers to zero, leaving all the areas with value
1 intact.

6. Save the output under exercise_data/raster_analysis/ as all_conditions_simple.
tif.

Rezultatul dvs. arată în felul următor:

This is what was expected: a simplified version of the earlier results. Remember that if the results you get from a tool
aren’t what you expected, viewing the metadata (and vector attributes, if applicable) can prove essential to solving
the problem.

7.3.10 ��� Follow Along: Reclassifying the Raster

We have used the Raster calculator to do calculations on raster layers. There is another powerful tool that we can use
to extract information from existing layers.
Back to the aspect layer. We know now that it has numerical values within a range from 0 through 360. What we
want to do is to reclassify this layer to other discrete values (from 1 to 4), depending on the aspect:

• 1 = North (from 0 to 45 and from 315 to 360);
• 2 = East (from 45 to 135)
• 3 = South (from 135 to 225)
• 4 = West (from 225 to 315)
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This operation can be achieved with the raster calculator, but the formula would become very very large.
The alternative tool is the Reclassify by table tool in Raster analysis in the Processing Toolbox.

1. Open the tool
2. Choose aspect as the Input raster layer

3. Click on the… of Reclassification table. A table-like dialog will pop up, where you can choose the minimum,
maximum and new values for each class.

4. Click on the Add row button and add 5 rows. Fill in each row as the following picture and click OK:

The method used by the algorithm to treat the threshold values of each class is defined by the Range boundaries.
5. Save the layer as reclassified.tif in the exercise_data/raster_analysis/ folder
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6. Click on Run
If you compare the native aspect layer with the reclassified one, there are not big differences. But by looking at the
legend, you can see that the values go from 1 to 4.
Let us give this layer a better style.

1. Open the Layer Styling panel
2. Choose Paletted/Unique values, instead of Singleband gray
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3. Click on the Classify button to automatically fetch the values and assign them random colors:

The output should look like this (you can have different colors given that they have been randomly generated):
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With this reclassification and the paletted style applied to the layer, you can immediately differentiate the aspect areas.

7.3.11 ��� Follow Along: Querying the raster

Unlike vector layers, raster layers don’t have an attribute table. Each pixel contains one or more numerical values
(singleband or multiband rasters).
All the raster layers we used in this exercise consist of just one band. Depending on the layer, pixel values may
represent elevation, aspect or slope values.

How can we query the raster layer to get the value of a pixel? We can use the Identify Features button!
1. Select the tool from the Attributes toolbar.
2. Click on a random location of the srtm_41_19 layer. Identify Results will appear with the value of the band at

the clicked location:
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3. You can change the output of the Identify Results panel from the current tree mode to a table one by
selecting Table in the View menu at the bottom of the panel:

Clicking each pixel to get the value of the raster could become annoying after a while. We can use the Value Tool
plugin to solve this problem.

1. Go to Plugins ► Manage/Install Plugins…

2. In the All tab, type value t in the search box
3. Select the Value Tool plugin, press Install Plugin and then Close the dialog.

7.3. Lesson: Terrain Analysis 285



QGIS Training Manual

The new Value Tool panel will appear.

Sfat: If you close the panel you can reopen it by enabling it in the View► Panels► Value Tool or by clicking
on the icon in the toolbar.

4. To use the plugin just check the Enable checkbox and be sure that the srtm_41_19 layer is active (checked)
in the Layers panel.

5. Move the cursor over the map to see the value of the pixels.
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6. But there is more. The Value Tool plugin allows you to query all the active raster layers in the Layers panel.
Set the aspect and slope layers active again and hover the mouse on the map:

7.3.12 În concluzie

You’ve seen how to derive all kinds of analysis products from a DEM. These include hillshade, slope and aspect
calculations. You’ve also seen how to use the raster calculator to further analyze and combine these results. Finally
you learned how to reclassify a layer and how to query the results.

7.3.13 Ce urmează?

Now you have two analyses: the vector analysis which shows you the potentially suitable plots, and the raster analysis
that shows you the potentially suitable terrain. How can these be combined to arrive at a final result for this problem?
That’s the topic for the next lesson, starting in the next module.
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Module: Completing the Analysis

Avet,i acum două jumătăt,i ale unei analize: o parte vector s, i o parte raster. În acest modul, vet,i afla cum să le
combinat,i. Vet,i încheia analiza s, i vet,i prezenta rezultatele finale.

8.1 Lesson: Raster to Vector Conversion

Conversia între formatele raster s, i cele vectoriale, vă permite să facet,i uz atât de datele raster cât s, i de cele vectoriale,
atunci când rezolvat,i o problemă GIS, precum s, i utilizarea diferitelor metode unice de analiză, pentru aceste două
forme de date geografice. Acest lucru cres, te flexibilitatea atunci când luat,i în calcul sursele de date s, i metodele de
procesare pentru rezolvarea unei probleme GIS.
Pentru a combina analiza raster cu cea vectorială, trebuie să convertit,i un tip de date în altul. Haidet,i să convertim
rasterul rezultat din lect,ia anterioară într-un vector.
Scopul acestei lect,ii: De a obt,ine rezultatul raster într-un vector, care să poată fi utilizat pentru a completa analiza.

8.1.1 ��� Follow Along: The Raster to Vector Tool

Începet,i cu harta de la ultimul modul, raster_analysis.qgs. Ar trebui să avet,i
all_conditions_simple.tif calculat în timpul exercit,iilor anterioare.

• Clic pe Raster ► Conversion ► Polygonize (Raster to Vector). Va apărea fereastra de dialog a instrumentului.
• Setat,i-l astfel:
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• Change the field name (describing the values of the raster) to suitable.
• Save the layer under exercise_data/residential_development as all_terrain.shp.

Now you have a vector file which contains all the values of the raster, but the only areas you’re interested in are those
that are suitable; i.e., those polygons where the value of suitable is 1. You can change the style of this layer if you
want to have a clearer visualization of it.

8.1.2 ��� Try Yourself:

Consultat,i înapoi la modulul de analiză vectorială.
• Create a new vector file that contains only the polygons where suitable has the value of 1.
• Save the new file under exercise_data/residential_development/ as
suitable_terrain.shp.

Răspuns
1. Open theQuery Builder by right-clicking on the all_terrain layer in the Layers panel, and selecting the Properties

► Source tab.
2. Then build the query "suitable" = 1.
3. Click OK to filter out all the polygons where this condition isn’t met. When viewed over the original raster, the

areas should overlap perfectly:
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4. You can save this layer by right-clicking on the all_terrain layer in the Layers panel and choosing Save As…,
then continue as per the instructions.

8.1.3 ��� Follow Along: The Vector to Raster Tool

Although unnecessary for our current problem, it’s useful to know about the opposite conversion from the one
performed above. Convert to raster the suitable_terrain.shp vector file you just created in previous step.

• Clic pe Raster ► Conversion ► Rasterize (Vector to Raster) pentru a lansa acest instrument, apoi setat,i-l ca în
imaginea de mai jos:
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• Input layer is all_terrain.
• Field name is suitable.
• Output raster size units is Pixels.
• Width and Height are 837 and 661, respectively.
• Get the Output extent from the all_terrain layer.
• Set output file Rasterized to exercise_data/residential_development/
raster_conversion.tif.

Notă: Dimensiunea imaginii de ies, ire este specificată aici pentru a fi similară cu cea a rasterului original, care a
fost vectorizat. Pentru a vizualiza dimensiunile unei imagini, deschidet,i-i metadatele (fila Metadata din Proprietăt,ile
Stratului).

• Clic pe OK, în fereastra de dialog, pentru a începe procesul de conversie.
• Atunci când at,i încheiat, evaluat,i succesul prin compararea noului raster cu cel original. Cele două ar trebui să
se potrivească exact, pixel cu pixel.
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8.1.4 În concluzie

Conversia între formatele raster s, i cele vectoriale vă permite să extindet,i aplicabilitatea datelor, s, i nu trebuie să ducă
la degradarea datelor.

8.1.5 Ce urmează?

Acum, că avem rezultatele analizei de teren disponibile în format vectorial, ele pot fi folosite pentru a rezolva problema
clădirii pe care ar trebui să o propunem în scopul dezvoltării rezident,iale.

8.2 Lesson: Combining the Analyses

Folosind rezultatele vectorizate ale analizei raster, vet,i putea selecta numai acele clădiri de pe terenul potrivit.
Scopul acestei lect,ii: De a utiliza terenul vectorizat rezultat la selectarea terenurilor adecvate.

8.2.1 ��� Try Yourself:

1. Save your current map (raster_analysis.qgs).
2. Open the map which you created during the vector analysis earlier (you should have saved the file as

analysis.qgs).
3. In the Layers panel, enable these layers:

• relieful,
• solut,ia (or buildings_over_100)

4. In addition to these layers, which should already be loaded in the map from when you worked on it before, also
add the suitable_terrain.shp dataset.

5. If you are missing some layers, you should find them in exercise_data/
residential_development/

6. Use the Intersection tool (Vector►Geoprocessing Tools) to create a new vector layer called new_solution.
shp which contains only those buildings which intersect the suitable_terrain layer.

Ar trebui să avet,i de acum un strat care prezintă anumite clădiri din solut,ia dvs., cum ar fi:
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8.2.2 ��� Try Yourself: Inspecting the Results

Uitat,i-vă la fiecare dintre clădirile dumneavoastră din stratul new_solution. Comparat,i-le cu stratul suitable_terrain,
prin schimbarea simbologiei stratului new_solution, astfel încât acesta să aibă numai are contur. Ce părere avet,i despre
observa unele dintre clădiri? Sunt toate acestea potrivite doar pentru că se intersectează cu stratul suitable_terrain?
De ce sau de ce nu? Pe care dintre ele le-at,i considera ca fiind necorespunzătoare?

Răspuns
You may notice that some of the buildings in your new_solution layer have been „sliced” by the Intersection tool.
This shows that only part of the building - and therefore only part of the property - lies on suitable terrain. We can
therefore sensibly eliminate those buildings from our dataset.

8.2.3 ��� Try Yourself: Refining the Analysis

Putet,i vedea din rezultate, că unele clădirile care au fost incluse nu au fost cu adevărat adecvate, astfel încât să putem
rafina acum analiza.
We want to ensure that our analysis returns only those buildings which fall entirely within the suitable_terrain layer.
How would you achieve this? Use one or more Vector Analysis tools and remember that our buildings are all over
100m squared in size.

Răspuns
At the moment, your analysis should look something like this:
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Consider a circular area, continuous for 100 meters in all directions.

If it is greater than 100 meters in radius, then subtracting 100 meters from its size (from all directions) will result in
a part of it being left in the middle.
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Therefore, you can run an interior buffer of 100 meters on your existing suitable_terrain vector layer. In the output
of the buffer function, whatever remains of the original layer will represent areas where there is suitable terrain for
100 meters beyond.
To demonstrate:

1. Go to Vector ► Geoprocessing Tools ► Buffer(s) to open the Buffer(s) dialog.
2. Setat,i-l astfel:
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3. Use the suitable_terrain layer with 10 segments and a buffer distance of -100. (The distance is automatically
in meters because your map is using a projected CRS.)

4. Save the output in exercise_data/residential_development/ as
suitable_terrain_continuous100m.shp.

5. If necessary, move the new layer above your original suitable_terrain layer.
Your results will look like something like this:

8.2. Lesson: Combining the Analyses 297



QGIS Training Manual

6. Now use the Select by Location tool (Vector ► Research Tools ► Select by location).
7. Set up like this:

8. Select features in new_solution that intersect features in suitable_terrain_continuous100m.shp.
This is the result:
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The yellow buildings are selected. Although some of the buildings fall partly outside the new
suitable_terrain_continuous100m layer, they lie well within the original suitable_terrain layer and therefore
meet all of our requirements.

9. Save the selection under exercise_data/residential_development/ as final_answer.
shp.

8.2.4 În concluzie

At,i răspuns acum la întrebarea de cercetare originală, s, i v-at,i conturat deja o opt,iune (argumentată s, i sust,inută de o
analiză) care poate sta la baza unei recomandări cu privire la proprietatea de dezvoltat.

8.2.5 Ce urmează?

Mai departe, vom prezenta aceste rezultate ca parte a celei de-a doua dvs. misiuni.

8.3 Exercit,iu

Folosind compozitorul de hărt,i, creat,i o nouă hartă care reprezintă rezultatele analizei dumneavoastră. Includet,i
următoarele straturi:

• locuri (cu etichete),
• relieful,
• solut,ie (sau noua_solut,ie),
• drumuri s, i
• fie aerial_photos, fie DEM.

Scriet,i un scurt text explicativ, însot,itor. Includet,i în acest text criteriile care au fost luate în considerare pentru
achizit,iea s, i dezvoltarea ulterioară a casei, precum s, i recomandările dvs. de utilizare a clădirilor.
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8.4 Lesson: Supplementary Exercise

În această lect,ie, vet,i efectua o analiză GIS completă în QGIS.

Notă: Lesson developed by Linfiniti Consulting (South Africa) and Siddique Motala (Cape Peninsula University of
Technology)

8.4.1 Definirea Problemei

You are tasked with finding areas in and around the Cape Peninsula that are suitable habitats for a rare fynbos plant
species. The extent of your area of investigation covers Cape Town and the Cape Peninsula between Melkbosstrand
in the north and Strand in the south. Botanists have provided you with the following preferences exhibited by the
species in question:

• It grows on east facing slopes
• It grows on slopes with a gradient between 15% and 60%
• It grows in areas that have a total annual rainfall of > 1000 mm
• It will only be found at least 250 m away from any human settlement
• The area of vegetation in which it occurs should be at least 6000m2 in area

As a student at the University, you have agreed to search for the plant in four different suitable areas of land. You
want those four suitable areas to be the ones that are closest to the University of Cape Town where you live. Use your
GIS skills to determine where you should go to look.

8.4.2 Conturarea unei Solut, ii

The data for this exercise can be found in the exercise_data/more_analysis folder.
You are going to find the four suitable areas that are closest to the University of Cape Town.
The solution will involve:

1. Analyzing a DEM raster layer to find the east facing slopes and the slopes with the correct gradients
2. Analyzing a rainfall raster layer to find the areas with the correct amount of rainfall
3. Analyzing a zoning vector layer to find areas that are away from human settlement and are of the correct size

8.4.3 Follow Along: Setting up the Map

1. Click on the Current CRS button in the lower right corner of the screen. Under the CRS tab of the dialog that
appears, use the „Filter” tool to search for „33S”. Select the entryWGS 84 / UTM zone 33S (with EPSG code
32733).

2. Clic pe OK
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Fig. 8.1: Setting up the CRS

3. Save the project file by clicking on the Save Project toolbar button, or use the Project► Save As…menu item.
Save it in a new directory called Rasterprac, that you should create somewhere on your computer. You will
save whatever layers you create in this directory as well. Save the project as your_name_fynbos.qgs.

8.4.4 Încărcarea Datelor în Hartă

In order to process the data, you will need to load the necessary layers (street names, zones, rainfall, DEM, districts)
into the map canvas.

Pentru vectori…

1. Click on the Open Data Source Manager button in the Data Source Manager Toolbar, and enable the Vector

tab in the dialog that appears, or use the Layer ► Add Layer ► Add Vector Layer… menu item

2. Ensure that File is selected
3. Click on the… button to browse for vector dataset(s)
4. In the dialog that appears, open the exercise_data/more_analysis/Streets directory
5. Selectat,i fis, ierul Street_Names_UTM33S.shp
6. Clic pe Deschidere.

The dialog closes and shows the original dialog, with the file path specified in the text field next to Vector
dataset(s). This allows you to ensure that the correct file is selected. It is also possible to enter the file path in
this field manually, should you wish to do so.
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7. Click Add. The vector layer will be loaded into your map. Its color is automatically assigned. You will change
it later.

8. Rename the layer to Streets
1. Right-click on it in the Layers panel (by default, the pane along the left-hand side of the screen)
2. Click Rename in the dialog that appears and rename it, pressing the Enter key when done

9. Repeat the vector adding process, but this time select theGeneralised_Zoning_Dissolve_UTM33S.
shp file in the Zoning directory.

10. Rename it to Zoning.
11. Load also the vector layer admin_boundaries/Western_Cape_UTM33S.shp into your map.
12. Rename it to Districts.

For rasters…

1. Click on the Open Data Source Manager button and enable the Raster tab in the dialog that appears, or use
the Layer ► Add Layer ► Add Raster Layer… menu item

2. Ensure that File is selected
3. Navigate to the appropriate file, select it, and click Open
4. Do this for each of the following two raster files, DEM/SRTM.tif and rainfall/reprojected/

rainfall.tif

5. Rename the SRTM raster to DEM and the rainfall raster to Rainfall (with an initial capital)

8.4.5 Modificarea ordinii straturilor

Click and drag layers up and down in the Layers panel to change the order they appear in on the map so that you can
see as many of the layers as possible.
Now that all the data is loaded and properly visible, the analysis can begin. It is best if the clipping operation is done
first. This is so that no processing power is wasted on computing values in areas that are not going to be used anyway.

8.4.6 Găsires Districtelor Corecte

Due to the aforementioned area of investigation, we need to limit our districts to the following ones:
• Bellville

• Cape

• Goodwood

• Kuils River

• Mitchells Plain

• Simon Town

• Wynberg

1. Right-click on the Districts layer in the Layers panel.
2. In the menu that appears, select the Filter… menu item. The Query Builder dialog appears.
3. You will now build a query to select only the candidate districts:
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1. In the Fields list, double-click on the NAME_2 field to make it appear in the SQL where clause text field
below

2. Click the IN button to append it to the SQL query
3. Open the brackets
4. Click the All button below the (currently empty) Values list.

After a short delay, this will populate the Values list with the values of the selected field (NAME_2).
5. Double-click the value Bellville in the Values list to append it to the SQL query.
6. Add a comma and double-click to add Cape district
7. Repeat the previous step for the remaining districts
8. Close the brackets

Fig. 8.2: Query builder
The final query should be (the order of the districts in the brackets does not matter):

"NAME_2" in ('Bellville', 'Cape', 'Goodwood', 'Kuils River',
'Mitchells Plain', 'Simon Town', 'Wynberg')

Notă: You can also use the OR operator; the query would look like this:

"NAME_2" = 'Bellville' OR "NAME_2" = 'Cape' OR
"NAME_2" = 'Goodwood' OR "NAME_2" = 'Kuils River' OR
"NAME_2" = 'Mitchells Plain' OR "NAME_2" = 'Simon Town' OR
"NAME_2" = 'Wynberg'

1. Click OK twice.
The districts shown in your map are now limited to those in the list above.

8.4.7 Decuparea Rasterelor

Acum, că avet,i o zonă de interes, putet,i decupa rasterele după ea.
1. Open the clipping dialog by selecting the menu item Raster ► Extraction ► Clip Raster by Mask Layer…

2. In the Input layer dropdown list, select the DEM layer
3. In the Mask layer dropdown list, select the Districts layer
4. Scroll down and specify an output location in theClipped (mask) text field by clicking the… button and choosing

Save to File…

1. Navigate to the Rasterprac directory
2. Enter a file name - DEM_clipped.tif
3. Save

5. Make sure that Open output file after running algorithm is checked
6. Click Run

After the clipping operation has completed, leave the Clip Raster by Mask Layer dialog open, to be able to
reuse the clipping area

7. Select the Rainfall raster layer in the Input layer dropdown list and save your output as
Rainfall_clipped.tif
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8. Do not change any other options. Leave everything the same and click Run.
9. After the second clipping operation has completed, you may close the Clip Raster by Mask Layer dialog
10. Save the map

Fig. 8.3: Map view with filtered vector, clipped raster and reordered layers

Align the rasters

For our analysis we need the rasters to have the same CRS and they have to be aligned.
First we change the resolution of our rainfall data to 30 meters (pixel size):

1. In the Layers panel, ensure that Rainfall_clipped is the active layer (i.e., it is highlighted by having been
clicked on)

2. Click on the Raster ► Projections ►Warp (Reproject)… menu item to open theWarp (Reproject) dialog
3. Under Resampling method to use, select Bilinear (2x2 kernel) from the drop down menu
4. Set Output file resolution in target georeferenced units to 30
5. Scroll down to Reprojected and save the output in your rainfall/reprojected directory as

Rainfall30.tif.

6. Make sure that Open output file after running algorithm is checked

Fig. 8.4: Warp (Reproject) Rainfall_clipped

Then we align the DEM:
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1. In the Layers panel, ensure that DEM_clipped is the active layer (i.e., it is highlighted by having been clicked
on)

2. Click on the Raster ► Projections ►Warp (Reproject)… menu item to open theWarp (Reproject) dialog
3. Under Target CRS, select Project CRS: EPSG:32733 - WGS 84 / UTM zone 33S from the drop down menu
4. Under Resampling method to use, select Bilinear (2x2 kernel) from the drop down menu
5. Set Output file resolution in target georeferenced units to 30
6. Scroll down to Georeferenced extents of output file to be created. Use the button to the right of the text box to

select Calculate from Layer ► Rainfall30.
7. Scroll down to Reprojected and save the output in your DEM/reprojected directory as DEM30.tif.

8. Make sure that Open output file after running algorithm is checked
Pentru a vedea în mod corespunzător ce se întâmplă, simbolistica pentru straturi trebuie să fie schimbată.

8.4.8 Schimbarea simbologiei straturilor vectoriale

1. In the Layers panel, right-click on the Streets layer
2. Select Properties from the menu that appears
3. Switch to the Symbology tab in the dialog that appears
4. Click on the Line entry in the top widget
5. Select a symbol in the list below or set a new one (color, transparency, …)
6. Click OK to close the Layer Properties dialog. This will change the rendering of the Streets layer.
7. Follow a similar process for the Zoning layer and choose an appropriate color for it

8.4.9 Schimbarea simbologiei straturilor raster

Simbologia straturilor raster este oarecum diferită.
1. Open the Properties dialog for the Rainfall30 raster layer
2. Switch to the Symbology tab. You’ll notice that this dialog is very different from the version used for vector

layers.
3. Expand Min/Max Value Settings
4. Ensure that the button Mean +/- standard deviation is selected
5. Make sure that the value in the associated box is 2.00
6. For Contrast enhancement, make sure it says Stretch to MinMax
7. For Color gradient, change it toWhite to Black
8. Clic pe OK

Fig. 8.5: Raster symbology

The Rainfall30 raster, if visible, should change colors, allowing you to see different brightness values for
each pixel

9. Repeat this process for the DEM30 layer, but set the standard deviations used for stretching to 4.00
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8.4.10 Curăt,area hărt, ii

1. Remove the original Rainfall and DEM layers, as well as Rainfall_clipped and DEM_clipped
from the Layers panel:

• Clic-dreapta pe aceste straturi apoi selectat,i Remove.

Notă: Acest lucru nu va elimina datele de pe dispozitivul de stocare, doar le va scoate din harta dvs.

2. Save the map
3. You can now hide the vector layers by unchecking the box next to them in the Layers panel. This will make

the map render faster and will save you some time.

8.4.11 Crearea reliefului

In order to create the hillshade, you will need to use an algorithm that was written for this purpose.
1. In the Layers panel, ensure that DEM30 is the active layer (i.e., it is highlighted by having been clicked on)
2. Click on the Raster ► Analysis ► Hillshade… menu item to open the Hillshade dialog
3. Scroll down to Hillshade and save the output in your Rasterprac directory as hillshade.tif

4. Make sure that Open output file after running algorithm is checked
5. Click Run
6. As, teptat,i să se termine prelucrarea.

Fig. 8.6: Raster analysis Hillshade

The new hillshade layer has appeared in the Layers panel.
1. Right-click on the hillshade layer in the Layers panel and bring up the Properties dialog
2. Click on the Transparency tab and set the Global Opacity slider to 20%
3. Clic pe OK
4. Note the effect when the transparent hillshade is superimposed over the clipped DEM. You may have to change

the order of your layers, or click off the Rainfall30 layer in order to see the effect.

8.4.12 Slope

1. Click on the Raster ► Analysis ► Slope… menu item to open the Slope algorithm dialog
2. Select DEM30 as Input layer

3. Check Slope expressed as percent instead of degrees. Slope can be expressed in different units (percent or
degrees). Our criteria suggest that the plant of interest grows on slopes with a gradient between 15% and 60%.
So we need to make sure our slope data is expressed as a percent.

4. Specify an appropriate file name and location for your output.

5. Make sure that Open output file after running algorithm is checked
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6. Click Run

Fig. 8.7: Raster analysis Slope

The slope image has been calculated and added to the map. As usual, it is rendered in grayscale. Change the
symbology to a more colorful one:

1. Open the layer Properties dialog (as usual, via the right-click menu of the layer)
2. Click on the Symbology tab
3. Where it says Singleband gray (in the Render type dropdown menu), change it to Singleband pseudocolor
4. Choose Mean +/- standard deviation x for Min / Max Value Settings with a value of 2.0
5. Select a suitable Color ramp
6. Click Run

8.4.13 Try Yourself: Aspect

Use the same approach as for calculating the slope, choosing Aspect… in the Raster ► Analysis menu.
Remember to save the project periodically.

8.4.14 Reclasificarea rasterelor

1. Choose Raster ► Raster calculator…

2. Specify your Rasterprac directory as the location for the Output layer (click on the… button), and save it
as slope15_60.tif

3. Ensure that the Open output file after running algorithm box is selected.
In the Raster bands list on the left, you will see all the raster layers in your Layers panel. If your Slope layer is
called slope, it will be listed as slope@1. Indicating band 1 of the slope raster.

4. The slope needs to be between 15 and 60 degrees.
Using the list items and buttons in the interface, build the following expression:

(slope@1 > 15) AND (slope@1 < 60)

5. Aleget,i o locat,ie pentru câmpul Output layer s, i numele de fis, ier corespunzător.
6. Clic pe Run

Fig. 8.8: Raster calculator Slope

Now find the correct aspect (east-facing: between 45 and 135 degrees) using the same approach.
1. Build the following expression:

(aspect@1 > 45) AND (aspect@1 < 135)

You will know it worked when all of the east-facing slopes are white in the resulting raster (it’s almost as if they are
being lit by the morning sunlight).
Find the correct rainfall (greater than 1000 mm) the same way. Use the following expression:
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Rainfall30@1 > 1000

Now that you have all three criteria each in separate rasters, you need to combine them to see which areas satisfy all
the criteria. To do so, the rasters will be multiplied with each other. When this happens, all overlapping pixels with
a value of 1 will retain the value of 1 (i.e. the location meets the criteria), but if a pixel in any of the three rasters
has the value of 0 (i.e. the location does not meet the criteria), then it will be 0 in the result. In this way, the result
will contain only the overlapping areas that meet all of the appropriate criteria.

8.4.15 Combinarea rasterelor

1. Open the Raster Calculator (Raster ► Raster Calculator…)
2. Build the following expression (with the appropriate names for your layers):

[aspect45_135] * [slope15_60] * [rainfall_1000]

3. Set the output location to the Rasterprac directory
4. Name the output raster aspect_slope_rainfall.tif

5. Ensure that Open output file after running algorithm is checked
6. Click Run

The new raster now properly displays the areas where all three criteria are satisfied.
Save the project.

Fig. 8.9: Map view where all three criteria are satisfied

The next criterion that needs to be satisfied is that the area must be 250 m away from urban areas. We will satisfy
this requirement by ensuring that the areas we compute are inside rural areas, and are 250 m or more from the edge
of the area. Hence, we need to find all rural areas first.

8.4.16 Găsirea zonele rurale

1. Hide all layers in the Layers panel
2. Unhide the Zoning vector layer
3. Right-click on it and bring up the Attribute Table dialog. Note the many different ways that the land is zoned

here. We want to isolate the rural areas. Close the Attribute table.
4. Right-click on the Zoning layer and select Filter… to bring up the Query Builder dialog
5. Build the following query:

"Gen_Zoning" = 'Rural'

See the earlier instructions if you get stuck.
6. Click OK to close the Query Builder dialog. The query should return one feature.

Query builder Zoning
You should see the rural polygons from the Zoning layer. You will need to save these.

308 Capitolul 8. Module: Completing the Analysis



QGIS Training Manual

1. In the right-click menu for Zoning, select Export ► Save Features As….
2. Save your layer under the Rasterprac directory
3. Name the output file rural.shp
4. Clic pe OK
5. Save the project

Now you need to exclude the areas that are within 250m from the edge of the rural areas. Do this by creating a
negative buffer, as explained below.

8.4.17 Crearea unui tampon negativ

1. Click the menu item Vector ► Geoprocessing Tools ► Buffer…

2. In the dialog that appears, select the rural layer as your input vector layer (Selected features only should not
be checked)

3. Set Distance to -250. The negative value means that the buffer will be an internal buffer. Make sure that the
units are meters in the dropdown menu.

4. Check Dissolve result

5. In Buffered, place the output file in the Rasterprac directory, and name it rural_buffer.shp
6. Click Save
7. Click Run and wait for the processing to complete
8. Închidet,i dialogul Buffer.

Make sure that your buffer worked correctly by noting how the rural_buffer layer is different from the
rural layer. You may need to change the drawing order in order to observe the difference.

9. Remove the rural layer
10. Save the project
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Fig. 8.10: Map view with rural buffer

Now you need to combine your rural_buffer vector layer with the aspect_slope_rainfall raster. To
combine them, we will need to change the data format of one of the layers. In this case, you will vectorize the raster,
since vector layers are more convenient when we want to calculate areas.

8.4.18 Vectorizarea rasterului

1. Click on the menu item Raster ► Conversion ► Polygonize (Raster to Vector)…

2. Select the aspect_slope_rainfall raster as Input layer
3. Set Name of the field to create to suitable (the default field name is DN - Digital number data)
4. Save the output. Under Vectorized, select Save file as. Set the location to Rasterprac and name the file

aspect_slope_rainfall_all.shp.

5. Ensure that Open output file after running algorithm is checked
6. Click Run
7. Close the dialog when processing is complete
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Fig. 8.11: Raster to Vector

All areas of the raster have been vectorized, so you need to select only the areas that have a value of 1 in the
suitable field. (Digital Number.

1. Open the Query Builder dialog (right-click - Filter…) for the new vector layer
2. Build this query:

"suitable" = 1

3. Clic pe OK
4. After you are sure the query is complete (and only the areas that meet all three criteria, i.e. with a value of

1 are visible), create a new vector file from the results, using the Export ► Save Features As… in the layer’s
right-click menu

5. Save the file in the Rasterprac directory
6. Name the file aspect_slope_rainfall_1.shp
7. Remove the aspect_slope_rainfall_all layer from your map
8. Save your project

When we use an algorithm to vectorize a raster, sometimes the algorithm yields what is called „Invalid geometries”,
i.e. there are empty polygons, or polygons with mistakes in them, that will be difficult to analyze in the future. So,
we need to use the „Fix Geometry” tool.
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8.4.19 Fixing geometry

1. In the Processing Toolbox, search for „Fix geometries”, and Execute… it
2. For the Input layer, select aspect_slope_rainfall_1
3. Under Fixed geometries, select Save file as, and save the output to Rasterprac and name the file

fixed_aspect_slope_rainfall.shp.

4. Ensure that Open output file after running algorithm is checked
5. Click Run
6. Close the dialog when processing is complete

Now that you have vectorized the raster, and fixed the resulting geometry, you can combine the aspect,
slope, and rainfall criteria with the distance from human settlement criteria by finding the intersection of the
fixed_aspect_slope_rainfall layer and the rural_buffer layer.

8.4.20 Determining the Intersection of vectors

1. Click the menu item Vector ► Geoprocessing Tools ► Intersection…

2. In the dialog that appears, select the rural_buffer layer as Input layer
3. For the Overlay layer, select the fixed_aspect_slope_rainfall layer
4. In Intersection, place the output file in the Rasterprac directory
5. Name the output file rural_aspect_slope_rainfall.shp
6. Click Save
7. Click Run and wait for the processing to complete
8. Close the Intersection dialog.

Make sure that your intersection worked correctly by noting that only the overlapping areas remain.
9. Save the project

The next criteria on the list is that the area must be greater than 6000m2. You will now calculate the polygon areas
in order to identify the areas that are the appropriate size for this project.

8.4.21 Calculat, i aria pentru fiecare poligon

1. Open the new vector layer’s right-click menu
2. Select Open attribute table

3. Click the Toggle editing button in the top left corner of the table, or press Ctrl+e

4. Click the Open field calculator button in the toolbar along the top of the table, or press Ctrl+i

5. In the dialog that appears, make sure that Create new field is checked, and set the Output field name to
area The output field type should be a decimal number (real). Set Precision to 1 (one decimal).

6. In the Expression area, type:

$area

This means that the field calculator will calculate the area of each polygon in the vector layer and will then
populate a new integer column (called area) with the computed value.
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Fig. 8.12: Calculatorul de Câmpuri

7. Clic pe OK
8. Do the same thing for another new field called id. In Field calculator expression, type:

$id

Acest lucru ne asigură că fiecare poligon are un ID unic, în scop de identificare.

9. Click Toggle editing again, and save your edits if prompted to do so
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Fig. 8.13: Attribute table with area and id columns

8.4.22 Selectarea zonelor cu o dimensiune dată

Acum, că ariile sunt cunoscute:
1. Build a query (as usual) to select only the polygons that are larger than 6000m2. The query is:

"area" > 6000

2. Save the selection in the Rasterprac directory as a new vector layer called suitable_areas.shp.
You now have the suitable areas that meet all of the habitat criteria for the rare fynbos plant, from which you will
pick the four areas that are nearest to the University of Cape Town.

8.4.23 Digitize the University of Cape Town

1. Create a new vector layer in the Rasterprac directory as before, but this time, use Point as Geometry type
and name it university.shp

2. Ensure that it is in the correct CRS (Project CRS:EPSG:32733 - WGS 84 / UTM zone 33S)
3. Finish creating the new layer (click OK)
4. Hide all layers except the new university layer and the Streets layer.
5. Add a background map (OSM):

1. Go to the Browser panel and navigate to XYZ Tiles ► OpenStreetMap

2. Drag and drop the OpenStreetMap entry to the bottom of the Layers panel
Using your internet browser, look up the location of the University of Cape Town. Given Cape Town’s unique
topography, the university is in a very recognizable location. Before you return to QGIS, take note of where
the university is located, and what is nearby.
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6. Ensure that the Streets layer clicked on, and that the university layer is highlighted in the Layers panel
7. Navigate to theView► Toolbarsmenu item and ensure thatDigitizing is selected. You should then see a toolbar

icon with a pencil on it ( Toggle editing). This is the Toggle Editing button.
8. Click the Toggle editing button to enter edit mode. This allows you to edit a vector layer

9. Click the Add Point Feature button, which should be nearby the Toggle editing button
10. With the Add feature tool activated, left-click on your best estimate of the location of the University of Cape

Town
11. Supply an arbitrary integer when asked for the id
12. Clic pe OK

13. Click the Save Layer Edits button
14. Click the Toggle editing button to stop your editing session
15. Save the project

8.4.24 Find the locations that are closest to the University of Cape Town

1. Go to the Processing Toolbox, locate the Join Attributes by Nearest algorithm (Vector general ► Join Attributes
by Nearest) and execute it

2. Input layer should be university, and Input layer 2 suitable_areas
3. Set an appropriate output location and name (Joined layer)
4. Set the Maximum nearest neighbors to 4

5. Ensure that Open output file after running algorithm is checked
6. Leave the rest of the parameters with their default values
7. Click Run

The resulting point layer will contain four features - they will all have the location of the university and its attributes,
and in addition, the attributes of the nearby suitable areas (including the id), and the distance to that location.

1. Open the attribute table of the result of the join
2. Note the id of the four nearest suitable areas, and then close the attribute table
3. Open the attribute table of the suitable_areas layer
4. Build a query to select the four suitable areas closest to the university (selecting them using the id field)

Acesta este răspunsul final la întrebarea.
For your submission, create a fully labeled layout that includes the semi-transparent hillshade layer over an appealing
raster of your choice (such as the DEM or the slope raster, for example). Also include the university and the
suitable_areas layer, with the four suitable areas that are closest to the university highlighted. Follow all
the best practices for cartography in creating your output map.
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CAPITOLUL9

Module: Plugins

Plugin-uri vă permit extinderea funct,ionalitatăt,ii QGIS. În acest modul, vi se arată cum să activat,i s, i să utilizat,i
plugin-uri.

9.1 Lesson: Installing and Managing Plugins

Pentru a începe să utilizat,i plugin-uri, trebuie să s, tit,i cum să le descărcat,i, să le instalat,i s, i să le activat,i. Pentru a face
acest lucru, vet,i învăt,a cum să utilizat,i Instalatorul de Plugin-uri s, i Managerul de Plugin-uri.
Scopul acestei lect,ii: Pentru a înt,elege s, i pentru a utiliza sistemul de plugin-uri QGIS.

9.1.1 ��� Follow Along: Managing Plugins

1. Pentru a deschide Plugin Manager, facet,i clic pe elementul de meniu Plugins ► Manage and Install Plugins.
2. În fereastra de dialog care apare, identificat,i plugin-ul Processing:
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3. Click in the box next to this plugin and uncheck it to deactivate it.
4. Clic Close.
5. Looking at the menu, you will notice that the Processing menu is is now gone. This means that many of the

processing functions you have been using before have disappeared! For example look at the Vector ► and
Raster ► menus. This is because they are part of the Processing plugin, which needs to be activated to use
them.

6. Open the Plugin Manager again and reactivate the Processing plugin by clicking in the checkbox next to it.
7. Close the dialog. The Processing menu and functions should be available again.

9.1.2 ��� Follow Along: Installing New Plugins

The list of plugins that you can activate and deactivate draws from the plugins that you currently have installed. To
install new plugins:

1. Select the Not Installed option in the Plugin Manager dialog. The plugins available for you to install will be
listed here. This list will vary depending on your existing system setup.
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2. Find information about the plugin by selecting it in the list

3. Install the one(s) you are interested in by clicking the Install Plugin button below the plugin information panel.

Notă: if the plugin has some error it will be listed in the Invalid tab. You can then contact the plugin owner to fix
the problem.
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9.1.3 ��� Follow Along: Configuring Additional Plugin Repositories

Plugin-urile care sunt disponibile pentru instalare depind de depozitele configurate pentru utilizare.
QGIS plugins are stored online in repositories. By default, only the official repository is active, meaning that you can
only access plugins that are published there. Given the diversity of available tools, this repository should meet most
of your needs.
Este posibil, totus, i, să încercat,i mai multe plugin-uri decât cele implicite. În primul rând, at,i vrea să configurat,i
depozite suplimentare. Pentru a face acest lucru:

1. Open the Settings tab in the Plugin Manager dialog

2. Clic pe butonul Adăugare, pentru a găsi s, i a adăuga un nou depozit.
3. Furnizat,i un Nume s, i Adresa URL pentru noul depozit pe care dorit,i să-l configurat,i s, i asigurat,i-vă că este

selectată caseta Enabled.
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4. Vet,i vedea acum noul depozit de plugin-uri, enumerat în lista Depozitelor configurate pentru Plugin-uri

5. Putet,i selecta, de asemenea, opt,iunea de a afis,a Plugin-urile Experimentale, prin alegerea Show also
experimental plugins

6. If you now switch back to the Not Installed tab, you will see that additional plugins are available for installation.
7. To install a plugin, click on it in the list and then on the Install plugin button.
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9.1.4 În concluzie

Installing plugins in QGIS should be straightforward and effective!

9.1.5 Ce urmează?

Mai departe, vă vom prezenta câteva plugin-uri utile ca exemple.

9.2 Lesson: Useful QGIS Plugins

Acum, că putet,i instala, activa s, i dezactiva plugin-uri, să vedem cum vă poate ajuta în practică acest lucru, privind la
câteva exemple de plugin-uri utile.
Scopul acestei lect,ii: De a vă familiariza cu interfat,a plugin-urilor s, i de a face cunos, tint,ă cu unele plugin-uri utile.

9.2.1 ��� Follow Along: The QuickMapServices Plugin

The QuickMapServices plugin is a simple and easy to use plugin that adds base maps to your QGIS project. It has
many different options and settings. Let’s start to explore some of its features.

1. Start a new map and add the roads layer from the training_data Geopackage.
2. Install the QuickMapServices plugin.
3. Click on Web ► QuickMapServices. The first menu lists different map providers (OSM, NASA) with available

maps.
4. Click on an entry and you would load the base map into your project.

Nice! But one of the main strengths of QMS is to provide access to many data providers. Let’s add them.
1. Click onWeb ► QuickMapServices ► Settings

2. Go to the More services tab.
3. Read carefully the message of this tab and if you agree click on the Get Contributed pack button.
4. Click Save.
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5. Reopen theWeb ► QuickMapServices menu you will see that more providers are available.

6. Choose the one that best fits your needs, and load the data in the project!
It is also possible to search trough the now available data providers

1. Open the plugin’s search tab by clicking onWeb► QuickMapServices► Search QMS. This option of the plugin
allows you to filter the available base maps by the current extent of the map canvas or using a search word.

2. Click on the Filter by extent and you should see one service available. If no service is found, zoom out and pan
around the world (or your location) or search with a keyword.

3. Click on the Add button next to a returned dataset to load it.
4. The base map will be loaded and you will have a background for the map.
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9.2.2 ��� Follow Along: The QuickOSM Plugin

With an incredible simple interface, the QuickOSM plugin allows you to download OpenStreetMap data.

��� Follow Along: Using the Quick Query

1. Start a new empty project and add the roads layer from the training_data GeoPackage.
2. Install the QuickOSM plugin. The plugin adds two new buttons in the QGIS Toolbar and is accessible in the

Vector ► QuickOSM menu.
3. Open the QuickOSM dialog. The plugin has many different tabs: we will use the Quick Query one.
4. You can download specific features by selecting a generic Key or be more specific and choose a specific Key

and Value pair.

Sfat: if you are not familiar with the Key and Value system, click on the Help with key/value button. It will
open a web page with a complete description of this concept of OpenStreetMap.

5. Look for railway in the Key menu and let the Value be empty: so we are downloading all the railway features
without specifying any values.

6. Select Layer Extent in the next drop-down menu and choose roads.
7. Click on the Run query button.

After some seconds the plugin will download all the features tagged in OpenStreetMap as railway and load them
directly into the map.
Nothing more! All the layers are loaded in the legend and are shown in the map canvas.
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Atent,ionare: QuickOSM creates temporary layer when downloading the data. If you want to save them
permanently, click on the icon next to the layer and choose the options you prefer. Alternatively you can
open the Advanced menu in QuickOSM and choose where to save the data in the Directory menu.

��� Follow Along: The QuickOSM Query engine

The quickest way to download data from QuickOSM plugin is using the Quick query tab and set some small
parameters. But if you need some more specific data?
If you are an OpenStreetMap query master you can use QuickOSM plugin also with your personal queries.
QuickOSM has an incredible data parser that, together with the amazing query engine of Overpass, lets you download
data with your specific needs.
For example: we want to download themountain peaks that belongs into a specificmountain area known as Dolomites.
You cannot achieve this task with the Quick query tab, you have to be more specific and write your own query. Let’s
try to do this.

1. Start a new project.
2. Open the QuickOSM plugin and click on the Query tab.
3. Copy and paste the following code into the query canvas:

<!--
This shows all mountains (peaks) in the Dolomites.
You may want to use the "zoom onto data" button. =>
-->
<osm-script output="json">
<!-- search the area of the Dolomites -->
<query type="area">
<has-kv k="place" v="region"/>
<has-kv k="region:type" v="mountain_area"/>
<has-kv k="name:en" v="Dolomites"/>

</query>
<print mode="body" order="quadtile"/>
<!-- get all peaks in the area -->
<query type="node">
<area-query/>
<has-kv k="natural" v="peak"/>

</query>
<print mode="body" order="quadtile"/>
<!-- additionally, show the outline of the area -->
<query type="relation">
<has-kv k="place" v="region"/>
<has-kv k="region:type" v="mountain_area"/>
<has-kv k="name:en" v="Dolomites"/>

</query>
<print mode="body" order="quadtile"/>
<recurse type="down"/>
<print mode="skeleton" order="quadtile"/>
</osm-script>

Notă: This query is written in a xml like language. If you are more used to the Overpass QL you can
write the query in this language.

4. And click on Run Query:
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The mountain peaks layer will be downloaded and shown in QGIS:

You can write complex queries using the Overpass Query language. Take a look at some example and try to explore
the query language.

9.2.3 ��� Follow Along: The DataPlotly Plugin

The DataPlotly plugin allows you to create D3 plots of vector attributes data thanks to the plotly library.
1. Start a new project
2. Load the sample_points layer from the exercise_data/plugins folder
3. Install the plugin following the guidelines described in ��� Follow Along: Installing New Plugins searching

Data Plotly

4. Open the plugin by clicking on the new icon in the toolbar or in the Plugins ► Data Plotly menu
In the following example we are creating a simple Scatter Plot of two fields of the sample_points layer. In the
DataPlotly Panel:
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1. Choose sample_points in the Layer filter, cl for the X Field and mg for the Y Field:

2. If you want you can change the colors, the marker type, the transparency and many other settings: try to change
some parameters to create the plot below.
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3. Once you have set all the parameters, click on the Create Plot button to create the plot.
The plot is interactive: this means you can use all the upper buttons to resize, move, or zoom in/out the plot
canvas. Moreover, each element of the plot is interactive: by clicking or selecting one or more point on the plot,
the corresponding point(s) will be selected in the plot canvas.

You can save the plot as a png static image or as an html file by clicking on the or on the button in the
lower right corner of the plot.
There is more. Sometimes it can be useful to have two (or more) plots showing different plot types with different
variables on the same page. Let’s do this!

1. Go back to the main plot settings tab by clicking on the button in the upper left corner of the plugin panel
2. Change the Plot Type to Box Plot
3. Choose group as Grouping Field and ph as Y Field
4. In the lower part of the panel, change the Type of Plot from SinglePlot to SubPlots and let the default option

Plot in Rows selected.
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5. Once done click on the Create Plot button to draw the plot

Now both scatter plot and box plot are shown in the same plot page. You still have the chance to click on each plot
item and select the corresponding features in the map canvas.
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Sfat: Each plot has its own manual page available in the tab. Try to explore all the plot types and see all the
other settings available.

9.2.4 În concluzie

Sunt disponibile multe plugin-uri utile pentru QGIS. Folosind instrumentele încorporate, pentru instalarea s, i
gestionarea acestor plugin-uri, putet,i găsi noi plugin-uri s, i să efectuat,i o utilizare optimă a acestora.

9.2.5 Ce urmează?

Apoi, vom analiza modul de utilizare al straturilor care sunt găzduite pe servere aflate la distant,ă, în timp real.
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CAPITOLUL10

Module: Online Resources

Atunci când se analizează sursele de date pentru o hartă, nu este necesar să vă limitat,i la datele pe care le-at,i salvat
pe computerul la care lucrat,i. Există surse de date online, pe care le putet,i încărca atât timp cât suntet,i conectat la
Internet.
În acest modul, vom acoperi cele două tipuri de servicii GIS bazate pe web: Servicii WebMapping (WMS) s, i Servicii
Web Feature (WFS).

10.1 Lesson: Web Mapping Services

Un Serviciu de Cartografiere Web (WMS) este un serviciu găzduit pe un server aflat la distant,ă. Similar unui site
web, îl putet,i accesa, atât timp cât avet,i o conexiune la server. Cu ajutorul QGIS, putet,i încărca un WMS direct în
harta existentă.
Din lect,ia despre plugin-uri, ne amintim că este posibilă încărcarea unei noi imagini raster, spre exemplu, de la
Google. Totus, i, aceasta este o tranzact,ie once-off: o dată ce at,i descărcat imaginea, aceasta nu se mai schimbă. Un
WMS este diferit prin faptul că este un serviciu live, care se va actualiza automat, la deplasarea sau mărirea hărt,ii.
Scopul acestei lect,ii: De a folosi un WMS s, i de a-i înt,elege limitările.

10.1.1 ��� Follow Along: Loading a WMS Layer

For this exercise, you can either use the basic map you made at the start of the course, or just start a new map and
load some existing layers into it. For this example, we used a new map and loaded the original places, landuse and
protected_areas layers and adjusted the symbology:
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1. Încărcat,i aceste straturi într-o nouă hartă, sau folosit,i harta originală doar cu aceste straturi vizibile.
2. Before starting to add the WMS layer, deactivate „on the fly” projection (Project ► Properties… ► CRS tab,

check No CRS (or unknown/non-Earth projection). This may cause the layers to no longer overlap properly, but
don’t worry: we’ll fix that later.

3. To add WMS layers, click on the button to open the Data Source Manager dialog and enable the
WMS/WMTS tab.
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Remember how you connected to a SpatiaLite or GeoPackage database at the beginning of the course. The
landuse, buildings, and roads layers are stored in a database. To use those layers, you first needed to connect
to the database. Using a WMS is similar, with the exception that the layers are on a remote server.

4. Pentru a crea o nouă conexiune la un WMS, facet,i clic pe butonul New.
You’ll need a WMS address to continue. There are several free WMS servers available on the Internet. One
of these is terrestris, which makes use of the OpenStreetMap dataset.

5. Pentru a face uz de acest WMS, setat,i-l în dialogul curent, astfel:
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• The value of the Name field should be terrestris.
• The value of the URL field should be https://ows.terrestris.de/osm/service.

6. Facet,i clic pe Ok. Ar trebui să vedet,i listat noul server WMS:
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7. Facet,i clic pe Conectare. În lista de mai jos, ar trebui să vedet,i încărcate acum, aceste noi intrări:
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Acestea sunt toate straturile găzduite de acest server WMS.
8. Click once on the OSM-WMS layer. This will display the default Coordinate Reference System in use and the

number of CRSes supported by the dataset:
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Since we’re not using EPSG:4326 - WGS 84 for our map, let’s find one that meets our needs.

1. Click the Select CRS button. Youwill see a standardCoordinate Reference System Selector dialog showing
all the CRS the data is published with.

2. We want a projected CRS, so let’s choose WGS 84 / Pseudo-Mercator with EPSG:3857. You can use
the top Filter widget.
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1. Click OK. The Coordinate Reference System associated with the entry has changed.
9. Click Add to load the layer in your project using Layer name` (default is OpenStreetMap WMS - by terrestris).
10. Close the Data Source Manager dialog if not done automatically
11. In the Layers panel, click and drag it to the bottom of the list.
12. Zoom out in order to get a global view of the layers. You will notice that your layers aren’t located correctly

(near west of Africa). This is because „on the fly” projection is disabled.
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13. Let’s enable the reprojection again, but using the same projection as the OpenStreetMap WMS layer, which is
WGS 84 / Pseudo Mercator.
1. Open the Project ► Properties… ► CRS tab
2. Uncheck No CRS (or unknown/non-Earth projection)
3. Aleget,iWGS 84 / Pseudo Mercator din listă.
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4. Clic pe OK
14. Now right-click on one of your own layers in the Layers panel and click Zoom to layer(s). You should see the

Swellendam area:

340 Capitolul 10. Module: Online Resources



QGIS Training Manual

Notă cum se suprapun străzile stratului WMS cu propriile noastre străzi. Ăsta e un semn bun!

Natura s, i limitele WMS

By now you may have noticed that this WMS layer actually has many features in it. It has streets, rivers, nature
reserves, and so on. What’s more, even though it looks like it’s made up of vectors, it seems to be a raster, but you
can’t change its symbology. Why is that?
This is how a WMS works: it’s a map, similar to a normal map on paper, that you receive as an image. What usually
happens is that you have vector layers, which QGIS renders as a map. But using a WMS, those vector layers are on
the WMS server, which renders it as a map and sends that map to you as an image. QGIS can display this image, but
can’t change its symbology, because all that is handled on the server.
This has several advantages, because you don’t need to worry about the symbology. It’s already worked out, and
should be nice to look at on any competently designed WMS.
On the other hand, you can’t change the symbology if you don’t like it, and if things change on the WMS server, then
they’ll change on your map as well. This is why you sometimes want to use a Web Feature Service (WFS) instead,
which gives you vector layers separately, and not as part of a WMS-style map.
This will be covered in the next lesson, however. First, let’s add another WMS layer.

10.1.2 ��� Try Yourself:

1. Add the eAtlasWMS server at this URL: https://maps.eatlas.org.au/maps/wms
2. Load aWorld: Hillshading layer into the map.
3. You might want to set its Encoding to JPEG and its Tile size option to 200 by 200, so that it loads faster.
4. Your map should look like this (you may need to re-order the layers, and apply some transparency):

Answer
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1. Go to the Data Source Manager, WMS / WMTS tab and create a new connection entry

2. Use the text box to filter the list of layers and select the corresponding layer
3. Remember to check/turn its CRS into EPSG:3857 - WGS 84 / Pseudo Mercator as the rest of the map.

4. After the layer is loaded, you can modify its Opacity value (under the Transparency properties tab)

10.1.3 ��� Try Yourself:

O parte din dificultatea de a folosi WMS, este de a găsi un server bun (s, i gratuit).
• Find a new WMS at directory.spatineo.com (or elsewhere online). It must not have associated fees or
restrictions, and must have coverage over the Swellendam study area.
Amintit,i-vă că pentru un WMS avet,i nevoie doar de URL-ul său (s, i, de preferint,ă, un fel de descriere).

Answer
Spatineo is one of many places you can search for a OGC data. Type in the text area a name, keyword, location of
your interest to see if you get some working results. For this lesson, you might want to filter the results to include
WMS only.
You may notice that many WMS servers are not always available. Sometimes this is temporary, sometimes
it is permanent. An example of a WMS server that worked at the time of writing is the MapServer
Demonstration Server WMS at https://demo.mapserver.org/cgi-bin/wms?SERVICE=WMS&VERSION=1.3.0&
REQUEST=GetCapabilities. It does not require fees or have access constraints, and it is global. Therefore, it does
satisfy the requirements. Keep in mind, however, that this is merely an example. There are many other WMS servers
to choose from.
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10.1.4 ��� Try Yourself:

• Add the bluemarble layer from the MapServer Demonstration Server. Is that a suitable dataset for our study
area?

Answer
1. Hide all other WMS layers to prevent them from rendering unnecessarily in the background.
2. Use the same approach as before to add the new server and the appropriate layer as hosted on that server:

3. If you zoom into the Swellendam area, you’ll notice that this dataset has a low resolution:
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Therefore, it’s better not to use this data for the current map. The Blue Marble data is more suitable at global
or national scales

10.1.5 În concluzie

Folosind un WMS, putet,i adăuga hărt,i inactive ca fundaluri pentru datele hărt,ilor existente.

10.1.6 Further Reading

• Spatineo Directory
• OpenStreetMap.org list of WMS servers

10.1.7 Ce urmează?

Now that you’ve added an inactive map as a backdrop, you’ll be glad to know that it’s also possible to add features
(such as the other vector layers you added before). Adding features from remote servers is possible by using a Web
Feature Service (WFS). That’s the topic of the next lesson.
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10.2 Lesson: Web Feature Services

Un Serviciu Web Feature (WFS) pune la dispozit,ie utilizatorilor date GIS în formate care pot fi încărcate direct în
QGIS. Spre deosebire de un WMS, care oferă doar o hartă pe care nu o putet,i edita, un WFS oferă acces direct la
entităt,i.
Scopul acestei lect,ii: De a folosi un WFS s, i de a-i înt,elege cum diferă de un WMS.

10.2.1 ��� Follow Along: Loading a WFS Layer

1. Începet,i o nouă hartă. Aceasta are scop demonstrativ s, i nu va fi salvată.

2. Click the Open Data Source Manager button.

3. Enable the WFS / OGC API - Features tab.
4. Clic pe butonul New.
5. În caseta de dialog care apare, introducet,i nsidc.org la Nume s, i https://nsidc.org/cgi-bin/

atlas_south?version=1.1.0 la URL.

6. Clic OK, apoi noua conexiune va apărea în Conexiunile serverului.
7. Clic pe Connect. Va apărea o listă a straturilor disponibile:
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8. Uncheck the Only request features overlapping the view extent option below the layers list, since your current
map canvas may not cover our area of interest: Antarctica.

9. Find the layer antarctica_country_border. You can use the Filter box at the top.
10. Facet,i clic pe strat pentru a-l selecta.
11. Find and select also the layer south_poles_wfs. You might need to hold Ctrl.
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12. Clic pe Add.
It may take a while to load the layers. When they are loaded, they will appear in the map, showing the outlines
of Antarctica and a few points over.
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How is this different from having a WMS layer?
13. Select any of the layers and you’ll notice that feature selection and attribute table tools are enabled. These are

vector layers.
14. Select the south_poles_wfs layer and open its attribute table. You should see this:

De vreme ce punctele au atribute, putem să le punem etichete s, i să le schimbăm simbolistica. Iată un exemplu:
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Diferent,e între straturile WMS

Un Serviciu Web Feature întoarce stratul însus, i, nu doar o hartă redată pentru acesta. Asta vă dă acces direct la date,
însemnând că putet,i să schimbat,i simbologia s, i putet,i rula funct,ii analitice. Cu toate acestea, costul este transmiterea
unui volum mai mare de date. Asta va fi evident dacă straturile pe care le încărcat,i au forme complexe, multe atribute
sau multe entităt,i; sau chiar dacă doar încărcat,i multe straturi. Din această cauză straturile WFS au nevoie de regulă
de mult timp pentru a se încărca.

10.2.2 ��� Follow Along: Querying a WFS Layer

Des, i este posibil să interogat,i un strat WFS după încărcare, este de regulă mai eficient să îl interogat,i înainte de a-l
încărca. În felul acesta ceret,i doar entităt,ile pe care le dorit,i, ceea ce înseamnă că utilizat,i o bandă mai mică.
De exemplu, pe serverul WFS pe care îl utilizăm în acest moment, există un strat numit countries (excluding
Antarctica). Să spunem că dorim să s, tim unde se află Africa de Sud fat,ă de stratul south_poles_wfs (s, i poate s, i
fat,ă de antarctica_country_border layer) care a fost deja încărcat.
Există două metode. Putet,i încărca tot stratul countries …, după care să construit,i o interogare ca în mod normal
după ce acesta s-a încărcat. Dar, transmit,ând datele pentru toate t,ările lumii s, i utilizând pe urmă doar datele pentru
Africa de Sud pare a fi o irosire a lăt,imii de bandă. În funct,ie de conexiune, acest set de date poate necesita mai multe
minute pentru a se încărca.
Alternativa este de a construi o interogare ca pe un filtru, chiar înainte de încărcarea stratului de pe server.

1. Enable theWFS / OGC API Features tab in the Data Source Manager dialog
2. Connect to the server we used before and you should see the list of available layers.
3. Find and double-click the countries (excluding Antarctica) layer. The layer name is

country_borders_excluding_antarctica. You can also select the layer and press Build
query button at the bottom of the dialog:
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4. In the dialog that appears, type the following SELECT * FROM
country_borders_excluding_antarctica WHERE "Countryeng" = 'South Africa'
query in the SQL Statement box.

5. Press OK.
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6. The expression used will appear as the Sql value of the target layer:

7. Click Add with the layer selected as above. Only the country with the Countryeng value of South
Africa will load from that layer:
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Did you notice the icon next to the country_borders_excluding_antarctica layer? It
indicates that the loaded layer is filtered and does not display in the project all of its features.

8. Dacă at,i încercat ambele metode, vet,i observa că această variantă este mult mai rapidă decât încărcarea tuturor
t,ărilor înaintea filtrării!

Note cu privire la disponibilitatea WFS

Este o raritate să găsit,i un WFS care să pună la dispozit,ie caracteristicile dorite dacă acestea sunt foarte specifice.
Motivul pentru care cele mai multe servicii Web Feature sunt relativ rare este pentru că necesită transmiterea unui
volum mare de date pentru a descrie complet o entitate. În concluzie nu este foarte rentabilă găzduirea unui WFS în
comparat,ie cu un WMS, care trimite doar imagini.
Cel mai comun tip de WFS pe care îl vet,i întâlni va fi deci probabil într-o ret,ea local sau chiar pe propriul calculator,
mai degrabă decât in Internet.

10.2.3 În concluzie

Straturile WFS sunt de preferat fat,ă de straturile WMS dacă avet,i nevoie de acces direct la atributele si geometriile
acestora. Cu toate acestea, t,inând cont de volumul de date care trebuie descărcat (ceea ce duce la probleme de viteză
s, i de asemenea la lipsa de servere WFS disponibile publicului larg) nu este întotdeauna posibil să folosit,i un WFS în
loc de un WMS.
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10.2.4 Ce urmează?

În continuare, vom vedea cum se utilizează QGIS Server pentru a furniza servicii OGC.
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CAPITOLUL11

Module: QGIS Server

Acest modul a fost publicat de Tudor Bărăscu.
În acest capitol vom examina modul de instalare s, i utilizare a serverului QGIS.
Pentru a afla mai multe despre QGIS Server, citit,i QGIS-Server-manual.

11.1 Lesson: Install QGIS Server

The goal for this lesson: To learn how to install QGIS Server on Debian Stretch. With negligible variations you
can also follow it for any Debian based distribution like Ubuntu and its derivatives.

Notă: In Ubuntu you can use your regular user, prepending sudo to commands requiring admin permissions. In
Debian you can work as admin (root), without using sudo.

11.1.1 ��� Follow Along: Install from packages

In this lesson we’re going to do only the install from packages as shown here .
Instalat,i Serverul QGIS cu:

apt install qgis-server --no-install-recommends --no-install-suggests

# if you want to install server plugins, also:
apt install python3-qgis

QGIS Server should be used in production without QGIS Desktop (with the accompanying X Server) installed on the
same machine.
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11.1.2 ��� Follow Along: QGIS Server Executable

The QGIS Server executable is qgis_mapserv.fcgi. You can check where it has been installed by running
find / -name 'qgis_mapserv.fcgi' which should output something like /usr/lib/cgi-bin/
qgis_mapserv.fcgi.
Optionally, if you want to do a command line test at this time you can run the /usr/lib/cgi-bin/
qgis_mapserv.fcgi --version command which should output something like:

QGIS 3.21.0-Master 'Master' (1c70953f1e)
QGIS code revision 1c70953f1e
Qt version 5.15.2
Python version 3.9.5
GDAL/OGR version 3.2.2
PROJ version 7.2.1
EPSG Registry database version v10.008 (2020-12-16)
GEOS version 3.9.0-CAPI-1.16.2
SQLite version 3.34.1
OS Ubuntu 21.04

We’ll see later on how to make WMS requests.

11.1.3 ��� HTTP Server Configuration

In order to access on the installed QGIS server from an Internet Browser we need to use an HTTP server. The Apache
HTTP Server installation process is detailed in httpserver section.

Notă: If you installed QGIS Server without running an X Server (included in Linux Desktop) and if you also want
to use the GetPrint command then you should install a fake X Server and tell QGIS Server to use it. You can do
that by following the Xvfb installation process.

11.1.4 ��� Follow Along: Create another virtual host

Let’s create another Apache virtual host pointing to QGIS Server. You can choose whatever name you like (coco.
bango, super.duper.training, example.com, etc.) but for simplicity sake we’re going to use myhost.

• Let’s set up the myhost name to point to the localhost IP by adding 127.0.0.1 x to the /etc/hosts
with the following command: sh -c "echo '127.0.0.1 myhost' >> /etc/hosts" or by
manually editing the file with gedit /etc/hosts.

• We can check that myhost points to the localhost by running in the terminal the ping myhost command
which should output:

qgis@qgis:~$ ping myhost
PING myhost (127.0.0.1) 56(84) bytes of data.
64 bytes from localhost (127.0.0.1): icmp_seq=1 ttl=64 time=0.024 ms
64 bytes from localhost (127.0.0.1): icmp_seq=2 ttl=64 time=0.029 ms

• Let’s try if we can access QGIS Server from the myhost site by doing: curl http://myhost/
cgi-bin/qgis_mapserv.fcgi or by accessing the url from your Debian box browser. You will
probably get:

<!DOCTYPE HTML PUBLIC "-//IETF//DTD HTML 2.0//EN">
<html><head>
<title>404 Not Found</title>
</head><body>
<h1>Not Found</h1>
<p>The requested URL /cgi-bin/qgis_mapserv.fcgi was not found on this server.</p>

(continues on next page)
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(continuare din pagina precedentă)
<hr>
<address>Apache/2.4.25 (Debian) Server at myhost Port 80</address>
</body></html>

• Apache doesn’t know that he’s supposed to answer requests pointing to the server named myhost. In
order to setup the virtual host the simplest way would be to make a myhost.conf file in the /etc/
apache2/sites-available directory that has the same content as qgis.demo.conf except for
the ServerName line that should be ServerName myhost. You could also change where the logs go as
otherwise the logs for the two virtual hosts would be shared but this is optional.

• Let’s now enable the virtual host with a2ensite myhost.conf and then reload the Apache service with
service apache2 reload.

• If you try again to access the http://myhost/cgi-bin/qgis_mapserv.fcgi url you’ll notice everything is working
now!

11.1.5 În concluzie

You learned how to install different QGIS Server versions from packages, how to configure Apache with QGIS Server,
on Debian based Linux distros.

11.1.6 Ce urmează?

Now that you’ve installed QGIS Server and it’s accessible through the HTTP protocol, we need to learn how to access
some of the services it can offer. The topic of the next lesson is to learn how to access QGIS Server WMS services.

11.2 Lesson: Serving WMS

The data used for this exercise are available in the qgis-server-tutorial-data subdirectory of the training
data you downloaded. For convenience and to avoid possible permissions problems, we will assume that these files
are stored in /home/qgis/projects directory. Hence, adapt the following instructions to your path.
Datele demo cont,in un proiect QGIS denumit world.qgs, care este pregătit deja pentru a fi expus de către serverul
QGIS. Dacă dorit,i să utilizat,i propriul proiect sau să aflat,i cum se poate pregăti un proiect, consultat,i sect,iunea
Creatingwmsfromproject.

Notă: Acest modul prezintă adresele URL, astfel încât audient,a să poată distinge cu us,urint,ă parametri s, i valorile
acestora. În timp ce formatul normal este:

...&field1=value1&field2=value2&field3=value3

acest tutorial foloses, te:

&field1=value1
&field2=value2
&field3=value3

Pasting them into Mozilla Firefox works properly but other web browsers like Chrome may add unwanted spaces
between the field:parameter pairs. So, if you encounter this issue you can either use Firefox or modify the
URLs so that they’re in one line format.

Let’s make a WMS GetCapabilities request in the web browser or with curl:
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http://qgisplatform.demo/cgi-bin/qgis_mapserv.fcgi
?SERVICE=WMS
&VERSION=1.3.0
&REQUEST=GetCapabilities
&map=/home/qgis/projects/world.qgs

In the Apache config from the previous lesson the QGIS_PROJECT_FILE variable sets the default project to /
home/qgis/projects/world.qgs. However, in the above request we made use of themap parameter to be
explicit and to show it can be used to point at any project. If you delete the map parameter from the above request
QGIS Server will output the same response.
By pointing any WMS client to the GetCapabilities URL, the client gets in response an XML document with
metadata of the Web Map Server’s information, e.g. what layers does it serve, the geographical coverage, in what
format, what version of WMS etc.
As QGIS is also a ogc-wms you can create a new WMS server connection with the help of the above GetCapabilities
url. See the Lesson: Web Mapping Services or the ogc-wms-servers section on how to do it.
By adding the countriesWMS layer to your QGIS project you should get an image like the one below:

Fig. 11.1: QGIS Desktop consuming the QGIS Server countries layer WMS service
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Notă: QGIS Server serves layers that are defined in the world.qgs project. By opening the project with QGIS
you can see there are multiple styles for the countries layer. QGIS Server is also aware of this and you can choose
the style you want in your request. The classified_by_population style was chosen in the above image.

11.2.1 Jurnalizarea

When you’re setting up a server, the logs are always important as they show you what’s going on. We have setup in
the *.conf file the following logs:

• QGIS Server log at /logs/qgisserver.log
• qgisplatform.demo Apache access log at qgisplatform.demo.access.log
• qgisplatform.demo Apache error log at qgisplatform.demo.error.log

The log files are simply text files so you can use a text editor to check them out. You can also use the tail command
in a terminal: sudo tail -f /logs/qgisserver.log.
This will continuously output in the terminal what’s written in that log file. You can also have three terminals opened
for each of the log files like so:
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Fig. 11.2: Using the tail command to visualise QGIS Server logs output

When you use QGIS Desktop to consume the QGIS Server WMS services you will see all the requests QGIS sends
to the Server in the access log, the errors of QGIS Server in the QGIS Server log etc.

Notă:
• If you look at the logs in the following sections you should get a better understanding on what’s happening.
• By restarting Apache while looking in the QGIS Server log you can find some extra pointers on how things
work.
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11.2.2 GetMap requests

In order to display the countries layer, QGIS Desktop, like any other WMS client, is using GetMap requests.
A simple request looks like:

http://qgisplatform.demo/cgi-bin/qgis_mapserv.fcgi
?MAP=/home/qgis/projects/world.qgs
&SERVICE=WMS
&VERSION=1.3.0
&REQUEST=GetMap
&BBOX=-432786,4372992,3358959,7513746
&SRS=EPSG:3857
&WIDTH=665
&HEIGHT=551
&LAYERS=countries
&FORMAT=image/jpeg

The above request should output the following image:
Figure: simple GetMap request to QGIS Server

Fig. 11.3: Qgis Server response after a simple GetMap request
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11.2.3 ��� Try Yourself: Change the Image and Layers parameters

Based on the request above, let’s replace the countries layer with another.
In order to see what other layers are available you could open up the world.qgs project in QGIS and look at its
contents. Keep in mind though that the WMS clients don’t have access to the QGIS project, they just look at the
capabilities document contents.
Also, there’s a configuration option so that some of the layers existing in the QGIS project are ignored by QGIS when
serving the WMS service.
So, you could look at the layer list when you point QGIS Desktop to the GetCapabilities URL or you could
try yourself finding other layer names in the GetCapabilities XML response.
One of the layer names that you could find and works is countries_shapeburst. You may find others but
keep in mind some may not be visible at such a small scale so you could get a blank image as response.
You can also play around with others parameters from above, like changing the returned image type to image/png.

11.2.4 ��� Follow Along: Use Filter, Opacities and Styles parameters

Let’s do another request that adds another layer, some basic parameters, FILTER and OPACITIES, but also uses
the standard STYLES parameter.

http://qgisplatform.demo/cgi-bin/qgis_mapserv.fcgi
?MAP=/home/qgis/projects/world.qgs
&SERVICE=WMS
&VERSION=1.3.0
&REQUEST=GetMap
&BBOX=-432786,4372992,3358959,7513746
&SRS=EPSG:3857
&WIDTH=665
&HEIGHT=551
&FORMAT=image/jpeg
&LAYERS=countries,countries_shapeburst
&STYLES=classified_by_name,blue
&OPACITIES=255,30
&FILTER=countries:"name" IN ( 'Germany' , 'Italy' )

The above request should output the following image:
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Fig. 11.4: Response to a GetMap request with FILTER and OPACITIES parameters

As you can see from the above image, among other things, we told QGIS Server to render only Germany and Italy
from the countries layer.

11.2.5 ��� Follow Along: Use Redlining

Let’s do another GetMap request that makes use of the redlining feature and of the SELECTION parameter detailed
in the Basics section:

http://qgisplatform.demo/cgi-bin/qgis_mapserv.fcgi
?MAP=/home/qgis/projects/world.qgs
&SERVICE=WMS
&VERSION=1.3.0
&REQUEST=GetMap
&BBOX=-432786,4372992,3358959,7513746
&SRS=EPSG:3857
&WIDTH=665
&HEIGHT=551
&LAYERS=countries,countries_shapeburst
&FORMAT=image/jpeg
&HIGHLIGHT_GEOM=POLYGON((590000 6900000, 590000 7363000, 2500000 7363000, 2500000␣
↪→6900000, 590000 6900000))
&HIGHLIGHT_SYMBOL=<StyledLayerDescriptor><UserStyle><Name>Highlight</Name>
↪→<FeatureTypeStyle><Rule><Name>Symbol</Name><LineSymbolizer><Stroke><SvgParameter␣

(continues on next page)
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(continuare din pagina precedentă)
↪→name="stroke">%233a093a</SvgParameter><SvgParameter name="stroke-opacity">1</
↪→SvgParameter><SvgParameter name="stroke-width">1.6</SvgParameter></Stroke></
↪→LineSymbolizer></Rule></FeatureTypeStyle></UserStyle></StyledLayerDescriptor>
&HIGHLIGHT_LABELSTRING=QGIS Tutorial
&HIGHLIGHT_LABELSIZE=30
&HIGHLIGHT_LABELCOLOR=%23000000
&HIGHLIGHT_LABELBUFFERCOLOR=%23FFFFFF
&HIGHLIGHT_LABELBUFFERSIZE=3
&SELECTION=countries:171,65

Pasting the above request in your web browser should output the following image:

Fig. 11.5: Response to a request with the REDLINING feature and SELECTION parameter

You can see from the above image that the countries with the 171 and 65 ids were highlighted in yellow (Romania
and France) by using the SELECTION parameter and we used theREDLINING feature to overlay a rectangle with
the QGIS Tutorial label.
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11.2.6 GetPrint requests

One very nice feature of QGIS Server is that it makes use of the QGIS Desktop print layouts. You can learn about it
in the wms_getprint section.
If you open the world.qgs project with QGIS Desktop you will find a print layout named Population
distribution. A simplified GetPrint request that exemplifies this amazing feature is:

http://qgisplatform.demo/cgi-bin/qgis_mapserv.fcgi
?map=/home/qgis/projects/world.qgs
&SERVICE=WMS
&VERSION=1.3.0&
REQUEST=GetPrint
&FORMAT=pdf
&TRANSPARENT=true
&SRS=EPSG:3857
&DPI=300
&TEMPLATE=Population distribution
&map0:extent=-432786,4372992,3358959,7513746
&LAYERS=countries

Fig. 11.6: Shows the pdf resulted from the above GetPrint request

Naturally, it’s hard to write your GetMap, GetPrint etc. requests.
QGIS Web Client or QWC is a Web client project that can work alongside QGIS Server so that you can publish your
projects on the Web or help you create QGIS Server requests for a better understanding about the possibilities.
O putet,i instala în felul următor:

• As user qgis go to the home directory with cd /home/qgis.
• Download the QWC project from here and unzip it.
• Make a symbolic link to the /var/www/html directory as it’s the DocumentRoot that we’ve setup
in the virtual host configuration. If you unzipped the archive under /home/qgis/Downloads/
QGIS-Web-Client-master we can do that with sudo ln -s /home/qgis/Downloads/
QGIS-Web-Client-master /var/www/html/.

• Access http://qgisplatform.demo/QGIS-Web-Client-master/site/qgiswebclient.html?map=/home/qgis/
projects/world.qgs from your Web browser.

Now you should be able to see the Map as in the following figure:
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Fig. 11.7: QGIS Web Client consuming the world.qgs project

If you click the Print button in QWC you can interactively create GetPrint requests. You can also click the ? icon
in the QWC to access the available help so that you can better discover the QWC possibilities.

11.2.7 În concluzie

You learned how use QGIS Server to provide WMS Services.

11.2.8 Ce urmează?

În continuare, vom vedea cum se utilizează QGIS ca interfat,ă pentru faimosul GIS GRASS.
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GRASS (Sistem de Suport pentru Analiza Resurselor Geografice) este un GIS bine-cunoscut, cu sursă deschisă, s, i
cu o gamă largă de funct,ii utile. Acesta a fost lansat în 1984, s, i a cunoscut multe îmbunătăt,iri s, i funct,ionalităt,i
suplimentare de atunci. QGIS vă permite să facet,i uz direct de puternicele instrumente GIS din Grass.

12.1 Lesson: GRASS Setup

Using GRASS in QGIS requires you to think of the interface in a slightly different way. Remember that you’re not
working in QGIS directly, but working in GRASS via QGIS. Hence, make sure you have installed QGIS Desktop
with Grass support.

To open a QGIS session with GRASS available on Windows you have to click on the QGIS Desktop with
GRASS icon.
Scopul acestei lect,ii: Pentru a începe un proiect GRASS în QGIS.

12.1.1 ��� Follow Along: Start a New GRASS Session

To launch GRASS from within QGIS, you need to activate it as with any other plugin:
1. First, open a new QGIS project.

2. In the Plugin Manager, enable GRASS 8 in the list:
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The GRASS toolbar and the GRASS panel will appear:

Fig. 12.1: GRASS Toolbar and Panel

The GRASS panel is not active because, before you can use GRASS, you need to create a Mapset. GRASS always
works in a database environment, which means that you need to import all the data you want to use into a GRASS
database.
The GRASS database has a straightforward structure, even if at a first look it seems very complicated. The most
important thing you should know is that the upper level of the database is the Location. Each Location can
contain different Mapset: in every Mapset you will find the PERMANENTMapset because it is created by default
by GRASS. Each Mapset contains the data (raster, vector, etc) in a particular structure, but don’t worry, GRASS
will take care of this for you.
Just remember: Location containsMapset that contains the data. Formore information visit the GRASSwebsite.

368 Capitolul 12. Module: GRASS

https://grass.osgeo.org/grass-stable/manuals/grass_database.html


QGIS Training Manual

Fig. 12.2: GRASS database structure (from GRASS docs)

12.1.2 ��� Follow Along: Start a New GRASS Project

1. Click on the Plugins ► GRASS ► New Mapset menu:

You’ll be asked to choose the location of the GRASS database.
2. Setat,i-l ca director care va fi utilizat de către GRASS pentru instalarea bazei de date:
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3. Clic pe Next.
GRASS needs to create a Location, which describes the maximum extent of the geographic area you’ll be working
in, also known as Grass Region.

Notă: the Region is extremely important for GRASS because it describes the area in which all layers will be taken
into account for GRASS. Everything that is outside will not be considered. Don’t worry, you can always change the
extent of the GRASS Region after the Location has been created

1. Call the new location SouthAfrica:

2. Clic pe Next.
3. We’ll be working with WGS 84, so search for and select this CRS:
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4. Clic pe Next.
5. Acum selectat,i regiunea Africii de Sud din caseta cu derulare verticală s, i facet,i clic pe Set:
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6. Clic pe Next.
7. Creat,i un set de hărt,i, care este fis, ierul hărt,ii cu care vet,i lucra.

Once you’re done, you’ll see a dialog asking with a summary of all the information entered.
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8. Clic Finish.
9. Clic pe OK, în dialogul de încheiere cu succes.

You will see that the GRASS Panel will become active and you can start to use all GRASS tools.

12.1.3 ��� Follow Along: Loading Vector Data into GRASS

You have now a blank map and before you can start to use all the GRASS tools you have to load data into the GRASS
database, specifically into the Mapset. You cannot use GRASS tools with layer that are not loaded into a GRASS
Mapset.
There are many different ways to load data in the GRASS database. Let’s start with the first one.

��� Follow Along: Load data using the QGIS Browser

In section ��� The Browser Panel we saw that the easiest and quickest way to load the data in QGIS is the Browser
Panel.
GRASS data are recognized from the QGIS Browser as real GRASS data and you can notice it because you will see

the GRASS icon next to the GRASS Mapset. Moreover you will see the icon next to the Mapset that is opened.
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Notă: You will see a replication of the GRASS Location as normal folder: GRASS Mapset data are those within
the folder

You can easily drag and drop layers from a folder to the GRASS Mapset.
Let’s try to import the roads layer into the grass_mapsetMapset of the SouthAfrica Location.
Go to the Browser, and simply drag the roads layer from the training_data.gpkg GeoPackage file into the
grass_mapsetMapset.
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That’s it! If you expand the Mapset you will see the imported roads layer. You can now load in QGIS the imported
layer like all the other layers.

Sfat: You can also load layers from the Layer Legend Panel to Mapset in the Browser Panel. This will speed up
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incredibly your workflow!

��� Follow Along: Load data using the GRASS Panel

We will use now the long method to load the rivers.shp layer into the same Mapset.
1. Load data into QGIS as usual. Use the rivers.shp dataset (found in the exercise_data/

shapefile/ folder)
2. As soon as it is loaded, click on the Filter box of the GRASS Panel and find the vector import tool by

entering the term v.in.ogr.qgis (available under File management► Import into GRASS► Import vector
into GRASS):

Atent,ionare: There are 2 similar tools: v.in.ogr.qgis and v.in.ogr.qgis.loc. We are
looking for the first one.

The v stands for vector, in means a function to import data into the GRASS database, ogr is the software
library used to read vector data, and qgis means that the tool will look for a vector from among the vectors
already loaded into QGIS.

3. Once you’ve found this tool, click on it to bring up the tool itself. Choose the rivers layer in the Loaded Layer
box and type and name it g_rivers to prevent confusion:
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Notă: ★★★ Note the extra import options provided under Advanced Options. These include the ability to
add a WHERE clause for the SQL query used for importing the data.

4. Facet,i clic pe Run pentru a începe importul.
5. După finalizare, dat,i clic pe butonul View output pentru a vedea noul strat GRASS importat în hartă.
6. Închidet,i primul instrument de import (dat,i clic pe butonul Close imediat în dreapta de View output), după care

închidet,i fereastra GRASS Tools.
7. Remove the original rivers layer.

Acum at,i rămas doar cu stratul GRASS importat, as,a cum este afis,at în harta dvs. din QGIS.

12.1.4 ��� Follow Along: Loading Raster Data into GRASS

You can import a raster layer in the same ways we imported vector layers.
We are going to import in the GRASS Mapset the layer srtm_41_19_4326.tif.

Notă: the raster layer is already in the correct CRS, WGS 84. If you have layers in different CRS you must reproject
them in the same CRS of the GRASS Mapset

1. Load the srtm_41_19_4326.tif layer in QGIS
2. Deschidet,i iarăs, i dialogul Instrumentelor GRASS.
3. Click on the Modules tab.
4. Search for r.in.gdal.qgis (available under File management ► Import into GRASS ► Import raster into

GRASS ► Import raster into GRASS from QGIS view) and double click the tool to open the tool’s dialog.
5. Set it up so that the input layer is srtm_41_19_4326.tif and the output is g_dem.
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6. Clic pe Run
7. Când procesul s-a încheiat, facet,i clic pe Vizualizare rezultat.
8. Închidet,i fila curentă, apoi Închidet,i întregul dialog.

9. You may now remove the original srtm_41_19_4326.tif layer.
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12.1.5 ��� Try Yourself: Add Layers to Mapset

Try to import in the GRASS Mapset the vector layers water.shp and places.shp from the
exercise_data/shapefile/ folder. As we did for rivers rename the imported layer as g_water and
g_places to avoid confusion

Răspuns
You can add layers (both vector and raster) into a GRASS Mapset by drag and drop them in the Browser (see ���
Follow Along: Load data using the QGIS Browser) or by using the v.in.gdal.qgis for vector and r.in.gdal.
qgis for raster layers.

12.1.6 ��� Open an existing GRASS Mapset

If you have an existing GRASS Mapset you can easily reopen it in another session of QGIS.
You have several method to open a GRASS Mapset, let’s explore some of them.
Let’s close the Mapset by clicking on the Close Mapset button of the GRASS Tools window.

��� Follow Along: Using the GRASS plugin

1. Click on the Plugins ► GRASS ► Open Mapset menu.
2. Browse to the GRASS database folder: be careful! You must choose the parent folder, not the GRASSMapset

one. Indeed GRASS will read all the Locations of the database and all the Mapsets of each Location:

3. Choose the Location SouthAfrica and the Mapset grass_mapset that we have created before.
That’s it! The GRASS Panel will become active meaning that the Mapset has been correctly opened.

��� Follow Along: Using the QGIS Browser

Even faster and easier is opening a Mapset using the QGIS Browser:
1. Close the Mapset (if it is open) by clicking on the Close Mapset button of the GRASS Tools window.
2. In the QGIS Browser, browse to the folder of the GRASS database.

3. Right click on the Mapset (remember, the Mapset has the GRASS icon next to it). You will see some
options.

4. Click on Open mapset:
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The Mapset is now open and ready to use!

Sfat: Right click on a GRASSMapset offers you a lot of different settings. Try to explore them and see all the useful
options.
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12.1.7 În concluzie

Fluxul de lucru GRASS pentru asimilarea datelor este us,or diferit de metoda QGIS pentru că GRASS încarcă datele
într-o structură de bază de date spat,ială. Cu toate acestea, utilizănd QGIS ca interfat,ă, putet,i us,ura setarea unui
mapset GRASS prin utilizarea straturilor existente QGIS ca surse de date pentru GRASS.

12.1.8 Ce urmează?

Acum, o dată ce datele sunt importate în GRASS, ne putem uita la operat,iunile avansate de analiză pe care le oferă
GRASS.

12.2 Lesson: GRASS Tools

În această lect,ie vom prezenta o select,ie de instrumente pentru a vă oferi o idee despre capabilităt,ile GRASS.

12.2.1 ��� Follow Along: Create an aspect map

1. Open the GRASS Tools tab
2. Load the g_dem raster layer from the grass_mapset Mapset
3. Look for the r.aspect module by searching for it in the Filter field of the Modules List tab
4. Open the tool and set it up like this and click on the Run button:
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5. When the process is finished click on View Output to load the resulting layer in the canvas:
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The g_aspect layer is stored within the grass_mapset Mapset so you can remove the layer from the canvas and
reload it whenever you want.

12.2.2 ��� Follow Along: Get basic statistic of raster layer

We want to know some basic statistics of the g_dem raster layer.
1. Open the GRASS Tools tab
2. Load the g_dem raster layer from the grass_mapset Mapset
3. Look for the r.info module by searching for it in the Filter field of the Modules List tab
4. Set up the tool like this and click on Run:
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5. Within the Output tab you will see some raster information printed, like the path of the file, the number of
rows and columns and other useful information:
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12.2.3 ��� Follow Along: The Reclass Tool

Reclassifying a raster layer is a very useful task. We just created the g_aspect layer from the g_dem one. The
value range gets from 0 (North) passing through 90 (East), 180 (South), 270 (West) and finally to 360 (North again).
We can reclassify the g_aspect layer to have just 4 categories following specific rules (North = 1, East = 2, South
= 3 and West = 4).
Grass reclassify tool accepts a txt file with the defined rules. Writing the rules is very simple and the GRASSManual
contains very good description.

Sfat: Each GRASS tool has its own Manual tab. Take the time to read the description of the tool you are using to
don’t miss some useful parameters

1. Load the g_aspect layer or, if you don’t have create it, go back to the ��� Follow Along: Create an aspect
map section.
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2. Look for the r.reclass module by searching for it in the Filter field of the Modules List tab
3. Open the tool and set it up like the following picture. The file containing the rules is in the exercise_data/

grass/ folder, named reclass_aspect.txt.
4. Click on Run and wait until the process is finished:

5. Click on View Output to load the reclassified raster in the canvas
The new layer is made up by just 4 values (1, 2, 3, and 4) and it is easier to manage and to process.
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Sfat: Open the reclass_aspect.txt with a text editor to see the rules and to start becoming used to them.
Moreover, take a deep look at the GRASS manual: a lot of different examples are pointed out.

12.2.4 ��� Try Yourself: Reclassify with your rules

Try to reclassify the g_dem layer into 3 new categories:
• from 0 to 1000, new value = 1
• from 1000 to 1400, new value = 2
• from 1400 to the maximum raster value, new value = 3

Răspuns
To discover the maximum value of the raster run the r.info tool: in the console you will see that the maximum
value is 1699. You are now ready to write the rules.

1. Open a text editor and add the following rules:

0 thru 1000 = 1
1000 thru 1400 = 2
1400 thru 1699 = 3

2. Save the file as my_rules.txt file and close the text editor.
3. Run the r.reclass tool: choose the g_dem layer and load the file containing the rules you just have saved.
4. Click on Run and then on View Output. You can change the colors and the final result should look like the

following picture:
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12.2.5 ��� Follow Along: The Mapcalc Tool

The Mapcalc tools is similar to the Raster Calculator of QGIS. You can perform mathematical operation on one or
more raster layers and the final result will be a new layer with the calculated values.
The aim of the next exercise is to extract the values greater than 1000 from the g_dem raster layer.

1. Look for the r.mapcalc module by searching for it in the Filter field of the Modules List tab.
2. Startat,i instrumentul.

The Mapcalc dialog allows you to construct a sequence of analyses to be performed on a raster, or collection
of rasters. You will use these tools to do so:

În ordine, acestea sunt:
• Add map: Add a raster file from your current GRASS mapset.
• Add constant value: Add a constant value to be used in functions, 1000 in this case
• Add operator or function: Add an operator or function to be connected to inputs and outputs, we will use
the operator greater equals than

• Add connection: Connect elements. Using this tool, click and drag from the red dot on one item to the
red dot on another item. Dots that are correctly connected to a connector line will turn gray. If the line
or dot is red, it is not properly connected!

• Select item: Select an item and move selected items.
• Delete selected item: Removes the selected item from the current mapcalc sheet, but not from the mapset
(if it is an existing raster)

• Open: Open an existing file with the operation defined
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• Save: Save all the operation in a file
• Save as: Save all the operations as a new file on the disk.

3. Using these tools, construct the following algorithm:

4. Click on Run and then on View output to see the output displayed in your map:
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This shows all the areas where the terrain is higher than 1000 meters.

Sfat: You can also save the formula you have created and load it in another QGIS project by clicking on the last
button on the GRASS Mapcalc toolbar.

12.2.6 În concluzie

În această lect,ie, am acoperit doar câteva dintre numeroasele instrumente GRASS. Pentru a explora capacităt,ile
GRASS, deschidet,i dialogul Instrumentelor GRASS, apoi derulat,i până la Lista Modulelor. Sau, pentru o abordare
mai structurată, căutat,i în fila Modules Tree, care prezintă instrumentele organizate după tip.
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Folosit,i datele dvs pentru această secţiune. Vet,i avea nevoie de:
• un set de date vectoriale al punctelor de interes, cu numele punctelor s, i multiple categorii
• un set vectorial cu datele drumurilor
• un set vectorial cu date poligonale despre utilizarea terenurilor (folosind limitele de proprietate)
• o imagine a spectrului vizibil (cum ar fi o fotografie aeriană)
• un DEM (descărcabil de la CGIAR-CSI daca nu avet,i unul propriu)

13.1 Crearea unei hărt,i de bază

Înainte de a orice, avet,i nevoie de o hartă de bază, care va asigura un context pentru rezultatele analizei dvs.

13.1.1 Adăugarea unui strat de tip punct

• Adăugat,i stratul de tip punct. În funct,ie de nivelul la care urmat,i cursul, efectuat,i doar ceea ce este listat în
sect,iunea corespunzătoare de mai jos:

���

• Etichetat,i punctele în conformitate cu un atribut unic, cum ar fi numele locurilor. Utilizat,i un font mic pentru
a nu scoate în evident,ă etichetele. Informat,iile trebuie să fie disponibile, dar nu ar trebui să fie principalele
entităt,i de pe hartă.

• Clasificat,i punctele în culori diferite, pe baza unei categorii. De exemplu, categoriile ar putea include „destinat,ie
turistică”, „sect,ie de polit,ie” s, i „centrul oras,ului”.
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���

• Do the same as the ★☆☆ section.
• Clasificat,i dimensiunea punctului după important,ă: cu cât mai semnificativă e o entitate, cu atât mai mare este
punctul. Cu toate acestea, nu depăs, it,i o dimensiune a punctului de 2.00.

• Entităt,ilor care nu sunt localizate într-un singur punct (cum ar fi un nume de provincie/regiune, sau un nume
de oras, , la o scară mai mare), nu le atribuit,i nici un punct.

���

• Nu folosit,i deloc simboluri punctiforme pentru a simboliza stratul. În schimb, folosit,i etichetele centrate pe
puncte; simbolurile punctiforme nu ar trebui să aibă o dimensiune.

• Folosit,i Setări definite cu ajutorul datelor pentru a stiliza etichetele în categorii semnificative.
• Adăugat,i coloanele corespunzătoare pentru datele atributelor, dacă este necesar. Când facet,i acest lucru, nu
creat,i date fictive - mai degrabă, utilizat,i Calculatorul de Câmpuri pentru a popula noile coloane, pe baza
valorilor existente în setul de date.

13.1.2 Adăugarea stratului de tip linie

• Adăugat,i stratul rutier s, i apoi schimbat,i-i simbolistica. Nu etichetat,i drumurile.

���

• Aleget,i pentru simbolistica drumului o linie lată, de culoare deschisă. De asemenea, adăugat,i-i o oarecare
transparent,ă.

���

• Creat,i un simbol cu straturi multiple pentru simboluri. Simbolul rezultat ar trebui să arate ca un drum adevărat.
Avet,i posibilitatea să utilizat,i un simbol simplu pentru aceasta; de exemplu, o linie neagră, cu o linie solidă,
albă s, i subt,ire în centru. Simbolul ar putea arăta chiar s, i mai elaborat, totus, i, harta rezultată nu ar trebui să
arate prea încărcată.

• Dacă setul dvs. de date are o densitate mare de drumuri la scara la care dorit,i să prezentat,i harta, atunci, ar
trebui să avet,i două straturi rutiere: unul cu un simbol mai complex, s, i altul cu un simbol mai simplu, pentru
scări mai mici. (Utilizat,i vizibilitatea în funct,ie de scară, pentru a se face trecerea la scara adecvată.)

• Toate mqrcajele ar trebui să aibă straturi multiple cu simboluri. Utilizat,i simbolurile pentru a le afis,a corect.

���

• Do the same as in the ★★☆ section above.
• În plus, drumurile ar trebui să fie clasificate. Atunci când se utilizează simboluri de teren realiste, fiecare tip
de drum ar trebui să aibă un simbol adecvat; de exemplu, o autostradă ar trebui să apară cu două benzi pentru
fiecare sens.
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13.1.3 Adăugarea stratului de tip poligon

• Adăugat,i stratul de folosint,ă a terenurilor s, i schimbat,i-i simbolistica.

���

• Clasificat,i stratul conform utilizării terenului. Folosit,i culori solide.

���

• Clasificat,i stratul conform utilizării terenurilor. Dacă este cazul, includet,i straturi simbol, diferite tipuri de
simboluri, etc. Avet,i grijă ca rezultatele să aibă intensitate redusă s, i să arate uniform, cu toate acestea. T, inet,i
minte că acesta va fi parte a unui fundal!

���

• Utilizat,i clasificarea bazata pe reguli pentru a clasifica utilizarea terenurilor în categorii generale, cum ar fi
„urban”, „rural”, „rezervat,ie naturală”, etc.

13.1.4 Crearea fundalului raster

• Creat,i o reliefare din DEM, s, i utilizat,i-o ca o suprapunere pentru o versiune clasificată a DEM-ului în sine. At,i
putea folosi, de asemenea, plugin-ul Relief (după cum se arată în lect,ia despre plugin-uri).

13.1.5 Finalizarea hărt, ii de bază

• Utilizând resursele de mai sus, creat,i o hartă de bază folosind unele straturi sau pe toate. Această hartă ar trebui
să includă toate informat,iile de bază necesare pentru a orienta utilizatorul, s, i să fie vizual unificată / „simplă”.

13.2 Analiza datelor

• Căutat,i o proprietate care îndeplines, te anumite criterii.
• Putet,i decide cu privire la propriile criterii, pe care le trebuie să le documentat,i.
• Iată unele indicat,ii pentru aceste criterii:

– proprietatea t,intă ar trebui să aibă (un) anumit tip(uri) de utilizare a terenului
– ar trebui să fie la o anumită distant,ă de drumuri, sau să fie traversată de un drum
– ar trebui să fie la o anumită distant,ă de unele categorii de puncte, cum ar fi un spital, de exemplu

13.2.1 ��� / ���

• Includet,i analiza raster în rezultatele dvs. Luat,i în considerare cel put,in o proprietate derivată din raster, cum
ar fi aspectul sau panta acestuia.
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13.3 Harta Finală

• Utilizat,i Compozit,ii Imprimabile pentru a crea o hartă finală, care încorporează rezultatele analizei dvs.
• Includet,i această hartă într-un document, împreună cu criteriile documentate. Dacă harta a devenit prea ocupată
vizual, datorită strat(ului) adăugat, deselectat,i straturile care vă sunt cel mai put,in necesare.

• Harta dvs. trebuie să includă un titlu s, i o legendă.
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Module: Forestry Application

În modulele 1 până la 13, at,i învăt,at deja destul de multe despre lucrul în QGIS. Dacă vă interesează să aflat,i despre
unele utilizări forestiere ale GIS, urmând acest modul vet,i avea posibilitatea de a aplica ceea ce at,i învăt,at, s, i, în plus,
vi se vor prezenta câteva noi instrumente utile.

Dezvoltarea acestui modul a fost sponsorizată de Uniunea Europeană.

14.1 Lesson: Forestry Module Presentation

Utilizarea acestui modul pentru silvicultură necesită cunos, tint,ele acumulate în modulele de la 1 la 11 din acest manual
de formare. Exercit,iile din următoarele lect,ii presupun că avet,i abilitatea de a face multe dintre operat,iunile de bază
din QGIS, iar instrumentele care nu au mai fost utilizate înainte sunt prezentate acum în detaliu.
În plus, modulul urmează un nivel de bază de-a lungul lect,iilor, astfel încât, dacă avet,i experient,ă anterioară cu QGIS,
putet,i urma instruct,iunile fără probleme.
Ret,inet,i că trebuie să descărcat,i un pachet de date suplimentare pentru acest modul.
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14.1.1 Datele Es, antion pentru Silvicultură

Notă: The sample data used in this module is part of the training manual data set and is available in the
exercise_data\forestry\ folder.

The forestry related sample data (forestry map, forest data), has been provided by the EVO-HAMK forestry school.
The datasets have been modified to adapt to the lessons needs.
The general sample data (aerial images, LiDAR data, basic maps) has been obtained from the National Land Survey
of Finland open data service, and adapted for the purposes of the exercises. The open data file download service can
be accessed in English here.

Atent,ionare: În ceea ce prives, te restul manualului de instruire, acest modul include instruct,iuni privind
adăugarea, s, tergerea s, i modificarea seturilor de date GIS. V-am furnizat seturile de date de instruire în acest
scop. Înainte de a utiliza tehnicile descrise aici asupra datelor dvs., asigurat,i-vă întotdeauna că avet,i copiile de
rezervă corespunzătoare!

14.2 Lesson: Georeferencing a Map

O activitate silvică obis,nuită constă în actualizarea informat,iilor pentru zonele forestiere. Este posibil ca informat,iile
anterioare pentru acea zonă să aibă o vechime de mai mult,i ani, să fi fost colectate în mod analogic (adică, pe hârtie)
sau poate că au fost digitizate, dar tot ce avet,i reprezintă versiunea pe hârtie a datelor inventarului respectiv.
Cel mai probabil, v-at,i dori să utilizat,i aceste informat,ii în GIS, de exemplu, pentru a le compara mai târziu cu
inventarele ulterioare. Acest lucru presupune că va trebui să digitizat,i manual informat,iile, cu ajutorul softului GIS.
Dar, înainte de a începe digitizarea, trebuie făcut,i pas, i important,i, cum ar fi scanarea s, i georeferent,ierea hărt,ii de
hârtie.
Scopul acestei lect,ii: De a afla cum să utilizat,i instrumentul de Georeferent,iere din QGIS.

14.2.1 ��� Scan the map

Prima activitate constă în scanarea hărt,ii. Dacă harta dvs. este prea mare, atunci o putet,i scana pe port,iuni, dar
ret,inet,i că pentru fiecare parte va trebui să reluat,i act,iunile de preprocesare s, i georeferent,iere. Din acest motiv, este
recomandabil să împărt,it,i harta în cel mai mic număr de port,iuni posibile.
If you are going to use a different map that the one provided with this manual, use your own scanner to scan the map
as an image file, a resolution of 300 DPI will do. If your map has colors, scan the image in color so that you can
later use those colors to separate information from your map into different layers (for ex., forest stands, contour lines,
roads…).
For this exercise you will use a previously scanned map, you can find it as rautjarvi_map.tif in the data folder
exercise_data/forestry
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14.2.2 ��� Follow Along: Georeferencing the scanned map

1. Open QGIS and set the project’s CRS to EPSG:3067 - ETRS89 / TM35FIN(E,N) in Project ►
Properties ► CRS, which is the currently used CRS in Finland.

2. Save the QGIS project as map_digitizing.qgs.
You will use the georeferencing tool from QGIS named Georeferencer. To georeference the map:

1. Open the georeference tool, Layer ► Georeferencer….
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2. Add the map image file, rautjarvi_map.tif, as the image to georeference, File ► Open raster.
3. Clic pe OK

Ulterior ar trebui să definit,i setările de transformare pentru georeferent,ierea hărt,ii:
1. Deschidet,i Settings ► Transformation settings.
2. Set the Transformation type to Linear and the Resampling method to Nearest neighbour.

3. Press the Select CRS button next to the Target SRS option and select the EPSG:2392 - KKJ / Finland
zone 2 CRS; it is the CRS that was used in Finland back in 1994 when this map was created.

4. Click the icon next to the Output raster box, go to the folder and create the folder exercise_data\
forestry\digitizing and name the file as rautjarvi_georef.tif.

5. Check Load in QGIS when done

6. Leave the rest of parameters as default.
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7. Clic pe OK
Themap contains several cross-hairs marking the coordinates in themap, we will use those to georeference this image.
You can use the zooming and panning tools as you usually do in QGIS to inspect the image in the Georeferencer’s
window.

1. Zoom in to the left lower corner of the map and note that there is a cross-hair with a coordinate pair, X and Y,
that as mentioned before are in KKJ / Finland zone 2 CRS. You will use this point as the first ground
control point for the georeferencing your map.

2. Selectat,i instrumentul Adăugare punct, apoi facet,i clic pe intersect,ia firelor reticulare (deplasat,i s, i mărit,i după
nevoie).

3. In the Enter map coordinates dialogue write the coordinates that appear in the map (X: 2557000 and Y:
6786000) and their CRS (EPSG:2392 - KKJ / Finland zone 2)

4. Clic pe OK
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Prima coordonată de georeferent,iat deja este gata.
5. Look for other black cross-hairs in the image, they are separated 1000 meters from each other both in North

and East direction. You should be able to calculate the coordinates of those points in relation to the first one.
6. Zoom out in the image and move to the right or the top until you find other cross-hair, and estimate how many

kilometres you have moved. Try to get ground control points as far from each other as possible.
7. Digitize at least three more ground control points in the same way you did the first one. You should end up

with something similar to this:

With already three digitized ground control points you will be able to see the georeferencing error as a red line coming
out of the points. The error in pixels can be seen also in the GCP table in the dX[pixels] and dY[pixels] columns. The
error in pixels should not be higher than 10 pixels. If it is, you should review the points you have digitized and the
coordinates you have entered to find what the problem is. You can use the image above as a guide.
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Once you are happy with your control points, you can save them for later use:
1. Go to File ► Save GCP points as….
2. In the folder exercise_data\forestry\digitizing, name the file rautjarvi_map.tif.

points.
Finally, georeference your map:

1. Go to File ► Start georeferencing.
2. Note that you named the file already as rautjarvi_georef.tif when you edited the Georeferencer

settings.
Now you can see the map in QGIS project as a georeferenced raster. Note that the raster seems to be slightly
rotated, but that is simply because the data is in KKJ / Finland zone 2 and your project is in ETRS89
/ TM35FIN(E,N).

3. To check that your data is properly georeferenced, you can
1. Open the aerial image in the exercise_data\forestry folder, named rautjarvi_aerial.

tif.
2. Your map and this image should match quite well: set the map transparency to 50% and compare it to

the aerial image.

14.2. Lesson: Georeferencing a Map 401



QGIS Training Manual

4. Salvat,i modificările proiectului QGIS, apoi vet,i continua din acest punct cu lect,ia următoare.
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14.2.3 În concluzie

You have now georeferenced a paper map, making it possible to use it as a map layer in QGIS.

14.2.4 Ce urmează?

In the next lesson, you will digitize the forest stands in your map as polygons and add the inventory data to them.

14.3 Lesson: Digitizing Forest Stands

Unless you are going to use your georeferenced map as a simple background image, the next natural step is to digitize
elements from it. You have already done so in the exercises about creating vector data in Lesson: Creating a New
Vector Dataset, when you digitized the school fields. In this lesson, you are going to digitize the forest stands» borders
that appear in the map as green lines but instead of doing it using an aerial image, you will use your georeferenced
map.
Scopul acestei lect,ii: Învăt,area unei tehnici pentru a ajuta activitatea de digitizare a arboretului forestier s, i, în cele
din urmă, adunarea din acesta a datelor de inventar.

14.3.1 ��� Follow Along: Extracting the Forest Stands Borders

Open your map_digitizing.qgs project in QGIS, that you saved from the previous lesson.
O dată ce at,i scanat s, i georeferent,iat harta, at,i putea începe digitizarea, folosind imaginea drept ghid. Acesta ar fi,
probabil, cel mai potrivit mod de lucru, atunci când imaginea pe care trebuie să o digitizat,i reprezintă, de fapt, o
fotografie aeriană.
If what you are using to digitize is a good map, as it is in our case, it is likely that the information is clearly displayed
as lines with different colors for each type of element. Those colors can be relatively easy extracted as individual
images using an image processing software like GIMP. Such separate images can be used to assist the digitizing, as
you will see below.
Primul pas va fi de a utiliza GIMP la obt,inerea unei imagini care cont,ine doar pâlcuri de pădure, reprezentate de
toate acele linii verzui pe care le putet,i vedea în harta originală, scanată:

1. Deschidet,i GIMP (dacă nu l-at,i instalat încă, descărcat,i-l de pe internet sau ceret,i-l profesorului dvs.).
2. Open the original map image, File► Open, rautjarvi_map.tif in the exercise_data/forestry

folder. Note that the forest stands are represented as green lines (with the number of the stand also in green
inside each polygon).
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3. Acum putet,i selecta pixelii din imagine, care reprezintă limitele parcelelor forestiere (pixelii verzui):
1. Deschidet,i instrumentul Select ► By color.
2. With the tool active, zoom into the image (Ctrl + mouse wheel) so that a forest stand line is close

enough to differentiate the pixels forming the line. See the left image below.
3. Facet,i clic s, i glisat,i cursorul mouse-ului în partea din mijloc a liniei, astfel încât instrumentul va colecta

valorile câtorva dintre culorile pixelilor.
4. Eliberat,i butonul mouse-ului s, i as, teptat,i câteva secunde. Din întreaga imagine vor fi selectat,i pixelii care

se potrivesc culorilor colectate de către instrument.
5. Mics,orat,i, pentru a vedea cum au fost selectat,i pixelii verzui din întreaga imagine.
6. Dacă rezultatul nu vă mult,umes, te, repetat,i operat,iunea de clic s, i glisare.
7. Pixelii selectat,i de către dumneavoastră ar trebui să arate în genul imaginii din dreapta-jos.

404 Capitolul 14. Module: Forestry Application



QGIS Training Manual

4. O dată ce at,i terminat select,ia, trebuie să o copiat,i sub forma unui nou strat, care se va salva ulterior ca fis, ier
de tip imagine:
1. Copy (Ctrl+C or Edit ► Copy) the selected pixels.
2. And paste the pixels directly as a new layer (Edit► Paste as► New Layer). GIMP will display the pasted

pixels as a new layer (Pasted Layer) in the Layers panel.
3. Facet,i clic pe pictograma „ochiului” de lângă stratul de imagine original pentru a-l dezactiva, astfel încât

numai Stratul Lipit va fi vizibil:
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5. Finally, select File► Export As…, set Select File Type (By Extension) as a TIFF image, select the digitizing
folder and name it rautjarvi_map_green.tif. Select no compression when asked.

At,i putea face acelas, i proces cu alte elemente din imagine, de exemplu, extrăgând liniile negre care reprezintă
drumurile, sau cele maro care reprezintă liniile de contur ale terenului. Dar pentru noi, arboretul forestier este
suficient.

14.3.2 ��� Try Yourself: Georeference the Green Pixels Image

Ca s, i în lect,ia anterioară, trebuie să georeferent,iat,i această nouă imagine pentru a o putea folosi cu restul de date.
Note that you don’t need to digitize the ground control points anymore because this image is basically the same image
as the original map image, as far as the Georeferencer tool is concerned. Here are some things you should remember:

• This image is also, of course, in KKJ / Finland zone 2 CRS.
• Ar trebui să utilizat,i punctele de control din teren salvate, Fis, ier ► Încărcare puncte GCP.
• Amintit,i-vă să revizuit,i Setările de Transformare.
• Name the output raster as rautjarvi_green_georef.tif in the digitizing folder.

Verificat,i dacă noul raster se potrives, te cu harta originală.

14.3.3 ��� Follow Along: Creating Supporting Points for Digitizing

Având în vedere instrumentele de digitizare din QGIS, v-at,i putea gândi că ar fi de ajutor acros,area la pixelii verzi,
pe durata digitizării. Exact acest lucru îl vet,i face în continuare: vet,i crea puncte din acei pixeli, pentru a le folosi
mai târziu ca ghidaje în digitizarea arboretelor forestiere, când se vor utiliza instrumentele de acros,are disponibile în
QGIS.

1. Folosit,i instrumentul Raster ► Conversie ► Poligonizare (Din Raster în Vector) pentru a vectoriza liniile verzi
în poligoane. Dacă nu vă mai amintit,i cum se efectuează acest lucru, putet,i să reexaminat,i Lesson: Raster to
Vector Conversion.

2. Save as rautjarvi_green_polygon.shp inside the digitizing folder.
3. Mărit,i s, i analizat,i forma poligoanelor. Vet,i obt,ine ceva de genul:
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4. Next option to get points out of those polygons is to get their centroids:
1. Open Vector ► Geometry Tools ► Centroids….

2. Set Input Layer to rautjarvi_green_polygon (the polygon layer you have just created)
3. Set Centroids output to green_centroids.shp file within the folder digitizing

4. Check Open output file after running algorithm

5. Press Run. This will calculate the centroids for the polygons as a new layer and add it to the project.
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5. Now you can remove the rautjarvi_green_polygon layer from the TOC.
6. Change the symbology of the centroids layer as follows:

1. Open the Layer Properties for green_centroids.
2. Merget,i la fila Simbologiei.
3. Set Size to 1.00 and choose Map Units

It is not necessary to differentiate points from each other, you just need them to be there for the snapping tools to use
them. You can use those points now to follow the original lines much easily than without them.
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14.3.4 ��� Follow Along: Digitize the Forest Stands

Now you are ready to start with the actual digitizing work. You would start by creating a vector file of polygon type,
but for this exercise, there is a shapefile with part of the area of interest already digitized. You will just finish digitizing
the half of the forest stands that are left between the main roads (wide pink lines) and the lake:

1. Go to the digitizing folder using your file manager browser.
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2. Drag and drop the forest_stands.shp vector file to your map.
3. Change the new layer’s symbology so that it will be easier to see the polygons that have already been digitized.

1. Set Fill color to green - and change the Opacity to 50%.
2. Select Simple Fill and set Stroke width to 1.00 mm.

Acum, as,a cum vă amintit,i de la modulele din trecut, trebuie să configurat,i s, i activat,i opt,iunile de acros,are:
1. Go to Project ► Snapping options…

2. Press Enable Snapping and select Advanced Configuration
3. Check the green_centroids and forest_stands layers
4. Set Type for each layer to Vertex
5. Set Tolerance for each layer to 10
6. Set Units for each layer to pixels

7. Check Avoid Overlap for the forest_stands layer

8. Press Topological editing

9. Choose Follow Advanced Configuration

10. Close the pop-up

With these snapping settings, whenever you are digitizing and get close enough to one of the points in the
centroids layer or any vertex of your digitized polygons, a pink square will appear on the point that will be
snapped to.

11. Finally, turn off the visibility of all the layers except forest_stands and rautjarvi_georef. Make sure that the
map image has not transparency any more.

A few important things to note before you start digitizing:
• Nu încercat,i să fit,i prea exact,i în digitizarea frontierelor.
• If a border is a straight line, digitize it with just two nodes. In general, digitize using as few nodes as possible.
• Zoom in to close ranges only if you feel that you need to be accurate, for example, at some corners or when
you want a polygon to connect with another polygon at a certain node.

• Folosit,i butonul din mijloc al mouse-ului pentru a mări/mics,ora s, i deplasa, pe durata digitizării.
• Digitizat,i doar un singur poligon la un moment dat.
• După digitizarea unui poligon, scriet,i id-ul pâlcului de pădure pe care îl putet,i vedea în hartă.

Acum putet,i începe digitizarea:
1. Locate the forest stand number 357 in the map window.
2. Select the forest_stands layer.
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3. Click the Toggle Editing button to enable editing

4. Select Add Polygon Feature tool.
5. Start digitizing the stand 357 by connecting some of the dots. Note the pink crosses indicating the snapping.

When you are done:
1. Right click to end digitizing that polygon.
2. Enter the forest stand ID within the form (in this case 357).
3. Clic pe OK

If a form did not appear when you finished digitizing the polygon, go to Settings ► Options ► Digitizing and make
sure that the Suppress attribute form pop-up after feature creation is not checked.
Poligonul dvs. digitizat va arăta astfel:
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Now for the second polygon, pick up the stand number 358. Make sure that Avoid Overlap is checked for the
forest_stands layer (as shown above). This option ensures polygons do not overlap. So, if you digitize over an existing
polygon, the new polygon will be trimmed to meet the border of the existing polygons. You can use this option to
automatically obtain a common border.

1. Începet,i digitizarea standului 358 la unul dintre colt,urile comune cu pâlcul 357.
2. Continue normally until you get to the other common corner for both stands.
3. Finally, digitize a few points inside polygon 357 making sure that the common border is not intersected. See

left image below.
4. Clic-dreapta pentru a termina editarea pâlcului de pădure 358.
5. Enter the ID as 358.
6. Click OK. Your new polygon should have a common border with the stand 357 as you can see in the image

below.
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The part of the polygon that was overlapping the existing polygon has been automatically trimmed and you are left
with a common border - as you intended it to be.

14.3.5 ��� Try Yourself: Finish Digitizing the Forest Stands

Now you have two forest stands ready. And a good idea on how to proceed. Continue digitizing on your own until
you have digitized all the forest stands that are limited by the main road and the lake.
It might look like a lot of work, but you will soon get used to digitizing the forest stands. It should take you about 15
minutes.
During the digitizing you might need to edit or delete nodes, split or merge polygons. You learned about the necessary
tools in Lesson: Feature Topology, now is probably a good moment to go read about them again.
Remember that having Enable topological editing activated, allows you to move nodes common to two polygons so
that the common border is edited at the same time for both polygons.
Rezultatul dvs. va arăta în felul următor:
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14.3.6 ��� Follow Along: Joining the Forest Stand Data

It is possible that the forest inventory data you have for you map is also written in paper. In that case, you would have
to first write that data to a text file or a spreadsheet. For this exercise, the information from the inventory for 1994
(the same inventory as the map) is ready as a comma separated text (csv) file.

1. Open the rautjarvi_1994.csv file from the exercise_data\forestry directory in a text editor
and note that the inventory data file has an attribute called ID that has the numbers of the forest stands. Those
numbers are the same as the forest stands ids you have entered for your polygons and can be used to link
the data from the text file to your vector file. You can see the metadata for this inventory data in the file
rautjarvi_1994_legend.txt in the same folder.

2. Now add this file into the project:

414 Capitolul 14. Module: Forestry Application



QGIS Training Manual

1. Use the Add Delimited Text Layer tool. This is accessed via Layer ► Add Layer ► Add Delimited Text
Layer….

2. Set details in the dialog as follows:

3. Press Add to load the formatted csv file in the project.
3. To link the data from the .csv file with the digitized polygons, create a join between the two layers:

1. Open the Layer Properties for the forest_stands layer.
2. Merget,i la fila Îmbinări.

3. Click Add new join on the bottom of the dialog box.
4. Select rautjarvi_1994.csv as the Join layer
5. Set the Join field to ID
6. Set the Target field to ID
7. Facet,i clic pe Ok de două ori.

The data from the text file should be now linked to your vector file. To see what has happened, select the
forest_stands layer and use Open Attribute Table. You can see that all the attributes from the inventory data
file are now linked to your digitized vector layer.
You will see that the field names are prefixed with rautjarvi_1994_. To change this:

1. Open the Layer Properties for the forest_stands layer.
2. Merget,i la fila Îmbinări.
3. Select Join Layer rautjarvi_1994

4. Click the Edit selected join button to enable editing

5. Under Custom field name prefix remove the prefix name
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The data from the .csv file is just linked to your vector file. To make this link permanent, so that the data is actually
recorded to the vector file you need to save the forest_stands layer as a new vector file. To do this:

1. Right click on forest_stands layer
2. Choose Export ► Save Features As…

3. Set Format to ESRI Shapefile
4. Set file name to forest_stands_1994.shp under the forestry folder

5. To include the new file as a layer in the project, check Add saved file to map

416 Capitolul 14. Module: Forestry Application



QGIS Training Manual

14.3.7 ��� Try Yourself: Adding Area and Perimeter

To finish gathering the information related to these forest stands, you might calculate the area and the perimeter of
the stands. You calculated areas for polygons in Lesson: Supplementary Exercise. Go back to that lesson if you need
to and calculate the areas for the forest stands. Name the new attribute Area and make sure that the values calculated
are in hectares. You could also do the same for the perimeter.
Now your forest_stands_1994 layer is ready and packed with all the available information.
Save your project to keep the current map layers in case you need to come back later to it.

14.3. Lesson: Digitizing Forest Stands 417



QGIS Training Manual

14.3.8 În concluzie

It has taken a few clicks of the mouse but you now have your old inventory data in digital format and ready for use in
QGIS.

14.3.9 Ce urmează?

You could start doing different analysis with your brand new dataset, but you might be more interested in performing
analysis in a dataset more up to date. The topic of the next lesson will be the creation of forest stands using current
aerial photos and the addition of some relevant information to your dataset.

14.4 Lesson: Updating Forest Stands

Now that you have digitized the information from the old inventory maps and added the corresponding information
to the forest stands, the next step is to create the inventory of the current state of the forest.
You will digitize new forest stands using an aerial photo. As with the previous lesson, you will use an aerial Color
Infrared (CIR) photograph. This type of imagery, where the infrared light is recorded instead of the blue light, is
widely used to study vegetated areas.
După digitizarea pâlcurilor de pădure, vet,i adăuga informat,ii, cum ar fi noile constrângeri rezultate din reglementările
de conservare.
The goal for this lesson: To digitize a new set of forest stands from CIR aerial photographs and add information
from other datasets.

14.4.1 ��� Comparing the Old Forest Stands to Current Aerial Photographs

The National Land Survey of Finland has an open data policy that allows you downloading a variety of geographical
data like aerial imagery, traditional topographicmaps, DEM, LiDAR data, etc. The service can be accessed in English
here. The aerial image used in this exercise has been created from two orthorectified CIR images downloaded from
that service (M4134F_21062012 and M4143E_21062012).

1. Open QGIS and set the project’s CRS to ETRS89 / ETRS-TM35FIN in Project ► Properties… ► CRS

2. Add the CIR image rautjarvi_aerial.tif to the project:
1. Go to the exercise_data\forestry\ folder using your file manager browser
2. Drag and drop the file rautjarvi_aerial.tif onto your project

3. Save the QGIS project as digitizing_2012.qgs
Imaginile CIR sunt din 2012. Putet,i compara pâlcurile care au fost create în 1994 cu aproape 20 de ani mai târziu.

1. Add the forest_stands_1994.shp layer created in the previous lesson:
1. Go to the exercise_data\forestry\ folder using your file manager browser
2. Drag and drop the file forest_stands_1994.shp onto your project

2. Set the symbology for the layer so that you can see through your polygons:
1. Right click forest_stands_1994
2. Select Properties

3. Go to the Symbology tab
4. Set Fill color to transparent fill

418 Capitolul 14. Module: Forestry Application

https://asiointi.maanmittauslaitos.fi/karttapaikka/tiedostopalvelu?lang=en


QGIS Training Manual

5. Set Stroke color to purple
6. Set Stroke width to 0.50 mm

3. Examinat,i modul în care vechiul pâlc forestier poate fi interpretat vizual (sau nu) ca o pădure omogenă.
4. Focalizat,i s, i deplasat,i-vă în jurul zonei. Vet,i observa, probabil, că unele dintre pâlcurile vechi de pădure ar

putea corespunde încă cu imaginea, pe când altele nu.
This is a normal situation, as some 20 years have passed and different forest operations have been carried
out (harvesting, thinning…). It is also possible that the forest stands looked homogeneous back in 1992 to
the person who digitized them but as time has passed some forest has developed in different ways. It is also
possible that that forest inventory priorities back then were different from those of today.

Apoi, vet,i crea noi pâlcuri de pădure pentru această imagine, fără a le utiliza pe cele vechi. Mai târziu, le putet,i
compara pentru a vedea diferent,ele.

14.4.2 ��� Interpreting the CIR Image

Let’s digitize the same area that was covered by the old inventory, limited by the roads and the lake. You don’t have
to digitize the whole area, as in the previous exercise you can start with a vector file that already contains most of the
forest stands.

1. Remove the layer forest_stands_1994

2. Add the file exercise_data\forestry\forest_stands_2012.shp to the project
3. Set the styling of this layer so that the polygons have no fill and the borders are visible

1. Open Properties dialog of the forest_stands_2012 layer

2. Go to the Symbology tab
3. Set Fill color to transparent fill
4. Set Stroke color to green
5. Set Stroke width to 0.50 mm
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You can see that the northern section of the inventory area is still missing. Your task is to digitize the missing forest
stands.
Before you start, spend some time reviewing the forest stands already digitized and the corresponding forest in the
image. Try to get an idea about how the stands borders are decided, it helps if you have some forestry knowledge.
Some points to consider:

• Which forests have deciduous species (in Finland these are mostly birch forests) and which ones have conifers
(in this area these are pine or spruce)? In CIR images, deciduous species usually show up as a bright red color
whereas conifers show as a dark green color.
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• How old is the forest? The size of the tree crowns can be identified in the imagery.
• How dense are the different forest stands? A forest stand where a thinning operation has recently been done
would show spaces between the tree crowns and should be easy to differentiate from other forest stands around
it.

• Zonele albăstrui indică terenuri virane, drumuri s, i zone urbane, culturi care nu au ajuns să crească, etc.
• Don’t use zooms too close to the image when trying to identify forest stands. A scale between 1:3 000 and 1:5
000 should be enough for this imagery. See the image below (1:4000 scale):

14.4.3 ��� Try Yourself: Digitizing Forest Stands from CIR Imagery

When digitizing the forest stands, you should try to get forest areas that are as homogeneous as possible in terms of
tree species, forest age, stand density… Don’t be too detailed though, or you will end up making hundreds of small
forest stands - and that would not be useful at all. You should try to get stands that are meaningful in the context of
forestry, not too small (at least 0.5 ha) but not too big either (no more than 3 ha).
With these points in mind, you can now digitize the missing forest stands.

1. Set up the snapping and topology options:
1. Go to Project ► Snapping options…

2. Press Enable Snapping and select Advanced Configuration

3. Check the forest_stands_2012 layer
1. Set Type to Vertex
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2. Set Tolerance to 10
3. Set Units to pixels
4. Check the box under Avoid Overlap

5. Press Topological editing

6. Choose Follow Advanced Configuration

7. Close the pop-up

2. Select the forest_stands_2012 layer on the Layers list

3. Click the Toggle Editing button to enable editing
4. Start digitizing using the same techniques as in the previous lesson. The only difference is that you don’t have

any point layer that you are snapping to. For this area you should get around 14 new forest stands. While
digitizing, fill in the StandID field with numbers starting at 901.

5. Când vet,i definitiva, stratul dvs. ar trebui să arate în felul următor:
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Now you have a new set of polygons showing the different forest stands in 2012 - as interpreted from the CIR images.
However, you are missing the forest inventory data. For that you will need to visit the forest and get some sample
data that you will use to estimate the forest attributes for each of the forest stands. You will see how to do that in the
next lesson.
You can add some extra information about conservation regulations that need to be taken into account for this area.

14.4.4 ��� Follow Along: Updating Forest Stands with Conservation
Information

For the area you are working in, there are some conservation regulations that must be taken into account when doing
the forest planning:

• Two locations of a protected species of Siberian flying squirrel (Pteromys volans) have been identified.
According to the regulation, an area of 15 meters around the spots must be left untouched.

• A riparian forest of special interest that is growing along a stream in the area must be protected. In a visit to
the field, it was found that 20 meters to both sides of the stream must be protected.

You have a vector file containing the information about the squirrel locations and another containing the digitized
stream running from the North area towards the lake.

1. From the exercise_data\forestry\ folder, add the squirrel.shp and stream.shp files to the
project.
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2. Use the Open Attribute Table tool to view the squirrel layer
You can see that there are two locations that are defined as Siberian flying squirrel, and that the area to be
protected is indicated by a distance of 15 meters from the locations.

Let’s more accurately delimitate that area to protect. We will create a buffer around the point locations, using the
protection distance.

1. Deschidet,i Vector ► Geoprocessing Tools ► Buffer.

2. Set Input layer to squirrel

3. Set Distance to 15 meters

4. Set Buffered to exercise_data\forestry\squirrel_15m.shp

5. Check Open output file afer running algorithm

6. Click Run
7. Once the process is completed, click Close
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If you zoom in to the location in the northern part of the area, you will notice that the buffer area extends over two
neighbouring stands. This means that whenever a forest operation takes place in that stand, the protected location
should also be taken into account.

For the protection of the squirrels locations, you are going to add a new attribute (column) to your new forest stands that
will contain information about locations that have to be protected. This information will then be available whenever
a forest operation is planned, and the field team will be able to mark the area that has to be left untouched before the
work starts.
To join the information about the squirrels to your forest stands, you can use the Join attributes by location algorithm:

1. Deschidet,i Vector ► Managementul Datelor ► Îmbină atributele după locat,ie.

2. Set Join to features in to forest_stands_2012

3. In Geometric predicate, check intersect

4. Set By comparing to to squirrel_15m

5. Set Join type as Take attributes of the first matching feature only (one-to-one)
6. Leave unchecked Discard records which could not be joined
7. Set Joined layer to exercise_data\forestry\stands_squirrel.shp

8. Check Open output file afer running algorithm

9. Click Run
10. Once the process is completed, you can Close the dialog.

14.4. Lesson: Updating Forest Stands 425



QGIS Training Manual

Now you have a new forest stands layer, stands_squirrel.shp showing the protection information for the
Siberian flying squirrel.

1. Open the attribute table of the stands_squirrel layer
2. Sort the table by clicking on point_pr field in the table header.
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You can see that there are some forest stands that have the information about the protection locations. The
information in the forest stands data will indicate to the forest manager that there are protection considerations
to be taken into account. Then he or she can get the location from the squirrel dataset, and visit the area to
mark the corresponding buffer around the location so that the operators in the field can avoid disturbing the
squirrels environment.

14.4.5 ��� Try Yourself: Updating Forest Stands with Distance to the Stream

Following the same approach as for the protected squirrel locations you can now update your forest stands with
protection information related to the stream. A few points:

• Remember the buffer is 20 meters around the stream
• You want to have all the protection information in the same vector file, so use stands_squirrel.shp as
the base layer

• Name your output as forest_stands_2012_protect.shp
Once the process is completed, open the attribute table of the output layer and confirm that you have all the protection
information for the riparian forest stands associated with the stream.
When you are happy with the results, save your QGIS project.

14.4.6 În concluzie

You have seen how to interpret CIR images to digitize forest stands. Of course it would take some practice to make
more accurate stands and usually using other information like soil maps would give better results, but you know now
the basis for this type of task. And adding information from other datasets resulted to be quite a trivial task.
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14.4.7 Ce urmează?

The forest stands you digitized will be used for planning forestry operations in the future, but you still need to get
more information about the forest. In the next lesson, you will see how to plan a set of sampling plots to inventory
the forest area you just digitized, and get the overall estimate of forest parameters.

14.5 Lesson: Systematic Sampling Design

At,i digitizat deja un set de poligoane care reprezintă arboretul, totus, i, încă nu avet,i informat,ii despre pădure. Pentru
aceasta, putet,i programa o achizit,ie de date pentru a inventaria întreaga pădure s, i pentru a-i estima parametrii. În
această lect,ie vet,i crea un set sistematic de suprafet,e de probă.
Atunci când începet,i planificarea inventarului forestier, este important să vă definit,i în mod clar obiectivele, tipurile de
suprafet,e de probă care vor fi utilizate, precum s, i datele care vor fi colectate în vederea atingerii obiectivelor. Pentru
fiecare caz în parte, acestea vor depinde de tipul pădurii s, i de scopul managementului; ar trebui să fie planificate cu
atent,ie de către cineva cu cunos, tint,e forestiere. În această lect,ie, vet,i crea un inventar teoretic, bazat pe un design
sistematic al suprafet,elor de probă.
Scopul acestei lect,ii: Crearea planului sistematic al suprafet,elor de probă, pentru o vedere de ansamblu a zonei de
pădure.

14.5.1 Inventarierea Pădurii

There are several methods to inventory forests, each of them suiting different purposes and conditions. For example,
one very accurate way to inventory a forest (if you consider only tree species) would be to visit the forest and make a
list of every tree and their characteristics. As you can imagine this is not commonly applicable except for some small
areas or some special situations.
The most common way to find out about a forest is by sampling it, that is, taking measurements in different locations
at the forest and generalizing that information to the whole forest. These measurements are often made in sample
plots that are smaller forest areas that can be easily measured. The sample plots can be of any size (for ex. 50 m2, 0.5
ha) and form (for ex. circular, rectangular, variable size), and can be located in the forest in different ways (for ex.
randomly, systematically, along lines). The size, form and location of the sample plots are usually decided following
statistical, economical and practical considerations. If you have no forestry knowledge, you might be interested in
reading this Wikipedia article.

14.5.2 ��� Follow Along: Implementing a Systematic Sampling Plot Design

For the forest you are working with, the manager has decided that a systematic sampling design is the most appropriate
for this forest and has decided that a fixed distance of 80 meters between the sample plots and sampling lines will
yield reliable results (for this case, +- 5% average error at a probability of 68%). Variable size plots has been decided
to be the most effective method for this inventory, for growing and mature stands, but a 4 meters fixed radius plots
will be used for seedling stands.
În practică, trebuie pur s, i simplu să reprezentăm suprafet,ele de probă sub formă de puncte, care vor fi folosite ulterior
de către echipele din teren:

1. Open your digitizing_2012.qgs project from the previous lesson.
2. Remove all the layers except for forest_stands_2012.
3. Salvat,i proiectul în forest_inventory.qgs

Acum trebuie să creat,i o ret,ea dreptunghiulară de puncte separate, aflate la 80 de metri unul de altul:

1. Open Vector ► Research Tools Regular points.
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2. Press the drop-down button next to the Input extent field and from the Calculate from Layer menu, select
forest_stands_2012.

3. In the Point spacing/count settings, enter 80 meters.
4. Check the Use point spacing box to indicate that the value represents the distance between the points.
5. Under Regular points, save the output as systematic_plots.shp in the forestry\sampling\

folder.
6. Check Open output file after running algorithm.
7. Press Run.

Notă: The suggested Regular points creates the systematic points starting in the upper-left corner of the extent of
the selected polygon layer. If you want to add some randomness to this regular points, you could use a randomly
calculated number between 0 and 80 (80 is the distance between our points), and then write it as the Initial inset from
corner (LH side) parameter in the tool’s dialog.

Observat,i că instrumentul a folosit întreaga extindere a stratului de arboret, pentru a genera o grilă dreptunghiulară
de puncte. Însă, vă interesează doar acele puncte care se află în interiorul suprafet,ei de pădure (a se vedea imaginile
de mai jos):

1. From the Processing toolbox, open GDAL ► Vector geoprocessing ► Clip vector by mask layer.
2. Select systematic_plots as the Input layer.
3. Set forest_stands_2012 as the Mask layer.
4. Save the Clipped (mask) result as systematic_plots_clip.shp in the forestry\sampling\

folder.
5. Check Open output file after running algorithm.
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6. Press Run.
You have now the points that the field teams will use to navigate to the designed sample plots locations. You can
still prepare these points so that they are more useful for the field work. At the least you will have to add meaningful
names for the points and export them to a format that can be used in their GPS devices.
Let’s start with the naming of the sample plots. If you check the Attribute table for the plots inside the forest area,
you can see that you have the default id field automatically generated by the Regular points tool. Label the points to
see them in the map and consider if you could use those numbers as part of your sample plot naming:

1. Open the Layer Properties ► Labels for the systematic_plots_clip layer.
2. Turn the top menu into Single Labels.
3. For the Value entry, select the field id.
4. Go to the Buffer tab, check the Draw text buffer and set the buffer Size to 1.
5. Clic pe OK

Acum, privit,i etichetele de pe hartă. Putet,i vedea că punctele au fost create s, i numerotate mai întâi de la vest înspre
est s, i apoi de la nord înspre sud. Dacă privit,i iarăs, i la tabela de atribute, vet,i observa că ordinea din tabel urmează,
de asemenea, acest model. Numai dacă avet,i un alt motiv pentru a denumi suprafet,ele de probă într-un mod diferit,
modul de denumire Vest-Est/Nord-Sud urmează o ordine logică s, i reprezintă o opt,iune bună.
Nevertheless, the number values in the id field are not so good. It would be better if the naming would be something
like p_1, p_2.... You can create a new column for the systematic_plots_clip layer:

1. Go to the Attribute table for systematic_plots_clip.

2. Enable the edit mode.

3. Open the Field calculator:
1. Check Create a new field

2. Enter Plot_id as Output field name
3. Set the Output field type to Text (string).
4. In the Expression field, write, copy or construct this formula concat('P_', @row_number ).

Remember that you can also double click on the elements inside the Function list. The concat function
can be found under String and @row_number is under the Variables group.

4. Clic pe OK
5. Dezactivat,i modul de editare s, i salvat,i modificările.

Now you have a new column with plot names that are meaningful to you. For the systematic_plots_clip
layer, change the field used for labeling to your new Plot_id field.
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14.5.3 ��� Follow Along: Exporting Sample Plots as GPX format

The field teams will be probably using a GPS device to locate the sample plots you planned. The next step is to export
the points you created to a format that your GPS can read. QGIS allows you to save your point and line vector data
in GPS eXchange Format (GPX), which is an standard GPS data format that can be read by most of the specialized
software. You need to be careful with selecting the CRS when you save your data:

1. Right-click systematic_plots_clip layer and select Export ► Save features as….

2. În Format selectat,i GPS eXchange Format [GPX].
3. Save the output File name as plots_wgs84.gpx in the forestry\sampling\ folder.
4. În CRS aleget,i CRS-ul Selectat.
5. Browse for EPSG:4326 - WGS 84.

Notă: The GPX format accepts only this CRS, if you select a different one, QGIS will give no error but you
will get an empty file.

6. Clic pe OK
7. In the dialog that opens, select only the waypoints layer (the rest of the layers are empty).

The inventory sample plots are now in a standard format that can be managed by most of the GPS software. The field
teams can now upload the locations of the sample plots to their devices. That would be done by using the specific
devices own software and the plots_wgs84.gpx file you just saved. Other option would be to use the GPS Tools
plugin but it would most likely involve setting the tool to work with your specific GPS device. If you are working with
your own data and want to see how the tool works you can find out information about it in the section working_gps
in the QGIS User Manual.
Salvat,i acum proiectul dvs. QGIS.
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14.5.4 În concluzie

You just saw how easily you can create a systematic sampling design to be used in a forest inventory. Creating other
types of sampling designs will involve the use of different tools within QGIS, spreadsheets or scripting to calculate
the coordinates of the sample plots, but the general idea remains the same.

14.5.5 Ce urmează?

In the next lesson you will see how to use the Atlas capabilities in QGIS to automatically generate detailed maps that
the field teams will be using to navigate to the sample plots assigned to them.

14.6 Lesson: Creating Detailed Maps with the Atlas Tool

Proiectarea sistematică de es,antionare este gata, iar echipele de teren s, i-au încărcat coordonatele GPS în dispozitivele
de navigare. Există, de asemenea, un formular pentru date, în care se vor colecta informat,iile măsurate pentru fiecare
schit,ă. Pentru a găsi mai us,or drumul spre fiecare parcelă, s-au solicitat o serie de hărt,i detaliate, în cazul în care
unele informat,ii din teren pot fi văzute în mod clar, împreună cu un subset mic de schit,e s, i câteva informat,ii despre
zonă. Putet,i utiliza instrumentul Atlas pentru a genera automat o serie de hărt,i, având un format comun.
Scopul acestei lect,ii: Aflat,i cum să utilizat,i instrumentul Atlas în QGIS, pentru a genera hărt,i tipăribile detaliate, în
scopul sprijinirii activităt,ii de inventariere în teren.

14.6.1 ��� Follow Along: Preparing the Print Layout

Înainte de a putea automatiza hărt,ile detaliate ale zonei forestiere s, i schit,ele noastre de es,antionare, trebuie să creăm
un s,ablon cu toate elementele pe care le considerăm utile în munca de teren. Desigur, cea mai importantă va fi
o stilizare corectă, dar, după cum at,i văzut mai înainte, va trebui să adăugat,i s, i o mult,ime de alte elemente care
completează harta tipărită.

1. Deschidet,i proiectul QGIS din lect,ia anterioară forest_inventory.qgs. Ar trebui să avet,i cel put,in
următoarele straturi:

• forest_stands_2012 (cu o transparent,ă de 50%, umplere verde s, i linii de margine de culoare verde mai
închis)

• systematic_plots_clip

• rautjarvi_aerial

2. Salvat,i proiectul sub un nume nou, map_creation.qgs.
To create a printable map, remember that you use the Layout Manager:

1. Open Project ► Layout Manager….
2. In the Layout manager dialog:

1. Under New from template, press the Create… button next to the Empty layout entry
2. Name your print layout forest_map.
3. Press OK. A new print layout is created and opened, showing a blank paper.

3. In the print Layout window, ensure properties are set for an A4 paper:
1. Right-click over the paper and select Page properties. The Page properties panel is open on the right side

of the layout.
2. Asigurat,i-vă că Dimensiunea este A4.
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3. Asigurat,i-vă că Orientarea este Peisaj.
4. Enable the Layout tab next to the Page properties panel and set Export resolution to 300 dpi.

Composing a map is easier if you make use of the canvas grid to position the different elements. Review the settings
for the layout grid:

1. In the Layout tab expand the Guides and Grid region.
2. Check that Grid spacing is set to 10 mm and that Snap tolerance is set to 5 px.

Trebuie să activat,i folosirea grilei:
1. Deschidet,i meniul :menuselection:`Vizualizare
2. Bifat,i Afis,area grilei.
3. Bifat,i Acros,are la grilă.
4. Notice that options for using Guides are checked by default, which allows you to see guiding lines when you

are moving elements in the layout.
5. Now you can start to add elements to your layout. Add first a map element so you can review how the map

canvas looks as you will be making changes in the layers symbology:

1. Click on the Add Map button.
2. T, inet,i apăsat butonul stâng al mouse-ului s, i trasat,i un dreptunghi în care să încadrat,i cea mai mare parte

a hărt,ii.

Observat,i modul în care cursorul mouse-ului se acros,ează la grila canevasului. Utilizat,i această funct,ie atunci când
adăugat,i alte elemente. Dacă dorit,i să avet,i mai multă acuratet,e, schimbat,i setările de Spat,iere ale grilei. Dacă
dintr-un motiv oarecare nu mai dorit,i acros,area la grilă la un moment dat, putet,i întotdeauna bifa sau debifa meniul
Vizualizare.
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14.6.2 ��� Follow Along: Adding Background Map

Leave the layout open but go back to the map. Let’s add some background data and create some styling so that the
map content is as clear as possible.

1. Add the background raster basic_map.tif that you can find in the exercise_data\forestry\
folder.

2. If prompted select the ETRS89 / ETRS-TM35FIN CRS for the raster.
După cum putet,i vedea, harta de fundal este deja stilizată. Acest tip de raster cartografic gata de utilizare este
foarte frecvent. El este creat din date vectoriale, stilizate într-un format standard s, i stocate ca un raster, as,a că
nu trebuie să vă îngrijoreze obt,inerea unui rezultat bun.

3. Acum mărit,i schit,ele dvs., astfel încât să putet,i vedea doar aproximativ patru sau cinci linii de parcele.
The current styling of the sample plots is not the best:

While during the last exercises, the white buffer was OK on top of the aerial image, now that the background image
is mostly white you barely can see the labels. But how does it look in the print layout? Let’s check it:

1. Go to the print layout window.

2. Use the Select/Move item button to select the map element in the layout.
3. Merget,i la fila Proprietăt,ile itemului tab.

4. Click on Set map extent to match main canvas extent.

5. If you need to refresh the element, click on Update map preview.
Obviously this is not good enough; you want to make the plot numbers as clearly visible as possible for the field teams.

14.6.3 ��� Try Yourself: Changing the Symbology of the Layers

At,i exersat simbologia cu Modulul;: Crearea s, i Explorarea unei Hărt,i de Bază, s, i etichetarea cu Module: Classifying
Vector Data. Revenit,i la acestemodule dacă trebuie să vă reamintit,i unele dintre opt,iunile s, i instrumentele disponibile.
Scopul dvs. este de a afis,a locat,iile loturilor s, i numele lor cât mai clar, dar întotdeauna să fie posibilă vizualizarea
elementelor din fundalul hărt,ii. Vă putet,i orienta după această imagine:
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You will use later the the green styling of the forest_stands_2012 layer. In order to keep it, and have a
visualization of it that shows only the stand borders:

1. Right click on forest_stands_2012 and select Duplicate
2. Obt,inet,i un nou strat numit forest_stands_2012 copy pe care îl putet,i utiliza pentru a defini un stil

diferit, de ex.: fără umplere s, i cu margini ros, ii.
Acum avet,i două vizualizări diferite ale parcelelor împădurite s, i putet,i decide pe care să o afis,at,i pentru harta
dvs. detaliată.

3. Go back to the print layout window often to see what the map would look like. For the purposes of creating
detailed maps, you are looking for a symbology that looks good not at the scale of the whole forest area (left
image below) but at a closer scale (right image below). Remember to use Update map preview and Set map
extent to match main canvas extent whenever you change the zoom in your map or the layout.
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14.6.4 ��� Try Yourself: Create a Basic Map Template

1. Once you have a symbology you are happy with, you are ready to add some more information to your printed
map. Add at least the following elements:

• Titlu.
• O scară grafică.
• Cadrul grilei pentru harta dvs.
• Coordonate situate pe părt,ile laterale ale grilei.

2. You have created a similar layout already inModule: Laying out the Maps. Go back to that module as you need.
You can look at this example image for reference:

3. Exportat,i harta dvs. ca o imagine s, i privit,i-o.
1. Layout ► Export as Image….
2. Use for example the JPG format.

Iată cum va arăta atunci la tipărire.

14.6.5 ��� Follow Along: Adding More Elements to the Print Layout

As,a cum probabil at,i observat în imaginea hărt,ii s,ablon propusă, există o mult,ime de loc în partea dreaptă a
canevasului. Haidet,i să vedem ce altceva ar putea merge acolo. Pentru scopul hărt,ii noastre, o legendă nu este
cu adevărat necesară, dar o imagine de ansamblu a hărt,ii s, i nis, te casete de text ar putea adăuga valoare hărt,ii.
Harta de ansamblu va ajuta echipele de teren să plaseze harta detaliată în interiorul suprafet,ei generală a pădurii:

1. Adăugat,i un alt element de hartă pe canevas, chiar sub textul din titlu.
2. În fila Proprietăt,ilor elementului, deschidet,i caseta cu derulare verticală Overview.
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3. Punet,i Overview frame pe Map 0. Acest lucru creează un dreptunghi umbrit deasupra hărt,ii mici, care
reprezintă extinderea vizibilă în harta mai mare.

4. Check also the Frame option with a black color and a Thickness of 0.30.

Notice that your overview map is not really giving an overview of the forest area which is what you want. You
want this map to represent the whole forest area and you want it to show only the background map and the
forest_stands_2012 layer, and not display the sample plots. And also you want to lock its view so it does
not change anymore whenever you change the visibility or order of the layers.

1. Go back to the map, but don’t close the Print Layout.
2. Right click the forest_stands_2012 layer and click on Zoom to Layer Extent.
3. Dezactivat,i toate straturile, cu except,ia basic_map s, i forest_stands_2012.
4. Expand the Manage map themes tool on the Layers panel and select Add theme.
5. Name it basic_overview.
6. Go back to the print layout.
7. With the small map selected, click the Set map extent to match main canvas extent to set its extents to what you

can see in the map window.
8. Lock the view for the overview map by checking Follow map theme and selecting basic_overview under

Main properties.
Now your overview map is more what you expected and its view will not change anymore. But, of course, now your
detail map is not showing anymore the stand borders nor the sample plots. Let’s fix that:

1. Merget,i din nou la fereastra hărt,ii s, i selectat,i straturile pe care le dorit,i să fie vizibile
(systematic_plots_clip, forest_stands_2012 copy s, i Basic_map).

2. Transfocat,i iarăs, i, pentru a avea vizibile doar câteva linii ale parcelelor.
3. Go back to the Print Layout window.

438 Capitolul 14. Module: Forestry Application



QGIS Training Manual

4. Select the bigger map in your layout.
5. In Item properties click on Update preview and Set map extent to match main canvas extent.

Observat,i că numai harta mai mare afis,ează vizualizarea curentă a hărt,ii, iar harta mai mică de ansamblu păstrează
aceeas, i vedere pe care at,i blocat-o.
Ret,inet,i, de asemenea, că o vedere de ansamblu afis,ează un cadru umbrit pentru extinderea prezentată în harta
detaliată.

S, ablonul hărt,ii dvs. este aproape gata. Adăugat,i în hartă cele două casete de text de mai jos, una cont,inând textul
«Zona detaliată a hărt,ii:», iar cealaltă «Observat,ii:». Plasat,i-le as,a cum se vede în imaginea de mai sus.
Putet,i adăuga, de asemenea, o săgeată a Nordului la harta generală:

1. Select the Add North Arrow tool.
2. Click and drag a rectangle at the upper right corner of the overview map.
3. In Item properties Check SVG image

4. Browse SVG Browser ► SVG Groups for an arrow image.
5. Under Image rotation, check the Sync with map and select Map 1 (the overview map).
6. Redimensionat,i imaginea săget,ii la o dimensiune care arată bine pe hărt,ile mici.

The basic map layout is ready, now you want to make use of the Atlas tool to generate as many detail maps in this
format as you consider necessary.
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14.6.6 ��� Follow Along: Creating an Atlas Coverage

Acoperirea Atlasului reprezintă doar un strat vectorial care va fi folosit pentru a genera hărt,ile detaliate, o hartă pentru
fiecare entitate din aria de acoperire. Pentru a vă face o idee despre aceasta, iată un set complet de hărt,i detaliate
pentru zona de pădure:

Acoperirea poate fi orice strat existent, dar, de obicei, are mai mult sens crearea unuia în acest scop specific. Haidet,i
să creăm o ret,ea de poligoane care acoperă zona de pădure:

1. In the QGIS map view, open Vector ► Research Tools ► Create grid.
2. Setat,i instrumentul as,a cum se arată în această imagine:
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3. Salvat,i rezultatul ca atlas_coverage.shp.
4. Style the new atlas_coverage layer so that the polygons have no filling.

Noile poligoane acoperă întreaga zonă de pădure s, i vă conferă o idee despre ceea ce va cont,ine fiecare hartă (creată
din fiecare poligon).
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14.6.7 ��� Follow Along: Setting Up the Atlas Tool

Ultimul pas este de a crea instrumentul Atlas:
1. Go back to the print layout.
2. În panoul din dreapta, merget,i la fila Atlas generation.
3. Setat,i opt,iunile după cum urmează:
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That tells the Atlas tool to use the features (polygons) inside atlas_coverage as the focus for every detail
map. It will output one map for every feature in the layer. The Hidden coverage layer tells the Atlas to not
show the polygons in the output maps.

Mai trebuie să fie făcut un lucru. Trebuie să indicat,i Atlasului care element va fi actualizat pentru fiecare hartă de
ies, ire. Până acum, probabil că at,i ghicit că harta care urmează a fi schimbată pentru fiecare entitate, este cea pe
care at,i pregătit-o să cont,ină vederile detaliate ale parcelelor es,antion, ea reprezentând elementul cel mai mare de pe
canevas:

1. Select the bigger map element (Map 0).
2. Merget,i la fila Proprietăt,ile itemului tab.
3. În listă, bifat,i Controlat de atlas.
4. And set the Marging around feature to 10%. The view extent will be 10% bigger than the polygons, which

means that your detail maps will have a 10% overlap.
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Acum putet,i utiliza instrumentul de vizualizare pentru Atlas, pentru a revizui ceea ce vor arăta hărt,ile:

1. Activat,i previzualizarea Atlasului folosind butonul sau, în cazul în care bara de instrumente nu este vizibilă,
via Atlas ► Previzualizare Atlas.

2. Putet,i folosi săget,ile din bara de instrumente a Atlasului, sau din meniul Atlas, pentru a vă deplasa printre
hărt,ile care vor fi create.

Note that some of them cover areas that are not interesting. Let’s do something about it and save some trees by not
printing those useless maps.

14.6.8 ��� Follow Along: Editing the Coverage Layer

Pe lângă eliminarea poligoanelor pentru acele zone care nu sunt interesante, putet,i personaliza, de asemenea, etichetele
din harta dvs., prin generarea cont,inutului acestora din Tabela de atribute a stratului de acoperire.

1. Merget,i înapoi la vizualizarea hărt,ii.
2. Enable editing for the atlas_coverage layer.
3. Selectat,i poligoanele care sunt evident,iate (în galben) în imaginea de mai jos.
4. Eliminat,i poligoanele selectate.
5. Dezactivat,i editarea s, i salvat,i modificările.
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You can go back to the print layout and check that the previews of the Atlas use only the polygons you left in the
layer.
Stratul de acoperire pe care îl utilizat,i, încă nu cont,ine informat,ii utile, pe care să le putet,i folosi la personalizarea
cont,inutului etichetelor din hartă. Primul pas este de a le crea; în acest scop putet,i adăuga, de exemplu, un cod de
zonă pentru zonele poligonale, s, i un câmp cu câteva observat,ii pe care să le aibă în vedere echipele din teren:

1. Open the Attribute table for the atlas_coverage layer.
2. Activează editarea.

3. Folosit,i calculatorul pentru a crea s, i popula următoarele două câmpuri.
4. Create a field named Zone of typeWhole number (integer).
5. In the Expression box write/copy/construct @row_number.
6. Create another field named Remarks, of type Text (string) and a width of 255.
7. In the Expression box write 'No remarks.'. This will set all the default value for all the polygons.

The forest manager will have some information about the area that might be useful when visiting the area. For
example, the existence of a bridge, a swamp or the location of a protected species. The atlas_coverage layer is

14.6. Lesson: Creating Detailed Maps with the Atlas Tool 445



QGIS Training Manual

probably in edit mode still, add the following text in the Remarks field to the corresponding polygons (double click
the cell to edit it):

• For the Zone 2: Bridge to the North of plot 19. Siberian squirrel between p_13
and p_14.

• For the Zone 6: Difficult to transit in swamp to the North of the lake.`
• For the Zone 7: Siberian squirrel to the South East of p_94.

• Dezactivează editarea s, i salvează modificările.
Almost ready, now you have to tell the Atlas tool that you want some of the text labels to use the information from
the atlas_coverage layer’s attribute table.

1. Go back to the Print Layout.
2. Select the text label containing Detailed map....
3. Setat,i dimensiunea Fontului la 12.
4. Ducet,i cursorul la sfârs, itul textului din etichetă.
5. In the Item properties tab, inside the Main properties click on Insert or Edit an Expression….
6. In the Function list double-click on the field Zone under Field and Values.
7. Clic pe OK
8. The text inside the box in the Item properties should showDetail map inventory zone: [% "Zone"

%]. Note that the [% "Zone" %] will be substituted by the value of the field Zone for the corresponding
feature from the layer atlas_coverage.

9. Testat,i cont,inutul etichetei, prin vizualizarea unor diferite hărt,i din Atlas.
10. Do the same for the labels with the text Remarks: using the field with the zone information. You can leave a

break line before you enter the expression. You can see the result for the preview of zone 2 in the image below:
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11. Utilizat,i previzualizarea din Atlas pentru a naviga prin toate hărt,ile care vor fi create în curând!

14.6.9 ��� Follow Along: Printing the Maps

Nu în ultimul rând, imprimat,i sau exportat,i hărt,ile în fis, iere imagine sau PDF. Avet,i posibilitatea să utilizat,i Atlas►
Export Atlas as Images… sau Atlas► Export Atlas as PDF…. În prezent, formatul de export SVG nu funct,ionează în
mod corespunzător s, i va da un rezultat slab.
Haidet,i să exportăm hărt,ile într-un singur PDF pe care îl putet,i trimite la biroul teritorial pentru imprimare:

1. Merget,i la fila Atlas generation, în panoul din dreapta.
2. Sub Output bifat,i Single file export when possible. Acest lucru va pune toate hărt,ile împreună într-un fis, ier PDF;

în cazul în care această opt,iune nu este bifată, vet,i obtine câte un fis, ier pentru fiecare hartă.
3. Open Layout ► Export as PDF….
4. Save the PDF file as inventory_2012_maps.pdf in your exercise_data\forestry\

samplig\map_creation\ folder.
5. Deschidet,i fis, ierul PDF pentru a verifica dacă totul a mers cum era de as, teptat.
6. Putet,i crea la fel de us,or imagini separate pentru fiecare hartă (amintit,i-vă să debifat,i crearea unui singur fis, ier),

unde putet,i vedea miniaturile imaginilor care vor fi create:

7. In the Print Layout, press Save in order to save your print layout changes in the project. This also saves the
project file. You can reopen the project at any time and run or edit the atlas.
It is also possible to save your map as a layout template as forestry_atlas.qpt in your
exercise_data\forestry\map_creation\ folder. Use Layout ► Save as Template. You will be
able to use this template again and again in other projects.

8. Close the Print Layout and the project.

14.6.10 În concluzie

At,i reus, it să creat,i o hartă s,ablon, care poate fi folosită pentru a genera automat hărt,i detaliate, în scopul us,urării
utilizării în teren. După cum at,i observat, acest lucru nu a fost o sarcină us,oară, dar beneficiul va veni atunci când va
trebui să creat,i hărt,i similare pentru alte regiuni, unde putet,i utiliza s,ablonul pe care tocmai l-at,i salvat.
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14.6.11 Ce urmează?

In the next lesson, you will see how you can use LiDAR data to create a DEM and then use it to enhance your data
and maps visibility.

14.7 Lesson: Calculating the Forest Parameters

Estimarea parametrilor unei păduri reprezintă scopul inventarului forestier. Continuând exemplul din lect,ia
precedentă, vom utiliza informat,iile de inventar adunate din teren pentru a calcula parametrii, mai întâi pentru întreaga
pădure, iar ulterior pentru pâlcurile digitizate anterior.
Scopul acestei lect,ii: De a calcula parametrii forestieri la nivel general s, i la nivel de pâlc.

14.7.1 ��� Follow Along: Adding the Inventory Results

Echipele din teren au vizitat pădurea s, i, cu ajutorul informat,iilor pe care le-at,i furnizate dvs., au adunate informat,ii
despre fiecare parcelă de pădure.
Most often the information will be collected into paper forms in the field, then typed to a spreadsheet. The sample
plots information has been condensed into a .csv file that can be easily open in QGIS.
Continue with the QGIS project from the lesson about designing the inventory, you probably named it
forest_inventory.qgs.
În primul rând, adăugat,i măsurătorile din suprafet,ele de probă în proiectul dvs. QGIS:

1. Go to Layer ► Add Layer ► Add Delimited Text Layer….
2. Browse to the file systematic_inventory_results.csv located in exercise_data/

forestry/results/.
3. Asigurat,i-vă că este selectată opt,iunea Point coordinates.
4. Set the fields for the coordinates to the X and Y fields.
5. Clic pe OK
6. When prompted, select ETRS89 / ETRS-TM35FIN as the CRS.
7. Deschidet,i noul Tabel de Atribute s, i aruncat,i o privire datelor.

You can read the type of data that is contained in the sample plots measurements in the text file
legend_2012_inventorydata.txt located in the exercise_data/forestry/results/ folder.
The systematic_inventory_results layer you just added is actually just a virtual representation of the
text information in the .csv file. Before you continue, convert the inventory results to a real spatial dataset:

1. Right click on the systematic_inventory_results layer.
2. Browse to exercise_data/forestry/results/ folder.
3. Name the file sample_plots_results.shp.
4. Bifat,i caseta Add saved file to map.
5. Remove the systematic_inventory_results layer from your project.
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14.7.2 ��� Follow Along: Whole Forest Parameters Estimation

You can calculate the averages for this whole forest area from the inventory results for the some interesting
parameters, like the volume and the number of stems per hectare. Since the systematic sample plots represent
equal areas, you can directly calculate the averages of the volumes and number of stems per hectare from the
sample_plots_results layer.
Putet,i calcula media unui câmp dintr-un strat vectorial, folosind instrumentul Basic statistics:

1. Open Vector ► Analysis Tools ► Basic statistics for Fields.
2. Select sample_plots_results as the Input Vector Layer.
3. Select Vol as Target field.
4. Clic pe OK

The average volume in the forest is 135.2 m3/ha.
You can calculate the average for the number of stems in the same way, 2745 stems/ha.

14.7.3 ��� Follow Along: Estimating Stand Parameters

Putet,i folosi acelas, i es,antion de date pentru a calcula estimări pentru diferitele pâlcuri de pădure digitizate anterior.
Despre unele pâlcuri nu există date s, i, de aceea, pentru ele nu se vor obt,ine informat,ii. S-ar fi putut prevedea o
culegere de date suplimentară, la momentul planificării inventarului sistematic, în cadrul căreia echipele din teren să
fi efectuat măsurători. Sau, ar putut fi trimisă ulterior o echipă în teren pentru a estima pâlcurile omise, în scopul
completării inventarul. Chiar s, i as,a, vet,i obt,ine informat,ii pentru un număr bun de pâlcuri folosind doar parcelele
planificate.
Trebuie să obt,inet,i media parcelelor care se încadrează în fiecare pâlc forestier. Atunci când dorit,i să combinat,i
informat,iile, în funct,ie de locat,iile relative ale acestora, vet,i efectua o îmbinare spat,ială:

1. Deschidet,i instrumentul Vector ► Data Management ► Join attributes by location.
2. Set forest_stands_2012 as the Target vector layer. The layer you want the results for.
3. Set sample_plots_results as the Join vector layer. The layer you want to calculate estimates from.
4. Bifat,i Take summary of intersecting features.
5. Bifat,i pentru a calcula doar Media.
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6. Name the result as forest_stands_2012_results.shp and save it in the exercise_data/
forestry/results/ folder.

7. La final, selectat,i Keep all records…, astfel încât să putet,i verifica mai târziu care locat,ie nu a primit informat,ii.
8. Clic pe OK
9. Acceptat,i adăugarea noului strat la proiectul dvs. când vi se solicită.
10. Închidet,i instrumentul de Îmbinare a atributelor după locat,ie.

Open the Attribute table for forest_stands_2012_results and review the results you got. Note that a number of forest
stands have NULL as the value for the calculations, those are the ones having no sample plots. Select them all and
view them in the map, they are some of the smaller stands:
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Let’s calculate now the same averages for the whole forest as you did before, only this time you will use the averages
you got for the stands as the bases for the calculation. Remember that in the previous situation, each sample plot
represented a theoretical stand of 80x80 m. Now you have to consider the area of each of the stands individually
instead. That way, again, the average values of the parameters that are in, for example, m3/ha for the volumes are
converted to total volumes for the stands.
Trebuie să calculat,i mai întâi ariile pentru locat,ii, iar apoi volumele totale s, i numărul de tulpini pentru fiecare dintre
acestea:

1. Activat,i editarea în Tabela de Atribute.
2. Deschidet,i Calculatorul de câmpuri.
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3. Create a new field called area.
4. Set the Output field type to Decimal number (real).
5. Set the Precision to 2.
6. In the Expression box, write $area / 10000. This will calculate the area of the forest stands in ha.
7. Clic pe OK

Acum calculat,i un câmp cu volumele totale s, i numărul estimat de tulpini, pentru fiecare element:
1. Name the fields s_vol and s_stem.
2. Valorile numerice din câmpurile pot fi de tip întreg sau chiar s, i de tip real.
3. Use the expressions "area" * "MEANVol" and "area" * "MEANStems" for total volumes and total

stems respectively.
4. Închidet,i editările, după ce at,i încheiat.
5. Dezactivat,i editarea.

În situat,ia anterioară, zonele reprezentate de fiecare parcelă es,antion au fost aceleas, i, astfel încât a fost suficientă
calcularea mediei parcelelor es,antion. Acum, pentru a calcula estimările, trebuie să împărt,im suma volumelor
pâlcurilor, sau numărul de tulpini, la suma suprafet,elor acelor pâlcuri care cont,in informat,ii.

1. In the Attribute table for the forest_stands_2012_results layer, select all the stands containing
information.

2. Open Vector ► Analysis Tools ► Basic statistics for fields.
3. Select the forest_stands_2012_results as the Input layer.
4. Select area as Field to calculate statistics on.
5. Check the Selected features only
6. Clic pe OK
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As you can see, the total sum of the stands» areas is 66.04 ha. Note that the area of the missing forest stands is
only about 7 ha.
In the same way, you can calculate that the total volume for these stands is 8908 m3/ha and the total number of
stems is 179594 stems.
Folosind informat,iile din pâlcurile forestiere, în locul folosirii directe a celor din parcelele es,antion, rezultă
următoarele estimări medii:

• 184.9 m3/ha and
• 2719 stems/ha.

Salvat,i proiectul în forest_inventory.qgs.

14.7.4 În concluzie

At,i reus, it să efectuat,i estimări pentru întreaga pădure, folosind informat,iile din parcelele de probă, fără a t,ine
seama de caracteristicile forestiere, precum s, i utilizând interpretarea imaginilor aeriene ale pâlcurilor forestiere. De
asemenea, at,i primit informat,ii valoroase despre anumite pâlcuri, care pot fi utilizate pentru gestionarea pădurilor în
anii următori.
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14.7.5 Ce urmează?

În lect,ia următoare, vet,i crea mai întâi un fundal reliefat, dintr-un set de date LiDAR, care va fi folosit pentru a pregăti
prezentarea pe hartă a rezultatelor forestiere, pe care tocmai le-at,i calculat.

14.8 Lesson: DEM from LiDAR Data

Putet,i îmbunătăt,i aspectul hărt,i folosind diverse imagini de fundal. At,i putea folosi harta de bază sau imaginile
aeriene pe care le-at,i utilizat înainte, dar un raster cu relieful terenului va arata mai frumos în anumite situat,ii.
Vet,i folosi LAStools pentru a extrage un DEM dintr-un set de date LIDAR, s, i apoi să creat,i un raster al reliefului pe
care să-l folosit,i mai târziu în prezentarea hărt,ii dvs.
Scopul acestei lect,ii: Instalarea LAStools s, i calcularea unui DEM din datele LiDAR s, i dintr-un raster cu relieful.

14.8.1 ��� Follow Along: Installing Lastools

Managing LiDAR data within QGIS is possible using the Processing framework and the algorithms provided by
LAStools.
Putet,i obt,ine un model de elevat,ie digital (DEM), dintr-un nor de puncte LiDAR, iar ulterior se poate crea un raster
al umbririi reliefului, care este vizual mai intuitiv în scopuri de prezentare. În primul rând, va trebui să configurat,i
setările cadrului de lucru Processing pentru a lucra în mod corespunzător cu LAStools:

• Închidet,i QGIS, dacă at,i început deja.
• Un plugin LiDAR vechi ar putea fi deja instalat în sistemul dvs., în dosarul C:/Program Files/QGIS
Valmiera/apps/qgis/python/plugins/processing/.

• Dacă avet,i un folder denumit lidar, s, terget,i-l. Acest lucru este valabil pentru anumite instalări de QGIS 2.2
s, i 2.4.
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• Go to the exercise_data\forestry\lidar\ folder, there you can find the file
QGIS_2_2_toolbox.zip. Open it and extract the lidar folder to replace the one you just deleted.

• If you are using a different QGIS version, you can see more installation instructions in this tutorial.
Now you need to install the LAStools to your computer. Get the newest lastools version here and extract the content of
the lastools.zip file into a folder in your system, for example, C:\lastools\. The path to the lastools
folder cannot have spaces or special characters.

Notă: Citit,i fis, ierul LICENSE.txt din interiorul folderului lastools. Unele dintre aceste instrumente LAS
sunt gratuite, pe când altele nu, acestea necesitând licent,iere pentru utilizare comercială s, i guvernamentală. În scopuri
educat,ionale sau de evaluare, putet,i utiliza s, i testa LAStools oricât de mult dorit,i.

Plugin-ul s, i algoritmii curent,i sunt de acum instalat,i în computerul dvs., aproape gata de utilizare, fiind nevoie doar
să configurat,i cadrul de lucru Processing pentru a începe utilizarea lor:

• Deschidet,i un nou proiect în QGIS.
• Setat,i ETRS89 / ETRS-TM35FIN ca CRS al proiectului.
• Salvat,i proiectul ca forest_lidar.qgs.

Pentru a seta LAStools în QGIS:
• Merget,i la Processing ► Options and configuration.
• În dialogul Opt,iunilor de procesare, merget,i la Furnizori s, i apoi la Instrumente pentru datele LiDAR.
• Bifat,i Activare.
• Pentru Folderul LAStools setat,i c:\lastools\ (sau folderul în care at,i extras LAStools).
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14.8.2 ��� Follow Along: Calculating a DEM with LAStools

At,i folosit deja bara de instrumente Processing din Lesson: Spatial Statistics pentru a rula cât,iva algoritmi SAGA.
Acum o vet,i utiliza pentru a rula programele LAStools:

• Deschidet,i Processing ► Toolbox.
• În meniul derulant din partea inferioară, selectat,i Interfat,ă avansată.
• Ar trebui să vedet,i categoria Instrumentelor pentru datele LiDAR.
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• Extindet,i-o pentru a vedea instrumentele disponibile, apoi extindet,i, de asemenea, categoria LAStools (numărul
de algoritmi poate varia).

• Derulat,i în jos până când găsit,i algoritmul lasview, apoi facet,i dublu-clic pentru a-l deschide.
• At Input LAS/LAZ file, browse to exercise_data\forestry\lidar\ and select the
rautjarvi_lidar.laz file.

• Clic pe Run
Acum putet,i vedea datele LiDAR în fereastra dialogului Doar un mic vizualizator LAS s, i LAZ:
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Există multe alte lucruri pe care le putet,i efectua în cadrul acestui vizualizator, dar pentru moment trebuie doar să
facet,i un clic s, i să glisat,i norul de puncte LiDAR, pentru a vedea cum arată.

Notă: If you want to know further details on how the LAStools work, you can read the README text files about
each of the tools, in the C:\lastools\bin\ folder. Tutorials and other materials are available at the Rapidlasso
webpage.

• Închidet,i vizualizatorul atunci când suntet,i gata.
Crearea unui DEM cu LAStools se poate face în două etape, mai întâi pentru a clasifica norul de puncte în ground
s, i no ground, iar apoi pentru a calcula DEM-ul folosind numai punctele ground.

• Merget,i înapoi la Bara Instrumentelor de Procesare.
• Notat,i Search… box, write lasground.
• Dublu clic pentru a deschide instrumentul lasground, apoi setat,i-l as,a cum se arată în această imagine:
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• The output file is saved to the same folder where the rautjarvi_lidar.laz is located and it is named
rautjarvi_lidar_1.las.

Putet,i să-l deschidet,i cu lasview,
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The brown points are the points classified as ground and the gray ones are the rest, you can click the letter g to
visualize only the ground points or the letter u to see only the unclassified points. Click the letter a to see all the
points again. Check the lasview_README.txt file for more commands. If you are interested, also this tutorial
about editing LiDAR points manually will show you different operations within the viewer.

• Închidet,i iarăs, i vizualizatorul.
• În Processing Toolbox, căutat,i las2dem.
• Deschidet,i instrumentul las2dem, apoi setat,i-l as,a cum se arată în această imagine:
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DEM-ul rezultat este adăugat la hartă cu numele generic Output raster file.

Notă: Instrumentele lasground s, i las2dem necesită licent,iere. Le putet,i utiliza chiar s, i în lipsa licent,ei, as,a cum este
indicat în fis, ierul licent,ei, dar vet,i obt,ine diagonale în imaginile rezultate.

14.8.3 ��� Follow Along: Creating a Terrain Hillshade

For visualization purposes, a hillshade generated from a DEM gives a better
visualization of the terrain:

• Deschidet,i Raster ► Terrain analysis ► Hillshade.
• As the Output layer, browse to exercise_data\forestry\lidar\ and name the file hillshade.
tif.

• Lasă restul parametrilor la setările implicite.
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• Selectat,i ETRS89 / ETRS-TM35FIN ca s, i CRS, atunci când vi se solicită.
În ciuda liniilor diagonale rămase în relieful rasterului rezultat, putet,i vedea în mod clar un relief exact al zonei. Putet,i
vedea chiar s, i diferite albii săpate de curgerea apelor prin pădure.
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14.8.4 În concluzie

Using LiDAR data to get a DEM, specially in forested areas, gives good results with not much effort. You could also
use ready LiDAR derived DEMs or other sources like the SRTM 9m resolution DEMs. Either way, you can use them
to create a hillshade raster to use in your map presentations.
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14.8.5 Ce urmează?

În următorul, s, i ultimul pas din acest modul, vet,i folosi un raster rezultat s, i rezultatele inventarului forestier pentru a
crea o prezentare pentru harta rezultatelor.

14.9 Lesson: Map Presentation

În lect,iile anterioare at,i importat, sub formă de proiect GIS, un vechi inventar de pădure, l-at,i actualizat, at,i proiectat
un inventar, at,i creat hărt,i pentru munca de teren s, i at,i calculat parametrii pădurii folosind măsurătorile din teren.
Adesea, pentru a prezenta rezultatele, este importantă crearea de hărt,i, în cadrul unui proiect GIS. O hartă care
prezintă inventarul forestier va facilita înt,elegerea acestuia dintr-o simplă privire, fără analiza detaliată a cifrelor.
Scopul acestei lect,ii: De a crea o hartă care să prezinte rezultatele inventarerii, folosind ca fundal un raster al
reliefului umbrit.

14.9.1 ��� Follow Along: Preparing the Map Data

Deschidet,i proiectul QGIS din lect,ia de calculare a parametrilor, forest_inventory.qgs. Păstrat,i cel put,in
următoarele straturi:

• forest_stands_2012_results.
• basic_map.
• rautjarvi_aerial.
• kbd:lakes (dacă nu îl avet,i, adăugat,i-l din exercise_data\forestry\ folder).

You are going to present the average volumes of your forest stands in a map. If you open the Attribute table for the
forest_stands_2012_results layer, you can see the NULL values for the stands without information. To
be able to get also those stands into your symbology you should change the NULL values to, for example, -999,
knowing that those negative numbers mean there is no data for those polygons.
Pentru stratul forest_stands_2012_results:

• Deschidet,i Tabela sa de Atribute s, i activat,i editarea.
• Selectati poligoanele cu valoarea NULL.
• Utilizat,i calculatorul pentru a actualiza valorile din câmpul MEANVol la -999, doar pentru entităt,ile selectate.
• Dezactivat,i editarea s, i salvat,i modificările.

Acum putet,i un stil implicit pentru acest strat:
• Merget,i la fila Simbologiei.
• Click on Style ► Load Style….
• Selectat,i folderul forest_stands_2012_results.qml from the exercise_data\forestry\
results\.

• Clic pe OK

464 Capitolul 14. Module: Forestry Application



QGIS Training Manual

Harta dvs. va arăta în felul următor:
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14.9.2 ��� Try Yourself: Try Different Blending Modes

Stilul pe care l-at,i încărcat:
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is using the Hard light mode for the Layer blending mode. Note that the different modes apply different filters
combining the underlying and overlying layers, in this case the hillshade raster and your forest stands are used. You
can read about these modes in the User Guide.
Încercat,i în diverse moduri s, i observat,i diferent,ele în hartă. Apoi, stabilit,i unul care vă place cel mai mult pentru
harta finală.

14.9.3 ��� Try Yourself: Using a Layout Template to Create the Map result

Use a template prepared in advanced to present the results. The template forest_map.qpt is located in the
exercise_data\forestry\results\ folder. Load it using the Project ► Layout Manager… dialog.
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Open the print layout and edit the final map to get a result you are happy with.
S, ablonul hărt,ii pe care îl utilizat,i vă va oferi o hartă similară cu aceasta:
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Salvat,i proiectul dumneavoastră QGIS ca referint,ă pentru viitor.
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14.9.4 În concluzie

Prin intermediul acestui modul at,i văzut cum poate fi planificat s, i prezentat un inventar forestier de bază în QGIS.
Mult mai multe analize forestiere sunt posibile în varietatea de instrumente pe care le putet,i accesa, dar sperăm că
acest manual va oferit un bun punct de plecare pentru a explora noi modalităt,i de obt,inere a rezultatelor dorite.
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Module: Database Concepts with PostgreSQL

Baze de date relat,ionale sunt o parte importantă a oricărui sistem GIS. În acest modul, vet,i învăt,a despre Sistemele de
Gestiune a Bazelor de date Relat,ionale (RDBMS), utilizând PostgreSQL pentru a crea o nouă bază de date în scopul
stocării datelor, s, i vet,i afla despre alte funct,ii tipice RDBMS.

15.1 Lesson: Introduction to Databases

Înainte de a utiliza PostgreSQL, să ne asigurăm de terenul nostru prin acoperirea teoriei generale a bazelor de date.
Nu va fi nevoie să introducet,i codul exemplificat; acesta este prezent doar în scopuri ilustrative.
Scopul acestei lect,ii: De a înt,elege conceptele fundamentale ale bazelor de date.

15.1.1 Ce este o bază de date?

O bază de date constă într-o colect,ie organizată de date, pentru una sau mai multe utilizări, de obicei în formă digitală.
- Wikipedia

Un sistem de management al bazelor de date (DBMS) este format din software care operează bazele de date, oferind
depozitare, acces, securitate, backup s, i alte facilităt,i. - Wikipedia

15.1.2 Tabele

În bazele de date tradit,ionale s, i în bazele de date tip fis, ier, o tabelă este un set de elemente de date (valori) care este
organizat utilând un model de coloane verticale (care sunt identificate prin numele lor) s, i de rânduri orizontale. O
tableă are un număr specificat de coloane, dar poate avea oricâte rânduri. Fiecare rând este identificat prin valorile
unui anumit subset de coloane care a fost identificat ca o potent,ială cheie. - Wikipedia

id | name | age
----+-------+-----

1 | Tim | 20
2 | Horst | 88

(2 rows)

În bazele de date SQL, o tabelă este, de asemenea, cunoscută ca relat,ie.
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15.1.3 Coloane / Câmpuri

O coloană este un set de valori de date având un anume tip simplu, câte una pentru fiecare rând din tabel. Coloanele
funizează structura pe baza căreia se compune fiecare rând. Termenul de câmp este utilizat interschimbabil cu
coloană, des, i mult,i consideră că este mai corect să se utilizeze câmp (sau valoare a câmpului) când este vorba de
elementul care există la intersect,ia dintre o coloană s, i un rând. - Wikipedia
O coloană:

| name |
+-------+
| Tim |
| Horst |

Un câmp:

| Horst |

15.1.4 Înregistrări

O înregistrare reprezintă informat,ia stocată într-un rând din tabelă. Fiecare înregistrare va avea câte un câmp pentru
fiecare dintre coloanele tabelei.

2 | Horst | 88 <-- one record

15.1.5 Tipuri de date

Tipurile de date restrâng tipurile de informat,ii care pot fi stocate într-o coloană. - Tim and Horst

Există mai multe feluri de tipuri de date. Să ne concentrăm pe cele mai comune:
• String - to store free-form text data
• Integer - to store whole numbers
• Real - to store decimal numbers
• Date - to store Horst’s birthday so no one forgets
• Boolean - to store simple true/false values

You can tell the database to allow you to also store nothing in a field. If there is nothing in a field, then the field
content is referred to as a «null» value:

insert into person (age) values (40);

select * from person;

Rezultat:

id | name | age
---+-------+-----
1 | Tim | 20
2 | Horst | 88
4 | | 40 <-- null for name

(3 rows)

There are many more datatypes you can use - check the PostgreSQL manual!
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15.1.6 Modelarea unei Baze de Date cu Adrese

Să folosim un studiu de caz simplu, pentru a vedea cum este construită o bază de date. Dorim să creăm o bază de
date cu adrese.

��� Try Yourself:

Notat,i proprietăt,ile care alcătuiesc o adresă simplă s, i pe care am dori să le stocăm în baza noastră de date.

Răspuns
For our theoretical address table, we might want to store the following properties:

House Number
Street Name
Suburb Name
City Name
Postcode
Country

When creating the table to represent an address object, we would create columns to represent each of these properties
and we would name them with SQL-compliant and possibly shortened names:

house_number
street_name
suburb
city
postcode
country

Structura Adresei

Propietăt,ile care descriu o adresă sunt coloanele. Tipul de informat,ie stocat în fiecare coloană este tipul de date
al acesteia. În sect,iunea următoare vom analiza tabela noastră conceptuală de adrese pentru a vedea cum o putem
înbunătăt,i!

15.1.7 Teoria Bazelor de Date

Procesul de creare a unei baze de date presupune crearea unui model al lumii reale; luând concepte din lumea reală
s, i reprezentându-le, ca entităt,i, în baza de date.

15.1.8 Normalizarea

Un concept de bază al bazelor de date este evitarea duplicării / redundant,ei datelor. Procesul eliminării redundant,ei
dintr-o bază de date este numit Normalizare.
Normalizarea este o metodă sistematică de garantare că structura bazei de date este potrivită pentru interogări de uz
general s, i nu prezintă anumite caracterisitici - anomalii de inserare, modificare sau s, tergere - care ar putea duce la
pierderea integrităt,ii datelor. - Wikipedia
Există diferite tipuri de «forme» de normalizare.
Let’s take a look at a simple example:
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Table "public.people"

Column | Type | Modifiers
----------+------------------------+------------------------------------
id | integer | not null default

| | nextval('people_id_seq'::regclass)
| |

name | character varying(50) |
address | character varying(200) | not null
phone_no | character varying |

Indexes:
"people_pkey" PRIMARY KEY, btree (id)

select * from people;

id | name | address | phone_no
---+---------------+-----------------------------+-------------
1 | Tim Sutton | 3 Buirski Plein, Swellendam | 071 123 123
2 | Horst Duester | 4 Avenue du Roix, Geneva | 072 121 122

(2 rows)

Imaginat,i-vă că avet,i mult,i prieteni cu acelas, i nume de stradă sau oras, . Fiecare dintre aceste date sunt duplicate,
consumă spat,iu. Mai rău, dacă un nume de oras, se schimbă, trebuie să depunet,i mult efort pentru a actualiza baza de
date.

15.1.9 ��� Try Yourself:

Reproiectat,i tabela people de mai sus pentru a reduce duplicarea s, i pentru a normaliza structura de date.
You can read more about database normalisation here

Răspuns
The major problem with the people table is that there is a single address field which contains a person’s entire address.
Thinking about our theoretical address table earlier in this lesson, we know that an address is made up of many
different properties. By storing all these properties in one field, we make it much harder to update and query our
data. We therefore need to split the address field into the various properties. This would give us a table which has the
following structure:

id | name | house_no | street_name | city | phone_no
--+---------------+----------+----------------+------------+-----------------
1 | Tim Sutton | 3 | Buirski Plein | Swellendam | 071 123 123
2 | Horst Duester | 4 | Avenue du Roix | Geneva | 072 121 122

In the next section, you will learn about Foreign Key relationships which could be used in this example to further
improve our database’s structure.
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15.1.10 Indecs, i

Un index în baza de date este o structură de date care îmbunătăt,es, te viteza operat,iilor de extragere de date dintr-o
tabelă a bazei de date. - Wikipedia
Imagine you are reading a textbook and looking for the explanation of a concept - and the textbook has no index!
You will have to start reading at one cover and work your way through the entire book until you find the information
you need. The index at the back of a book helps you to jump quickly to the page with the relevant information:

create index person_name_idx on people (name);

Now searches on name will be faster:

Table "public.people"

Column | Type | Modifiers
----------+------------------------+-------------------------------------
id | integer | not null default

| | nextval('people_id_seq'::regclass)
| |

name | character varying(50) |
address | character varying(200) | not null
phone_no | character varying |

Indexes:
"people_pkey" PRIMARY KEY, btree (id)
"person_name_idx" btree (name)

15.1.11 Secvent,e

O secvent,ă este un generator de numere unice. Este utilizat în mod normal pentru a creea un identificator unic pentru
o coloană a unei tabele.
In this example, id is a sequence - the number is incremented each time a record is added to the table:

id | name | address | phone_no
---+--------------+-----------------------------+-------------
1 | Tim Sutton | 3 Buirski Plein, Swellendam | 071 123 123
2 | Horst Duster | 4 Avenue du Roix, Geneva | 072 121 122

15.1.12 Diagrama Relat, iilor dintre Entităt, i

Într-o bază de date normalizată, există în mod uzual multe relat,ii (tabele). Diagrama relat,iilor între entităt,i (Diagrama
ER) este utilizată pentru stabilirea dependent,elor logice între relat,ii. Să examinăm tabela noastră nenormalizată
people, utilizată anterior în cadrul lect,iei:

select * from people;

id | name | address | phone_no
----+--------------+-----------------------------+-------------
1 | Tim Sutton | 3 Buirski Plein, Swellendam | 071 123 123
2 | Horst Duster | 4 Avenue du Roix, Geneva | 072 121 122

(2 rows)

With a little work we can split it into two tables, removing the need to repeat the street name for individuals who live
in the same street:

select * from streets;

id | name

(continues on next page)
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(continuare din pagina precedentă)
----+--------------
1 | Plein Street

(1 row)

s, i:

select * from people;

id | name | house_no | street_id | phone_no
----+--------------+----------+-----------+-------------

1 | Horst Duster | 4 | 1 | 072 121 122
(1 row)

Putem apoi lega cele două tabele utilizând «keys» streets.id s, i people.streets_id.
Dacă desenăm o Diagramă ER pentru aceste două tabele ar arăta cam as,a:

Diagrama ER ne ajută să exprimăm relat,ii «unul la mult,i». În acest caz simbolul săgeată spune că pe o stradă pot
locui mai mult,i oameni.

��� Try Yourself:

Modelul nostru people are încă nis, te probleme de normalizare - încercat,i să îl normalizat,i în continuare s, i ilustrat,i-vă
ideile printr-o Diagramă ER.

Răspuns
Our people table currently looks like this:

id | name | house_no | street_id | phone_no
---+--------------+----------+-----------+-------------
1 | Horst Duster | 4 | 1 | 072 121 122

The street_id column represents a «one to many» relationship between the people object and the related street object,
which is in the streets table.
One way to further normalise the table is to split the name field into first_name and last_name:

id | first_name | last_name | house_no | street_id | phone_no
---+------------+------------+----------+-----------+------------
1 | Horst | Duster | 4 | 1 | 072 121 122

We can also create separate tables for the town or city name and country, linking them to our people table via «one
to many» relationships:

id | first_name | last_name | house_no | street_id | town_id | country_id
---+------------+-----------+----------+-----------+---------+------------
1 | Horst | Duster | 4 | 1 | 2 | 1

An ER Diagram to represent this would look like this:
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15.1.13 Constrângeri, Chei Primare s, i Chei Externe

O constrîngere într-o bază de date este utilizată pentru a garanta că o relat,ie se potrives, te cu viziunea celui care a
modelat baza de date despre cum ar trebui stocate datele. De exemplu o constrângere pentru codul pos, tal ar putea
garanta că numărul trebuie să se afle între 1000 s, i 9999.
O cheie Primară este compusă din unul sau mai multe câmpuri care fac o înregistrare unică. În mod uzual cheia
primară se numes, te id s, i este o secvent,ă.
O cheie Externă este utilizată pentru a face legătura unei înregistrări cu o altă tabelă (folosind cheia primară a acelui
tabel).
În Diagramele ER, legăturile dintre tabele sunt în mod normal bazate pe chei Externe legate de chei Primare.
If we look at our people example, the table definition shows that the street column is a foreign key that references the
primary key on the streets table:

Table "public.people"

Column | Type | Modifiers
-----------+-----------------------+--------------------------------------
id | integer | not null default

| | nextval('people_id_seq'::regclass)
name | character varying(50) |
house_no | integer | not null
street_id | integer | not null
phone_no | character varying |

Indexes:
"people_pkey" PRIMARY KEY, btree (id)
Foreign-key constraints:
"people_street_id_fkey" FOREIGN KEY (street_id) REFERENCES streets(id)
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15.1.14 Tranzact, ii

La adăugarea, modificarea sau s, tergerea datelor într-o bază de date, este important ca de fiecare dată baza de dată să
rămână într-o stare bună în cazul în care ceva nu merge bine. Cele mai multe baze de date pun la dispozit,ie o facilitate
numită tranzact,ie. Tranzact,iile permit crearea unui moment de revenire la care vă putet,i întoarce dacă modificările
bazei de date nu au funct,ionat conform planului.
Să considerăm un scenariu în care avet,i un sistem contabil. Trebuie să transferat,i fonduri dintr-un cont s, i să le adăugat,i
în altul. Secvent,a de pas, i ar fi:

• eliminat,i R20 din Joe
• adăugat,i R20 la Anne

Dacă ceva nu merge bine în cadrul procesului (ex. pană de curent), tranzact,ia va reveni.

15.1.15 În concluzie

Bazele de date permit administrarea datelor într-un mod structurat utilizând structuri de cod simple.

15.1.16 Ce urmează?

Acum că am văzut cum funct,ionează teoretic bazele de date, să creăm o bază de date nouă pentru a implementa
partea teoretică prezentată.

15.2 Lesson: Implementing the Data Model

Acum, că am acoperit toată teoria, haidet,i să creăm o bază de date nouă. Această bază de date va fi utilizată în
exercit,iile noastre din lect,iile care vor urma.
Scopul acestei lect,ii: De a instala soft-ul necesar s, i de a-l utiliza la implementarea bazei de date exemplu.

15.2.1 Instalare PostgreSQL

Notă: You can find PostgreSQL packages and installation instructions for your operating system at https://www.
postgresql.org/download/. Please note that the documentation will assume users are running QGIS under Ubuntu.

Pe Ubuntu:

sudo apt install postgresql-9.1

Vet,i obt,ine un mesaj de genul ăsta:

[sudo] password for qgis:
Reading package lists... Done
Building dependency tree
Reading state information... Done
The following extra packages will be installed:
postgresql-client-9.1 postgresql-client-common postgresql-common
Suggested packages:
oidentd ident-server postgresql-doc-9.1
The following NEW packages will be installed:
postgresql-9.1 postgresql-client-9.1 postgresql-client-common postgresql-common
0 upgraded, 4 newly installed, 0 to remove and 5 not upgraded.

(continues on next page)

478 Capitolul 15. Module: Database Concepts with PostgreSQL

https://www.postgresql.org/download/
https://www.postgresql.org/download/


QGIS Training Manual

(continuare din pagina precedentă)
Need to get 5,012kB of archives.
After this operation, 19.0MB of additional disk space will be used.
Do you want to continue [Y/n]?

Apăsat,i Y s, i Enter apoi as, teptat,i ca descărcarea s, i instalarea să se încheie.

15.2.2 Ajutor

PostgreSQL has very good online documentation.

15.2.3 Crearea unui utilizator pentru baza de date

Pe Ubuntu:
After the installation is complete, run this command to become the postgres user and then create a new database user:

sudo su - postgres

Introducet,i parola când vi se solicită (avet,i nevoie de drepturi sudo).
Now, at the postgres user’s bash prompt, create the database user. Make sure the user name matches your unix login
name: it will make your life much easier, as postgres will automatically authenticate you when you are logged in as
that user:

createuser -d -E -i -l -P -r -s qgis

Introducet,i o parolă când vi se solicită. Ar trebui să utilizat,i o parolă diferită pentru parola contului dumneavoastră.
Ce reprezintă aceste opt,iuni?

-d, --createdb role can create new databases
-E, --encrypted encrypt stored password
-i, --inherit role inherits privileges of roles it is a member of (default)
-l, --login role can login (default)
-P, --pwprompt assign a password to new role
-r, --createrole role can create new roles
-s, --superuser role will be superuser

Now you should leave the postgres user’s bash shell environment by typing:

exit

15.2.4 Verificat, i noul cont

psql -l

Ar trebui să returneze ceva de genul următor:

Name | Owner | Encoding | Collation | Ctype |
----------+----------+----------+------------+------------+
postgres | postgres | UTF8 | en_ZA.utf8 | en_ZA.utf8 |
template0 | postgres | UTF8 | en_ZA.utf8 | en_ZA.utf8 |
template1 | postgres | UTF8 | en_ZA.utf8 | en_ZA.utf8 |
(3 rows)

Type Q to exit.
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15.2.5 Crearea unei baze de date

The createdb command is used to create a new database. It should be run from the bash shell prompt:

createdb address -O qgis

You can verify the existence of your new database by using this command:

psql -l

Which should return something like this:

Name | Owner | Encoding | Collation | Ctype | Access privileges
----------+----------+----------+------------+------------+-----------------------
address | qgis | UTF8 | en_ZA.utf8 | en_ZA.utf8 |
postgres | postgres | UTF8 | en_ZA.utf8 | en_ZA.utf8 |
template0 | postgres | UTF8 | en_ZA.utf8 | en_ZA.utf8 | =c/postgres:␣
↪→postgres=CTc/postgres
template1 | postgres | UTF8 | en_ZA.utf8 | en_ZA.utf8 | =c/postgres:␣
↪→postgres=CTc/postgres
(4 rows)

Type Q to exit.

15.2.6 Pornirea unei sesiuni către baza de date, din linia de comandă

Vă putet,i conecta us,or la baza de date, procedând astfel:

psql address

Pentru a ies, i din mediul bazei de date psql, tastat,i:

\q

Pentru ajutor în utilizarea liniei de comandă, tastat,i:

\?

Pentru ajutor în utilizarea comenzii SQL, tastat,i:

\help

Pentru a obt,ine ajutor pentru o anumită comandă, tastat,i (de exemplu):

\help create table

See also the Psql cheat sheet.

15.2.7 Crearea Tabelelor SQL

Let’s start making some tables! We will use our ER Diagram as a guide. First, connect to the address db:

psql address

Apoi creat,i o tabelă a străzilor:

create table streets (id serial not null primary key, name varchar(50));
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serial s, i varchar sunt tipuri de date. serial îi spune lui PostgreSQL să pornească o secvent,ă (generator
automat) pentru completarea automată a id pentru fiecare înregistrare nouă. varchar(50) îi spune lui
PostgreSQL să creeze un câmp de caractere de lungime 50.
Vet,i remarca faptul că comanda se termină cu ; - toate comenzile SQL trebuie terminate în acest fel. Când apăsat,i
Enter, psql va raporta ceva de genul:

NOTICE: CREATE TABLE will create implicit sequence "streets_id_seq"
for serial column "streets.id"

NOTICE: CREATE TABLE / PRIMARY KEY will create implicit index
"streets_pkey" for table "streets"

CREATE TABLE

Asta înseamnă că tabelul a fost creeat cu succes, având cheia primară streets_pkey care foloses, te streets.
id.
Notă: Dacă apăsat,i enter fără a introduce ;, vet,i obt,ine un prompt de tipul: address-#. Aceasta deoarece PG
as, teaptă să mai introducet,i ceva. Introducet,i ; pentru a executa comanda.
To view your table schema, you can do this:

\d streets

Which should show something like this:

Table "public.streets"
Column | Type | Modifiers
--------+-----------------------+--------------------------------------
id | integer | not null default

| | nextval('streets_id_seq'::regclass)
name | character varying(50) |

Indexes:
"streets_pkey" PRIMARY KEY, btree (id)

To view your table contents, you can do this:

select * from streets;

Which should show something like this:

id | name
---+------
(0 rows)

După cum putet,i vedea, tabela noastră este vidă, în mod curent.

Try Yourself: ���

Folosit,i abordarea de mai sus pentru a crea un tabel denumit people:
Adăugat,i câmpuri ca număr de telefon, adresă de acasă, nume etc. (acestea nu sunt toate nume valide: schimbat,i-le
pentru a deveni valide). Asigurat,i-vă că îi adăugat,i tabelului o coloană ID cu acelas, i tip de date ca s, i mai sus.

Răspuns
The SQL required to create the correct people table is:

create table people (id serial not null primary key,
name varchar(50),
house_no int not null,
street_id int not null,
phone_no varchar null );
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The schema for the table (enter \\d people) looks like this:

Table "public.people"

Column | Type | Modifiers
-----------+-----------------------+-------------------------------------
id | integer | not null default

| | nextval('people_id_seq'::regclass)
name | character varying(50) |
house_no | integer | not null
street_id | integer | not null
phone_no | character varying |
Indexes:

"people_pkey" PRIMARY KEY, btree (id)

For illustration purposes, we have purposely omitted the fkey constraint.

15.2.8 Crearea Cheilor în SQL

Problema cu solut,ia noastră de mai sus este că baza de date nu s, tie că oamenii s, i străzile au o relat,ie logică. Pentru a
exprima această relat,ie va trebui să definim o cheie externă care face legătura cu cheia primară a tabelului de străzi.

Sunt două moduri de a face asta:
• Adăugat,i cheia după crearea tabelului
• Definit,i cheia la momentul creării tabelului

Our table has already been created, so let’s do it the first way:

alter table people
add constraint people_streets_fk foreign key (street_id) references streets(id);

Asta spune tabelului people că valoarea câmpurilor street_id trebuie să fie o valoare validă id din tabelul
streets.
The more usual way to create a constraint is to do it when you create the table:

create table people (id serial not null primary key,
name varchar(50),
house_no int not null,
street_id int references streets(id) not null,
phone_no varchar null);

\d people

After adding the constraint, our table schema looks like this now:

Table "public.people"

Column | Type | Modifiers
-----------+-----------------------+---------------------------------
id | integer | not null default

| | nextval('people_id_seq'::regclass)

(continues on next page)
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(continuare din pagina precedentă)
name | character varying(50) |
house_no | integer | not null
street_id | integer | not null
phone_no | character varying |

Indexes:
"people_pkey" PRIMARY KEY, btree (id)

Foreign-key constraints:
"people_streets_fk" FOREIGN KEY (id) REFERENCES streets(id)

15.2.9 Crearea de indecs, i în SQL

We want lightning fast searches on peoples names. To provide for this, we can create an index on the name column
of our people table:

create index people_name_idx on people(name);

\d people

Which results in:

Table "public.people"

Column | Type | Modifiers
-----------+-----------------------+-----------------------------------
id | integer | not null default nextval

| | ('people_id_seq'::regclass)
name | character varying(50) |
house_no | integer | not null
street_id | integer | not null
phone_no | character varying |

Indexes:
"people_pkey" PRIMARY KEY, btree (id)
"people_name_idx" btree (name) <-- new index added!

Foreign-key constraints:
"people_streets_fk" FOREIGN KEY (id) REFERENCES streets(id)

15.2.10 S, tergerea Tabelelor în SQL

If you want to get rid of a table you can use the drop command:

drop table streets;

In our current example, the above command would not work. Why not?

Răspuns
The reason the DROP command would not work in this case is because the people table has a Foreign Key constraint
to the streets table. This means that dropping (or deleting) the streets table would leave the people table with references
to non-existent streets data.
It is possible to «force» the streets table to be deleted by using the CASCADE command, but this would also delete
the people and any other table which had a relationship to the streets table. Use with caution!

If you used the same drop table command on the people table, it would be successful:

drop table people;
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Notă: Dacă at,i introdus acea comandă s, i at,i s, ters tabelul people, ar fi un moment bun să îl refacet,i, deoarece îl
vet,i folosi în exercit,iile următoare.

15.2.11 Câteva cuvinte despre pgAdmin III

Prezentăm comenzile SQL de la promptul psql pentru că este un mod foarte util de a învăt,a despre bazele de date. Cu
toate acestea, există metode mai rapide s, i mai us,oare de a face ce am prezentat. Instalat,i pgAdmin III s, i vet,i putea
crea, s, terge, modifica etc. tabele utilizănd operat,ii «point and click» într-un GUI.
Under Ubuntu, you can install it like this:

sudo apt install pgadmin3

pgAdmin III va fi acoperit mai detaliat în alt modul.

15.2.12 În concluzie

At,i văzut cum să creat,i o bază de date complet nouă, pornind de la zero.

15.2.13 Ce urmează?

În continuare vet,i învăt,a cum să folosit,i DBMS-ul pentru adăguarea datelor.

15.3 Lesson: Adding Data to the Model

Modelele pe care le-am creat vor trebui să fie populate de acum cu datele pe care trebuie să le cont,ină.
Scopul acestei lect,ii: De a afla cum se pot insera noi date în baza de date a modelelor.

15.3.1 Inserarea instruct, iunilor

Cum adăugat,i date într-o tabelă? Instruct,iunea SQL INSERT oferă funct,ionalitatea necesară:

insert into streets (name) values ('High street');

Mai multe lucruri de ret,inut:
• După numele tabelului (streets), vet,i lista numele coloanelor pe care le vet,i popula (în acest caz, doar
coloana name).

• După cuvântul cheie values, plasat,i lista valorilor de câmp.
• S, irurile de caractere ar trebui să fie citate cu ajutorul ghilimelelor simple.
• Ret,inet,i că nu vom introduce o valoare pentru coloana id; acest lucru se datorează faptului că este o secvent,ă,
ea fiind generată în mod automat.

• Dacă setat,i manual id-ul, pot apărea probleme grave cu integritatea bazei de date.
Ar trebui să vedet,i INSERT 0 1 dacă a avut succes.
Putet,i vedea rezultatul act,iunii dvs. de inserare selectând toate datele din tabelă:
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select * from streets;

Rezultat:

select * from streets;
id | name

----+-------------
1 | High street

(1 row)

Try Yourself: ���

Folosit,i comanda INSERT pentru a adăuga o nouă stradă în tabelul streets.

Răspuns
Comanda SQL pe care ar trebui să o utilizat,i arată astfel (putet,i înlocui numele străzii cu un nume la alegere):

insert into streets (name) values ('Low Road');

15.3.2 Secvent, ierea Adăugării Datelor, Conform Constrângerilor

15.3.3 Try Yourself: ���

Încercat,i să adăugat,i un obiect persoană în tabela people cu următoarele detalii:

Name: Joe Smith
House Number: 55
Street: Main Street
Phone: 072 882 33 21

Notă: Reamintim că, în acest exemplu, am definit numerele de telefon ca s, iruri de caractere, s, i nu ca numere întregi.

În acest moment, ar trebui să întâmpinat,i un raport de eroare, dacă încercat,i să facet,i acest lucru fără a crea mai întâi
o înregistrare pentru Main Street din tabela streets.
Ar trebui să ret,net,i, de asemenea, că:

• Nu putet,i adăuga strada folosind-ui numele
• Nu putet,i adăuga o stradă folosind un id, fără a crea mai întâi o înregistrare a străzii în tabela străzilor

Amintit,i-vă că cele două tabele sunt legate printr-o pereche de chei: primară/externă. Aceasta înseamnă că nici o
persoană validă nu pot fi creată fără a exista, de asemenea, o înregistrare de stradă validă, corespunzătoare.
Folosind cunos, tint,ele de mai sus, adăugat,i noua persoană în baza de date.

Răspuns
Iată instruct,iunea SQL corectă:

insert into streets (name) values('Main Road');
insert into people (name,house_no, street_id, phone_no)

values ('Joe Smith',55,2,'072 882 33 21');
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Dacă vă uitat,i din nou la tabela străzilor (folosind o instruct,iune select ca cea de dinainte), vet,i vedea că id-ul intrării
Drum principal este 2.
De aceea am putea introduce pur s, i simplu numărul 2 mai sus. Chiar dacă nu vedem Main Road scris complet în
intrarea de mai sus, baza de date va putea să-l asocieze cu valoarea street_id de 2.
Dacă at,i adăugat deja un nou obiect stradal, s-ar putea să descoperit,i că noul Drum Principal are un id de 3 nu
de 2.

15.3.4 Selectarea datelor

V-am arătat deja sintaxa pentru selectarea înregistrărilor. Să ne uităm la câteva exemple suplimentare:

select name from streets;

select * from streets;

select * from streets where name='Main Road';

În sesiunile ulterioare vom intra în mai multe detalii cu privire la modul de selectare s, i de filtrare a datelor.

15.3.5 Actualizarea datelor

Ce se întâmplă dacă dorit,i să facet,i o modificare a unor date existente? De exemplu, un nume de stradă este schimbat:

update streets set name='New Main Road' where name='Main Road';

Fit,i foarte atent,i la folosirea acestor declarat,ii de actualizare - în cazul în care mai mult de o înregistrare se potrives, te
clauzei WHERE, toate vor fi actualizate!
O solut,ie mai bună este de a folosi cheia primară a tabelului, pentru a referent,ia înregistrarea care trebuie schimbată:

update streets set name='New Main Road' where id=2;

Ar trebui să returneze UPDATE 1.

Notă: Criteriile instruct,iunii WHERE sunt sensibile la majuscule, astfel Main Road nu este similar cu Main road

15.3.6 Ştergere Dată

Pentru a s, terge un obiect dintr-o tabelă, utilizat,i comanda DELETE:

delete from people where name = 'Joe Smith';

Să ne uităm acum la tabela noastră de personal:

address=# select * from people;

id | name | house_no | street_id | phone_no
----+------+----------+-----------+----------

(0 rows)
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15.3.7 Try Yourself: ���

Folosit,i abilităt,ile pe care le-at,i învăt,at pentru a adăuga cât,iva prieteni noi în baza de date:

name | house_no | street_id | phone_no
-----------------+----------+-----------+--------------
Joe Bloggs | 3 | 2 | 072 887 23 45
Jane Smith | 55 | 3 | 072 837 33 35
Roger Jones | 33 | 1 | 072 832 31 38
Sally Norman | 83 | 1 | 072 932 31 32

15.3.8 În concluzie

Acum s, tit,i cum să adăugat,i date noi modelelor existente, pe care le-at,i creat anterior. Amintit,i-vă că, dacă dorit,i să
adăugat,i noi tipuri de date, poate dorit,i să modificat,i s, i/sau să creat,i noi modele, care să cont,ină aceste date.

15.3.9 Ce urmează?

Acum, că at,i adăugat câteva date, vet,i învăt,a cum să folosit,i interogările, pentru a accesa aceste date în diferite moduri.

15.4 Lesson: Queries

Când scriet,i o comandă SELECT ... interogat,i baza de date pentru informat,ii.
Scopul acestei lect,ii: De a afla cum să creat,i interogări, care vor returna informat,ii utile.

Notă: Dacă nu at,i făcut asta în lect,ia precedentă, adăugat,i următoarele obiecte persoană în tabela people. Dacă
primit,i erori legate de constrângerile de cheie externă, va trebui să adăugat,i mai întâi obiectul «Main Road» în tabela
de străzi.

insert into people (name,house_no, street_id, phone_no)
values ('Joe Bloggs',3,2,'072 887 23 45');

insert into people (name,house_no, street_id, phone_no)
values ('Jane Smith',55,3,'072 837 33 35');

insert into people (name,house_no, street_id, phone_no)
values ('Roger Jones',33,1,'072 832 31 38');

insert into people (name,house_no, street_id, phone_no)
values ('Sally Norman',83,1,'072 932 31 32');

15.4.1 Ordonarea Rezultatelor

Haidet,i să obt,inem o listă de persoane ordonate după numerele caselor lor:

select name, house_no from people order by house_no;

Rezultat:

name | house_no
--------------+----------
Joe Bloggs | 3
Roger Jones | 33
Jane Smith | 55

(continues on next page)
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(continuare din pagina precedentă)
Sally Norman | 83

(4 rows)

Putet,i sorta rezultatele după valorile a mai mult de o coloană:

select name, house_no from people order by name, house_no;

Rezultat:

name | house_no
--------------+----------
Jane Smith | 55
Joe Bloggs | 3
Roger Jones | 33
Sally Norman | 83

(4 rows)

15.4.2 Filtrare

Foarte des nu vet,i vedea fiecare înregistrare din baza de date - în mod special există mii de înregistrări s, i suntet,i
interesat doar de una sau două.
Iată un exemplu de filtru numeric care întoarce doar obiecte ale cărui house_no este mai mic de 50:

select name, house_no from people where house_no < 50;

name | house_no
-------------+----------
Joe Bloggs | 3
Roger Jones | 33
(2 rows)

Putet,i combina filtre (definite utilizănd clauza WHERE) cu sortare (definită folosind clauza ORDER BY):

select name, house_no from people where house_no < 50 order by house_no;

name | house_no
-------------+----------
Joe Bloggs | 3
Roger Jones | 33
(2 rows)

Putet,i filtra, de asemenea, pe baza datelor de text:

select name, house_no from people where name like '%s%';

name | house_no
-------------+----------
Joe Bloggs | 3
Roger Jones | 33
(2 rows)

Am folosit clauza LIKE pentru a găsi toate numele care cont,in un s. De remarcat că această interogare t,ine cont de
capitalizare, deci înregistrarea Sally Norman nu a fost întoarsă.
Dacă dorit,i să căutat,i un s, ir de caractere indiferent de capitalizare, putet,i executa o căutare care nu t,ine cont de
capitalizare folosind clauza ILIKE:
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select name, house_no from people where name ilike '%r%';

name | house_no
--------------+----------
Roger Jones | 33
Sally Norman | 83
(2 rows)

Acea interogare a returnat fiecare obiect people care cont,ine un r sau un R în nume.

15.4.3 Îmbinări

Dar dacă dorit,i să vedet,i detaliile persoanei s, i numele străzii în loc de ID-ul acesteia? Pentru a face asta, trebuie să
legat,i cele două tabele într-o singură interogare. Să vedem un exemplu:

select people.name, house_no, streets.name
from people,streets
where people.street_id=streets.id;

Notă: Cu legături, vet,i spune întotdeauna din ce tabele se extrage informat,ia, în aceest caz persoane s, i străzi. De
asemenea va trebui să precizat,i care chei trebuie să corespundă (cheia externă s, i cheia primară). Dacă nu facet,i
această precizare, vet,i obt,ine o listă cu toate combinat,iile posibile de persoane s, i străzi, dar nu vet,i putea s, ti de fapt
cine pe ce stradă locuies, te!

As,a ar trebui să arate rezultatul SQL corect:

name | house_no | name
--------------+----------+-------------
Joe Bloggs | 3 | Low Street
Roger Jones | 33 | High street
Sally Norman | 83 | High street
Jane Smith | 55 | Main Road

(4 rows)

Vom reveni la legături când vom creea interogări mai complexe în continuare. Pentru moment ret,inet,i că permit o
metodă simplă de a combina informat,ii din două sau mai multe tabele.

15.4.4 Sub-Selectarea

Sub-select,iile permit selectarea obiectelor dintr-un tabel, pe baza datelor dintr-un alt tabel de care este legat printr-o
relat,ie la cheia sa externă. În cazul nostru, dorim să găsim persoanele care locuiesc pe o anumită stradă.
În primul rând, să facem un pic de reglare a datelor noastre:

insert into streets (name) values('QGIS Road');
insert into streets (name) values('OGR Corner');
insert into streets (name) values('Goodle Square');
update people set street_id = 2 where id=2;
update people set street_id = 3 where id=3;

Haidet,i să aruncăm o privire rapidă la datele noastre în urma modificărilor: putem refolosi interogarea din sect,iunea
anterioară:

select people.name, house_no, streets.name
from people,streets
where people.street_id=streets.id;

Rezultat:
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name | house_no | name
--------------+----------+-------------
Roger Jones | 33 | High street
Sally Norman | 83 | High street
Jane Smith | 55 | Main Road
Joe Bloggs | 3 | Low Street

(4 rows)

Acum, vom efectua o sub-select,ie asupra acestor date. Vrem să arătăm doar persoanele care locuiesc în street_id
numărul 1:

select people.name
from people, (

select *
from streets
where id=1

) as streets_subset
where people.street_id = streets_subset.id;

Rezultat:

name
--------------
Roger Jones
Sally Norman

(2 rows)

Des, i acesta este un exemplu foarte simplu s, i inutil pentru seturile de date restrânse, el ilustrează utilitatea s, i important,a
sub-select,iilor în cazul interogărilor efectuate asupra seturilor de date mari s, i complexe.

15.4.5 Agregarea Îmbinărilor

Una dintre cele mai puternice caracteristici ale unei baze de date o reprezintă capacitatea sa de a sintetiza datele din
tabelele pe care le cont,ine. Aceste sinteze sunt denumite interogări agregate. Iată un exemplu tipic, care ne spune cât
de multe obiecte de tipul om sunt în tabela de personal:

select count(*) from people;

Rezultat:

count
-------

4
(1 row)

Dacă dorim un rezumat după numele străzii, putem proceda astfel:

select count(name), street_id
from people
group by street_id;

Rezultat:

count | street_id
-------+-----------

2 | 1
1 | 3
1 | 2

(3 rows)
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Notă: Pentru că nu am folosit clauza ORDER BY, ordinea rezultatelor dvs. ar putea să nu se potrivească ce ceea ce
este prezentat aici.

Try Yourself: ���

Rezumat,i persoanele după numele străzii s, i afis,at,i numele reale ale străzilor în loc de street_ids.

Răspuns
Iată instruct,iunea SQL corectă pe care ar trebui să o utilizat,i:

select count(people.name), streets.name
from people, streets
where people.street_id=streets.id
group by streets.name;

Rezultat:

count | name
------+-------------

1 | Low Street
2 | High street
1 | Main Road

(3 rows)

Vet,i observa că avem nume de câmpuri prefixate cu nume de tabel (de exemplu, persoane.nume s, i străzi.nume).
Acest lucru trebuie făcut ori de câte ori numele câmpului este ambiguu (adică nu este unic în toate tabelele din baza
de date).

15.4.6 În concluzie

At,i văzut cum se utilizează interogările pentru a returna datele din baza de date într-un mod care permite extragerea
de informat,ii utile.

15.4.7 Ce urmează?

Mai departe vet,i vedea cum să creat,i vizualizări, pornind de la interogările scrise.

15.5 Lesson: Views

De fiecare dată când scriet,i o interogare, cheltuit,i o mult,ime de timp s, i efort pentru a o formula. Cu ajutorul vederilor,
putet,i salva definit,ia unei interogări SQL într-o «tabelă virtuală» reutilizabilă.
Scopul acestei lect,ii: Salvarea unei interogări sub formă de vedere.
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15.5.1 Crearea unei Vederi

Putet,i trata o vedere la fel ca pe o tabelă, însă datele sale provin dintr-o interogare. Haidet,i să efectuăm o vedere
simplă, bazată pe cele de mai înainte:

create view roads_count_v as
select count(people.name), streets.name
from people, streets where people.street_id=streets.id
group by people.street_id, streets.name;

După cum se poate vedea, singura schimbare estecrearea vederii roads_count_v ca parte a începutului.
Acum, putem selecta datele din această vedere:

select * from roads_count_v;

Rezultat:

count | name
-------+-------------

1 | Main Road
2 | High street
1 | Low Street

(3 rows)

15.5.2 Modificarea unei Vederi

O vizualizare nu este fixă s, i nu cont,ine „date reale”. Aceasta înseamnă că o putet,i modifica cu us,urint,ă, fără a afecta
vreo dată din baza de date:

CREATE OR REPLACE VIEW roads_count_v AS
SELECT count(people.name), streets.name
FROM people, streets WHERE people.street_id=streets.id
GROUP BY people.street_id, streets.name
ORDER BY streets.name;

(Acest exemplu demonstrează, de asemenea, că cea mai bună practică este de a folosi MAJUSCULE pentru toate
cuvintele cheie SQL.)
Vet,i vedea că s-a adăugat o clauză ORDER BY, astfel încât rândurile vederii să fie bine sortate:

select * from roads_count_v;

count | name
-------+-------------

2 | High street
1 | Low Street
1 | Main Road

(3 rows)
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15.5.3 Eliminarea unei Vederi

Dacă nu mai avet,i nevoie de vedere, o putet,i s, terge astfel:

drop view roads_count_v;

15.5.4 În concluzie

Vederile constau în salvarea unei interogări, urmată de accesarea rezultatelor acesteia ca s, i cum ar fi o tabelă.

15.5.5 Ce urmează?

Uneori, atunci când are loc o schimbare asupra datelor, vet,i dori ca modificările să aibă efecte în altă parte a bazei
de date. Următoarea lect,ie vă arată cum să facet,i acest lucru.

15.6 Lesson: Rules

Regulile permit „arborelui de interogare” rescrierea interogărilor primite. O utilizare comună o reprezintă
implementarea vederilor, inclusiv a celor actualizabile. - Wikipedia
Scopul acestei lect,ii: De a afla cum se pot crea noi reguli pentru baza de date.

15.6.1 Crearea unei reguli de jurnalizare

Presupunem că dorit,i să înregistrat,i fiecare schimbare de număr_de_telefon în tabelul jurnalul_personalului. Astfel,
vet,i configura un tabel nou:

create table people_log (name text, time timestamp default NOW());

În etapa următoare, creat,i o regulă care înregistrează fiecare schimbare de număr_de_telefon în tabelul
jurnalul_personalului:

create rule people_log as on update to people
where NEW.phone_no <> OLD.phone_no
do insert into people_log values (OLD.name);

Pentru a testa funct,ionarea regulii, haidet,i să modificăm un număr de telefon:

update people set phone_no = '082 555 1234' where id = 2;

Asigurat,i-vă că tabela people a fost actualizată corect:

select * from people where id=2;

id | name | house_no | street_id | phone_no
----+------------+----------+-----------+--------------

2 | Joe Bloggs | 3 | 2 | 082 555 1234
(1 row)

Acum, datorită regulii pe care am creat-o, tabelul people_log va arăta astfel:
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select * from people_log;

name | time
------------+----------------------------
Joe Bloggs | 2014-01-11 14:15:11.953141

(1 row)

Notă: Valoarea câmpului time va depinde de data s, i ora curente.

15.6.2 În concluzie

Regulile vă permit adăugarea sau modificarea automată a datelor din baza de date, pentru a reflecta modificările din
alte părt,i ale bazei de date.

15.6.3 Ce urmează?

Modulul următor vă va introduce în Baza Datelor Spat,iale, cu ajutorul PostGIS, care preia conceptele bazelor de date
s, i le aplică datelor GIS.
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Module: Spatial Database Concepts with PostGIS

Bazele de date spat,iale permit stocarea geometriilor înregistrărilor în interiorul unei baze de date s, i, de asemenea,
furnizează funct,ii pentru interogarea s, i preluarea înregistrărilor folosind aceste Geometrii. În acest modul vom folosi
PostGIS, o extensie a PostgreSQL, pentru a învăt,a configurarea unei baze de date spat,iale, importarea datelor s, i
folosirea funct,iilor geografice oferite de PostGIS.
While working through this section, you may want to keep a copy of the PostGIS cheat sheet available from Boston
GIS user group. Another useful resource is the online PostGIS documentation.
There are also some more extensive tutorials on PostGIS and Spatial Databases created by Boundless that are now
hosted on the PostGIS’s website:

• Introduction to PostGIS
• PostGIS Database Tips and Tricks

Citit,i, de asemenea, PostGIS In Action.

16.1 Lesson: PostGIS Setup

Instalând funct,iile PostGIS vom putea accesa funct,iile spat,iale din interiorul PostgreSQL.
Scopul acestei lect,ii: De a instala funct,iile spat,iale, s, i pentru scurte demonstrat,ii a aplicării lor.

Notă: We will assume the use of PostGIS version 2.1 or newer in this exercise. The installation and database
configuration are different for older versions, but the rest of this material in this module will still work. Consult the
documentation for your platform for help with installation and database configuration.
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16.1.1 Instalarea sub Ubuntu

PostGIS este us,or de instalat din apt.

$ sudo apt install postgresql
$ sudo apt install postgis

Într-adevăr, este atât de us,or …

Notă: The exact versions that will be installed depend on which version of Ubuntu you are using and
which repositories you have configured. After installing you can check the version by issuing a select
PostGIS_full_version(); query with psql or another tool.

To install a specific version (eg, PostgreSQL version 13 and PostGIS 3), you can use the following commands.

$ sudo apt install wget ca-certificates
$ sudo lsb_release -a
$ wget --quiet -O - https://www.postgresql.org/media/keys/ACCC4CF8.asc | sudo apt-
↪→key add -
$ sudo sh -c 'echo "deb http://apt.postgresql.org/pub/repos/apt/ `lsb_release -cs`-
↪→pgdg main" >> /etc/apt/sources.list.d/pgdg.list'
$ sudo apt-get update
$ sudo apt install postgis postgresql-13-postgis-3

16.1.2 Instalare sub Windows

Installing on Windows can be done from binary packages using a normal Windows installation dialogs.
First Visit the download page. Then follow this guide.
More information about installing on Windows can be found on the PostGIS website.

16.1.3 Instalarea pe Alte Platforme

The PostGIS website download has information about installing on other platforms including macOS and on other
Linux distributions

16.1.4 Configurarea Bazei de Date pentru a utiliza PostGIS

După ce PostGIS este instalat, va trebui să configurat,i baza de date pentru a utiliza extensiile. Dacă at,i instalat
versiunea PostGIS > 2.0, aceasta este la fel de simplu ca s, i execut,ia următoarei comenzi în psql, folosind baza de date
de adrese din exercit,iul nostru anterior.

$ psql -d address -c "CREATE EXTENSION postgis;"

Notă: Depending on your version, you could find more instructions on how to spatially enable a database at https:
//postgis.net/docs/postgis_administration.html#create_spatial_db.
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16.1.5 Funct, iile PostGIS instalate

PostGIS poate fi considerat ca o colect,ie de funct,ii din baza de date, care extind capabilităt,ile de bază ale PostgreSQL,
astfel încât să poatădatelor spat,iale. Prin «a face fat,ă», înt,elegem stocarea, preluarea, interogarea s, i manipularea.
Pentru a face acest lucru, sunt instalate o serie de funct,ii în baza de date.
Our PostgreSQL address database is now geospatially enabled, thanks to PostGIS. We are going to delve a lot
deeper into this in the coming sections, but let’s give you a quick little taster. Let’s say we want to create a point
from text. First we use the psql command to find functions relating to point. If you are not already connected to the
address database, do so now. Then run:

\df *point*

This is the command we’re looking for: st_pointfromtext. To page through the list, use the down arrow, then
press Q to quit back to the psql shell.
Try running this command:

select st_pointfromtext('POINT(1 1)');

Rezultat:

st_pointfromtext
--------------------------------------------
0101000000000000000000F03F000000000000F03F
(1 row)

Trei lucruri de ret,inut:
• Am definit un punct la pozit,ia 1,1 (EPSG:4326 se presupune), folosind POINT(1 1),
• Am rulat o instruct,iune SQL, dar nu pe orice tabelă, doar pe datele introduse din promptul SQL,
• Rândul rezultat nu prea are sens.

Rândul rezultat se află în formatul OGC denumit «Well Known Binary» (WKB). Vom analiza în detaliu acest format
în sect,iunea următoare.
To get the results back as text, we can do a quick scan through the function list for something that returns text:

\df *text

The query we’re looking for now is st_astext. Let’s combine it with the previous query:

select st_astext(st_pointfromtext('POINT(1 1)'));

Rezultat:

st_astext
------------

POINT(1 1)
(1 row)

Aici, am intrat în s, irul POINT(1,1), transformându-l într-un punct folosind st_pointfromtext(), s, i
aducându-l înapoi într-o formă us,or de înt,eles de către utilizator cu st_astext(), care returează s, irul de caractere
init,ial.
One last example before we really get into the detail of using PostGIS:

select st_astext(st_buffer(st_pointfromtext('POINT(1 1)'),1.0));

Care este rezultatul acestuia? S-a creat un tampon de 1 grad în jurul punctului nostru, s, i s-a returnat un rezultat sub
formă de text.
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16.1.6 Sistemele de Referint,ă Spat, ială

În plus fat,ă de funct,iile PostGIS, extensia cont,ine o colect,ie cu definit,ii ale sistemelor de referint,ă spat,ială (SRS), as,a
cum au fost stabilite de către European Petroleum Survey Group (EPSG). Acestea sunt utilizate pentru operat,iuni de
conversie a sistemelor de referint,ă s, i coordonate (CRS).
Putem inspecta aceste definit,ii SRS din baza noastră de date, pe măsură ce acestea sunt stocate în tabelele normale
ale bazei de date.
First, let’s look at the schema of the table by entering the following command in the psql prompt:

\d spatial_ref_sys

The result should be this:

Table "public.spatial_ref_sys"
Column | Type | Modifiers

-----------+-------------------------+-----------
srid | integer | not null
auth_name | character varying(256) |
auth_srid | integer |
srtext | character varying(2048) |
proj4text | character varying(2048) |
Indexes:

"spatial_ref_sys_pkey" PRIMARY KEY, btree (srid)

Putet,i utiliza interogări SQL standard (as,a cum am învăt,at din sect,iunile introductive), pentru a vizualiza s, i manipula
acest tabel - totus, i, actualizarea sau s, tergerea înregistrărilor nu reprezintă o idee bună dacă nu s, tit,i ce facet,i.
One SRID you may be interested in is EPSG:4326 - the geographic / lat lon reference system using the WGS 84
ellipsoid. Let’s take a look at it:

select * from spatial_ref_sys where srid=4326;

Rezultat:

srid | 4326
auth_name | EPSG
auth_srid | 4326
srtext | GEOGCS["WGS 84",DATUM["WGS_1984",SPHEROID["WGS
84",6378137,298.257223563,AUTHORITY["EPSG","7030"]],TOWGS84[0,
0,0,0,0,0,0],AUTHORITY["EPSG","6326"]],PRIMEM["Greenwich",0,
AUTHORITY["EPSG","8901"]],UNIT["degree",0.01745329251994328,
AUTHORITY["EPSG","9122"]],AUTHORITY["EPSG","4326"]]
proj4text | +proj=longlat +ellps=WGS84 +datum=WGS84 +no_defs

srtext reprezintă definit,ia proiect,iei în well known text (putet,i recunoas, te acest lucru din fis, ierele .prj din colect,ia
dvs. de fis, iere shape).

16.1.7 În concluzie

Acum avet,i funct,iile PostGIS instalate în copia dvs. de PostgreSQL. Astfel, vet,i putea să facet,i uz de funct,iile spat,iale
extinse ale PostGIS.
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16.1.8 Ce urmează?

Mai departe, vet,i învăt,a cum se reprezintă entităt,ile spat,iale într-o bază de date.

16.2 Lesson: Simple Feature Model

Cum putem să stocăm s, i să reprezentăm entităt,ile geografice într-o bază de date? În această lect,ie vom detalia una
dintre abordări, Simple Feature Model, as,a cum este definită de către OGC.
Scopul acestei lect,ii: De a afla ce este Modelul SFS s, i cum să-l folosit,i.

16.2.1 Ce este OGC

Open Geospatial Consortium (OGC), o organizat,ie internat,ională de voluntariat, dedicată stabilirii unor standarde,
înfiint,ată în 1994. În OGC, mai mult de 370+ organizat,ii comerciale, guvernamentale, non-profit s, i de cercetare la
nivel mondial, colaborează într-un proces consensual deschis, încurajând dezvoltarea s, i implementarea standardelor
pentru cont,inut s, i servicii geospat,iale, prelucrarea s, i schimbul de date GIS. - Wikipedia

16.2.2 Ce este Modelul SFS

The Simple Feature for SQL (SFS) Model is a non-topological way to store geospatial data in a database and defines
functions for accessing, operating, and constructing these data.

Modelul defines, te date geospat,iale din tipurile Point, Linestring, s, i Polygon (s, i agregări ale acestora în obiecte Multi).
For further information, have a look at the OGC Simple Feature for SQL standard.
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16.2.3 Adăugat, i un câmp geometric la tabelă

Let’s add a point field to our people table:

alter table people add column geom geometry;

16.2.4 Adăugat, i o constrângere bazată pe tipul geometriei

You will notice that the geometry field type does not implicitly specify what type of geometry for the field - for that
we need a constraint:

alter table people
add constraint people_geom_point_chk

check(st_geometrytype(geom) = 'ST_Point'::text
OR geom IS NULL);

Aceasta adaugă o constrângere la tabelă, astfel încât ea va accepta doar o geometrie de tip punct sau o valoare nulă.

16.2.5 ��� Try Yourself:

Create a new table called cities and give it some appropriate columns, including a geometry field for storing polygons
(the city boundaries). Make sure it has a constraint enforcing geometries to be polygons.

Răspuns

16.2.6 Popularea tabelei geometry_columns

At this point you should also add an entry into the geometry_columns table:

insert into geometry_columns values
('','public','people','geom',2,4326,'POINT');

Why? geometry_columns is used by certain applications to be aware of which tables in the database contain
geometry data.

Notă: If the above INSERT statement causes an error, run this query first:

select * from geometry_columns;

If the column f_table_name contains the value people, then this table has already been registered and you
don’t need to do anything more.

The value 2 refers to the number of dimensions; in this case, two: X and Y.
The value 4326 refers to the projection we are using; in this case, WGS 84, which is referred to by the number 4326
(refer to the earlier discussion about the EPSG).
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��� Try Yourself:

Adăugat,i o intrare geometry_columns adecvată pentru noul strat al oras,elor

Răspuns

insert into geometry_columns values
('','public','cities','geom',2,4326,'POLYGON');

16.2.7 Adăugat, i o înregistare geometrică la tabelă, utilizând SQL

Now that our tables are geo-enabled, we can store geometries in them:

insert into people (name,house_no, street_id, phone_no, geom)
values ('Fault Towers',

34,
3,
'072 812 31 28',
'SRID=4326;POINT(33 -33)');

Notă: In the new entry above, you will need to specify which projection (SRID) you want to use. This is because
you entered the geometry of the new point using a plain string of text, which does not automatically add the correct
projection information. Obviously, the new point needs to use the same SRID as the data-set it is being added to, so
you need to specify it.
If at this point you were using a graphical interface, for example, specifying the projection for each point would be
automatic. In other words, you usually won’t need to worry about using the correct projection for every point you
want to add if you’ve already specified it for that data-set, as we did earlier.

Now is probably a good time to open QGIS and try to view your people table. Also, we should try editing / adding
/ deleting records and then performing select queries in the database to see how the data has changed.
Pentru a încărca un strat PostGIS în QGIS, utilizat,i opt,iunea de meniu Layer ► Add PostGIS Layers sau butonul
corespunzător din bara de instrumente:

Se va deschide acest dialog:
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Clic pe butonul New pentru a deschide acest dialog:
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Apoi definit,i o nouă conexiune, de exemplu.:

Name: myPG
Service:
Host: localhost
Port: 5432
Database: address
User:
Password:

To see whether QGIS has found the address database and that your username and password are correct, click
Test Connect. If it works, check the boxes next to Save Username and Save Password. Then click OK to create this
connection.
Înapoi în dialogul Add PostGIS Layers, facet,i clic pe Connect, apoi adăugat,i straturile pentru proiectul dumneavoastră,
ca de obicei.

16.2. Lesson: Simple Feature Model 503



QGIS Training Manual

��� Try Yourself:

Formulate a query that shows a person’s name, street name and position (from the geom column) as plain text.

Răspuns

select people.name,
streets.name as street_name,
st_astext(people.geom) as geometry

from streets, people
where people.street_id=streets.id;

Rezultat:

name | street_name | geometry
--------------+-------------+---------------
Roger Jones | High street |
Sally Norman | High street |
Jane Smith | Main Road |
Joe Bloggs | Low Street |
Fault Towers | Main Road | POINT(33 -33)

(5 rows)

As you can see, our constraint allows nulls to be added into the database.

16.2.8 În concluzie

At,i văzut cum să adăugat,i obiecte spat,iale în baza de date, s, i cum să le putet,i viziona în aplicat,ia GIS.

16.2.9 Ce urmează?

Mai departe, vet,i vedea cum se importă s, i se exportă datele în/din baza de date.

16.3 Lesson: Import and Export

Desigur, o bază de date care nu dispune de o modalitate de a migra facil datele. în interiorul s, i în afara ei, nu ar fi de
mare folos. Din fericire, există o serie de instrumente care vă permit mutarea cu us,urint,ă a datelor în interiorul s, i în
afara PostGIS.

16.3.1 shp2pgsql

shp2pgsql is a commandline tool to import ESRI Shapefile to the database. Under Unix, you can use the following
command for importing a new PostGIS table:

shp2pgsql -s <SRID> -c -D -I <path to shapefile> <schema>.<table> | \
psql -d <databasename> -h <hostname> -U <username>

Sub Windows, procesul de import trebuie efectuat în două etape:

shp2pgsql -s <SRID> -c -D -I <path to shapefile> <schema>.<table> > import.sql
psql psql -d <databasename> -h <hostname> -U <username> -f import.sql

Este posibil să întâlnit,i această eroare:
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ERROR: operator class "gist_geometry_ops" does not exist for access method
"gist"

This is a known issue regarding the creation in situ of a spatial index for the data you’re importing. To avoid the error,
exclude the -I parameter. This will mean that no spatial index is being created directly, and you’ll need to create it
in the database after the data have been imported. (The creation of a spatial index will be covered in the next lesson.)

16.3.2 pgsql2shp

pgsql2shp is a commandline tool to export PostGIS Tables, Views or SQL select queries. To do this under Unix:

pgsql2shp -f <path to new shapefile> -g <geometry column name> \
-h <hostname> -U <username> <databasename> <table | view>

Pentru a exporta datele folosit,i o interogare:

pgsql2shp -f <path to new shapefile> -g <geometry column name> \
-h <hostname> -U <username> "<query>"

16.3.3 ogr2ogr

ogr2ogr is a very powerful tool to convert data into and from postgis to many data formats. ogr2ogr is part of the
GDAL library and has to be installed separately. To export a table from PostGIS to GML, you can use this command:

ogr2ogr -f GML export.gml PG:'dbname=<databasename> user=<username>
host=<hostname>' <Name of PostGIS-Table>

16.3.4 DB Manager

You may have noticed another option in the Database menu labeled DB Manager. This is a tool that provides a
unified interface for interacting with spatial databases including PostGIS. It also allows you to import and export
from databases to other formats. Since the next module is largely devoted to using this tool, we will only briefly
mention it here.

16.3.5 În concluzie

Importing and exporting data to and from the database can be done in many various ways. Especially when using
disparate data sources, you will probably use these functions (or others like them) on a regular basis.

16.3.6 Ce urmează?

Apoi, vom vedea cum se interoghează datele pe care le-am creat mai înainte.
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16.4 Lesson: Spatial Queries

Interogările spat,iale nu sunt diferite de alte interogări de baze de date. Putet,i utiliza coloana de geometrie la fel ca
pe orice altă coloană de baze de date. O dată cu instalarea PostGIS în baza noastră de date, avem la dispozit,ie funct,ii
suplimentare pentru a interoga baza de date.
Scopul acestei lect,ii: De a afla cum sunt implementate funct,iile spat,iale similare cu funct,iile non-spat,iale „normale”.

16.4.1 Operatori Spaţiali

Când dorit,i să s, tit,i care puncte se află la o distant,ă de 2 grade fat,ă de un punct (X,Y), putet,i proceda astfel cu:

select *
from people
where st_distance(geom,'SRID=4326;POINT(33 -34)') < 2;

Rezultat:

id | name | house_no | street_id | phone_no | geom
----+--------------+----------+-----------+---------------+---------------

6 | Fault Towers | 34 | 3 | 072 812 31 28 | 01010008040C0
(1 row)

Notă: geom value above was truncated for space on this page. If you want to see the point in human-readable
coordinates, try something similar to what you did in the section „View a point as WKT”, above.

De unde s, tim că interogarea de mai sus returnează toate punctele incluse în cadrul a 2 grade? De ce nu 2 metri? Sau
oricare altă unitate?

Răspuns
The units being used by the example query are degrees, because the CRS that the layer is using is WGS 84. This
is a Geographic CRS, which means that its units are in degrees. A Projected CRS, like the UTM projections, is in
meters.
Remember that when you write a query, you need to know which units the layer’s CRS is in. This will allow you to
write a query that will return the results that you expect.

16.4.2 Indecs, i Spat, iali

We also can define spatial indexes. A spatial index makes your spatial queries much faster. To create a spatial index
on the geometry column use:

CREATE INDEX people_geo_idx
ON people
USING gist
(geom);

\d people

Rezultat:

Table "public.people"
Column | Type | Modifiers

-----------+-----------------------+----------------------------------------

(continues on next page)
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(continuare din pagina precedentă)
id | integer | not null default

| | nextval('people_id_seq'::regclass)
name | character varying(50) |
house_no | integer | not null
street_id | integer | not null
phone_no | character varying |
geom | geometry |

Indexes:
"people_pkey" PRIMARY KEY, btree (id)
"people_geo_idx" gist (geom) <-- new spatial key added
"people_name_idx" btree (name)

Check constraints:
"people_geom_point_chk" CHECK (st_geometrytype(geom) = 'ST_Point'::text
OR geom IS NULL)

Foreign-key constraints:
"people_street_id_fkey" FOREIGN KEY (street_id) REFERENCES streets(id)

16.4.3 Try Yourself: ���

Modificat,i tabelul oras,elor, astfel încât coloana de geometrie să fie indexată spat,ial.

Răspuns

CREATE INDEX cities_geo_idx
ON cities
USING gist (geom);

16.4.4 Demo Funct, ii Spat, iale PostGIS

În scopul demonstrării funct,iilor spat,iale PostGIS , vom crea o nouă bază de date care cont,ine câteva date (fictive).
To start, create a new database (exit the psql shell first):

createdb postgis_demo

Remember to install the postgis extensions:

psql -d postgis_demo -c "CREATE EXTENSION postgis;"

Next, import the data provided in the exercise_data/postgis/ directory. Refer back to the previous lesson
for instructions, but remember that you’ll need to create a new PostGIS connection to the new database. You can
import from the terminal or via DB Manager. Import the files into the following database tables:

• points.shp în building
• lines.shp în road
• polygons.shp în region

Încărcat,i aceste trei straturi ale bazei de date în QGIS ca de obicei, prin intermediul Adăugării Straturilor PostGIS.
Atunci când deschidet,i tabelele lor cu atribute, vet,i observa că ambele det,in atât un câmp id cât s, i unul gid, create
în urma importului PostGIS.
Acum, că tabelele sunt importate, putem folosi PostGIS pentru a interoga datele. Merget,i înapoi în ferestra
terminalului (linia de comandă) s, i introducet,i promptul psql astfel:

psql postgis_demo
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Vom demonstra unele dintre aceste expresii de selectare prin crearea unor vederi, pentru a le deschide apoi în QGIS
s, i pentru a le observa rezultatele.

Selectare după locat,ie

Get all the buildings in the KwaZulu region:

SELECT a.id, a.name, st_astext(a.geom) as point
FROM building a, region b
WHERE st_within(a.geom, b.geom)
AND b.name = 'KwaZulu';

Rezultat:

id | name | point
----+------+------------------------------------------
30 | York | POINT(1622345.23785063 6940490.65844485)
33 | York | POINT(1622495.65620524 6940403.87862489)
35 | York | POINT(1622403.09106394 6940212.96302097)
36 | York | POINT(1622287.38463732 6940357.59605424)
40 | York | POINT(1621888.19746548 6940508.01440885)

(5 rows)

Or, if we create a view from it:

CREATE VIEW vw_select_location AS
SELECT a.gid, a.name, a.geom
FROM building a, region b

WHERE st_within(a.geom, b.geom)
AND b.name = 'KwaZulu';

Adăugat,i vederea sub formă de strat, apoi vizualizat,i-o în QGIS:
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Selectat,i vecinii

Show a list of all the names of regions adjoining the Hokkaido region:

SELECT b.name
FROM region a, region b
WHERE st_touches(a.geom, b.geom)
AND a.name = 'Hokkaido';

Rezultat:

name
--------------
Missouri
Saskatchewan
Wales

(3 rows)

As a view:

CREATE VIEW vw_regions_adjoining_hokkaido AS
SELECT b.gid, b.name, b.geom
FROM region a, region b

WHERE st_touches(a.geom, b.geom)
AND a.name = 'Hokkaido';

În QGIS:

Note the missing region (Queensland). This may be due to a topology error. Artifacts such as this can alert us to
potential problems in the data. To solve this enigma without getting caught up in the anomalies the data may have,
we could use a buffer intersect instead:

CREATE VIEW vw_hokkaido_buffer AS
SELECT gid, ST_BUFFER(geom, 100) as geom

(continues on next page)
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(continuare din pagina precedentă)
FROM region

WHERE name = 'Hokkaido';

Aceasta va crea o zonă tampon de 100 de metri în jurul regiunii Hokkaido.
Zona mai închisă este tamponul:

Select using the buffer:

CREATE VIEW vw_hokkaido_buffer_select AS
SELECT b.gid, b.name, b.geom
FROM
(

SELECT * FROM
vw_hokkaido_buffer

) a,
region b
WHERE ST_INTERSECTS(a.geom, b.geom)
AND b.name != 'Hokkaido';

In this query, the original buffer view is used as any other table would be. It is given the alias a, and its geometry
field, a.geom, is used to select any polygon in the region table (alias b) that intersects it. However, Hokkaido
itself is excluded from this select statement, because we don’t want it; we only want the regions adjoining it.
În QGIS:
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It is also possible to select all objects within a given distance, without the extra step of creating a buffer:

CREATE VIEW vw_hokkaido_distance_select AS
SELECT b.gid, b.name, b.geom
FROM region a, region b

WHERE ST_DISTANCE (a.geom, b.geom) < 100
AND a.name = 'Hokkaido'
AND b.name != 'Hokkaido';

Prin aceasta se obt,ine acelas, i rezultat, fără a fi necesar pasul tamponului intermediar:
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Selectat,i valorile unice

Show a list of unique town names for all buildings in the Queensland region:

SELECT DISTINCT a.name
FROM building a, region b
WHERE st_within(a.geom, b.geom)
AND b.name = 'Queensland';

Rezultat:

name
---------
Beijing
Berlin
Atlanta

(3 rows)

Exemple suplimentare …

CREATE VIEW vw_shortestline AS
SELECT b.gid AS gid,

ST_ASTEXT(ST_SHORTESTLINE(a.geom, b.geom)) as text,
ST_SHORTESTLINE(a.geom, b.geom) AS geom

FROM road a, building b
WHERE a.id=5 AND b.id=22;

CREATE VIEW vw_longestline AS
SELECT b.gid AS gid,

ST_ASTEXT(ST_LONGESTLINE(a.geom, b.geom)) as text,
ST_LONGESTLINE(a.geom, b.geom) AS geom

FROM road a, building b
WHERE a.id=5 AND b.id=22;

CREATE VIEW vw_road_centroid AS
SELECT a.gid as gid, ST_CENTROID(a.geom) as geom
FROM road a

WHERE a.id = 1;

CREATE VIEW vw_region_centroid AS
SELECT a.gid as gid, ST_CENTROID(a.geom) as geom
FROM region a

WHERE a.name = 'Saskatchewan';

SELECT ST_PERIMETER(a.geom)
FROM region a
WHERE a.name='Queensland';

SELECT ST_AREA(a.geom)
FROM region a
WHERE a.name='Queensland';

CREATE VIEW vw_simplify AS
SELECT gid, ST_Simplify(geom, 20) AS geom
FROM road;

CREATE VIEW vw_simplify_more AS
SELECT gid, ST_Simplify(geom, 50) AS geom
FROM road;
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CREATE VIEW vw_convex_hull AS
SELECT
ROW_NUMBER() over (order by a.name) as id,
a.name as town,
ST_CONVEXHULL(ST_COLLECT(a.geom)) AS geom
FROM building a
GROUP BY a.name;

16.4.5 În concluzie

At,i văzut cum se pot interoga obiectele spat,iale, cu ajutorul noilor funct,ii de bază de date din PostGIS.

16.4.6 Ce urmează?

Mai departe vom investiga structurile geometriilor complexe s, i cum să le creat,i cu ajutorul PostGIS.

16.5 Lesson: Geometry Construction

În această sect,iune vom intra în detalii despre cum sunt construite geometriile în SQL. În realitate, probabil vet,i utiliza
un GIS cum ar fi QGIS pentru creearea geometriilor complexe folosind instrumentele acestora; cu toate acestea,
întelegerea modului cum sunt stocate poate fi utilă pentru scrierea de interogări s, i înt,elegerea modului cum este
alcătuită baza de date.
Scopul acestei lect,ii: De a înt,elege mai bine cum să creat,i entităt,i spat,iale direct în PostgreSQL/PostGIS.

16.5.1 Crearea S, irurilor de Linii

Întorcându-ne la baza de date address, să facem tabelul de străzi să se potrivească cu celelalte; de ex., să aibă o
constrângere pentru geometrie, un index s, i o intrare în tabelul geometry_columns.

16.5.2 Try Yourself: ���

• Modificat,i tabela streets, astfel încât ea să aibă o coloană de geometrie de tipul ST_LineString.
• Nu uitat,i să facet,i actualizarea coloanelor de geometrie!
• De asemenea, adăugat,i o constrângere pentru a preveni adăugarea geometrii care nu sunt null sau de tip
LINESTRINGS.

• Creat,i un index spat,ial în noua coloană de geometrie

Răspuns

alter table streets add column geom geometry;
alter table streets add constraint streets_geom_point_chk check

(st_geometrytype(geom) = 'ST_LineString'::text OR geom IS NULL);
insert into geometry_columns values ('','public','streets','geom',2,4326,

'LINESTRING');
create index streets_geo_idx

on streets
using gist
(geom);
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Now let’s insert a linestring into our streets table. In this case we will update an existing street record:

update streets
set geom = 'SRID=4326;LINESTRING(20 -33, 21 -34, 24 -33)'
where streets.id=2;

Aruncat,i o privire la rezultatele din QGIS. (Poate fi necesar să facet,i clic-dreapta pe stratul străzilor din panoul
«Straturilor», apoi aleget,i «Transfocare la extinderea stratului».)
Acum, creat,i mai multe intrări de străzi - unele în QGIS, iar altele din linia de comandă.

16.5.3 Crearea Poligoanelor

Creating polygons is just as easy. One thing to remember is that by definition, polygons have at least four vertices,
with the last and first being co-located:

insert into cities (name, geom)
values ('Tokyo', 'SRID=4326;POLYGON((10 -10, 5 -32, 30 -27, 10 -10))');

Notă: Un poligon necesită acolade duble în jurul listei sale de coordonate; aceasta pentru a permite poligoane
complexe având multiple zone neconectate. De exemplu

insert into cities (name, geom)
values ('Tokyo Outer Wards',

'SRID=4326;POLYGON((20 10, 20 20, 35 20, 20 10),
(-10 -30, -5 0, -15 -15, -10 -30))'

);

Dacă at,i urmat acest pas, putet,i verifica rezultatul prin încărcarea setului de date oras,e în QGIS, deschizând tabelul
de atribute al acestuia, s, i selectând noua intrare. Remarcat,i cum cele două noi poligoane se comportă ca unul singur.

16.5.4 Exercit, iu: Learea Oras, elor de Persoane

Pentru acest exercit,iu ar trebui să facet,i următoarele:
• S, terget,i toate datele din tabela de personal.
• Adăugat,i o coloană de cheie străină în tabela de personal, care face referire la cheia primară a tabelei oras,elor.
• Utilizat,i QGIS pentru a captura unele oras,e.
• Utilizat,i SQL pentru a introduce câteva înregistrări de personal, verificând că fiecare are asociate o stradă s, i
un oras, .

Your updated people schema should look something like this:

\d people

Table "public.people"
Column | Type | Modifiers

-----------+-----------------------+--------------------------------------------
id | integer | not null

| | default nextval('people_id_seq'::regclass)
name | character varying(50) |
house_no | integer | not null
street_id | integer | not null
phone_no | character varying |
geom | geometry |

(continues on next page)
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(continuare din pagina precedentă)
city_id | integer | not null

Indexes:
"people_pkey" PRIMARY KEY, btree (id)
"people_name_idx" btree (name)

Check constraints:
"people_geom_point_chk" CHECK (st_geometrytype(geom) =

'ST_Point'::text OR geom IS NULL)
Foreign-key constraints:

"people_city_id_fkey" FOREIGN KEY (city_id) REFERENCES cities(id)
"people_street_id_fkey" FOREIGN KEY (street_id) REFERENCES streets(id)

Răspuns

delete from people;
alter table people add column city_id int not null references cities(id);

(capture cities in QGIS)

insert into people (name,house_no, street_id, phone_no, city_id, geom)
values ('Faulty Towers',

34,
3,
'072 812 31 28',
1,
'SRID=4326;POINT(13 -15)');

insert into people (name,house_no, street_id, phone_no, city_id, geom)
values ('IP Knightly',

32,
1,
'071 812 31 28',
1,
'SRID=4326;POINT(18 -24)');

insert into people (name,house_no, street_id, phone_no, city_id, geom)
values ('Rusty Bedsprings',

39,
1,
'071 822 31 28',
1,
'SRID=4326;POINT(22 -25)');

If you’re getting the following error message:

ERROR: insert or update on table "people" violates foreign key constraint
"people_city_id_fkey"

DETAIL: Key (city_id)=(1) is not present in table "cities".

then it means that while experimenting with creating polygons for the cities table, you must have deleted some of
them and started over. Just check the entries in your cities table and use any id which exists.
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16.5.5 Analizat, i Schema Noastră

Acum, schrma noastră ar trebui să arate în felul următor:

16.5.6 Try Yourself: ���

Creat,i marginile oras,elor prin calucularea înfăs,urătorii convexe pentru toate adresele din acel oras, s, i calcularea unei
zone tampon în jurul acesteia.

Răspuns
• Add some people in «Tokyo Outer Wards» city

INSERT INTO people (name, house_no, street_id, phone_no, city_id, geom)
VALUES ('Bad Aboum',

57,
2,
'073 712 31 21',
2,
'SRID=4326;POINT(22 18)');

INSERT INTO people (name, house_no, street_id, phone_no, city_id, geom)
VALUES ('Pat Atra',

59,
2,
'074 712 31 25',
2,
'SRID=4326;POINT(23 14)');

INSERT INTO people (name, house_no, street_id, phone_no, city_id, geom)
VALUES ('Kat Herin',

65,
2,
'074 722 31 28',
2,
'SRID=4326;POINT(29 18)');

• Create myPolygonTable table

CREATE TABLE myPolygonTable (
id serial NOT NULL PRIMARY KEY,
city_id int NOT NULL REFERENCES cities(id),
geom geometry NOT NULL

);

(continues on next page)
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(continuare din pagina precedentă)

ALTER TABLE myPolygonTable
ADD CONSTRAINT myPolygonTable_geom_polygon_chk
CHECK (st_geometrytype(geom) = 'ST_Polygon'::text );

• Create and load the convex hulls

INSERT INTO myPolygonTable (city_id, geom)
SELECT * FROM
(
SELECT

ROW_NUMBER() over (order by city_id)::integer AS city_id,
ST_CONVEXHULL(ST_COLLECT(geom)) AS geom
FROM people
GROUP BY city_id

) convexHulls;

16.5.7 Accesul la Sub-Obiecte

Folosind funct,iile SFS-Model, avet,i la dispozit,ie o largă gamă de opt,iuni pentru accesarea sub-obiectelor geometriilor
SFS. Când dorit,i să selectat,i primul punct vertex al fiecărei geometrii poligon în tabelul myPolygonTable, trebuie să
o facet,i în felul acesta:

• Transform the polygon boundary to a linestring:

select st_boundary(geom) from myPolygonTable;

• Select the first vertex point of the resultant linestring:

select st_startpoint(myGeometry)
from (

select st_boundary(geom) as myGeometry
from myPolygonTable) as foo;

16.5.8 Procesarea Datelor

PostGIS suportă toate funct,iile conforme standardelor OGC SFS/MM. Toate aceste funct,ii încep cu ST_.

16.5.9 Decuparea

To clip a subpart of your data you can use the ST_INTERSECT() function. To avoid empty geometries, use:

where not st_isempty(st_intersection(a.geom, b.geom))
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select st_intersection(a.geom, b.geom), b.*
from clip as a, road_lines as b
where not st_isempty(st_intersection(st_setsrid(a.geom,32734),

b.geom));
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16.5.10 Construirea de Geometrii pornind de la Alte Geometrii

Plecând de la de la un tabel de puncte dat, dorit,i să generat,i un linestring. Ordinea punctelor este dată de valoarea
id. O altă metodă de ordonare ar putea fi marca de timp, cum ar fi cea pe care o primit,i când capturiat,i puncte cu
un receptor GPS.

To create a linestring from a new point layer called «points», you can run the following command:

select ST_LineFromMultiPoint(st_collect(geom)), 1 as id
from (

select geom
from points
order by id

) as foo;

Pentru a vedea cum funct,ionează fără a crea un nou strat, putet,i executa această comandă în stratul «people», des, i
desigur nu ar avea prea mult sens în lumea reală.
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16.5.11 Curăt,area Geometriilor

You can get more information for this topic in this blog entry.

16.5.12 Diferent,ele dintre tabele

To detect the difference between two tables with the same structure, you can use the PostgreSQL keyword EXCEPT:

select * from table_a
except
select * from table_b;

Ca rezultat, vet,i obt,ine toate acele înregistrări din table_a care nu se regăsesc s, i în table_b.
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16.5.13 Spat, iile tabelelor

You can define where postgres should store its data on disk by creating tablespaces:

CREATE TABLESPACE homespace LOCATION '/home/pg';

When you create a database, you can then specify which tablespace to use e.g.:

createdb --tablespace=homespace t4a

16.5.14 În concluzie

At,i învăt,at cum să creeat,i geometrii mai complexe folosing instruct,iuni PostGIS. Ret,inet,i că aceasta foloses, te la
îmbunătăt,irea cunos, tint,elor pentru lucrul cu o bază de date spat,ială printr-o interfat,ă GIS. În mod curent nu vet,i avea
nevoie să folosit,i aceste instruct,iuni manual, dar o înt,elegere generală vă va ajuta la utilizarea unui GIS, în special
dacă întâlnit,i erori care ar putea să pară altfel criptice.
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CAPITOLUL17

Ghidul de procesare al QGIS

Acest modul a fost publicat de Victor Olaya s, i Paolo Cavallini.
Cuprins:

17.1 Introducere

This guide describes how to use the QGIS processing framework. It assumes no previous knowledge of the Processing
framework or any of the applications that it rely on. It assumes basic knowledge of QGIS. The chapters about scripting
assume you have some basic knowledge of Python and maybe the QGIS Python API.
Acest ghid este conceput pentru studiu individual sau pentru utilizarea într-o sesiune de instruire.
Examples in this guide use QGIS 3.4. They might not work or not be available in versions other than that one.
This guide is comprised of a set of small exercises of progressive complexity. If you have never used the processing
framework, you should start from the very beginning. If you have some previous experience, feel free to skip lessons.
They are more or less independent of each other, and each one introduces some new concept or some new element,
as indicated in the chapter title and the short introduction at the beginning of each chapter. That should make it easy
to locate lessons dealing with a particular topic.
For a more systematic description of all the framework components and their usage, it is recommended to check the
corresponding chapter in the user manual. Use it as a support text along with this guide.
All the exercises in this guide use the same free dataset used throughout the training manual and referenced at section
Data. The zip file to download contains several folders corresponding to each one of the lessons in this guide. In each
of them you will find a QGIS project file. Just open it and you will be ready to start the lesson.
Utilizare plăcută!
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17.2 Câteva lucruri importante de ret,inut, înainte de a începe

Just like the manual of a word processor doesn’t teach you how to write a novel or a poem, or a CAD tutorial doesn’t
show you how to calculate the size of a beam for a building, this guide will not teach you spatial analysis. Instead, it
will show you how to use the QGIS Processing framework, a powerful tool for performing spatial analysis. It is up
to you to learn the required concepts that are needed to understand that type of analysis. Without them, there is no
point in using the framework and its algorithms, although you might be tempted to try.
Haidet,i să vedem, pentru mai multă claritate, un exemplu.
Având în vedere un set de puncte s, i, pentru fiecare punct, o anumită valoare, cu ajutorul geoalgoritmului Kriging se
poate calcula un strat raster. Caseta de dialog a parametrilor pentru acel modul este similară celei de mai jos.

It looks complex, right?
By reading this manual, you will learn things such as how to use that module, how to run it in a batch process to create
raster layers from hundreds of points layers in a single run, or what happens if the input layer has some points selected.
However, the parameters themselves are not explained. A seasoned analyst with a good knowledge of geostatistics
will have no problem understanding those parameters. If you are not one of them and sill, range, or nugget are not
familiar concepts to you, then you should not use the Krigingmodule. More than that, you are far from being ready to
use the Kriging module, since it requires learning about concepts such as spatial autocorrelation or semivariograms,
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which probably you also haven’t heard before, or at least haven’t studied long enough. You should first study and
understand them, and then come back to QGIS to actually run it and perform the analysis. Ignoring this will result in
wrong results and poor (and most likely useless) analysis.
Des, i nu tot,i algoritmii sunt la fel de complecs, i ca s, i algoritmul kriging (unii dintre ei având o complexitate chiar mai
mare!), aproape tot,i necesită o bună înt,elegere a metodelor fundamentale de analiză, pe care se bazează. Fără acea
cunoas, tere, folosirea lor va conduce, cel mai probabil, la rezultate slabe.
Using geoalgorithms without having a good foundation of spatial analysis is like trying to write a novel without
knowing anything about grammar or syntax, and having no knowledge about storytelling. You might get a result, but
it is likely to have no value at all. Please, don’t fool yourself and think that after reading this guide you are already
capable of performing spatial analysis and get sound results. You need to study spatial analysis as well.
În continuare, este indicat un bun punct de referint,ă, la care vă putet,i raporta pentru a afla mai multe despre analiza
datelor spat,iale.
Analize geospat,iale (a 3-a Edit,ie): Un Ghid Cuprinzător de Principii, Tehnici s, i Instrumente Software, Michael John
De Smith, Michael F. Goodchild, Paul A. Longley
It is available online here

17.3 Init,ierea cadrului de procesare

Primul lucru de făcut, înainte de a utiliza cadrul de prelucrare, este să-l configurat,i. Nu este mult de configurat, astfel
încât aceasta este o sarcină us,oară.
Ulterior, vom vedea cum se configurează aplicat,iile externe, care folosesc la extinderea listei algoritmilor disponibili,
însă pentru moment vom lucra cu cadrul de lucru propriu-zis.
The processing framework is a core QGIS plugin, which means that it should already be installed in your system,
since it is included with QGIS. In case it is active, you should see a menu called Processing in your menu bar. There
you can access all the framework components.

Dacă nu putet,i găsi acel meniu, trebuie să activat,i plugin-ul, din managerul de plugin-uri, s, i să-l activat,i.

17.3. Init,ierea cadrului de procesare 525

https://www.spatialanalysisonline.com/


QGIS Training Manual

Elementul principal cu care vom lucra este setul de instrumente. Facet,i clic pe intrarea de meniu corespunzătoare,
apoi vet,i vedea bara de instrumente andocată în partea dreaptă a ferestrei QGIS.
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The toolbox contains a list of all the available algorithms, divided in groups called Providers. Providers can be
(de)activated in the Settings ► Options ► Processing. We will discuss that dialog later in this manual.
By default, only providers that do not rely on third-party applications (that is, those that only require QGIS elements
to be run) are active. Algorithms requiring external applications might need additional configuration. Configuring
providers is explained in a later chapter in this manual.
Dacă at,i ajuns la acest punct, acum suntet,i gata de utilizare a geoalgoritmilor. Nu este nevoie să configurat,i nimic
altceva. Putem rula deja primul nostru algoritm, lucru pe care îl vom face în lect,ia următoare.

17.4 Rularea primului nostru algoritm. Setul de instrumente

Notă: În această lect,ie vom rula primul nostru algoritm pentru a obt,ine un prim rezultat.

As,a cum am ment,ionat deja, cadrul de procesare poate rula algoritmi ai altor aplicat,ii, dar cont,ine, de asemenea,
algoritmi nativi care nu au nevoie de nici un software extern pentru a rula. Pentru a începe explorarea cadrului de
procesare, vom rula unul dintre algoritmii nativi. În particular, vom calcula centroizii setului de poligoane.
În primul rând, deschidet,i proiectul QGIS corespunzător acestei lect,ii. Acesta cont,ine doar un singur strat, cu două
poligoane

Now go to the text box at the top of the toolbox. That is the search box, and if you type text in it, it will filter the list
of algorithms so just those ones containing the entered text are shown. If there are algorithms that match your search
but belong to a provider that is not active, an additional label will be shown in the lower part of the toolbox.
Introducet,i centroids, după care ar trebui să vedet,i ceva de genul următor:
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Caseta de căutare este o modalitate foarte practică de a găsi algoritmul pe care îl căutat,i. În partea de jos a casetei de
dialog, o etichetă suplimentară arată că există algoritmi care se potrivesc căutării dvs., dar apart,in unui furnizor care
nu este activ. Dacă dat,i clic pe linkul din acea etichetă, lista de algoritmi va include s, i rezultatele de la acei furnizori
inactivi, care vor fi afis,ate cu gri deschis. Este afis,at s, i un link pentru activarea fiecărui furnizor inactiv. Vom vedea
mai târziu cum să activăm alt,i furnizori.

Pentru a executa un algoritm, trebuie doar să facet,i dublu clic pe numele acestuia în caseta de instrumente. Când
facet,i dublu clic pe algoritmul Polygon centroids, vet,i vedea următoarea fereastră de dialog.
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Tot,i algoritmii au o interfat,ă similară, care cont,ine practic parametrii de intrare pe care trebuie să îi completat,i, s, i
ies, irile pentru care trebuie să specificat,i unde se păstrează. În acest caz, singura intrare pe care o avem este un strat
vectorial cu poligoane.
Selectat,i stratul Poligoanelor ca intrare. Algoritmul are o singură ies, ire, care este stratul centroizilor. Există două
opt,iuni pentru a defini locul de salvare a datelor de ies, ire: introducet,i o cale pentru fis, ier sau salvat,i-l sub numele unui
fis, ier temporar
In case you want to set a destination and not save the result in a temporary file, the format of the output is defined by
the filename extension. To select a format, just select the corresponding file extension (or add it if you are directly
typing the filepath instead). If the extension of the filepath you entered does not match any of the supported ones, a
default extension (usually .dbf for tables, .tif for raster layers and .shp for vector ones) will be appended to the
filepath and the file format corresponding to that extension will be used to save the layer or table.
În toate exercit,iile din acest ghid, vom salva rezultatele într-un fis, ier temporar, deoarece nu este nevoie să le salvăm
pentru o utilizare ulterioară. Simt,it,i-vă liber să le salvat,i într-o locat,ie permanentă dacă dorit,i.

Atent,ionare: O dată ce se închide QGIS, fis, ierele temporare vor fi s, terse. În cazul unui proiect cu o ies, ire
generată temporar, la deschiderea ulterioară a proiectului, QGIS va semnala acest lucru, din moment ce fis, ierul
nu mai există.

După ce at,i configurat fereastra de dialog pentru algoritm, apăsat,i Run pentru a rula algoritmul.
Vet,i obt,ine rezultatul următor.
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Ies, irea are acelas, i CRS ca s, i intrarea. Geoalgoritmii presupun că toate straturile de intrare au acelas, i CRS s, i, de
aceea, nu vor efectua nici o reproiectare. Cu except,ia cazului unor algoritmi speciali (cum ar fi cei de reproiectare),
ies, irile vor avea acelas, i CRS. Vom vedea în curând mai multe despre acest lucru.
Try yourself saving it using different file formats (use, for instance, shp and geojson as extensions). Also, if you
do not want the layer to be loaded in QGIS after it is generated, you can check off the checkbox that is found below
the output path box.

17.5 Mai multe tipuri de date s, i algoritmi

Notă: În această lect,ie vom rula mai mult de trei algoritmi, vet,i învăt,a cum să folosit,i alte tipuri de intrări, s, i cum
să configurat,i rezultatele pentru a fi salvate automat într-un anumit folder.

Pentru aceste lect,ii vom avea nevoie de o tabelă s, i de un strat poligonal. Vom crea un strat de puncte bazat pe
coordonatele din tabel, s, i apoi vom contoriza numărul de puncte din fiecare poligon. Dacă deschidet,i proiectul QGIS
corespunzător acestei lect,ii, vet,i găsi un tabel cu coordonatele X s, i Y, dar vet,i identifica nici un strat poligonal. Nu
vă facet,i griji, îl vom crea folosind un geoalgoritm de procesare.
Primul lucru pe care îl vom face este de a crea un strat de puncte din coordonatele din tabel, utilizând algoritmul
Stratului de puncte din tabelă. O dată ce s, tit,i cum se foloses, te caseta de căutare, nu vă va fi greu să-l găsit,i. Efectuat,i
un dublu-clic pe ea pentru a o rula s, i pentru a ajunge la următorul său dialog.
Acest algoritm, la fel ca s, i cel din lect,ia precedentă, generează doar o singură ies, ire, având trei intrări:

• Tabela: tabela cu coordonate. Ar trebui să selectat,i aici tabela corespunzătoare lect,iei.
• X and Y fields: these two parameters are linked to the first one. The corresponding selector will show the name
of those fields that are available in the selected table. Select the XCOORD field for the X parameter, and the
YYCOORD field for the Y parameter.

• CRS: Since this algorithm takes no input layers, it cannot assign a CRS to the output layer based on them.
Instead, it asks you to manually select the CRS that the coordinates in the table use. Click on the button on the
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left–hand side to open the QGIS CRS selector, and select EPSG:4326 as the output CRS. We are using this
CRS because the coordinates in the table are in that CRS.

Dialogul dvs. ar trebui să arate astfel.

Now press the Run button to get the following layer (you may need to zoom full to reenter the map around the newly
created points):
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Următorul lucru de care avem nevoie este stratul poligona;. Vom crea o grilă obis,nuită de poligoane, folosind
algoritmul Creare grilă, care are următoarea fereastră cu parametri.
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Atent,ionare: The options are simpler in recent versions of QGIS; you just need to enter min and max for X and
Y (suggested values: -5.696226,-5.695122,40.24742,40.248171)

The inputs required to create the grid are all numbers. When you have to enter a numerical value, you have two
options: typing it directly on the corresponding box or clicking the button on the right–hand side to get to a dialog
like the one shown next.
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The dialog contains a simple calculator, so you can type expressions such as 11 * 34.7 + 4.6, and the result
will be computed and put in the corresponding text box in the parameters dialog. Also, it contains constants that you
can use, and values from other layers available.
In this case, we want to create a grid that covers the extent of the input points layer, so we should use its coordinates to
calculate the center coordinate of the grid and its width and height, since those are the parameters that the algorithm
takes to create the grid. With a little bit of math, try to do that yourself using the calculator dialog and the constants
from the input points layer.
Selectat,i Dreptunghiuri (poligoane) în câmpul Tip.
As in the case of the last algorithm, we have to enter the CRS here as well. Select EPSG:4326 as the target CRS, as
we did before.
În cele din urmă, ar trebui să avet,i un dialog pentru parametri de genul următor:
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(Better add one spacing on the width and height: Horizontal spacing: 0.0001, Vertical spacing: 0.0001, Width:
0.001004, Height: 0.000651, Center X: -5.695674, Center Y: 40.2477955) The case of X center is a bit tricky, see:
-5.696126+(( -5.695222+ 5.696126)/2)
Apăsat,i Run pentru a obt,ine stratul de graticule.
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The last step is to count the points in each one of the rectangles of that graticule. We will use the Count points in
polygons algorithm.

Acum avem rezultatul dorit.
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Before finishing this lesson, here is a quick tip to make your life easier in case you want to persistently save your
data. If you want all your output files to be saved in a given folder, you do not have to type the folder name each
time. Instead, go to the processing menu and select the Options and configuration item. It will open the configuration
dialog.

In the Output folder entry that you will find in the General group, type the path to your destination folder.
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Now when you run an algorithm, just use the filename instead of the full path. For instance, with the configuration
shown above, if you enter graticule.shp as the output path for the algorithm that we have just used, the result
will be saved in D:\processing_output\graticule.shp. You can still enter a full path in case you want
a result to be saved in a different folder.
Încercat,i să rulat,i algoritmul Creare grilă folosind diferite mărimi ale grilei, s, i, totodată, utilizând diverse tipuri de
grilă.

17.6 Reproiectarea CRS-urilor

Notă: În această lect,ie, vom discuta despremodul în care Processing utilizează CRS-urile. Vom vedea, de asemenea,
un algoritm foarte util: reproiectarea.

CRS-urile sunt o mare sursă de confuzie pentru utilizatorii QGIS Processing, as,a că aici sunt câteva reguli generale
cu privire la modul în care pot fi gestionate de către geoalgoritmi, la crearea unui nou strat.

• Dacă există straturi de intrare, se va utiliza CRS-ul primului strat. Acesta este presupus a fi CRS-ul tuturor
straturilor de intrare, atât timp cât este necesar ca acestea să-l aibă pe acelas, i. În cazul în care utilizat,i straturi
cu un CRS diferit, QGIS va emite un avertisment. Observat,i că CRS-ul straturilor de intrare este afis,at alături
de numele său, în dialogul parametrilor.
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• Dacă nu există niciun strat de intrare, atunci se va folosi CRS-ul proiectului, cu except,ia cazului în care
algoritmul cont,ine un câmp specific pentru CRS (cum s-a întâmplat în ultima lect,ie cu algoritmul graticulelor)

Deschidet,i proiectul corespunzător acestei lect,ii, s, i vet,i vedea două straturi denumite 23030 s, i 4326. Ambele cont,in
acelas, i număr de puncte, dar aflate în diferite CRS-uri (EPSG:23030 s, i EPSG:4326). Ele apar în acelas, i loc, deoarece
QGIS este reproiectat „din zbor” în CRS-ul proiectului (EPSG:4326), ele nefiind, de fapt, unul s, i acelas, i strat.
Deschide algoritmul Export/Adăugare coloane de geometrie.

Acest algoritm adaugă coloane noi în tabela de atribute a unui strat vectorial. Cont,inutul coloanelor depinde de tipul
geometriei stratului. În cazul punctelor, se vor adăuga coloane noi, cont,inând coordonatele X s, i Y ale fiecărui punct.
În lista de straturi disponibile, pe care le vet,i găsi în câmpul stratului de intrare, le vet,i vedea pe fiecare, alături de
CRS-ul corespunzător. Astfel, des, i apar în acelas, i loc pe canevas, ele vor fi tratate în mod diferit. Selectat,i stratul
4326.
Celălalt parametru al algoritmului permite setarea modului în care algoritmul foloses, te coordonatele, pentru a calcula
noua valoare care se va adăuga la straturile rezultate. Cei mai mult,i algoritmi nu au o opt,iune de acest gen, s, i vor folosi
în mod direct coordonatele. Selectat,i opt,iunea CRS-ul Stratului pentru a folosi coordonatele as,a cum sunt. Acesta
este modul în care lucrează aproape tot,i geo-algoritmii.
Ar trebui să obt,inet,i un nou strat, cu exact aceleas, i puncte ca s, i celelalte două. Dacă facet,i clic dreapta pe numele
stratului s, i îi deschidet,i proprietăt,ile, vet,i vedea că foloses, te CRS-ul stratului de intrare, adică, EPSG:4326. Atunci
când stratul este încărcat în QGIS, nu vi se va cere să introducet,i CRS-ul stratului, atât timp cât QGIS îl cunoas, te.
Dacă deschidet,i tabelul de atribute a noului strat, vet,i vedea că ea cont,ine două noi câmpuri, cu coordonatele X s, i Y
ale fiecărui punct.
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Aceste valori de coordonate sunt date în CRS-ul stratului, întrucât am ales această opt,iune. Totus, i, chiar dacă s-ar fi
ales o altă opt,iune, CRS-ul de ies, ire al stratului ar fi fost acelas, i, deoarece CRS-ul de intrare este folosit pentru a seta
CRS-ul stratului de ies, ire. Alegerea unei alte opt,iuni va face ca valorile să fie diferite, dar fără schimbarea punctului
rezultat s, i fără ca CRS-ul stratului de ies, ire să fie diferit de CRS-ul celui de intrare.
Acum, efectuat,i acelas, i calcul, utilizând celălalt strat. Ar trebui să găsit,i stratul rezultat, randat exact în acelas, i loc ca
s, i celelalte, având acelas, i CRS, EPSG:23030, acesta fiind CRS-ul stratului de intrare.
Dacă merget,i la tabela sa de atribute, vet,i vedea valori care sunt diferite de cele din primul strat pe care l-am creat.

Acest lucru se datorează faptului că datele originale sunt diferite (se foloses, te un alt CRS), s, i acele coordonate sunt
preluate din ea.
Ce ar trebui să învăt,at,i din asta? Ideea principală din spatele acestor exemple este aceea că geoalgoritmii folosesc
stratul as,a cum se află în sursa sa de date originală, ignorând complet reproiectările pe care QGIS le-ar putea efectua
înainte de randare. Cu alte cuvinte, nu avet,i încredere în ceea ce vedet,i pe pânză, dar avet,i întotdeauna în vedere
faptul că vor fi utilizate datele originale. Acest lucru nu este atât de important în acest caz, din moment ce folosim
doar un singur strat la un moment dat, dar într-un algoritm care are nevoie de mai multe (cum ar fi un algoritm de
decupare), straturile care par să se potrivească sau să se suprapună, ar putea fi foarte departe unul fat,ă de celălalt, atât
timp cât pot avea diferite CRS-uri.
Algoritmii nu realizează nici o reproiectare (cu except,ia algoritmului de reproiectare pe care îl vom vedea în
continuare), de aceea, trebuie ca dvs. să vă asigurat,i că straturile au acelas, i CRS.
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Un modul interesant, care are de-a face cu CRS-ul, este cel de reproiectare. Acesta reprezintă un caz particular,
deoarece are un strat de intrare (cel de reproiectat), însă nu îi va folosi CRS-ul pentru stratul de ies, ire.
Deschide algoritmul de Reproiectare a stratului.

Selectat,i oricare dintre straturile ca intrare, s, i aleget,i EPSG:23029 ca CRS destinat,ie. Rulat,i algoritmul s, i vet,i obt,ine
un nou strat, identic cu cel de intrare, dar cu un alt CRS. Acesta va apărea în aceeas, i regiune a canevasului, ca s, i
celelalte, din moment ce QGIS îl va reproiecta din zbor, dar coordonatele sale originale sunt diferite. Putet,i vedea
acest lucru, prin rularea algoritmului de Exportare/Adăugare coloane de geometrie asupra acestui nou strat de intrare, s, i
prin verificarea diferent,elor dintre coordonatele adăugate s, i cele din tabelele de atribute ale ambelor straturi, calculate
anterior.

17.7 Select,ia

Notă: În această lect,ie vom vedea cum gestionează select,iile algoritmii de procesare din straturile vectoriale care
sunt utilizate ca intrare, s, i cum se poate crea o select,ie, folosindu-se un anumit tip de algoritm.

Spre deosebire de alte plugin-uri de analiză din QGIS, geoalgoritmii de procesare nu dispun de caseta de bifare
pentru „Utilizare doar a entităt,ilor selectate” sau ceva similar acesteia. Comportamentul privitor la selectare este
stabilit pentru întreg plugin-ul s, i pentru tot,i algoritmii, s, i nu pentru fiecare rulare a algoritmului. Algoritmii respectă
următoarele reguli simple, atunci când se utilizează un strat vectorial.

• Dacă stratul are o select,ie, vor fi utilizate numai entităt,ile selectate.
• Dacă nu există nici o select,ie, atunci vor fi utilizate toate entităt,ile.
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Vă rugăm să ret,inet,i că putet,i schimba acest comportament prin deselectarea meniului opt,iunii relevante Processing
► Options ► General`.
You can test that yourself by selecting a few points in any of the layers that we used in the last chapter, and running
the reprojection algorithm on them. The reprojected layer that you will obtain will contain only those points that
were selected, unless there was no selection, which will cause the resulting layer to contain all points from the original
layer.
To make a selection, you can use any of the available methods and tools in QGIS. However, you can also use a
geoalgorithm to do so. Algorithms for creating a selection are found in the toolbox under Vector/Selection

Deschidet,i algoritmul de Select,ie aleatoare.

Lăsând valorile implicite, se vor selecta 10 puncte din stratul curent.
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Vet,i observa că acest algoritm nu produce nici o ies, ire, dar modifică stratul de intrare (nu stratul în sine, ci select,ia
sa). Acesta este un comportament mai put,in frecvent, deoarece tot,i ceilalt,i algoritmi vor produce noi straturi s, i nu
vor modifica straturile de intrare.
Since the selection is not part of the data itself, but something that only exist within QGIS, these selection algorithms
only must be used selecting a layer that is open in QGIS, and not with the file selection option that you can find in the
corresponding parameter value box.
The selection we have just made, like most of the ones created by the rest of the selection algorithms, can also be
done manually from QGIS, so you might be wondering what is the point on using an algorithm for that. Although
now this might not make much sense to you, we will later see how to create models and scripts. If you want to make
a selection in the middle of a model (which defines a processing workflow), only a geoalgorithm can be added to a
model, and other QGIS elements and operations cannot be added. That is the reason why some processing algorithms
duplicate functionality that is also available in other QGIS elements.
By now, just remember that selections can be made using processing geoalgorithms, and that algorithms will only use
the selected features if a selection exists, or all features otherwise.

17.8 Rularea unui algoritm extern

Notă: În această lect,ie vom vedea cum să folosim algoritmi care depind de o tert,ă aplicat,ie, în spet,ă SAGA, care
este unul dintre principalii furnizori de algoritmi.

All the algorithms that we have run so far are part of processing framework. That is, they are native algorithms
implemented in the plugin and run by QGIS just like the plugin itself is run. However, one of the greatest features of
the processing framework is that it can use algorithms from external applications and extend the possibilities of those
applications. Such algorithms are wrapped and included in the toolbox, so you can easily use them from QGIS, and
use QGIS data to run them.
Pentru a rula, unii dintre algoritmii pe care îi vedet,i în vizualizarea simplificată necesită, în prealabil, instalarea
unor aplicat,ii tert,e în sistemul dumneavoastră. Un furnizor de algoritm de interes special este SAGA (Sistem
de Analize Geospat,iale Automate). Pentru a apela în mod corect SAGA, QGIS trebuie să fie configurat în mod
corespunzător. Acest lucru nu este dificil, dacă înt,elegem principiul de funct,ionare. Fiecare aplicat,ie externă are
propria sa configurat,ie, iar mai târziu, în acelas, i manual vom vorbi despre altele, însă acum vom discuta despre
SAGA.
În cazul în care vă aflat,i pe Windows, cel mai bun mod de a lucra cu algoritmii externi este de a instala QGIS cu
ajutorul programului de instalare. Acesta va avea grijă de instalarea dependent,elor necesare, inclusiv SAGA, astfel
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că, dacă l-at,i folosit, nu mai trebuie să întreprindet,i altceva. Putet,i deschide dialogul setărilor, apoi să merget,i la
grupul Furnizorilor/SAGA.

Calea către SAGA trebuie să fie deja configurată s, i să indice folderul în care este instalat SAGA.
Dacă at,i instalat QGIS fără să folosit,i programul autonom de instalare, atunci trebuie să introducet,i calea către SAGA
(care trebuie să fie deja instalată). Versiunea necesară este SAGA 2.1 [aceasta se schimbă în funct,ie de versiunile de
SAGA].
In case you are using Linux, you do not have to set the path to your SAGA installation in the processing configuration.
Instead, you must install SAGA and make sure that the SAGA folder is in PATH, so it can be called from the console
(just open a console and type saga_cmd to check it). Under Linux, the target version for SAGA is also 2.1, but in
some installations (such as the OSGeo Live DVD) you might have just 2.0.8 available. There are some 2.1 packages
available, but they are not commonly installed and might have some issues, so if you prefer to use the more common
and stable 2.0.8, you can do it by enabling 2.0.8 compatibility in the configuration dialog, under the SAGA group.
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O dată ce SAGA este instalat, putet,i lansa un algoritm SAGA printr-un dublu clic pe numele său, similar celorlalt,i
algoritmi. Din moment ce folosim interfat,a simplificată, nu s, tim care dintre algoritmi se bazează pe SAGA sau pe o
altă aplicat,ie externă, dar dacă se întâmplă să rulat,i unul pentru care aplicat,ia corespunzătoare nu este instalată, vi se
va indica acest lucru.

În cazul nostru, presupunând că aplicat,ia SAGA este instalată s, i configurată corect, nu ar trebui să vedet,i această
fereastră ci, în schimb, vet,i obt,ine parametrii dialogului.

17.8. Rularea unui algoritm extern 545



QGIS Training Manual

Să încercăm cu un algoritm bazat pe SAGA, cel denumit Split shapes layer randomly.

Folosind ca intrare stratul de puncte din proiectul corespunzător acestei lect,ii, împreună cu valorile implicite ale
parametrilor, vet,i obt,ine ceva de genul următor (divizarea este aleatorie, de aceea rezultatul dvs. poate fi diferit).

The input layer has been split in two layers, each one with the same number of points. This result has been computed
by SAGA, and later taken by QGIS and added to the QGIS project.
If all goes fine, you will not notice any difference between this SAGA–based algorithm and one of the others that we
have previously run. However, SAGA might, for some reason, not be able to produce a result and not generate the
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file that QGIS is expecting. In that case, there will be problems adding the result to the QGIS project, and an error
message like this will be shown.

This kind of problems might happen, even if SAGA (or any other application that we are calling from the processing
framework) is correctly installed, and it is important to know how to deal with them. Let’s produce one of those error
messages.
Deschidet,i algoritmul Creare graticule, s, i folosit,i-l cu următoarele valori.
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We are using width and height values that is larger than the specified extent, so SAGA cannot produce any output. In
other words, the parameter values are wrong, but they are not checked until SAGA gets them and tries to create the
graticule. Since it cannot create it, it will not produce the expected layer, and you will see the error message shown
above.

Notă: În SAGA >= 2.2.3, comanda va ajusta în mod automat datele de intrare gres, ite, as,a că nu vet,i obt,ine o eroare.
Pentru a provoca o eroare, utilizat,i valori negative la divizare.

Understanding this kind of problems will help you solve them and find an explanation to what is happening. As
you can see in the error message, a test is performed to check that the connection with SAGA is working correctly,
indicating you that there might be a problem in how the algorithm was executed. This applies not only to SAGA, but
also to other external applications as well.
In the next lesson we will introduce the processing log, where information about commands run by geoalgorithms is
kept, and you will see how to get more detail when issues like this appear.
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17.9 Jurnalul de Procesare

Notă: Această lect,ie descrie procesarea jurnalului.

Toate analizele efectuate de cadrul de procesare se înregistrează în sistemul de jurnalizare al aplicat,iei QGIS. Acest
lucru vă permite să aflat,i mai multe despre istoricul utilizării uneltelor de procesare, pentru a putea depăs, i problemele
atunci când acestea apar s, i, de asemenea, vă facilitează repetarea operat,iunilor anterioare, întrucât sistemul de
jurnalizare dispune de o anumită interactivitate.
To open the log, click on the balloon at the bottom right, on the QGIS status bar. Some algorithms might leave
here information about their execution. For instance, those algorithms that call an external application usually log the
console output of that application to this entry. If you have a look at it, you will see that the output of the SAGA
algorithm that we just run (and that fails to execute because input data was not correct) is stored here.
Aceste informat,ii v-ar putea fi utile, pentru a înt,elege ce se întâmplă. Utilizatorii avansat,i vor putea să analizeze o
ies, ire, pentru a afla de ce a es,uat algoritmul. Dacă nu suntet,i un utilizator avansat, informat,iile respective vor fi utile
celor care vă vor ajuta la diagnosticarea unei probleme, pentru a determina dacă a fost cauzată de instalarea unei
aplicat,ii externe sau de datele pe care le-at,i introdus.
Chiar dacă un algoritm poate fi executat, în unele cazuri aces, tia ar putea emite avertismente dacă rezultatul s-ar putea
să nu fie corect. Un exemplu ar fi execut,ia unui algoritm de interpolare pe baza unui număr foarte mic de puncte,
care, des, i se poate desfăs,ura, poate genera un rezultat incorect, atât timp cât ar fi trebuit să fie folosite mai multe
puncte. Este foarte bune să verificat,i în mod regulat acest tip de avertismente, dacă nu vă sunt clare anumite aspecte
ale unui algoritm.
From the Processing► History…menu, you’ll find algorithms that are executed, regardless of they are executed from
the GUI or from the console (which will be explained later in this manual). The execution is stored in this dialog as a
console call. That means that everytime you run an algorithm, a console command is added to the log, and you have
the full history of your working session. Here is how that history looks like:
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Acest lucru poate fi foarte util atunci când începe lucrul cu consola, pentru a aflamai multe despre sintaxa algoritmilor.
Îl vom folosi când vom discuta despre modul în care se pot rula comenzile de analiză din consolă.

17.9.1 ��� Follow Along

The history is also interactive, and you can run any previous algorithm just by double-clicking on its entry. This is an
easy way of replicating the work we already did before.
For instance, try the following:

1. Open the data corresponding to the first chapter of this manual and run the algorithm explained there.
2. Now go to the History dialog and locate the last algorithm in the list, which corresponds to the algorithm you

have just run.
3. Double-click on it and a new result should be produced, just like when you run it using the normal dialog and

calling it from the toolbox.
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17.9.2 ��� Follow Along

You can also modify the algorithm.
1. Copy the algorithm call
2. Open the Plugins ► Python console

3. Paste your copy to run the analysis; change the parameters at will.
4. To display the resulting file, you may want to replace processing.run in the pasted command with

processing.runAndLoadResults.

17.10 Calculatorul raster. Valorile fără-date

Notă: În această lect,ie vom vedea cum se utilizează calculatorul raster pentru a efectua unele operat,ii asupra
straturilor raster. Vom explica, de asemenea, ce sunt valorile fără-date s, i modul în care lucrează cu ele calculatorul
s, i alt,i algoritmi

Calculatorul raster reprezintă unul dintre cei mai puternici algoritmi. Este un algoritm foarte flexibil s, i versatil, care
poate fi folosit în diverse calcule, s, i care va deveni în curând o parte importantă a setului dvs. cu instrumente.
În această lect,ie vom efectua unele calcule, majoritatea simple, cu ajutorul calculatorului raster. Acest lucru ne
va permite să observăm modul de gestionare a unor situat,ii particulare cu care ne-am putea confrunta. Înt,elegerea
acestor aspecte este importantă pentru obt,inerea ulterioară a rezultatelor as, teptate s, i, de asemenea, pentru deprinderea
tehnicilor comune care se pot aplica.
Deschideti proiectul QGIS corespunzător acestei lect,ii s, i vet,i vedea că ea cont,ine mai multe straturi raster.
Acum deschidet,i caseta de instrumente s, i caseta de dialog corespunzătoare calculatorului raster.
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Notă: Interfat,a diferă pentru versiunile recente.

Dialogul cont,ine 2 parametri.
• Straturile de utilizat pentru analiză. Aceasta este o intrare multiplă, ceea ce înseamnă că putet,i selecta câte
straturi dorit,i. Facet,i clic pe butonul din partea dreaptă s, i apoi selectat,i straturile pe care dorit,i să le utilizat,i
în dialogul care va apărea.

• Formula de aplicat. Formula foloses, te ca variabile straturile selectate în parametrul de mai sus, folosind litere
din alfabet (a, b, c...) sau g1, g2, g3.... Adică, formula a + 2 * b este aceeas, i cu g1 + 2 *
g2 s, i va calcula suma valorii din primul strat plus de două ori valoarea din al doilea strat. Ordinea straturilor
corespunde ordinii pe care o vedet,i în dialogul de select,ie.

Atent,ionare: Calculator t,ine cont de majuscule/minuscule.

Pentru a începe, vom schimba unităt,ile DEM-ului din metri în picioare. Formula de care avem nevoie este:

h' = h * 3.28084

Selectat,i DEM-ul din câmpul straturilor s, i introducet,i a * 3.28084 în câmpul formulei.

Atent,ionare: Pentru utilizatorii care nu sunt englezi: folosit,i întotdeauna „.”, nu „,”.

Facet,i clic pe Run pentru a rula algoritmul. Vet,i obt,ine un strat care are acelas, i aspect cu cel al stratului de intrare,
dar cu valori diferite. Stratul de intrare pe care l-am folosit are valori valide în toate celulele sale, astfel încât ultimul
parametru nu are niciun efect.
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Să facem acum un alt calcul, de data aceasta pe stratul accflow. Acest strat cont,ine valori ale debitului acumulat,
un parametru hidrologic. Cont,ine acele valori numai în zona unui bazin hidrografic dat, cu valori fără date în afara
acestuia. După cum putet,i vedea, randarea nu este foarte informativă, din cauza modului în care sunt distribuite
valorile. Folosind logaritmul acestei acumulări de flux va rezulta o reprezentare mult mai informativă. O putem
calcula folosind calculatorul raster.
Deschidet,i iarăs, i dialogul algoritmului, selectat,i stratul accflow ca singur strat de intrare, apoi introducet,i următoarea
formulă: log(a).
Acesta este stratul pe care îl vet,i obt,ine.

Dacă selectat,i instrumentul Identificare pentru a cunoas, te valoarea unui strat într-un anumit punct, selectat,i stratul pe
care tocmai l-am creat s, i facet,i clic pe un punct din afara bazinului, vet,i vedea că acesta cont,ine o valoare no–data.
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Pentru exercit,iul următor vom folosi două straturi în loc de unul s, i vom obt,ine un DEM cu valori de cotă valide numai
în bazinul definit în cel de-al doilea strat. Deschidet,i dialogul calculatorului s, i aleget,i ambele straturi ale proiectului
în câmpul straturilor de intrare. Introducet,i următoarea formulă în câmpul corespunzător:

a/a * b

a refers to the accumulated flow layer (since it is the first one to appear in the list) and b refers to the DEM. What we
are doing in the first part of the formula here is to divide the accumulated flow layer by itself, which will result in a
value of 1 inside the basin, and a no–data value outside. Then we multiply by the DEM, to get the elevation value in
those cells inside the basin (DEM * 1 = DEM) and the no–data value outside (DEM * no_data = no_data)
Acesta este stratul rezultat.

This technique is used frequently to mask values in a raster layer, and is useful whenever you want to perform
calculations for a region other that the arbitrary rectangular region that is used by raster layer. For instance, an
elevation histogram of a raster layer doesn’t have much meaning. If it is instead computed using only values
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corresponding to a basin (as in he case above), the result that we obtain is a meaningful one that actually gives
information about the configuration of the basin.
There are other interesting things about this algorithm that we have just run, apart from the no–data values and how
they are handled. If you have a look at the extents of the layers that we have multiplied (you can do it double–clicking
on their names of the layer in the table of contents and looking at their properties), you will see that they are not the
same, since the extent covered by the flow accumulation layer is smaller that the extent of the full DEM.
That means that those layers do not match, and that they cannot be multiplied directly without homogenizing those
sizes and extents by resampling one or both layers. However, we did not do anything. QGIS takes care of this situation
and automatically resamples input layers when needed. The output extent is the minimum covering extent calculated
from the input layers, and the minimum cell size of their cellsizes.
In this case (and in most cases), this produces the desired results, but you should always be aware of the additional
operations that are taking place, since they might affect the result. In cases when this behaviour might not be the
desired, manual resampling should be applied in advance. In later chapters, we will see more about the behaviour of
algorithms when using multiple raster layers.
Să încheiem această lect,ie cu un alt exercit,iu de mascare. Urmează să calculăm panta în toate zonele cu o altitudine
între 1000 s, i 1500 de metri.
În acest caz, nu dispunem de un strat pentru a-l utiliza drept mască, dar îl putem crea cu ajutorul calculatorului.
Pornes, te calculatorul folosind DEM-ul doar ca pe un strat de intrare, s, i următoarea formulă

ifelse(abs(a-1250) < 250, 1, 0/0)

După cum putet,i vedea, putem folosi calculatorul nu numai pentru a face operat,ii algebrice simple, ci s, i pentru a
efectua calcule mai complexe, care implică propozit,ii condit,ionate, precum cea de mai sus.
Rezultatul are o valoare de 1 în interiorul gamei în care dorim să lucrăm, s, i valori fără-date în celulele din exterior.

The no-data value comes from the 0/0 expression. Since that is an undetermined value, SAGA will add a NaN (Not a
Number) value, which is actually handled as a no-data value. With this little trick you can set a no-data value without
needing to know what the no–data value of the cell is.
Now you just have to multiply it by the slope layer included in the project, and you will get the desired result.
All that can be done in a single operation with the calculator. We leave that as an exercise for the reader.
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17.11 Calculatorul vectorial

Notă: În această lect,ie vom vedea cum se vor adăuga noi atribute în stratul vectorial, pe baza unei expresii
matematice, cu ajutorul calculatorului vectorial.

Cunoas, tem deja cum să utilizăm calculatorul raster pentru a crea noi straturi raster cu ajutorul expresiilor matematice.
Un algoritm similar este disponibil pentru straturi vectoriale, s, i generează un nou strat cu aceleas, i atribute ale stratului
de intrare, plus unul suplimentar cu rezultatul expresiei introduse. Algoritmul este denumit Calculator de câmpuri s, i
are următoarea fereastră de dialog cu parametri.

Notă: În versiunile mai noi de Processing, interfat,a s-a schimbat considerabil, fiind mult mai puternică s, i mai us,or
de utilizat.

Aici sunt câteva exemple de utilizare ale acestui algoritm.
First, let’s calculate the population density of white people in each polygon, which represents a census. We have two
fields in the attributes table that we can use for that, namely WHITE and SHAPE_AREA. We just have to divide them
and multiply by one million (to have density per square km), so we can use the following formula in the corresponding
field

( "WHITE" / "SHAPE_AREA" ) * 1000000

Dialogul parametrilor trebuie completat,i as,a cum se arată mai jos.
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Acest lucru va genera un nou câmp denumit WHITE_DENS
Now let’s calculate the ratio between the MALES and FEMALES fields to create a new one that indicates if male
population is numerically predominant over female population.
Introducet,i următoarea formulă

"MALES" / "FEMALES"

Fereastra parametrilor ar trebui să arate acest lucru, înainte de a apăsa pe butonul OK.
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In earlier version, since both fields are of type integer, the result would be truncated to an integer. In this case the
formula should be: 1.0 * "MALES" / "FEMALES", to indicate that we want floating point number a result.
We can use conditional functions to have a new field with male or female text strings instead of those ratio value,
using the following formula:

CASE WHEN "MALES" > "FEMALES" THEN 'male' ELSE 'female' END

Fereastra parametrilor ar trebui să arate acest lucru.
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Un calculator de câmpuri python este disponibil în Advanced Python field calculator, care nu va fi detaliat aici
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17.12 Definirea eextinderilor

Notă: În această lect,ie vom vedea cum se definesc extinderile, acest lucru fiind necesar unor algoritmi, mai ales cele
pentru rastere.

Unii algoritmi au nevoie de o extindere, pentru a defini zona care urmează să fie acoperită de analiză s, i, de obicei,
pentru a defini extinderea stratului rezultat.
Atunci când este cerută o anumită extindere, aceasta poate fi definită manual, prin introducerea celor patru valori care
o definesc (min X, min Y, max X, max Y), dar există s, i alte modalităt,i, mai practice s, i mai interesante, care pot face
la fel de bine acest lucru. Vom vedea toate acestea în cadrul lect,iei.
Mai întâi, haidet,i să deschidem un algoritm care necesită definirea unei extinderi. Deschidet,i algoritmul de
Rasterizare, care creează un strat raster dintr-un strat vectorial.
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All the parameters, except for the last two ones, are used to define which layer is to be rasterized, and configure how
the rasterization process should work. The two last parameters, on the other hand, define the characteristics of the
output layer. That means that they define the area that is covered (which is not necessarily the same area covered by
the input vector layer), and the resolution/cellsize (which cannot be inferred from the vector layer, since vector layers
do not have a cellsize).
Primul lucru pe care îl putet,i face este să tastat,i cele 4 valori de definire, prezentate anterior, separate prin virgulă.

That doesn’t need any extra explanation. While this is the most flexible option, it is also the less practical in some
cases, and that’s why other options are implemented. To access them, you have to click on the button on the right–hand
side of the extent text box.

Să vedem ce poate face fiecare.
Prima opt,iune este Use layer/canvas extent, care va afis,a dialogul de select,ie de mai jos.
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Here you can select the extent of the canvas (the extent covered by the current zoom), or the extension any of the
available layers. Select it and click on OK, and the text box will be automatically filled with the corresponding values.
The second option is Select extent on canvas. In this case, the algorithm dialog disappears and you can click and drag
on the QGIS canvas to define the desired extent.

După ce eliberat,i butonul mouse-ului, dialogul va reapărea iar caseta de text va cont,ine deja valorile corespunzătoare
în extinderea definită.
The last option is Use min covering extent from input layers, which is the default option. This will compute the min
covering extent of all layers used to run the algorithm, and there is no need to enter any value in the text box. In the
case of a single input layer, as in the algorithm we are running, the same extent can be obtained by selecting that same
input layer in the Use layer/canvas extent that we already saw. However, when there are several input layers, the min
covering extent does not correspond to any of the input layer extent, since it is computed from all of them together.
Vom folosi această ultimă metodă pentru a executa algoritmul nostru de rasterizare.
Completat,i dialogul parametrilor după cum se arată în continuare, apoi apăsat,i OK.
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Notă: In this case, better use an Integer (1 byte) instead of a Floating point (4 byte), since the NAME is an integer
with maximum value=64. This will result in a smaller file size and faster computations.

Vet,i primi un strat raster care acoperă exact zona acoperită de stratul vectorial init,ial.
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In some cases, the last option, Use min covering extent from input layers, might not be available. This will happen in
those algorithm that do not have input layers, but just parameters of other types. In that case, you will have to enter
the value manually or use any of the other options.
Notice that, when a selection exist, the extent of the layer is that of the whole set of features, and the selection is not
used to compute the extent, even though the rasterization is executed on the selected items only. In that case, you
might want to actually create a new layer from the selection, and then use it as input.

17.13 Ies, iri HTML

Notă: În această lect,ie învăt,ăm cum administrează QGIS ies, irile în format HTML, care sunt utilizate pentru a
produce text si grafică.

Toate rezultatele obt,inute până în prezent au fost sub formă de straturi (vectoriale sau raster). Cu toate acestea,
unii algoritmi generează ies, iri sub formă de text s, i grafică. Acestea sunt încapsulate în fis, iere HTML s, i afis,ate în
as,a–numitul Vizualizator de rezultate, care reprezintă un alt element al cadrului de procesare.
Să vedem unul dintre aces, ti algoritmi pentru a înt,elege cum funct,ionează.
Deschidet,i proiectul cu datele de utilizat în această lect,ie, apoi deschidet,i algoritmul Statistici de bază pentru câmpurile
numerice.
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Algoritmul este destul de simplu, trebuind să selectat,i doar stratul de utilizat s, i unul din câmpurile sale (unul numeric).
Ies, irea este de tip HTML, dar caseta corespunzătoare funct,ionează similar cu cea pentru o ies, ire de tip vectorial sau
raster. Putet,i introduce o cale de fis, ier sau să o lăsat,i necompletată, pentru ca salvarea să aibă loc într-un fis, ier
temporar. Totus, i, în acest caz sunt acceptate doar extensiile html s, i htm, nefiind nici o modalitate de a modifica
formatul de ies, ire.
Rulat,i algoritmul, selectând ca intrare singurul strat din proiect s, i câmpul POP2000, după care va apărea un nou
dialog, similar celui prezentat anterior, iar o dată ce algoritmul este executat dialogul parametrilor se va închide.
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Acesta este Vizualizatorul de rezultate. Aici se păstrează tot rezultatul HTML generat în timpul sesiunii curente,
într-o formă us,or accesibilă, astfel încât să-l putet,i verifica rapid, ori de câte ori este nevoie. Orice modificare adusă
straturilor se va pierde la închiderea QGIS, dacă at,i ales ies, irea într-un fis, ier temporar. Dacă at,i efectuat salvarea
într-o cale permanentă, fis, ierul se va păstra, dar nu va apărea în Vizualizatorul de rezultate la următoarea deschidere
a aplicat,iei QGIS.
Some algorithms generate text that cannot be divided into other more detailed outputs. That is the case if, for instance,
the algorithm captures the text output from an external process. In other cases, the output is presented as text, but
internally is divided into several smaller outputs, usually in the form of numeric values. The algorithm that we have
just executed is one of them. Each one of those values is handled as a single output, and stored in a variable. This
has no importance at all now, but once we move to the model designer, you will see that it will allow us to use those
values as numeric inputs for other algorithms.
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17.14 Un prim exemplu de analiză

Notă: În această lect,ie, vom efectua o analiză reală, folosind doar bara de instrumente, astfel încât să vă familiarizat,i
cu elementele cadrului de prelucrare.

O dată ce totul este configurat, iar algoritmii externi sunt gata de utilizare, dispunem de un instrument foarte puternic
pentru efectuarea analizelor spat,iale. Este timpul să elaborăm un exercit,iu mai amplu, folosind date din lumea reală.
We will be using the well-known dataset that John Snow used in 1854, in his groundbreaking work (https://en.
wikipedia.org/wiki/John_Snow_%28physician%29), and we will get some interesting results. The analysis of this
dataset is pretty obvious and there is no need for sophisticated GIS techniques to end up with good results and
conclusions, but it is a good way of showing how these spatial problems can be analyzed and solved by using different
processing tools.
Setul de date cont,ine fis, ierul shape cu decesele cauzate de holeră s, i locat,iile pompelor, precum s, i o hartă OSM randată
în format TIFF. Deschidet,i proiectul QGIS corespunzător acestei lect,ii.

The first thing to do is to calculate the Voronoi diagram (a.k.a. Thiessen polygons) of the pumps layer, to get the
influence zone of each pump. The Voronoi Diagram algorithm can be used for that.
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Destul de us,or, dar ne va oferi deja informat,ii interesante.

568 Capitolul 17. Ghidul de procesare al QGIS



QGIS Training Manual

În mod evident, cele mai multe cazuri se încadrează într-unul dintre poligoane
To get a more quantitative result, we can count the number of deaths in each polygon. Since each point represents a
building where deaths occured, and the number of deaths is stored in an attribute, we cannot just count the points.
We need a weighted count, so we will use the Count points in polygon (weighted) tool.
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The new field will be called DEATHS, and we use the COUNT field as weighting field. The resulting table clearly
reflects that the number of deaths in the polygon corresponding to the first pump is much larger than the other ones.
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Another good way of visualizing the dependence of each point in the Cholera_deaths layer with a point in the
Pumps layer is to draw a line to the closest one. This can be done with the Distance to nearest hub tool, and using
the configuration shown next.
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Rezultatul arată în felul următor:
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Although the number of lines is larger in the case of the central pump, do not forget that this does not represent the
number of deaths, but the number of locations where cholera cases were found. It is a representative parameter, but
it is not considering that some locations might have more cases than other.
A density layer will also give us a very clear view of what is happening. We can create it with the Kernel density
algorithm. Using the Cholera_deaths layer, its COUNT field as weight field, with a radius of 100, the extent and
cellsize of the streets raster layer, we get something like this.
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Amintit,i-vă că, pentru a obt,ine întinderea rezultatului, nu trebuie să o introducet,i. Facet,i clic pe butonul din partea
dreaptă s, i selectat,i Use layer/canvas extent.

574 Capitolul 17. Ghidul de procesare al QGIS



QGIS Training Manual

Selectat,i stratul străzilor raster iar întinderea sa va fi adăugată automat în câmpul de text. Trebuie să facet,i acelas, i
lucru cu dimensiunea celulei, selectând-o, de asemenea, din acel strat.
Prin combinarea cu stratul de pompe, vom vedea că există o pompă în mod clar în punctul fierbinte, în care se constată
densitatea maximă a cazurilor de deces.

17.15 Decuparea s, i îmbinarea straturilor raster

Notă: În această lect,ie vom vedea un alt exemplu de pregătire a datelor spat,iale, pentru a continua utilizarea
geoalgoritmilor în scenarii din lumea reală.

În această lect,ie, vom calcula un strat de pantă pentru suprafat,a care înconjoară o zonă dată a oras,ului, dintr-un
strat vectorial cu un singur poligon. DEM-ul de bază este împărt,it în două straturi raster care, împreună, acoperă
o suprafat,ă mult mai mare decât cea din jurul oras,ului în care ne dorim să lucrăm. Dacă deschidet,i proiectul
corespunzător acestei lect,ii, vet,i vedea ceva de genul următor.
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Aceste straturi au două probleme:
• Acestea acoperă o zonă care este prea mare pentru ceea ce dorim (suntem interesat,i de o regiune mai mică din
jurul centrului oras,ului)

• Ele se află în două fis, iere diferite (limitele oras,ului se încadrează doar într-un singur strat raster, dar, as,a cum
s-a mai zis, dorim o anumită suprafat,ă adit,ională în jurul acestuia).

Ambele sunt us,or rezolvabile cu geoalgoritmii corespunzători.
În primul rând, vom crea un dreptunghi care defines, te zona dorită. Pentru aceasta, vom crea un strat care cont,ine
caseta de încadrare a stratului, împreună cu limitele suprafet,ei oras,ului, apoi vom crea un tampon, astfel încât să
existe un strat raster care îl acoperă un pic mai mult decât este necesar.
Pentru a calcula caseta de încadrare, putem folosi algoritmul Poligonului din extinderea stratului
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Pentru a-l tampona, vom folosi algorimul Fixed distance buffer, cu următoarele valori pentru parametri.
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Atent,ionare: Sintaxa s-a schimbat în versiunile recente; setat,i atât Distant,a cât s, i vertexul Arcului la .25

Aici se află caseta de încadrare obt,inută, utilizând parametrii de mai sus

Este o casetă rotundă, dar putem obt,ine cu us,urint,ă o casetă echivalentă, cu unghiuri drepte, prin rularea algoritmului
Poligon din extinderea stratului asupra ei. Am putea să tamponăm mai întâi limitele oras,ului, iar apoi să calculăm
extinderea dreptunghiului, economisind un pas.

Vet,i observa că rasterele au o proiect,ie diferită fat,ă de vector. Prin urmare, ar trebui să le reproiectăm înainte de a
trece mai departe, folosind instrumentulWarp (reproiectare).
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Notă: Versiunile recente au o interfat,ămai complexă. Asigurat,i-vă că cel put,in ometodă de compresie este selectată.

Cu ajutorul acestui strat, care cont,ine caseta de încadrare a stratului raster pe care dorim să-l obt,inem, putem decupa
ambele straturi raster, utilizând algoritmul de Decupare grilă după un poligon.
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După ce straturile au fost decupate, ele se pot uni cu ajutorul algoritmului SAGA Straturi raster mozaicate.
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Notă: Putet,i economisi timp prin efectuarea mai întâi a îmbinării, s, i abia mai apoi a decupării, evitându-se astfel
apelarea de două ori a algoritmului de decupare. Totus, i, în cazul în care mai multe straturi cu o dimensiune apreciabilă
trebuie îmbinate, vă vet,i alege cu un strat voluminos, care poate fi dificil de prelucrat ulterior. În acest caz, s-ar putea
avea să apelat,i algoritmul de tăiere de mai multe ori, operat,ie consumatoare de timp, însă nu vă îngrijorat,i pentru că
vet,i vedea că există unele instrumente adit,ionale, dedicate automatizării acestui proces. Pentru exemplul următor nu
este cazul să vă facet,i griji, deoarece folosim numai două straturi.

Cu asta, vom obt,ine DEM-ul final pe care ni-l dorim.

Acum este timpul să calculăm stratul pantei.
Stratul pantei poate fi calculat cu ajutorul algoritmului Pantă, Aspect, Curbură, însă DEM-ul obt,inut în ultima etapă nu
este potrivit ca intrare, deoarece valorile altitudinii sunt exprimate în metri, iar mărimea celulei nu este exprimată în
metri (stratul foloses, te un CRS cu coordonate geografice). De aceea, este nevoie de o reproiectare. Pentru a reproiecta
stratul raster, se poate utiliza iarăs, i algoritmul Warp (reproiectare). Vom efectua reproiectarea într-un CRS având
metrul ca unitate (cum ar fi 3857), astfel încât vom putea calcula corect panta, fie cu SAGA, ori cu GDAL.
Panta poate fi de acum calculată, cu ajutorul noului DEM.
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Iar aici este stratul pantei rezultate.
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Panta produsă de algoritmul Pantă, Aspect, Curbură este exprimată în radiani, des, i gradele reprezintă o unitate mai
practică s, i mai comună. Algoritmul de Conversii metrice ne va ajuta să facem conversia (dar în cazul în care nu at,i fi
s, tiut că acest algoritm există, at,i fi putut utiliza calculatorul raster, pe care le-am folosit deja).
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Reproiectând stratului pantă convertit, cu ajutorul Reproiectării stratului raster, obt,inem stratul final pe care l-am
dorit.

Atent,ionare: todo: De adăugat imaginea

Datorită proceselor de reproiectare, stratul final ar putea cont,ine datele din afara casetei de încadrare, pe care am
calculat-o într-unul dintre primii pas, i. Acest lucru poate fi rezolvat prin reluarea decupării, as,a cum am procedat la
obt,inerea DEM-ului de bază.

17.16 Analize hidrologice

Notă: În această lect,ie, vom efectua unele analize hidrologice. Această analiză va fi utilizată în unele din următoarele
lect,ii, deoarece constituie un exemplu foarte bun de analiză a fluxului de lucru, pe care o vom folosi pentru a demonstra
unele caracteristici avansate.

Objectives: Starting with a DEM, we are going to extract a channel network, delineate watersheds and calculate some
statistics.

1. Primul lucru este de a încărca proiectul cu datele lect,iei, care cont,ine doar un DEM.
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2. The first module to execute is Catchment area (in some SAGA versions it is called Flow accumulation (Top
Down)). You can use any of the others named Catchment area. They have different algorithms underneath,
but the results are basically the same.

3. Select the DEM in the Elevation field, and leave the default values for the rest of the parameters.
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Some algorithms calculate many layers, but the Catchment Area layer is the only one we will be using. You can
get rid of the other ones if you want.
Randarea stratului nu este foarte informativă.
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To know why, you can have a look at the histogram and you will see that values are not evenly distributed (there
are a few cells with very high value, those corresponding to the channel network). Use the Raster calculator
algorithm to calculate the logarithm of the catchment value area and you will get a layer with much more
information
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4. The catchment area (also known as flow accumulation) can be used to set a threshold for channel initiation.
This can be done using the Channel network algorithm.

• Initiation grid: use the catchment area layer and not the logarithm one.
• Initiation threshold: 10.000.000
• Initiation type: Greater than

If you increase the Initiation threshold value, you will get a more sparse channel network. If you decrease it,
you will get a denser one. With the proposed value, this is what you get.
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The image above shows just the resulting vector layer and the DEM, but there should be also a raster layer with
the same channel network. That raster will be, in fact, the layer we will be using.

5. Now, we will use the Watersheds basins algorithm to delineate the subbasins corresponding to that channel
network, using as outlet points all the junctions in it. Here is how you have to set the corresponding parameters
dialog.
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Acesta vet,i obt,ine.
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6. This is a raster result. You can vectorise it using the Vectorising grid classes algorithm.
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Acum, să încercăm să calculăm statistici referitoare la valorile elevat,iei dintr-unul din sub-bazine. Ideea este de a
avea un strat cu altitudinile din cadrul acelui sub-bazin pe care, ulterior, să-l transmitem modulului care calculează
aceste statistici.

1. First, let’s clip the original DEM with the polygon representing a subbasin. We will use the Clip raster with
polygon algorithm. If we select a single subbasin polygon and then call the clipping algorithm, we can clip the
DEM to the area covered by that polygon, since the algorithm is aware of the selection.
1. Select a polygon
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2. Call the clipping algorithm with the following parameters:
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The element selected in the input field is, of course, the DEM we want to clip.
Vet,i obt,ine ceva de genul acesta.

2. This layer is ready to be used in the Raster layer statistics algorithm.
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Statisticile rezultate sunt următoarele.

Vom folosi s, i în alte lect,ii atât procedura de calcule a bazinului, cât s, i calcularea statisticilor, pentru a afla cum ne pot
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ajuta alte elemente la automatizarea amândurora, cât s, i pentru a lucra mai eficient.

17.17 Starting with the model designer

Notă: In this lesson we will use the model designer, a powerful component that we can use to define a workflow and
run a chain of algorithms.

O sesiune normală cu uneltele de procesare include mai mult decât rularea unui singur algoritm. De obicei, multe
dintre ele sunt rulate pentru a obt,ine o ies, ire, unele dintre aceste rezultate fiind folosite ca intrare pentru alt,i algoritmi.
Using the model designer, that workflow can be put into a model, which will run all the necessary algorithms in a
single run, thus simplifying the whole process and automating it.
To start this lesson, we are going to calculate a parameter named Topographic Wetness Index. The algorithm that
computes it is called Topographic wetness index (twi).

As you can see, there are two mandatory inputs: Slope and Catchment area. There is also an optional input, but we
will not be using it, so we can ignore it.
The data for this lesson contains just a DEM, so we do not have any of the required inputs. However, we know how
to calculate both of them from that DEM, since we have already seen the algorithms to compute slope and catchment
area. So we can first compute those layers and then use them for the TWI algorithm.
Aici sunt dialogurile pentru parametrii care ar trebui să fie utilizat,i în calculul a 2 straturi intermediare.
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Notă: Panta trebuie să fie calculată în radiani, nu în grade.
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Acesta este modul în care va trebui să setat,i parametrii dialogului pentru algoritmul TWI.
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This is the result that you will obtain (the default singleband pseudocolor inverted palette has been used for rendering).
You can use the twi.qml style provided.
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What we will try to do now is to create an algorithm that calculates the TWI from a DEM in just one single step.
That will save us work in case we later have to compute a TWI layer from another DEM, since we will need just one
single step to do it instead of the three above. All the processes that we need are found in the toolbox, so what we
have to do is to define the workflow to wrap them. This is where the model designer comes in.

1. Deschidet,i modelatorul, prin selectarea intrării sale din meniul de prelucrare.

Two things are needed to create a model: setting the inputs that it will need, and defining the algorithm that
it contains. Both of them are done by adding elements from the two tabs in the left-hand side of the modeler
window: Inputs and Algorithms.

2. Let’s start with the inputs. In this case we do not have much to add. We just need a raster layer with the DEM,
and that will be our only input data.

3. Double click on the Raster layer input and you will see the following dialog.

4. Here we will have to define the input we want:
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1. Since we expect this raster layer to be a DEM, we will call it DEM. That’s the name that the user of the
model will see when running it.

2. Since we need that layer to work, we will define it as a mandatory layer.
Iată cum ar trebui să fie configurat dialogul.

5. Click on OK and the input will appear in the modeler canvas.

6. Now let’s move to the Algorithms tab.
7. The first algorithm we have to run is the Slope, aspect, curvature algorithm. Locate it in the algorithm list,

double-click on it and you will see the dialog shown below.
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This dialog is very similar to the one that you can find when running the algorithm from the toolbox, but
the element that you can use as parameter values are not taken from the current QGIS project, but from the
model itself. That means that, in this case, we will not have all the raster layers of our project available for the
Elevation field, but just the ones defined in our model. Since we have added just one single raster input named
DEM, that will be the only raster layer that we will see in the list corresponding to the Elevation parameter.
Output generated by an algorithm are handled a bit differently when the algorithm is used as a part of a model.
Instead of selecting the filepath where you want to save each output, you just have to specify if that output is
an intermediate layer (and you do not want it to be preserved after the model has been executed), or it is a final
one. In this case, all layers produced by this algorithm are intermediate. We will only use one of them (the
slope layer), but we do not want to keep it, since we just need it to calculate the TWI layer, which is the final
result that we want to obtain.
When layers are not a final result, you should just leave the corresponding field. Otherwise, you have to enter a
name that will be used to identify the layer in the parameters dialog that will be shown when you run the model
later.

8. There is not much to select in this first dialog, since we do not have but just one layer in our model (The DEM
input that we created). Actually, the default configuration of the dialog is the correct one in this case, so you
just have to press OK. This is what you will now have in the modeler canvas.
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9. The second algorithm we have to add to our model is the catchment area algorithm. We will use the algorithm
named Catchment area (Paralell). We will use the DEM layer again as input, and none of the ouputs it produces
are final, so here is how you have to fill the corresponding dialog.
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Acum, modelul dvs. ar trebui să arate în felul următor:
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10. The last step is to add the Topographic wetness index algorithm, with the following configuration.

In this case, we will not be using the DEM as input, but instead, we will use the slope and catchment area layers
that are calculated by the algorithms that we previously added. As you add new algorithms, the outputs they
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produce become available for other algorithms, and using them you link the algorithms, creating the workflow.
11. In this case, the output TWI layer is a final layer, so we have to indicate so. In the corresponding textbox, enter

the name that you want to be shown for this output.
Acum, modelul dvs. este finalizat, s, i ar trebui să arate în felul următor:

12. Enter a name and a group name in the upper part of the model window.

13. Save it clicking on the Save button. You can save it anywhere you want and open it later, but if you save it in
the models folder (which is the folder that you will see when the save file dialog appears), your model will also
be available in the toolbox as well. So stay on that folder and save the model with the filename that you prefer.

14. Now close the modeler dialog and go to the toolbox. In the Models entry you will find your model.
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15. You can run it just like any normal algorithm, double-clicking on it.

După cum putet,i vedea, dialogul parametrilor, cont,ine intrarea pe care at,i adăugat-o modelului, împreună cu
ies, irile pe care le stabilit,i ca fiind finale, atunci când adăugat,i algoritmii corespunzători.

16. Rulat,i-l folosind DEM-ul ca intrare, apoi vet,i obt,ine stratul TWI, într-un singur singur pas.

17.18 Modele mai complexe

Notă: In this lesson we will work with a more complex model in the model designer.

The first model that we created in the previous chapter was a very simple one, with just one input and three algorithms.
More complex models can be created, with different types of inputs and containing more steps. For this chapter we
will work with a model that creates a vector layer with watersheds, based on a DEM and a threshold value. That
will be very useful for calculating several vector layers corresponding to different thresholds, without having to repeat
each single step each time.
This lesson does not contain instructions about how to create your model. You already know the necessary steps
(we saw them in a previous lesson) and you have already seen the basic ideas about the modeler, so you should try it
yourself. Spend a few minutes trying to create your model, and don’t worry about making mistakes. Remember: first
add the inputs and then add the algorithms that use them to create the workflow.

Notă: In case you could not create the full model yourself and you need some extra help, the data folder
corresponding to this lesson contains an «almost» finished version of it. Open the modeler and then open the model
file that you will find in the data folder. You should see something like this.
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This model contains all the steps needed to complete the calculation, but it just has one input: the DEM. That means
that the threshold for channel definition uses a fixed value, which makes the model not as useful as it could be. That
is not a problem, since we can edit the model, and that is exactly what we will do.

1. First, let’s add a numerical input. That will ask the user for a numerical input that we can use when such a
value is needed in any of the algorithms included in our model.

2. Click on the Number entry in the Inputs tree, and you will see the corresponding dialog.
3. Fill it with the following values.

• Numele parametrului: Pragul pentru definirea canalului

• Default value: 1,000,000

Acum, modelul dvs. ar trebui să arate în felul următor:
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The input that we have just added is not used, so the model hasn’t actually changed. We have to link that input
to the algorithm that uses it, in this case the Channel network one. To edit an algorithm that already exists in
the modeler, just click on the pen icon on the corresponding box in the canvas.

4. Click on the Channel network algorithm and you will see something like this.
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The dialog is filled with the current values used by the algorithm. You can see that the Initiation threshold
parameter has a fixed value of 1,000,000 (this is also the default value of the algorithm, but any other value
could be put in there). However, you might notice that the parameter is not entered in a common text box, but
in a drop-down menu.

5. Unfold the threshold parameter menu and you will see something like this.

The input that we added is there and we can select it. Whenever an algorithm in a model requires a numerical
value, you can hardcode it and directly type it, or you can use any of the available inputs and values (remember
that some algorithms generate single numerical values. We will see more about this soon). In the case of a
string parameter, you will also see string inputs and you will be able to select one of them or type the desired
fixed value.

6. Select the Threshold for channel definition input in the Initiation threshold parameter.
7. Click on OK to apply the changes to your model. Now the design of the model should look like this.
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8. The model is now complete. Run it using the DEM that we have used in previous lessons, and with different
threshold values.
Below you have a sample of the result obtained for different values. You can compare with the result for the
default value, which is the one we obtained in the hydrological analysis lesson.

Fig. 17.1: Prag = 100,000
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Fig. 17.2: Prag = 1,0000,000

17.19 Calculele numerice din modelator

Atent,ionare: Atent,ie, deoarece acest capitol nu este bine testat, vă rugăm să raportat,i orice problemă; imaginile
lipsesc

Notă: În această lect,ie vom vedea cum se generează ies, irile numerice din modelator

Pentru această lect,ie, vommodifica modelul hidrologic pe care l-am creat în ultimul capitol (deschidet,i-l în modelator
înainte de a începe), astfel încât să putem automatiza calcularea unei valori valide de prag, nefiind nevoie să cerem
utilizatorului să o introducă. Deoarece această valoare se referă la variabila din pragul stratului raster, o vom extrage
din acest strat, pe baza unor analize statistice simple.
Începand cu modelul ment,ionat mai înainte, haidet,i să facem următoarele modificări:
În primul rând, se calculează statisticile stratului de acumulare a fluxului, utilizând algoritmul Statisticile stratului
raster.
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Acest lucru va genera un set de valori statistice, care vor fi de acum disponibile pentru toate câmpurile numerice ai
altor algoritmi.
Dacă editat,i algoritmul Ret,elei de canale, as,a cum am făcut în ultima lect,ie, vet,i vedea că acum avet,i s, i alte opt,iuni
în afară de intrarea numerică pe care at,i adăugat-o.
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Cu toate acestea, nici una dintre aceste valori nu este adecvată pentru a fi utilizată ca s, i prag valid, atât timp cât
acestea vor produce ret,ele de canale nu prea realistice. Putem obt,ine, în schimb, un nou parametru pe baza lor,
pentru a obt,ine un rezultat mai bun. De exemplu, putem folosi media, la care se va adăuga de 2 ori deviat,ia standard.
Pentru a adăuga această operat,iune aritmetică, putem folosi calculatorul, pe care îl vet,i găsi în grupul
Geoalgorithms/modeler/modeler-tools. Acest grup cont,ine algoritmi care nu sunt foarte utili în afara modelatorului,
dar care oferă funct,ionalităt,i utile la crearea unui model.
Dialogul parametrilor pentru algoritmul calculatorului arată astfel:
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După cum putet,i vedea, dialogul este diferit fat,ă de celelalte pe care le-am văzut, dar avet,i acolo aceleas, i variabile
care au fost disponibile în câmpul Threshold din algoritmul Channel network. Introducet,i formula de mai sus, apoi
apăsat,i pe OK, pentru a adăuga algoritmul.

Dacă extindet,i intrarea rezultatului, as,a cum se arată mai sus, vet,i vedea că modelul este conectat la două dintre valori,
s, i anume media s, i abaterea standard, care sunt cele pe care le-am folosit în formulă.
Adăugarea acestui nou algoritm va aduce o nouă valoare numerică. Dacămerget,i iarăsi în algoritmulChannel network,
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putet,i selecta acea valoare din parametrul Threshold.

Facet,i clic pe OK, după care modelul dvs. ar trebui să arate în felul următor:

616 Capitolul 17. Ghidul de procesare al QGIS



QGIS Training Manual

Nu vom folosi intrarea numerică pe care am adăugat-o modelului, astfel încât ea poate fi eliminată. Facet,i clic-dreapta
pe ea s, i selectat,i Remove

Atent,ionare: todo: De adăugat imaginea

De acum, noul nostru model este terminat.

17.20 Un model în cadrul unui model

Atent,ionare: Atent,ie, deoarece acest capitol nu este bine testat, vă rugăm să raportat,i orice problemă; imaginile
lipsesc

Notă: În această lect,ie vom vedea cum să folosim un model într-un alt model, mai mare.

Am creat deja câteva modele, iar în această lect,ie vom vedea cum le putem combina într-unul singur, mai mare. Un
model se comportă la fel ca oricare alt algoritm, ceea ce înseamnă că putet,i adăuga un model pe care îl avet,i deja, ca
parte a altuia, pe care urmează să-l creat,i.
În acest caz, vom extinde modelul nostru hidrologic, prin adăugarea valorii medii TWI în fiecare dintre bazinele pe
care le generează ca rezultat. Pentru aceasta, avem nevoie de calculul LST s, i a unor statistici. Din moment ce am
creat deja un model pentru a calcula LST dintr-un DEM, este o idee bună să refolosit,i acel model, în locul adăugării
algoritmilor pe care îi cont,ine în mod individual.
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Să începem cu modelul folosit ca punct de plecare pentru ultima lect,ie.

Atent,ionare: todo: De adăugat imaginea

În primul rând, vom adăuga modelul LST. Pentru ca acesta să fie la îndemână, ar fi trebuit să fie salvat în dosarul
modelelor, în caz contrar el nefiind afis,at în caseta de instrumente sau în lista de algoritmi din modelator. Asigurat,i-vă
că este disponibil.
Adăugat,i-l la modelul actual s, i folosit,i DEM-ul de intrare ca s, i ies, ire. Ies, irea este una temporară, din moment ce
vrem să obt,inem doar stratul TWI, pentru a-l folosi la calculul statisticilor. Singura ies, ire a acestui model va fi, în
continuare, stratul vectorial al bazinelor hidrografice.
Iată dialogul parametrilor corespunzători:

Atent,ionare: todo: De adăugat imaginea

Acum avem un strat TWI, pe care îl putem folosi împreună cu stratul vectorial al bazinelor hidrologice, pentru a
genera unul nou, care cont,ine valorile TWI corespunzătoare fiecărui bazin hidrografic.
Acest calcul se face cu ajutorul algoritmului Statisticilor pentru grila acoprită de poligoane. Utilizat,i straturile
ment,ionate mai sus ca intrare, pentru a crea rezultatul final.

Atent,ionare: todo: De adăugat imaginea

Rezultatul algoritmului de Vectorizare a claselor grilei a reprezentat init,ial produsul nostru final, însă acum dorim doar
un rezultat intermediar. Pentru a schimba acest lucru, trebuie să editat,i algoritmul. Efectuat,i dublu-clic pe acesta
pentru a deschide dialogul parametrilor săi, apoi s, terget,i numele ies, irii. Astfel, va rezulta o ies, ire temporară, as,a cum
este în mod implicit.

Atent,ionare: todo: De adăugat imaginea

Iată cum ar trebui să arate modelul final:

Atent,ionare: todo: De adăugat imaginea

După cum vedet,i, utilizarea unui model într-un alt model nu reprezintă nimic special, putând fi adăugat la fel ca
oricare alt algoritm, atât timp cât modelul este salvat în dosarul de modele s, i este disponibil în caseta de instrumente.

17.21 Utilizarea pentru crearea unui model doar a instrumentelor
modelatorului

Notă: Această lect,ie vă arată cum să utilizat,i nis, te algoritmi disponibili doar în modelator, pentru a oferi
funct,ionalităt,i adit,ionale modelelor.

Scopul acestei lect,ii este de a folosi modelatorul la crearea unui algoritm de interpolare, care să t,ină cont de select,ia
curentă, nu doar să folosească numai entităt,ile selectate, dar s, i să utilizeze extinderea acelei select,ii pentru a crea
stratul raster interpolat.
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The interpolation process involves two steps, as it has been already explained in previous lessons: rasterizing the
points layer and fill the no-data values that appear in the rasterized layer. In case the points layer has a selection, only
selected points will be used, but if the output extent is set to be automatically adjusted, the full extent of the layer will
be used. That is, the extent of the layer is always considered to be the full extent of all features, not the one computed
from just the selected ones. We will try to fix that by using some additional tools into our model.
Open the modeler and start the model by adding the required inputs. In this case we need a vector layer (restricted
to points) and an attribute from it, with the values that we will use for rasterizing.

The next step is to compute the extent of the selected features. That’s where we can use the model-only tool called
Vector layer bounds. First, we will have to create a layer that has the extent of those selected features. Then, we can
use this tool on that layer.
An easy way of creating a layer with the extent of the selected features is to compute a convex hull of the input points
layer. It will use only the selected point, so the convex hull will have the same bounding box as the selection. Then we
can add the Vector layer bounds algorithm, and use the convex hull layer as input. It should look this in the modeler
canvas:

17.21. Utilizarea pentru crearea unui model doar a instrumentelor modelatorului 619



QGIS Training Manual

The result from the Vector layer bounds is a set of four numeric values and a extent object. We will use both the
numeric outputs and the extent for this exercise.

We can now add the algorithm that rasterizes the vector layer, using the extent from the Vector layer bounds algorithm
as input.
Completat,i parametrii după cum se arată în continuare:
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Canevasul ar trebui să arate astfel:
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Finally, fill the no-data values of the raster layer using the Close gaps algorithm.

The algorithm is now ready to be saved and added to the toolbox. You can run it and it will generate a raster layer
from interpolating the selected points in the input layer, and the layer will have the same extent as the selection.
Here’s an improvement to the algorithm. We have used a harcoded value for the cellsize when rasterizing. This value
is fine for our test input layer, but might not be for other cases. We could add a new parameter, so the user enters the
desired value, but a much better approach would be to have that value automatically computed.
We can use the modeler-only calculator, and compute that value from the extent coordinates. For instance, to create
a layer with a fixed width of 100 pixels, we can use the following formula in the calculator.
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Now we have to edit the rasterize algorithm, so it uses the output of the calculator instead of the hardcoded value.
The final algorithm should look like this:
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17.22 Interpolarea

Notă: Acest capitol prezintă cum se pot interpola datele punctuale, s, i vi se arată un alt exemplu real de efectuare de
analize spat,iale

În această lect,ie, vom interpola datele punctelor pentru a obt,ine un strat raster. Înainte de a face aceasta, va trebui să
realizăm o anumită pregătire a datelor, iar după interpolare vom efectua o procesare suplimentară, pentru a modifica
stratul rezultat, obt,inând în acest fel o rutină de analiză completă.
Deschidet,i datele exemplu pentru această lect,ie, care ar trebui să arate astfel.

The data correspond to crop yield data, as produced by a modern harvester, and we will use it to get a raster layer of
crop yield. We do not plan to do any further analysis with that layer, but just to use it as a background layer for easily
identifying the most productive areas and also those where productivity can be improved.
The first thing to do is to clean–up the layer, since it contains redundant points. These are caused by the movement
of the harvester, in places where it has to do a turn or it changes its speed for some reason. The Points filter algorithm
will be useful for this. We will use it twice, to remove points that can be considered outliers both in the upper and
lower part of the distribution.
Pentru prima execut,ie, folosit,i următoarele valori ale parametrilor.
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Pentru următoarea execut,ie, folosit,i configurat,ia prezentată mai jos.
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Observat,i că nu utilizăm stratul original ca intrare, ci rezultatul execut,iei anterioare în loc.
Stratul de filtrare final, cu un set redus de puncte, ar trebui să arate similar cu cel original, dar cont,ine un număr mai
mic de puncte. Putet,i verifica acest lucru, prin compararea tabelelor de atribute.
Acum, haidet,i să rasterizăm stratul folosind algoritmul Rasterizare.
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The Filtered points layer refers to the resulting one of the second filter. It has the same name as the one produced by
the first filter, since the name is assigned by the algorithm, but you should not use the first one. Since we will not be
using it for anything else, you can safely remove it from your project to avoid confusion, and leave just the last filtered
layer.
Rezultatul raster arată în felul următor.
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It is already a raster layer, but it is missing data in some of its cells. It only contain valid values in those cells that
contained a point from the vector layer that we have just rasterized, and a no–data value in all the other ones. To fill
the missing values, we can use the Close gaps algorithm.
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Stratul din care lipsesc valorile fără–date arată în felul următor.
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To restrict the area covered by the data to just the region where crop yield was measured, we can clip the raster layer
with the provided limits layer.
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And for a smoother result (less accurate but better for rendering in the background as a support layer), we can apply
a Gaussian filter to the layer.
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Cu parametrii de mai sus, vet,i primi următorul rezultat
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17.23 Mai multe despre interpolare

Notă: Acest capitol prezintă alte cazuri practice de folosire a algoritmilor de interpolare.

Interpolarea este o tehnică obis,nuită, acesta putând fi folosită pentru a demonstra mai multe tehnici care pot fi aplicate
cu ajutorul cadrului de lucru Processing din QGIS. Această lect,ie utilizează unii algoritmi de interpolare care au fost
deja prezentat,i, dar care utilizează o abordare diferită.
Datele pentru această lect,ie cont,in, de asemenea, un strat de puncte, în acest caz, cu date de elevat,ie. În general, îl
vom interpola în acelas, i mod ca s, i în lect,ia anterioară, însă, de data aceasta, vom salva o parte din datele originale,
pe care o vom utiliza în evaluarea calităt,ii procesului de interpolare.
First, we have to rasterize the points layer and fill the resulting no–data cells, but using just a fraction of the points
in the layer. We will save 10% of the points for a later check, so we need to have 90% of the points ready for the
interpolation. To do so, we could use the Split shapes layer randomly algorithm, which we have already used in a
previous lesson, but there is a better way to do that, without having to create any new intermediate layer. Instead of
that, we can just select the points we want to use for the interpolation (the 90% fraction), and then run the algorithm.
As we have already seen, the rasterizing algorithmwill use only those selected points and ignore the rest. The selection
can be done using the Random selection algorithm. Run it with the following parameters.
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Se vor selecta 90% dintre punctele din stratul de rasterizat
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Select,ia este aleatoare, astfel încât select,ia dvs. ar putea diferi de select,ia arătată în imaginea de mai sus.
Now run the Rasterize algorithm to get the first raster layer, and then run the Close gaps algorithm to fill the no–data
cells [Cell resolution: 100 m].

To check the quality of the interpolation, we can now use the points that are not selected. At this point, we know the
real elevation (the value in the points layer) and the interpolated elevation (the value in the interpolated raster layer).
We can compare the two by computing the differences between those values.
Din moment ce vom folosi punctele care nu sunt selectate, în primul rând, haidet,i să inversăm select,ia.
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The points contain the original values, but not the interpolated ones. To add them in a new field, we can use the Add
raster values to points algorithm
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The raster layer to select (the algorithm supports multiple raster, but we just need one) is the resulting one from the
interpolation. We have renamed it to interpolate and that layer name is the one that will be used for the name of the
field to add.
Acum avem un strat vectorial care cont,ine ambele valori, cu punctele care nu au fost utilizate pentru interpolare.

Acum, vom folosi calculatorul de câmpuri pentru această sarcină. Deschidet,i algoritmul Calculatorului de câmpuri
s, i-l vom rula cu următorii parametri.
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If your field with the values from the raster layer has a different name, you should modify the above formula
accordingly. Running this algorithm, you will get a new layer with just the points that we haven’t used for the
interpolation, each of them containing the difference between the two elevation values.
Reprezentând stratul în conformitate cu acea valoare, vom avea o primă idee despre locat,ia celor maimari discrepant,e.
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Interpolând acel strat vet,i obt,ine un strat raster cu eroarea estimată în toate punctele din zona interpolată.
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You can also get the same information (difference between original point values and interpolated ones) directly with
GRASS ► v.sample.
Your results might differ from these ones, since there is a random component introduced when running the random
selection, at the beginning of this lesson.

17.24 Execut,ia iterativă a algoritmilor

Notă: Această lect,ie prezintă un mod diferit de a executa algoritmii care folosesc straturi vectoriale, prin rularea lor
în mod repetat, iterând entităt,ile dintr-un strat vectorial de intrare

We already know the model designer, which is one way of automating processing tasks. However, in some situations,
the modeler might not be what we need to automate a given task. Let’s see one of those situations and how to easily
solve it using a different functionality: the iterative execution of algorithms.
Deschidet,i datele corespunzătoare acestui capitol. Acesta ar trebui să arate astfel.

Vet,i recunoas, te DEM-ul nostru bine-cunoscut din capitolele anterioare, s, i un set de bazine hidrografice extrase din
el. Imaginat,i-vă că trebuie să reducem DEM-ul în mai multe straturi mici, fiecare dintre ele cont,inând doar datele de
elevat,ie corespunzătoare unui singur bazin hidrografic. Acest lucru va fi util dacă dorit,i mai târziu să calculat,i unii
parametri ce t,in de fiecare bazine hidrografice, cum ar fi cota de elevat,ie sau curba hipsographică.
Acest lucru reprezintă o sarcină lungă durată s, i plictisitoare, mai ales în cazul în care numărul bazinelor hidrografice
este mare. Cu toate acestea, este o sarcină care poate fi us,or automatizată, as,a cum vom vedea.
Algoritmul utilizat pentru decuparea stratului raster după un strat poligonal este denumit Decuparea grilei cu ajutorul
poligoanelor, s, i are următorul dialog cu parametri.
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Putet,i să-l executat,i folosind stratul bazinelor hidrografice s, i DEM-ul ca intrare, apoi vet,i obt,ine următorul rezultat.
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După cum putet,i vedea, se utilizează aria acoperită de toate poligoanele bazinelor hidrografice.
Putet,i decupa DEM-ul după un singur bazin hidrografic, prin selectarea bazinului dorit, s, i apoi prin rularea
algoritmului as,a cum am făcut-o mai înainte.

Deoarece numai entităt,ile selectate sunt folosite, numai poligonul selectat va fi folosit pentru a decupa stratul raster.
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Făcând acest lucru pentru toate bazinele, se va produce rezultatul pe care îl căutăm, dar aceasta nu arată ca un mod
foarte practic de lucru. În schimb, să vedem cum automatizăm rutina selectare s, i decupare.
Mai întâi de toate, eliminat,i select,ia anterioară, astfel încât toate poligoanele să fie utilizate din nou. Deschidet,i
algoritmul Decupare grilă după un poligon, apoi selectat,i aceleas, i surse ca s, i înainte, dar de data aceasta facet,i clic
pe butonul pe care le vet,i regăsi în partea dreaptă a intrării stratului vectorial, în care at,i selectat stratul bazinelor
hidrografice.

Acest buton va cauza divizarea stratului de intrare selectat în mai multe straturi, pe măsură ce se descoperă entităt,ile,
fiecare dintre ele cont,inând câte un singur poligon. Algoritmul va fi solicitat în mod repetat, câte o dată pentru fiecare
dintre aceste straturi cu un singur poligon. Rezultatul, în loc de un singur strat raster, va consta într-un set de straturi
raster, fiecare dintre ele corespunzând câte unei execut,ii a algoritmului.
Iată rezultatul pe care îl vet,i obt,ine, dacă at,i rulat algoritmul de tăiere as,a cum s-a explicat.
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Pentru fiecare strat, paletă de culori alb-negru, (sau orice paletă pe care o utilizat,i), este ajustată în mod diferit, de la
minim până la valorile sale maxime. Acesta este motivul pentru care putet,i vedea diferite piese, iar culorile nu par a
se potrivi la granit,a dintre straturi. Valorile, cu toate acestea, se potrivesc.
Dacă introducet,i un nume pentru fis, ierul de ies, ire, fis, ierele rezultate vor fi denumite folosind ca nume de fis, ier s, i, ca
sufix, un număr corespunzător pentru fiecare iterat,ie.

17.25 Mai multe utilizări ale execut,iei iterative a algoritmilor

Notă: Această lect,ie vă arată cum să combinat,i execut,ia iterativă a algoritmilor cu modelatorul, pentru a extinde
automatizarea.

Execut,ia iterativă a algoritmilor este disponibilă nu doar pentru algoritmii încorporat,i, ci, de asemenea, s, i pentru
algoritmii pe care îi putet,i crea, cum ar fi modelele. Vom vedea cum putem combina un model cu executarea iterativă
a algoritmilor, astfel încât să putem obt,ine cu us,urint,ă rezultate mai complexe.
Datele pe care le vom folosi sunt aceleas, i pe care le-am folosit deja în ultima lect,ie. În acest caz, în afară de
decuparea DEM-ului în funct,ie de poligonul fiecărui bazin hidrografic, vom adăuga cât,iva pas, i, în care vom calcula
o curbă hipsometrică pentru fiecare bazin, pentru a studia modul în care este distribuită elevat,ia în cadrul bazinelor
hidrografice.
Din moment ce avem un flux de lucru care implică mai multe etape (decupare + calcul curbă hipsometrică), ar trebui
să mergem la modelator s, i să creăm modelul corespunzător fluxului respectiv.
You can find the model already created in the data folder for this lesson, but it would be good if you first try to create
it yourself. The clipped layer is not a final result in this case, since we are just interested in the curves, so this model
will not generated any layers, but just a table with the curve data.
Modelul ar trebui să arate astfel:
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Add the model to you models folder, so it is available in the toolbox, and execute it.
Select the DEM and watersheds basins.
The algorithm will generate tables for all the basins and place them in the output directory.
We can make this example more complex by extending the model and computing some slope statistics. Add the Slope
algorithm to the model, and then the Raster statistics algorithm, which should use the slope output as its only input.

Dacă rulat,i acum modelul, în afară de tabele, vet,i obt,ine un set de pagini cu statistici. Aceste pagini vor fi disponibile
în caseta de dialog a rezultatelor.
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17.26 Interfat,a de prelucrare în serie

Notă: Această lect,ie introduce interfat,a de prelucrare în serie, care permite executarea unui singur algoritm, cu un
set de valori de intrare diferite.

Uneori, un anumit algoritm trebuie executat în mod repetat cu diverse intrări. Acest caz se întâmplă, atunci când
un set de fis, iere de intrare trebuie convertit dintr-un format în altul, sau atunci când mai multe straturi aflate într-o
anumită proiect,ie trebuie convertite în altă proiect,ie.
În acest caz, apelarea repetată a algoritmului din bara de instrumente nu este cea mai bună opt,iune. În schimb,
ar trebui folosită interfat,a de prelucrare în serie, care simplifică foarte mult efectuarea unei execut,ii multiple a unui
algoritm dat. Pentru a rula un algoritm ca un proces în serie, identificat,i-l în bara de instrumente, s, i în loc de dublu-clic
pe el, facet,i clic pe el s, i aleget,i Rulare ca proces în serie.

Pentru acest exemplu, vom utiliza Reproiectare algoritm, as,a că găsit,i-l s, i procedat,i as,a cum este descris mai sus. Vet,i
obt,ine următorul dialog.

Dacă aruncat,i o privire la datele acestei lect,ii, vet,i vedea că acestea cont,in un set de trei fis, iere shape, dar nici un fis, ier
de proiect QGIS. Aceasta se datorează faptului că, atunci când un algoritm este rulat ca un proces în serie, intrările
stratului pot fi selectate fie din proiectul QGIS curent, fie din fis, iere. Asta face mai us,oară procesarea unei cantităt,i
mari de straturi, cum ar fi, de exemplu, toate straturile dintr-un folder dat.
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Fiecare rând din tabelul dialogului de prelucrare în serie, reprezintă o singură execut,ie a algoritmului. Celulele dintr-
un rând corespund parametrului necesar algoritmului, ele nefiind dispuse una deasupra celeilalte, la fel ca într-un
dialog normal de execut,ie singulară, ci orizontal în acel rând.
Definirea procesului care va rula în serie constă în completarea tabelului cu valorile corespunzătoare, iar dialogul în
sine cont,ine multe instrumente care us,urează această sarcină.
Să începem completarea, unul câte unul, a câmpurilor. Prima coloană de umplut este Stratul de intrare. În loc să
introducet,i numele fiecăruia dintre straturile pe care vrem să le procesăm, le putet,i selecta pe toate, s, i să lăsăm
dialogul să le ordoneze câte unul în fiecare rând. Facet,i clic pe butonul din celula din stânga-sus, iar în dialogul care
se va deschide, de select,ie a fis, ierului, selectat,i trei dosare pentru a fi reproiectate. Din moment ce numai unul dintre
ele este necesar pentru fiecare rând, cele rămase vor fi folosite pentru a umple rândurile de dedesubt.

Numărul implicit de rânduri este de 3, care este exact numărul de straturi pe care le avem de convertit, dar dacă
selectat,i mai multe straturi, noi rânduri vor fi adăugate automat. Dacă dorit,i să umplet,i manua intrărilel, putet,i
adăuga mai multe rânduri folosind butonul Adăugare rând.
Vom converti toate acele straturi la CRS-ul EPSG:23029, as,a că vom selecta acest CRS în al doilea câmp. Ne dorim
acelas, i lucru pentru toate rândurile, dar nu trebuie să repetăm aceeas, i pas, i pentru fiecare rând. În schimb, stabilim
CRS-ul pentru primul rând (cel din partea de sus), folosind butonul din celula corespunzătoare, s, i efectuând dublu clic
pe antetul de coloană. Asta va face ca toate celulele din coloană să se completeze utilizând valoarea celulei superioare.
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În cele din urmă, trebuie să selectat,i un fis, ier de ies, ire pentru fiecare execut,ie, care va cont,ine stratul reproiectat
corespunzător. Încă o dată, vom face acest lucru doar pentru primul rând. Facet,i clic pe butonul dn celula de sus, iar
în folderul în care dorit,i să punet,i fis, ierele de ies, ire, introducet,i un nume de fis, ier (de exemplu, reprojected.
shp).
Acum, când facet,i clic pe OK pe dialogul de select,ie a fis, ierului, denumirea fis, ierului nu va fi automat înscrisă în
celulă, dar o casetă de intrare, similară cu următoarea, va fi afis,ată în loc.

Dacă selectat,i prima opt,iune, atunci doar celula curentă va fi umplută. Dacă o selectat,i pe oricare dintre celelalte, toate
rândurile vor fi umplute cu un anumit model. În acest caz, vom selecta opt,iunea Umplere cu valoarea parametrului,
iar apoi valoarea Stratului de intrare din meniul derulant. Acest lucru va determina ca valoarea din Stratul de intrare
(adică, numele stratului) să fie adăugat la numele fis, ierului pe care l-am adaugat, făcând diferit fiecare nume de fis, ier
de ies, ire. Tabelul de prelucrare în serie ar trebui să arate astfel.
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Ultima coloană stabiles, te dacă, sau nu, se vor adăuga straturile rezultate la proiectul QGIS curent. Lăsat,i implicită
opt,iunea Da, astfel încât să putet,i vedea rezultatele, în acest caz.
Facet,i clic pe OK pentru a rula procesarea în serie. Dacă totul a mers bine, toate straturile vor fi procesate, s, i vor fi
create 3 straturi noi.

17.27 Modelele în interfat,a de prelucrare a loturilor

Atent,ionare: Atent,ie, deoarece acest capitol nu este bine testat, vă rugăm să raportat,i orice problemă; imaginile
lipsesc

Notă: Această lect,ie prezintă un alt exemplu de interfat,ă de prelucrare a loturilor, dar de data aceasta cu ajutorul
unui model în locul unui algoritm încorporat

Modelele sunt similare oricărui alt algoritm, ele putând fi utilizate în interfat,a de prelucrare a loturilor. Pentru a
demonstra aceasta, iată un scurtă exemplu în care folosim modelul nostru hidrologic, bine-cunoscut deja.
Asigurat,i-vă că avet,i modelul adăugat la setul de instrumente, apoi rulat,i-l ca lot. Iată cum ar trebui sa arate dialogul
de prelucrare a lotului:

Atent,ionare: todo: De adăugat imaginea

Adăugat,i un total de 5 rânduri. Selectat,i fis, ierul DEM corespunzător acestei lect,ii ca intrare pentru ele. Apoi
introducet,i 5 valori de prag diferite, as,a cum se arată în continuare.

17.27. Modelele în interfat,a de prelucrare a loturilor 649



QGIS Training Manual

Atent,ionare: todo: De adăugat imaginea

După cum vedet,i, interfat,a de prelucrare a lotului poate funct,iona nu doar la rularea aceluias, i proces pe diferite seturi
de date, dar, de asemenea, s, i pe acelas, i set de date cu parametrii diferit,i.
Facet,i clic pe OK, după care ar trebui să obt,inet,i 5 noi straturi, cu bazinele corespunzătoare celor 5 valoril de prag
specificate.

17.28 Script de interceptare a pre- s, i post-execut,iei

Notă: Această lect,ie vă arată cum se utilizează scrípturile de interceptare a pre- s, i post-execut,iei, permit,ând astfel
efectuarea unor operat,ii adit,ionale înainte s, i după procesarea efectivă.

Scrípturile Processing de interceptare a pre s, i post-execut,iei se execută înainte s, i după prelucrarea datelor efective.
Ele pot fi folosite pentru a automatiza sarcinile care ar trebui să fie efectuate, ori de câte ori un algoritm este executat.
The syntax of the hooks is identical to the syntax of Processing scripts, see the corresponding chapter in the QGIS
User Guide for more details.
În plus fat,ă de toate caracteristicile scrípturilor, în codurile de interceptare putet,i utiliza o variabilă globală specială
dnumită alg, care reprezintă algoritmul care tocmai a fost (sau urmează să fie) executat.
Here is an example post-execution script. By default, Processing stores analysis results in temporary files. This script
will copy outputs to a specific directory, so they won’t be deleted after closing QGIS.

import os
import shutil
from processing.core.outputs import OutputVector, OutputRaster, OutputFile

MY_DIRECTORY = '/home/alex/outputs'

for output in alg.outputs:
if isinstance(output, (OutputVector, OutputRaster, OutputFile)):

dirname = os.path.split(output.value)[0]
shutil.copytree(dirname, MY_DIRECTORY)

In the first two lines we import the required Python packages: os—for path manipulations, e.g. extracting file name,
and shutil— for various filesystem operations like copying files. In the third line we import Processing outputs.
This will be explained in more detail later in this lesson.
Then we define a MY_DIRECTORY constant, which is the path to the directory where we want to copy analysis
results.
La sfârs, itul scriptului, avem codul principal de interceptare. În cadrul unei bucle vom itera toate ies, irile algoritmilor
s, i vom verifica dacă ele reprezintă fis, iere s, i dacă pot fi copiate. Dacă da, determinăm directorul de nivel superior în
care sunt localizate fis, ierele de ies, ire, apoi le copiem în directorul nostru.
To activate this hook we need to open the Processing options, find the entry named Post-execution script file in the
General group, and specify the filename of the hook script there. the specified hook will be executed after each
Processing algorithm.
In a similar way, we can implement pre-execution hooks. For example, let’s create a hook to check input vectors for
geometry errors.

from qgis.core import QgsGeometry, QgsFeatureRequest
from processing.core.parameters import ParameterVector

(continues on next page)
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(continuare din pagina precedentă)
for param in alg.parameters:

if isinstance(param, ParameterVector):
layer = processing.getObject(param.value)
for f in layer.getFeatures(QgsFeatureRequest().setSubsetOfAttributes([])):

errors = f.geometry().validateGeometry()
if len(errors) > 0:

progress.setInfo('One of the input vectors contains invalid␣
↪→geometries!')

As in the previous example, first we import required QGIS and Processing packages.
Then we iterate over all the algorithm parameters and if a ParameterVector parameter is found, we get the
corresponding vector layer object from it. We loop over all the features of the layer and check them for geometry
errors. If at least one feature contains an invalid geometry, we print a warning message.
To activate this hook we need enter its filename in the Pre-execution script file option in the Processing configuration
dialog. The hook will be executed before running any Processing algorithm.

17.29 Alte programe

Module contributed by Paolo Cavallini - Faunalia

Notă: Acest capitol vă arată cum să utilizat,i programe suplimentare din interiorul Procesării. Pentru a finaliza,
trebuie să avet,i instalate pachetele relevante, cu ajutorul instrumentelor specifice sistemului de operare.

17.29.1 GRASS

GRASS este o suită GIS gratuită, cu sursă deschisă, pentru managementul s, i analiza datelor geospat,iale, pentru
prelucrare de imagine s, i grafică, product,ie de hărt,i, modelare s, i vizualizare spat,ială.
Acesta este instalat în mod implicit în Windows, cu ajutorul pachetului de instalare independent OSGeo4W (32 s, i 64
bit,i), existând pachete s, i pentru toate distribut,iile majore de Linux.

17.29.2 R

R este un mediu software cu sursă liberă s, i deschisă, pentru calcul statistic s, i grafică.
Trebuie instalate separat, împreună cu câteva biblioteci necesare (LIST). Pentru a permite utilizarea lui R în QGIS,
trebuie instalat s, i pluginul Processing R Provider.
Frumuset,ea implementării Processing este că putet,i adăuga propriile scrípturi, fie simple sau complexe, acestea putând
fi apoi utilizate ca orice alt modul, conectate în fluxuri de lucru mai complexe, etc.
Testat,i unele dintre exemplele preinstalate, dacă avet,i R deja instalat (amintit,i-vă să activat,i modulele R din interfat,a
de configurare generală a Processing).
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17.29.3 Altele

LASTools reprezintă un set de comenzi mixte, libere s, i proprietare, pentru a procesa s, i analiza datele Lidar.
Disponibilitatea în diferite sisteme de operare este variabilă.
Mai multe instrumente sunt disponibile, prin intermediul plugin-urilor suplimentare, cum ar fi:

• LecoS: o suită de statistici de acoperire a terenului s, i de ecologie a peisajului
• lwgeom: fostă parte din PostGIS, această bibliotecă aduce câteva instrumente utile pentru curăt,area geometriei
• Animove: instrumente de analiză a unei serii de animale domestice.

Mai multe vor urma.

17.29.4 Comparat, ie între backend-uri.

Distant,e s, i tampoane

Haidet,i să încărcăm points.shp s, i să scriem``buf`` în filtrul instrumentului din bara de instrumente, apoi facet,i
dublu clic pe el:

• Tamponul cu distant,ă fixă: Distant,a 10000
• Tamponul cu distant,ă variabilă: MĂRIMEA câmpului distant,ă
• v.buffer.distance: distant,a 10000
• v.buffer.column: MĂRIMEA bufcolumn
• Shapes Buffer: valoarea fixă 10000 (dissolve s, i not), câmpul atribut (cu scalare)

Vedet,i câtă viteză diferă, s, i câte opt,iuni sunt disponibile.
Exercit,iul pentru cititor: găsit,i diferent,ele din geometria rezultată prin metodele diferite.
Acum, tampoanele s, i distant,ele:

• în primul rând, încărcat,i s, i rasterizat,i vectorul rivers.shp cu GRASS ► v.to.rast.value; atent,ie: mărimea
celulelor trebuie să fie setată la 100 m, în caz contrar timpul de calcul va fi enorm; harta rezultată va cont,ine 1
s, i NULL-uri

• la fel, cu SAGA ► Shapes to Grid ► COUNT (harta rezultată: de la 6 la 60)
• apoi, proximitatea (valoarea= 1 pentru GRASS, o listă de ID-uri de râuri pentru SAGA), r.buffer cu parametrii
1000,2000,3000, r.grow.distance (prima din cele două hărt,i; a doua va arăta suprafet,ele ce t,in de fiecare râu,
dacă se aplică pe un raster SAGA).

Dizolvare

Dizolvare entităt,i pe baza unui atribut comun:
• GRASS ► v.dissolve municipalities.shp pe PROVINCIE
• QGIS ► Dissolve municipalities.shp pe PROVINCIE
• OGR ► Dizolvă municipalities.shp pe PROVINCIE
• SAGA► Polygon Dissolve municipalities.shp pe PROVINCIE (NB: Păstrare granit,e interioare trebuie
să fie neselectat)

Notă: Ultima nu funct,ionează în SAGA <=2.10

Exercit,iu pentru cititor: găsit,i diferent,ele (de geometrie s, i de atribute) prin metode diferite.
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17.30 Interpolarea s, i conturarea

Module contributed by Paolo Cavallini - Faunalia

Notă: Acest capitol prezintă folosirea diferitelor variante de calcularre a interpolărilor.

17.30.1 Interpolarea

Proiectul prezintă un gradient de precipitat,ii, de la sud la nord. Să folosim metode diferite pentru interpolare, toate
bazate pe vectorul points.shp, parametrul RAIN:

Atent,ionare: Setează dimensiunea celulei la 500 pentru toate analizele.

• GRASS ► v.surf.rst

• SAGA ► nterpolare B-Spline Multinivel

• SAGA►Distant,a Inversă Ponderată [Distant,a inversă ridicată la o putere; Puterea: 4; Raza de căutare: Global;
Intervalul de căutare: toate punctele]

• GDAL ► Grilă (Distant,a Inversă ridicată la o putere) [Puterea:4]
• GDAL ► Grilă (Deplasări medii) [Raza1&2: 50000]

Apoi măsurat,i variat,ia dintre metode s, i corelat,i-o cu distant,a până la puncte:
• GRASS ► r.series [Deselectare NULL-uri Propagate, Operat,ia de Agregare: stddev]
• GRASS ► v.to.rast.value asupra points.shp
• GDAL ► Proximitatea

• GRASS ► r.covar pentru a arăta matricea de corelat,ie; verificat,i semnificat,ia corelat,iei, de exemplu, cu http:
//vassarstats.net/rsig.html.

Astfel, zonele de puncte îndepărtate vor avea o interpolare mai put,in precisă.

17.30.2 Curbe de nivel

Diverse metode pentru a desena linii de contur [întotdeauna pasul= 10] în rasterul stddev:
• GRASS ► r.contour.step

• GDAL ► Curbe de nivel

• SAGA ► Curbele de nivel dintr-o grilă [NB: în unele versiuni mai vechi de SAGA, shp-ul nu este valid, ceea
ce este o eroare cunoscută]
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17.31 Simplificarea s, i netezirea vectorilor

Modulul a fost dezvoltat de Paolo Cavallini - Faunalia

Notă: Acest capitol prezintă modalităt,ile de simplificare a vectorilor, precum s, i de netezire a colt,urilor ascut,ite.

Uneori avem nevoie de o versiune simplificată a unui vector, pentru a avea o dimensiune mai mică de fis, ier s, i pentru
a scăpa de detaliile inutile. Multe instrumente fac acest lucru într-un mod foarte brut, omit,ând uneori corectitudinea
topologică s, i adiacent,a poligoanelor. GRASS este instrumentul ideal pentru acest lucru: fiind un GIS topologic,
adiacent,a s, i corectitudinea sunt păstrate chiar s, i la niveluri foarte ridicate de simplificare. În cazul nostru, avem un
vector rezultat dintr-un raster, fapt indicat de modelul „zimt,ilor” de la frontiere. Aplicarea simplificării va produce
linii drepte:

• GRASS ► v.generalize [Valoarea tolerant,ei maxime: 30 m]
De asemenea, putem proceda s, i invers, făcând un strat mai complex, prin netezirea colt,urilor ascut,ite:

• GRASS ► v.generalize [methoda: chaiken]
Încercat,i să aplicat,i această a doua comandă atât vectorului init,ial, cât s, i celui de la prima analiză, pentru a vedea
diferent,a. Ret,inet,i că adiacent,a nu este pierdută.
Această a doua opt,iune se poate aplica, de exemplu, curbelor de nivel care rezultă dintr-o raster grosier, la traseele
GPS cu noduri rare, etc.

17.32 Planificarea unei ferme solare

Module contributed by Paolo Cavallini - Faunalia

Notă: Acest capitol arată cum să utilizat,i diverse criterii, în scopul localizării zonelor potrivite pentru instalarea unei
centrale fotovoltaice

Mai întâi de toate, creat,i o hartă a aspectului dintr-un DTM:
• GRASS ► r.aspect [Tipul datei: int; cell size:100]

În GRASS, aspectul este calculat în grade, în sens invers acelor de ceasornic, pornind de la Est. Pentru a extrage
numai pantele orientate spre Sud (270 de grade +- 45), putem să-l reclasificăm:

• GRASS ► r.reclass

cu următoarele reguli:

225 thru 315 = 1 south
* = NULL

Putet,i utiliza fis, ierul text furnizat, reclass_south.txt. De asemenea, ret,inet,i că, folosind aceste fis, iere text
simple, putem crea reclasificări foarte complexe.
Dorim să construim o fermă mare, astfel încât vom selecta doar zonele învecinate mari (> 100 ha):

• GRASS ► r.reclass.greater

În final, le convertim într-un vector:
• GRASS ► r.to.vect [Tipul entităt,ii: arie; Colt,uri netede: da]

Exercit,iu pentru cititor: repetat,i analiza, înlocuind comenzile GRASS cu unele similare cu ale altor programe.
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17.33 Utilizarea scrípturilor R în cadrul procesării

Module contributed by Matteo Ghetta - funded by Scuola Superiore Sant’Anna
Processing (with the Processing R Provider plugin) makes it possible to write and run R scripts inside QGIS.

Atent,ionare: R has to be installed on your computer and the PATH has to be correctly set up. Moreover
Processing just calls the external R packages, it is not able to install them. So be sure to install external packages
directly in R. See the related chapter in the user manual.

Notă: If you have package problems, it may be related to missing mandatory packages required by Processing, like
sp, rgdal and raster.

17.33.1 Adăugarea scrípturilor

Adding a script is simple. The easiest way is to open the Processing toolbox and choose Create new R script… from
the R menu (labelled with an R icon) at the top of the Processing Toolbox. You can also create the script in for
instance a text editor and save it in your R scripts folder (processing/rscripts). When it has been saved
there, it will be available for editing by right-clicking on the script name in the processing toolbox and then choose
Edit Script…).

Notă: Dacă nu putet,i vizualiza R în Processing, trebuie să îl activat,i din Processing ► Opt,iuni ► Furnizori

Se va deschide o fereastră de editare a scriptului în care va trebui să specificat,i o serie de parametri, înainte de a putea
adăuga corpul scriptului.
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17.33.2 Crearea diagramelor

În cadrul acestui tutorial vom crea o diagramă de tip boxplot pentru un câmp al unui strat vectorial.
Open the r_intro.qgs QGIS project under the exercise_data/processing/r_intro/ folder.

Parametrii scriptului

Deschidet,i editorul s, i începet,i să scriet,i.
Va trebui să specificat,i cât,iva parametri înaintea editării scriptului:

1. The name of the group (plots in this case) in which you want to put your script (if the group does not exist, it
will be created):

##plots=group

You will find your script in the plots R group in the Processing toolbox.
2. You have to tell Processing that you want to display a plot (in this example):

##showplots

You will then find a link to the plot in the Result Viewer panel (can be turned on / off in View ► Panels and
with Processing ► Results Viewer).

3. You also need to tell Processing about your input data. In this example we want to create a plot from a field of
a vector layer:

##Layer=vector

Processing now knows that the input is a vector. The name Layer is not important, what matters is the vector
parameter.

4. Finally, you have to specify the input field of the vector layer (using the name you have provided above - Layer):

##X=Field Layer

Processing now knows that you need a field of Layer, and that you will call it X.
5. It is also possible to define the name of your script using name:

##My box plot script=name

If not defined, the file name will be used as the name of the script.
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Corpul scriptului

O dată ce partea introductivă a scriptului a fost setată, putet,i adăuga o funct,ie:

boxplot(Layer[[X]])

boxplot is the name of the R function, the parameter Layer is the name that you have defined for the input dataset
and X is the name you have defined for the field of that dataset.

Atent,ionare: The parameter X has to be within double square brackets ([[]]).

Scriptul final va trebui să arate astfel:

##Vector processing=group
##showplots
##Layer=vector
##X=Field Layer
boxplot(Layer[[X]])

Save the script in the default path suggested by Processing (processing/rscripts). If you have not defined a name in
the script heading, the file name you choose will become the name of the script in the Processing toolbox.

Notă: You can save the script wherever you like, but Processing will then not be able to include it in the processing
toolbox automatically, so you have to upload it manually.

Acum, doar rulat,i-l, folosind butonul din partea de sus a ferestrei editorului:
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Once the editor window has been closed, use the text box of Processing to find your script:

You can now fill the parameters required in the Processing algorithm window:
• for Layer choose sample_points
• for the X field choose value

Efectuat,i clic pe Executare.
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Fereastra rezultatelor ar trebui să fie deschisă în mod automat, dacă nu, doar facet,i clic pe Processing ► Result
Viewer….
Click on the link in the viewer and you will see:

17.33. Utilizarea scrípturilor R în cadrul procesării 659



QGIS Training Manual

Notă: You can open, copy and save the image by right clicking on the plot.

17.33.3 Crearea unui vector

You can also create a vector layer and have it automatically loaded into QGIS.
The following example has been taken from the Random sampling grid script that can be found in the online
collection of R scripts (the scripts in this online collection can be found in https://github.com/qgis/QGIS-Processing/
tree/master/rscripts).
The aim of this exercise is to create a random point vector layer using an input vector layer to restrict the extent using
the spsample function of the sp package.
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Parametrii scriptului

Ca s, i mai înainte, avem de stabilit cât,iva parametri la începutul script-ului:
1. Specify the name of the group in which you want to put your script, in this case Point pattern analysis:

##Point pattern analysis=group

2. Define an input parameter (a vector layer) that will constrain the placement of the random points:

##Layer=vector

3. Set an input parameter for the number of points that are going to be created (Size, with a default value of
10):

##Size=number 10

Notă: Since a default value (10) is defined, the user can change this number or can leave the parameter
without a number.

4. Specify that there is an output vector layer (called Output):

##Output=output vector

Corpul scriptului

Acum putet,i adăuga corpul funct,iei:
1. Use the spsample function:

pts=spsample(Layer, Size, type="random")

The function uses the Layer to constrain the placement of the points (if it is a line layer, a points will have to
be on one of the lines in the layer, if it is a polygon layer, a point will have to be within a polygon). The number
of points is taken from the Size parameter. The sampling method is random.

2. Generate the output (the Output parameter):

Output=SpatialPointsDataFrame(pts, as.data.frame(pts))

Scriptul final va trebui să arate astfel:

##Point pattern analysis=group
##Layer=vector
##Size=number 10
##Output=output vector
pts=spsample(Layer, Size, type="random")
Output=SpatialPointsDataFrame(pts, as.data.frame(pts))
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Save it and run it, clicking on the run button.
În noul tip de fereastră scriet,i parametrii potrivit,i:

apoi facet,i clic pe rulare.
The result layer will be added to the table of contents and its points will be displayed on the map canvas:
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17.33.4 Text and graph output from R - syntax

Processing (with the Processing R Provider plugin) uses special syntax to get the results out of R:
• > înainte de comanda dvs., ca în >lillie.test(Layer[[Field]]) denotă că rezultatul ar trebui să
fie trimis la ies, irea R (Vizualizatorul de rezultate)

• + after a plot enables overlay plots. For example plot(Layer[[X]], Layer[[Y]]) +
abline(h=mean(Layer[[X]]))

17.34 Prezicerea alunecărilor de teren

Modulul a fost dezvoltat de Paolo Cavallini - Faunalia

Notă: Acest capitol vă arată cum să creat,i un model simplificat pentru a prezice probabilitatea alunecărilor de teren.

În primul rând, vom calcula panta (aleasă dintre diferite variante; cititorul interesat poate calcula diferent,a dintre
rezultate):

• GRASS ► r.slope

• SAGA ► Pantă, Aspect, Curbură

• Panta GDAL

Apoi vom crea un model de predict,ie a precipitat,iilor, pe baza interpolării valorilor precipitat,iilor de la stat,iile meteo:
• GRASS ► v.surf.rst (rezolut,ia: 500 m)

Probabilitatea unei alunecări de teren va fi afectată atât de precipitat,ii cât s, i de pantă (desigur, un model la scară reală
va folosi mai multe straturi, s, i parametri mai potrivit,i), rezultând formula (precipitat,ii * pantă)/100:

• SAGA ► Calculator raster precipitat,ii, pantă: (a*b)/100 (sau: GRASS ► r.mapcalc)
• apoi vom calcula care sunt municipalităt,ile cu un mai mare risc de precipitat,ii: SAGA► Statistici pentru rastere
cu poligoane (parametrii de interes fiind Maximum s, i Medie)
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Module: Using Spatial Databases in QGIS

În acest modul vet,i învăt,a despre modul de utilizare a bazelor de Date Spat,iale în QGIS, pentru a gestiona, afis,a s, i
manipula datele, precum s, i pentru a le analiza prin efectuarea de interogări. Vom folosi în principal PostgreSQL s, i
PostGIS (care au fost acoperite în sect,iunile anterioare), dar aceleas, i concepte sunt aplicabile s, i altor implementări
de baze de date spat,iale, inclusiv SpatiaLite.

18.1 Lesson: Working with Databases in the QGIS Browser

În cele 2 module anterioare am prezentat conceptele de bază, facilităt,ile s, i funct,iile de bază ale bazelor de date
relat,ionale, precum s, i extensiile care permit stocarea, administrarea, interogarea s, i manipularea datelor spat,iale.
Această sect,iune va aborda, în detaliu, utilizarea eficientă a bazelor de date spat,iale în QGIS.
Scopul acestei lect,ii: Utilizarea interfet,ei QGIS pentru a interact,iona cu bazele de date spat,iale.

18.1.1 ��� Follow Along: Adding Database Tables to QGIS using the Browser

Am văzut, pe scurt, cum pot fi adăugate, sub formă de straturi QGIS, tabelele dintr-o bază de date; haidet,i acum să
intrăm în mai multe detalii s, i să vedem diverse moduri de a face acest lucru în QGIS. Să aruncăm, mai întâi, o privire
la noua interfat,ă a Navigatorului.

• Începet,i o nouă hartă în QGIS.
• Deschidet,i Navigatorul efectuând un clic pe fila Navigator, din partea de jos a Panoului Straturilor
• Deschidet,i port,iunea PostGIS a arborelui, pentru a găsi conexiunea configurată anterior (poate fi necesar să
facet,i clic pe butonul Refresh, din partea de sus a ferestrei navigatorului).
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• Un clic dublu pe oricare din tabelele/straturile listate aici va duce la adăugarea sa pe Canevasul Hărt,ii.
• Făcând clic dreapta pe o tabelă/strat în această vizualizare vet,i observa câteva opt,iuni. Aleget,i Proprietăt,i,
pentru a vedea proprietăt,ile stratului.
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Notă: Desigur, putet,i folosi această interfat,ă s, i pentru a vă conecta la bazele de date PostGIS găzduite pe un server
extern . Făcând clic dreapta pe intrarea PostGIS din arbore, vet,i putea specifica parametrii unei noi conexiuni.

18.1.2 ��� Follow Along: Adding a filtered set of records as a Layer

Acum, că am văzut cum putet,i adăuga în QGIS un întreg tabel, sub formă de strat, putet,i continua, adăugând un set
de înregistrări filtrate dintr-un tabel, utilizând interogările învăt,ate în sect,iunile anterioare.

• Începet,i o hartă nouă, fără straturi
• Facet,i clic pe butonul de Adăugare Straturi PostGIS sau selectat,i Strat► Adăugare Straturi PostGIS din meniu.
• În dialogul de Adăugare Tabel(e) PostGIS, care se deschide, folosit,i conexiunea postgis_demo.
• Extindet,i schema public s, i găsit,i cele trei tabele cu care am lucrat anterior.
• Facet,i clic pe stratul lines pentru a-l selecta, dar în loc să-l adăugat,i, apăsat,i butonul Setare Filtru, pentru a
deschide dialogul Constructorului de Interogări.

• Construit,i următoarea expresie, utilizând butoanele sau prin introducere directă:

"roadtype" = 'major'
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• Facet,i clic pe OK pentru a încheia editarea filtrului, apoi pe Adăugare, pentru a adăuga pe hartă stratul filtrat.
• Redenumire strat lines din arborele roads_primary.

Vet,i observa că numai Drumurile Primare au fost adăugate pe hartă, s, i nu întregul strat.

18.1.3 În concluzie

At,i văzut cum se poate interact,iona cu bazele de date spat,iale folosind QGIS Browser, s, i modul în care se pot adăuga
straturi pe hartă în funct,ie de un filtru de interogare.

18.1.4 Ce urmează?

În continuare, este prezentat lucrul cu interfat,a Managerului DB din QGIS, pentru o serie amplă de activităt,i de
gestiune a bazelor de date.

18.2 Lesson: Using DB Manager to work with Spatial Databases in
QGIS

Am văzut deja cum se pot efectua în QGIS multe operat,ii cu bazele de date, la fel de simplu ca s, i cu celelalte
instrumente, dar acum este timpul să ne uităm la instrumentul DB Manager, care oferă o mare parte din aceeas, i
funct,ionalitate, similar cu alte instrumente dedicate managementului.
Scopul acestei lect,ii: De a se învăt,a interact,iunea cu bazele de date raster, folosind interfat,a DBManager din QGIS.

18.2.1 ��� Follow Along: Managing PostGIS Databases with DB Manager

You should first open the DB Manager interface by selecting Database ► DB Manager ► DB Manager on the menu
or by selecting the DB Manager icon on the toolbar.
You should already see the previous connections we have configured and be able to expand the myPG section and its
public schema to see the tables we have worked with in previous sections.
Primul lucru care se remarcă este faptul că, de acum, putet,i vedea unele metadate ale Schemelor cont,inute în baza
de date.
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Schemas are a way of grouping data tables and other objects in a PostgreSQL database and a container for permissions
and other constraints. Managing PostgreSQL schemas is beyond the scope of this manual, but you can find more
information about them in the PostgreSQL documentation on Schemas. You can use the DB Manager to create new
Schemas, but will need to use a tool like pgAdmin III or the command line interface to manage them effectively.
De asemenea, DB Manager se poate folosi pentru a administra tabelele din baza de date. Am analizat deja diferite
moduri de creare s, i gestionare a tabelelor din linia de comandă, dar acum dorim să vedem cum se poate face acest
lucru în DB Manager.
First, its useful to just look at a table’s metadata by clicking on its name in tree and looking in the Info tab.
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In this panel you can see the General Info about the table as well the information that the PostGIS extension maintains
about the geometry and spatial reference system.
If you scroll down in the Info tab, you can see more information about the Fields, Constraints and Indexes for the table
you are viewing.
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Its also very useful to use DB Manager to simply look at the records in the database in much the same way you might
do this by viewing the attribute table of a layer in the Layer Tree. You can browse the data by selecting the Table tab.
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Există, de asemenea o filă Preview, care vă va arăta datele stratului într-o hartă de previzualizare.
Click-dreapta pe unul dintre straturi s, i, făcând clic pe Add to Canvas, acesta se va adăuga pe hartă.
So far we have only been viewing the database its schemas and tables and their metadata, but what if we wanted to
alter the table to add an additional column perhaps? DB Manager allows you to do this directly.

1. Selectat,i din arbore tabela pe care dorit,i să o editat,i
2. Select Table ► Edit Table from the menu, to open the Table Properties dialog.

Putet,i folosi acest dialog pentru a Adăuga Coloane, Coloane pentru geometrii, pentru a edita coloanele existente sau
pentru a elimina complet o coloană.
Using the Constraints tab, you can manage which fields are used as the primary key or to drop existing constraints.
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Fila Indecs, ilor poate fi folosită pentru a adăuga s, i s, terge atât indicii spat,iali, cât s, i cei normali.
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18.2.2 ��� Follow Along: Creating a New Table

Acum, că am trecut prin procesul de lucru cu tabelele existente în baza noastră de date, haidet,i să folosimDBManager
pentru a crea o nouă tabelă.

1. If it is not already open, open the DB Manager window, and expand the tree until you see the list of tables
already in your database.

2. Selectat,i meniul :guilabel:`Table –> Create Table`pentru a deschide dialogul de Creare a Tabelei.
3. Use the default Public schema and name the table places.
4. Add the id, place_name, and elevation fields as shown below
5. Make sure the id field is set as the primary key.
6. Click the checkbox to Create geometry column and make sure it is set to a POINT type and leave it named

geom and specify 4326 as the SRID.
7. Facet,i clic pe caseta de bifare de Creare a indexului spat,ial, apoi pe Create pentru a crea tabela.

674 Capitolul 18. Module: Using Spatial Databases in QGIS



QGIS Training Manual

8. Închidet,i dialogul care vă informează că tabela s-a creat cu succes, apoi facet,i clic pe Close pentru a închide
Dialogul de Creare a Tabelei.

You can now inspect your table in the DB Manager and you will of course find that there is no data in it. From here
you can Toggle Editing on the layer menu and begin to add places to your table.

18.2.3 ��� Follow Along: Basic Database Administration

The DB Manager will also let you do some basic database administration tasks. It is certainly not a substitute for a
more complete database administration tool, but it does provide some functionality that you can use to maintain your
database.
Database tables can often become quite large and tables which are being modified frequently can end up leaving
around remnants of records that are no longer needed by PostgreSQL. The VACUUM command takes care of doing
a kind of garbage collection to compact and optional analyze your tables for better performance.
Let us take a look at how we can perform a VACUUM ANALYZE command from within DB Manager.

1. Select one of your tables in the DB Manager Tree
2. Select Table ► Run Vacuum Analyze from the menu

PostgreSQL will now perform the operation. Depending on how big your table is, this may take some time to
complete.
You can find more information about the VACUUM ANALYZE process in the PostgreSQL Documentation on
VACUUM ANALYZE.
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18.2.4 ��� Follow Along: Executing SQL Queries with DB Manager

DB Manager also provides a way for you to write queries against your database tables and to view the results. We
have already seen this type of functionality in the Browser panel, but lets look at it again here with DB Manager.

1. Select the lines table in the tree.
2. Selectat,i butonul SQL window din bara de instrumente DB Manager.

3. Compunet,i următoarea Interogare SQL în spat,iul furnizat:

select * from lines where roadtype = 'major';

4. Clic pe butonul Execute (F5) pentru a rula interogarea.
5. Ar trebui să vedet,i acum înregistrările care corespund panoului Rezultate.

6. Facet,i clic pe caseta de bifare Load as new layer pentru a adăuga rezultatele în harta dvs.
7. Select the id column as the Column with unique integer values and the geom column as the Geometry column.
8. Enter roads_primary as the Layer name (prefix).
9. Facet,i clic pe Load now! pentru a încărca rezultatele ca un nou strat în harta dvs.
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The layers that matched your query are now displayed on your map. You can of course use this query tool to execute
any arbitrary SQL command including many of the ones we looked at in previous modules and sections.

18.2.5 Importarea datelor dintr-o Bază de date cu ajutorul DB Manager

We have already looked at how to import data into a spatial database using command line tools, so now let’s learn
how to use DB Manager to do imports.

1. Clic pe butonul Import layer/file din Bara de Instrumente a dialogului DB Manager.

2. Select the urban_33S.shp file from exercise_data/projected_data as the input dataset
3. Clic pe butonul Opt,iunilor de actualizare pentru a pre-completa unele din valorile formularului.
4. Asigurat,i-vă că este selectată opt,iunea Creare tabelă nouă.
5. Specify the Source SRID as 32722 and the Target SRID as 4326
6. Activat,i caseta de bifare pentru a Crea îndexul Spat,ial
7. Click OK to perform the import
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8. Închidet,i dialogul care vă informează că importul a avut loc cu succes
9. Click the Refresh button on the DB Manager Toolbar

You can now inspect the table in your database by clicking on it in the Tree. Verify that the data has been reprojected
by checking that the Spatial ref: is listed as WGS 84 (4326).
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Click-dreapta pe unul dintre straturile din Arbore s, i apoi, făcând clic pe Adăugare la Canevas, tabela se va adăuga
pe hartă, sub formă de strat.

18.2.6 Exportul datelor cu DB Manager dintr-o Bază de date

De asemenea, DB Manager se poate utiliza pentru exportul datelor din bazele de date spat,iale, as,a că haidet,i să
aruncăm o privire la modul în care se face aceasta.

1. Select the lines layer in the Tree and click the Export to File button on the toolbar to open the Export to
vector file dialog.

2. Click the … button to select the Output file and save the data to your exercise_data directory as
urban_4326.

3. Set the Target SRID as 4326.
4. Clic OK pentru a init,ializa exportul.
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5. Închidet,i dialogul care vă informează că exportul a avut loc cu succes, apoi închidet,i DB Manager.
Putet,i inspecta de acum fis, ierul shape pe care l-at,i creat cu panoul de Răsfoire.
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18.2.7 În concluzie

You have now seen how to use the DB Manager interface in QGIS to manage your spatial databases, to execute SQL
queries against your data and how to import and export data.

18.2.8 Ce urmează?

Next, we will look at how to use many of these same techniques with SpatiaLite databases.

18.3 Lesson: Working with SpatiaLite databases in QGIS

While PostGIS is generally used on a server to provide spatial database capabilities to multiple users at the same
time, QGIS also supports the use of a file format called SpatiaLite that is a lightweight, portable way to store an entire
spatial database in a single file. Obviously, these 2 types of spatial databases should be used for different purposes,
but the same basic principles and techniques apply to both. Let’s create a new SpatiaLite database and explore the
functionality provided to work with these databases in QGIS.
The goal for this lesson: To learn how to interact with SpatiaLite databases using the QGIS Browser interface.

18.3.1 ��� Follow Along: Creating a SpatiaLite database with the Browser

Using the Browser panel, we can create a new SpatiaLite database and get it setup for use in QGIS.
1. Right click on the SpatiaLite entry in the Browser tree and select Create Database.
2. Specify where on your filesystem you want to store the file and name it qgis-sl.db.
3. Again right click on the SpatiaLite entry in the Browser tree and now select the New Connection item. Find the

file you created in the last step and open it.
Acum, că v-at,i configurat noua bază de date, vet,i descoperi că intrarea din arborele Navigatorului nu are nimic sub
ea, iar singurul lucru pe care îl putet,i face în acest moment este de a s, terge conexiunea. Acest lucru se datorează
faptului că, desigur, noi nu am adăugat nici un tabel în această bază de date. Haidet,i să mergem mai departe s, i să
facem asta.

1. Find the button to create a new layer and use the dropdown to create a new SpatiaLite layer, or select Layer►
New ► New SpatiaLite Layer.

2. Selectat,i baza de date pe care am creat-o în pas, ii anteriori în meniul derulant.
3. Give the layer the name places.
4. Bifat,i caseta de lângă Create an auto-incrementing primary key.
5. Add two attributes as shown in below
6. Clic pe OK, pentru a crea tabela.
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7. Click the refresh button at the top of the Browser and you should now see your places table listed.
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Putet,i să facet,i clic dreapta pe tabelă s, i să-i vizualizat,i proprietăt,ile, as,a cum am făcut-o în exercit,iul precedent.
De aici putet,i începe o sesiune de editare s, i să adăugat,i date direct la noua bază de date.
We also learned about how to import data into a database using the DBManager and you can use this same technique
to import data into your new SpatiaLite DB.

18.3.2 În concluzie

You have seen how to create SpatiaLite databases, add tables to them and use these tables as layers in QGIS.
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Anexă: Contribut,ii La Acest Manual

To add materials to this course, you must follow the guidelines in this Appendix. You are not allowed to alter the
conditions in this Appendix except for clarification. This is to ensure that the quality and consistency of this manual
can be maintained.

19.1 Descărcare resurse.

Sursa acestui document se poate găsi la GitHub. Consultat,i GitHub.com pentru instruct,iunile de folosire a sistemului
de versionare git.

19.2 Formatul Manualului

Acest manual este scris folosind Sphinx, un generator de documente Python, care foloses, te limbajul de marcare
`reStructuredText <https://docutils.sourceforge.io/rst.html >`_ . Instruct,iuni despre cum să utilizat,i aceste
instrumente sunt disponibile pe respectivele site-uri.

19.3 Adăugarea unui Modul

To add a new module:
1. First create a new directory (directly under the top-level of the qgis-training-manual directory) with

the name of the new module.
2. Under this new directory, create a file called index.rst. Leave this file blank for now.
3. Open the index.rst file under the top-level directory. Its first lines are:

.. toctree::
:maxdepth: 2

foreword/index
introduction/index
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You will note that this is a list of directory names, followed by the name index. This directs the top-
level index file to the index files in each directory. The order in which they are listed determines the
order they will have in the document.

1. Add the name of your new module (i.e., the name you gave the new directory), followed by /index, to this
list, wherever you want your module to appear.

2. Amintit,i-vă să ment,inet,i ordinea modulelor logice, astfel încât modulele ulterioare se construiesc pe
cunos, tint,ele prezentate în modulele anterioare.

3. Open your new module’s own index file (module_name/index.rst).
4. Along the top of the page, create the module heading:

1. write a first line of asterisks (*).
2. Follow this with a line containing the markup phrase Module:, followed by the name of your module.
3. End this off with another line of same number of asterisks.

Notă: The underline and the overline should not be shorter than the line containing the module title.

5. Lăsat,i o linie deschisă după aceasta.
6. Scriet,i un scurt paragraf, explicând scopul s, i cont,inutul modulului.
7. Lăsat,i o linie deschisă, apoi adăugat,i următorul text:

.. toctree::
:maxdepth: 2

lesson1
lesson2

…where lesson1, lesson2, etc., are the names of your planned lessons.
Fis, ierul index la nivel de modul va arăta astfel:

*******************************************************************************
Module: Module Name
*******************************************************************************

Short paragraph describing the module.

.. toctree::
:maxdepth: 2

lesson1
lesson2

19.4 Adăugarea unei Lect,ii

Pentru a adăuga o lect,ie pentru un modul nou sau existent:
1. Deschidet,i directorul modulului
2. Open the index.rst file (created above in the case of new modules).
3. Ensure that the name of the planned lesson is listed underneath the toctree directive, as shown above.
4. Creat,i un nou fis, ier în directorul modulul.
5. Name this file exactly the same as the name you provided in the module’s index.rst file, and add the

extension .rst.
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Notă: For editing purposes, a .rst file works exactly like a normal text file (.txt).

1. To begin writing the lesson, write the markup phrase Lesson, followed by the lesson name.
2. In the next line, write a line of equal signs (=), not shorter than the lesson title.
3. Lăsat,i o linie deschisă după aceasta.
4. Scriet,i o scurtă descriere asupra scopului lect,iei.
5. Includet,i o introducere generală în subiect. Parcurget,i lect,iile existente în acest manual, pentru exemple.
6. Sub aceasta, începet,i un nou alineat, începând cu această frază:

**The goal for this lesson:**

7. Explicat,i pe scurt rezultatul intent,ionat al completării acestei lect,ii.
8. În cazul în care obiectivul lect,iei nu se poate descrie într-una sau două propozit,ii, luat,i în considerare împărt,irea

subiectului în mai multe lect,ii.
Fiecare lect,ie va fi împărt,ită în mai multe sect,iuni, care vor fi abordate în continuare.

19.5 Adăugarea unei Sect,iuni

Există două tipuri de sect,iuni: „procedat,i în mod similar” s, i „încercat,i singuri”.
• O sect,iune de „urmărire” reprezintă un set detaliat de instruct,iuni, menite să învet,e cititorul cum să folosească
un anumit aspect din QGIS. Acest lucru se face, de obicei, oferind instruct,iuni clic cu clic, cât mai clar posibil,
intercalate cu capturi de ecran.

• A „try yourself” section gives the reader a short assignment to try by themselves. It is usually associated with
an entry in the answer box beneath, which will show or explain how to complete the assignment, and will show
the expected outcome if possible.

Every section comes with a difficulty level. An easy section is denoted by ★☆☆, moderate by ★★☆, and advanced by
★★★.

19.5.1 Adăugat, i o sect, iune „procedat, i în mod similar”

1. Pentru a începe această sect,iune, scriet,i fraza de marcare a nivelului de dificultate intent,ionat (după cum se
arată mai sus).

2. Leave a space and then write Follow Along:.
3. Lăsat,i un alt spat,iu s, i scriet,i numele sect,iunii (folosit,i doar o literămare, precum s, i majuscule pentru substantive

proprii).
4. In the next line, write a line of minuses/dashes (-), not shorter than the section title.
5. Scriet,i o scurtă introducere a sect,iunii, explicându-i scopul. Apoi oferit,i instruct,iuni detaliate (clic-după-clic)

privind procedura care trebuie demonstrată.
6. În fiecare sect,iune, includet,i link-uri interne, link-uri externe s, i capturi de ecran după cum este necesar.
7. Încercat,i să terminat,i fiecare sect,iune cu un scurt paragraf, care să se încheie s, i să conducă în mod natural la

sect,iunea următoare, dacă este posibil.
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19.5.2 Adăugat, i o sect, iune „încercat, i singuri”

1. Pentru a începe această sect,iune, scriet,i fraza de marcare a nivelului de dificultate intent,ionat (după cum se
arată mai sus).

2. Leave a space and then write Try Yourself:.
3. In the next line, write a line of minuses/dashes (-), not shorter than the section title.
4. Explicat,i exercit,iul pe care dorit,i ca cititorul să-l finalizeze. Consultat,i sect,iunile anterioare, lect,iile sau

modulele, dacă este necesar.
5. Includet,i capturi de ecran pentru a clarifica cerint,ele, în cazul în care o descriere textuală simplă nu este de

ajuns.
In most cases, you will want to provide an answer regarding how to complete the assignment given in this section. To
do so, you will need to create and feed an answer block beneath the instructions.

1. First, create the custom collapsible widget that contains the answer:

.. admonition:: Answer
:class: dropdown

2. Keeping an indentation with regard to the above block, write the instructions on how to complete the
assignment, using links and images where needed.

19.6 Adăugarea unei Concluzii

To end a lesson:
1. Write the phrase In Conclusion, followed by a new line of minuses/dashes (-).
2. Write a conclusion for the lesson, explaining which concepts have been covered in the lesson.

19.7 Adăugarea unei Sect,iuni de Lecturi suplimentare

Această sect,iune este opt,ională.
• Write the phrase Further Reading, followed by a new line of minuses/dashes (-).
• Includet,i trimiteri către site-urile externe corespunzătoare.

19.8 Adăugarea Sect,iunii „Ce Urmează”

1. Scriet,i expresia Ce urmează?, urmată de o nouă linie de minusuri/liniut,e (-).
2. Explicat,i modul în care a pregătit această lect,ie student,ii pentru lect,ia sau modulul următor.
3. Nu uitat,i să schimbat,i sect,iunea „ce urmează” din lect,ia anterioară, dacă este necesar, astfel încât să se refere

la noua dvs. lect,ie. Acest lucru va fi necesar dacă at,i introdus o nouă lect,ie printre lect,iile existente sau după
o lect,ie existentă.
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19.9 Utilizarea Marcajelor

Pentru a adera la standardele acestui document, va trebui să adăugat,i marcajul standard textului dvs.

19.9.1 Noi concepte

If you are explaining a new concept, you will need to write the new concept’s name in italics by enclosing it in asterisks
(*).

This sample text shows how to introduce a *new concept*.

19.9.2 Atent, ie specială

• To emphasize a crucial term which is not a new concept, write the term in bold by enclosing it in double
asterisks (**).

• Folosit,i-le cu moderat,ie! Dacă utilizat,i prea multe, cititorul ar putea avea impresia că strigat,i sau ca avet,i un
aer de superioritate.

This sample text shows how to use **emphasis** in a sentence. Include the
punctuation mark if it is followed by a **comma,** or at the **end of the
sentence.**

19.9.3 Imagini

• When adding an image, save it to an img folder next to the lesson file.
• Includet,i-l în document, în felul următor:

.. figure:: img/image_file.extension
:align: center

• Nu uitat,i să lăsat,i o linie, deasupra s, i dedesubtul marcajului imaginii.

19.9.4 Legături interne

• Pentru a crea o ancoră pentru un link, scriet,i următoarea linie deasupra locului către care dorit,i să indice linkul:

.. _link-name:

• Nu uitat,i să lăsat,i o linie, deasupra s, i dedesubtul acestei linii.
• To create a link, refer to it as below:

:ref:`Descriptive link text <link-name>`
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19.9.5 Legături externe

• Pentru a crea o legătură externă, scriet,i-o astfel:

`Descriptive link text <link-url>`_

19.9.6 Utilizat, i text monospat, iat

• When you are writing text that the user needs to enter, a path name, or the name of a database element such
as a table or column name, you must write it in monospaced text. For example:

Enter the following path in the text box: ``path/to/file``.

19.9.7 Etichetarea elementelor GUI

• Dacă vă referit,i la un element GUI, cum ar fi un buton, trebuie să scriet,i numele acestuia în formatul etichetei
GUI. De exemplu:

To access this tool, click on the :guilabel:`Tool Name` button.

• Acest lucru se aplică, de asemenea, dacă ment,ionat,i numele unui instrument fără a cere utilizatorului să
efectueze clic pe un buton.

19.9.8 Select, ia meniului

• Dacă ghidat,i un utilizator prin meniuri, trebuie să utilizat,i menu ► selection ► format. De exemplu:

To use the :guilabel:`Tool Name` tool, go to :menuselection:`Plugins -->
Tool Type --> Tool Name`.

19.9.9 Adăugarea notelor

• You might need to add a note in the text, which explains extra details that can’t easily be made part of the flow
of the lesson. This is the markup:

[Normal paragraph.]

.. note:: Note text.
New line within note.

New paragraph within note.

[Unindented text resumes normal paragraph.]
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19.9.10 Adăugarea o notă de sponsorizare/drepturi de autor

Dacă scriet,i un noumodul, o lect,ie sau o sect,iune în numele unui sponsor, trebuie să includă un scurt mesaj, la alegerea
sponsorului. Acesta trebuie să informeze cititorul despre numele sponsorului s, i trebuie să apară sub titlul modulului,
lect,iei sau sect,iunii sponsorizate. Totus, i, mesajul nu poate consta într-o reclamă pentru compania sponsorului.
If you have volunteered to write a module, lesson or section in your own capacity, and not on behalf of a sponsor,
you may include an authorship note below the heading of the module, lesson or section that you authored. This must
take the form This [module/lesson/section] contributed by [author name]. Do not add
further text, contact details, etc. Such details are to be added in the „Contributors” section of the Foreword, along
with the name(s) of the part(s) you added. If you only made enhancements, corrections and/or additions, list yourself
as an editor.

19.10 Mult,umiri!

Vă mult,umim pentru contribut,ia la acest proiect! Procedând astfel, facet,i QGIS mai accesibil pentru utilizatori s, i
adăugat,i valoare întregului proiect QGIS.
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CAPITOLUL20

Pregătirea Datelor pentru Exercit,ii

Important: Acest proces este destinat profesorilor sau utilizatorilor de QGIS experimentat,i care doresc să creeze
seturi cu es,antioane de date localizate pentru cursurile lor. Seturile de date implicite sunt furnizate cu Manualul de
instruire, dar este posibilă utilizarea acestor instruct,iuni dacă dorit,i să înlocuit,i seturile de date implicite.

The sample data provided with the Training Manual refers to the town of Swellendam and its surroundings.
Swellendam is located about 2 hours» east of Cape Town in the Western Cape of South Africa. The dataset contains
feature names in both English and Afrikaans.
Oricine poate utiliza, fără dificultate, acest set de date, dar este posibil să preferat,i să utilizat,i date din propria t,ară
sau din oras,ul natal. În cazul în care aleget,i să facet,i acest lucru, datele dvs. localizate vor fi utilizate în toate lect,iile,
de la Modulul 3 până la modulul 7.2. Modulele ulterioare folosesc surse de date mai complexe, care pot fi valabile,
sau nu, pentru regiunea dumneavoastră.

Notă: Aceste instruct,iuni presupun că avet,i o bună cunoas, tere aQGIS, nefiind destinate utilizării camaterial didactic.

20.1 Create OSM based vector files

If you wish to replace the default data set with localised data for your course, this can easily be done with tools
built into QGIS. The region you choose to use should have a good mix of urban and rural areas, containing roads
of differing significance, area boundaries (such as nature reserves or farms) and surface water, such as streams and
rivers.

1. Deschidet,i un nou proiect QGIS
2. Select Layer ► Data Source Manager to open the Data Source Manager dialog
3. In the Browser tab, expand the XYZ Tiles drop-down menu and double-click the OpenStreetMap item.
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A map of the world is now visible on the map canvas.
4. Close the Data Source Manager dialog
5. Move to the area you’d like to use as study area

Now that we have the area we’ll extract the data from, let’s enable the extraction tools.
1. Go to Plugins ► Manage/Install Plugins…

2. In the All tab, type QuickOSM in the search box
3. Select the QuickOSM plugin, press Install Plugin and then Close the dialog.
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4. Execute the new plugin from Vector ► QuickOSM ► QuickOSM… menu
5. In the Quick query tab, select building in the Key drop-down menu
6. Leave the Value field empty, meaning that you are querying all buildings.
7. Select Canvas Extent in the next drop-down menu
8. Expand the Advanced group below and uncheck all geometry types on the right except Multipolygons.
9. Press Run query

A new building layer is added to the Layers panel, showing buildings in the selected extent.
10. Proceed as above to extract other data:

1. Key = landuse and Multipolygons geometry type.
2. Key = boundary, Value = protected_area and Multipolygons geometry type.
3. Key = natural, Value = water and Multipolygons geometry type.
4. Key = highway and check Lines and Multilines geometry types.
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5. Key = waterway, Value = river and check Lines and Multilines geometry types.
6. Key = place and Points geometry type.

This process adds the layers as temporary files (indicated by the icon next to their name).

You can sample the data your region contains in order to see what kind of results your region will yield.
We now need to save the resulting data to use during your course. We’ll be using ESRI Shapefile, GeoPackage and
SpatiaLite formats depending on the data.
To convert the place temporary layer to another format:

1. Click the icon next to the place layer to open the Save Scratch Layer dialog.

Notă: If you need to change any of the temporary layer’s properties (CRS, extent, fields…), use the Export
► Save Features as… contextual menu instead, and ensure the Add saved file to map option is checked. This
adds a new layer.

2. Select the ESRI Shapefile format
3. Use the… button to browse to the exercise_data/shapefile/ folder and save the file as places.

shp.
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4. Apăsat,i pe OK
In the Layers panel, the temporary place layer is replaced with the saved places shapefile layer and the temporary
icon next to it removed.

5. Double-click the layer to open its Layer Properties► Source tab and update the Layer name property to match
the file name.

6. Repeat the process for other layers, renaming them as follows:
• natural_water into water
• waterway_river into rivers
• boundary_protected_area into protected_areas

Each resulting data set should be saved in the exercise_data/shapefile/ directory.
The next step is to create a GeoPackage file from the building layer to use during the course:

1. Click the icon next to the building layer
2. Select the GeoPackage format
3. Save the file as training_data.gpkg under the exercise_data/ folder
4. By default, the Layer name is filled as the file name. Replace it with buildings.
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5. Apăsat,i pe OK
6. Rename the layer in its properties dialog
7. Repeat the process with the highway layer, saving it as roads in the same GeoPackage database.

The last step is to save the remaining temporary file as a SpatiaLite file.

1. Click the icon next to the landuse layer
2. Select the SpatiaLite format
3. Save the file as landuse.sqlite under the exercise_data/ folder. By default, the Layer name is

filled as the file name. Do not change it.
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4. Apăsat,i pe OK
You should now have a map which looks something like this (the symbology will certainly be very different, because
QGIS randomly assigns colors when layers are added to the map):

The important thing is that you have 7 vector layers matching those shown above and that all those layers have some
data.
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20.2 Create SRTM DEM tiff files

For modulesModule: Creating Vector Data andModulul: Rastere, you’ll also need raster images (SRTMDEM) which
cover the region you have selected for your course.
The CGIAR-CGI provides some SRTM DEM you can download from https://srtm.csi.cgiar.org/srtmdata/.
You’ll need images which cover the entire region you have chosen to use. To find the extent coordinates, in QGIS
, zoom to the extent of the largest layer and pick the values in the Extents box of the status bar. Keep the
GeoTiff format. Once the form is filled, click on the Click here to Begin Search >> button and download the file(s).
Once you have downloaded the required file(s), they should be saved in the exercise_data directory, under
raster/SRTM subfolders.

20.3 Create imagery tiff files

In Module Module: Creating Vector Data, ��� Follow Along: Data Sources lesson shows close-up images of three
school sports fields which students are asked to digitize. You’ll therefore need to reproduce these images using your
new SRTM DEM tiff file(s). There is no obligation to use school sports fields: any three school land-use types can
be used (e.g. different school buildings, playgrounds or car parks).
For reference, the image in the example data is:
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20.4 Replace tokens

Having created your localized dataset, the final step is to replace the tokens in the substitutions.txt file so
that the appropriate names will appear in your localized version of the Training Manual.
The tokens you need to replace are as follows:

• majorUrbanName: this defaults to „Swellendam”. Replace with the name of the major town in your region.
• schoolAreaType1: this defaults to „athletics field”. Replace with the name of the largest school area type
in your region.

• largeLandUseArea: this defaults to „Bontebok National Park”. Replace with the name of a large landuse
polygon in your region.

• srtmFileName: this defaults to srtm_41_19.tif. Replace this with the filename of your SRTM DEM
file.

• localCRS: this defaults to WGS 84 / UTM 34S. You should replace this with the correct CRS for your
region.
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